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Preface

Welcome to the Geneticist Assistant User’s Manual. The purpose of the Geneticist Assistant 
User’s Manual is to answer your questions and guide you through the procedures necessary 
to use Geneticist Assistant efficiently and effectively.

Using the manual
You will find the Geneticist Assistant User’s Manual easy to use. You can simply look up the 
topic that you need in the table of contents or the index. Later, in this Preface, you will find a 
brief discussion of each chapter to further assist you in locating the information that you 
need.

Special information about the manual
The Geneticist Assistant User’s Manual has a dual purpose design. It can be distributed 
electronically and then printed on an as-needed basis, or it can be viewed online in its fully 
interactive capacity. If you print the document, for best results, it is recommended that you 
print it on a duplex printer; however, single-sided printing will also work. If you view the 
document online, a standard set of bookmarks appears in a frame on the left side of the 
document window for navigation through the document. For better viewing, decrease the 
size of the bookmark frame and use the magnification box to increase the magnification of 
the document to your viewing preference.

Conventions used in the manual
The Geneticist Assistant User’s Manual uses the following conventions:

• Information that can vary in a command—variable information—is indicated by 
alphanumeric characters enclosed in angle brackets; for example, <Gene ID>. Do not type 
the angle brackets when you specify the variable information.

• A new term, or term that must be emphasized for clarity of procedures, is italicized.

• Page numbering is “online friendly.” Pages are numbered from 1 to x, starting with the 
cover and ending on the last page of the index.

If you do print the document using a single-sided printer, you might see a single 
blank page at the end of some chapters. This blank page has been added solely to 
ensure that the next chapter begins on an odd-numbered page. This blank page in 
no way indicates that your book is missing information.
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• This manual is intended for both print and online viewing.

• If information appears in blue, it is a hyperlink. Table of Contents and Index entries 
are also hyperlinks. Click the hyperlink to advance to the referenced information.

Assumptions for the manual
The Geneticist Assistant User’s Manual assumes that:

• You are familiar with windows-based applications and basic Windows functions and 
navigational elements.

• References to any third party standards or third party software functions were current as 
of the release of this version of Geneticist Assistant, and might have already changed. 

Organization of the manual
In addition to this Preface, the Geneticist Assistant User’s Manual contains the following 
chapters and appendices:

• Chapter 1, “Getting Started with Geneticist Assistant,” on page 13 details the installation 
requirements and installation procedure for Geneticist Assistant. It also explains how to 
open and log into Geneticist Assistant and it provides an overview of the major 
navigational elements on the main window for Geneticist Assistant, including the main 
menu, the toolbar, the tabs display area, the status bar, and the console.

• Chapter 2, “Geneticist Assistant Setup and Maintenance,” on page 53 details the objects 
that are available in Geneticist Assistant and how you can add, edit, or delete values for 
these objects. It also details the various settings (reference directory, pathogenicity colors 
coverages, and so on) that you can specify for your Geneticist Assistant installation. It 
also details quality metrics, which you can use for monitoring and reporting on the NGS 
data that are you adding to your historical NGS database.

• Chapter 3, “Geneticist Assistant User Management,” on page 85 details how to manage 
users and groups in Geneticist Assistant, including adding new users and groups, deleting 
users and groups, and managing the permissions for users and groups.

• Chapter 4, “Managing Panels and Subpanels,” on page 103 details the management of 
your Geneticist Assistant panels, which includes, adding, editing and deleting panels, and 
reviewing panel statistics, and adding, editing, and deleting subpanels.

• Chapter 5, “Managing Patients and Runs,” on page 125 details the management of 
patients. It also details how to add and carry out runs in Geneticist Assistant.

Although numbering begins on the cover page, this number is not visible on the 
cover page or front matter pages. Page numbers are visible beginning with the 
first page of the table of contents.
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• Chapter 6, “Geneticist Assistant Data Review - Runs Tab,” on page 177 details all the 
options that are available to you from the Runs tab for reviewing the data that is generated 
by a run.

• Chapter 7, “Geneticist Assistant Data Review - Run Tab,” on page 187 details all the 
options that are available to you from the Run tab for reviewing the data that is generated 
by a run.

• Chapter 8, “Geneticist Assistant Data Review - Sample Tab,” on page 209 details all the 
options that are available to you from the Sample tab for reviewing the data that is 
generated by a run.

• Chapter 9, “Geneticist Assistant Data Review - Variant Tab,” on page 243 details all the 
options that are available to you from the Variant tab for reviewing the data that is 
generated by a run.

• Chapter 10, “Geneticist Assistant Reports,” on page 265 details the generation of the six 
standard reports that are available in Geneticist Assistant. It also details how to generate 
a custom report, which includes only the data that you select. Finally, it details the Sample 
PDF report template, which you can use not only to specify the data that a Sample PDF 
report is to contain, but also the layout of the report.

• Chapter 11, “Geneticist Assistant Tools,” on page 287 details the various tools that are 
available in Geneticist Assistant to assist you with setting up, running, and analyzing 
sample data.

• Chapter 12, “The Geneticist Assistant Customer Portal and Submissions,” on page 305 
details the Geneticist Assistant customer portal, which is a web-based platform that serves 
as a dedicated hub for tracking and managing your organization’s patient and sample 
information and the tests that have been carried out for each patient/sample combination 
(a submission). It also describes the Submissions tab, which displays a full record of every 
submission that any user has ever made through your organization’s secure access point 
to the Geneticist Assistant customer portal. 

• Appendix A, “Common Procedures,” on page 317 details the procedures that are common 
to the different Geneticist Assistant entities (run, patient, sample, and variant). Where 
appropriate, it also details the slight differences that can exist based on the entity for 
which you are carrying out the procedure.

• The Glossary on page 345 provides detailed definitions of specialized terms for Geneticist 
Assistant. 
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Chapter 1
Getting Started with Geneticist 
Assistant

Geneticist Assistant is a web-based tool for the control, visualization, interpretation, and 
creation of a historical knowledge base of next generation sequencing data. This data is used 
to identify potentially pathogenic variants that are associated with specific conditions such as 
hereditary colon cancer. This chapter details the installation recommendations for Geneticist 
Assistant and how to install Geneticist Assistant. It also explains how to launch Geneticist 
Assistant and provides an overview of the major navigational elements for the application, 
including the menu bar, the toolbar, and the main window tabs. Finally, it details how to 
download and update the necessary reference files, and for data protection, how to review 
the database log and how to manually back up the Geneticist Assistant database at any time 
of your choosing.

This chapter covers the following topics:

• “Geneticist Assistant System Recommendations” on page 15.

• “Installing the SoftGenetics License Server” on page 16.

• “Installing Geneticist Assistant on a Windows OS” on page 17.

• “Starting and Logging in to Geneticist Assistant” on page 20.

• “Upgrading Geneticist Assistant” on page 26.

• “The Geneticist Assistant Main Window” on page 27.

• “Setting Display Preferences in the Geneticist Assistant Main Window” on page 31.

• “Searching the Geneticist Assistant Database” on page 46.

• “Updating References” on page 48.

• “Reviewing the Database Log” on page 50.

• “Backing up the Geneticist Assistant Database” on page 51.

     
Geneticist Assistant User’s Manual 13



Chapter 1
Getting Started with Geneticist Assistant
     
14 Geneticist Assistant User’s Manual



Chapter 1
Getting Started with Geneticist Assistant
Geneticist Assistant System Recommendations
You must have Administrator rights for the computer on which you are installing Geneticist 
Assistant.

Table 1-1: Geneticist Assistant Recommended Hardware Specifications

Client and/or Server
Operating System • Windows 7, 8, or 10 64 bit (Recommended)

• Windows Vista (64 bit)
• Windows Server 2008 (64 bit)
• Windows Server 2012 (64 bit)

Processors Two cores (64 bit)

RAM • 8 GB (Client)
• 4 GB (Server)
Minimum: 2 GB for client and server

Hard Drive • Solid State Drive
• 100 GB (Minimum)

Note: Virtual Machines are supported.

Table 1-2: Geneticist Assistant Data Specifications

Database Client
• 4 GB disk space (Minimum) • 150 GB space for reference and annotation data

• Starts at 15 MB and grows slowly • BAM files - ca. the same size as raw FASTQ data

• Backup with pgdump

• Low IOPS

Table 1-3: Geneticist Assistant Software Details

Server Client
• Apache httpd 2.4.25 (Latest) • Qt 5.5.1 • Gsl-lite 0.29.0

• mod_wsgi (Latest) • Rapidjson 1.1 • Catch

• OpenSSL 1.0.2p (Latest) • OpenSSL 1.0.2p • Curl 7.50.0

• Postgres 9.5.14 • LZ4 1.8.0 • Limereport 1.4

• Python 3.6.6 (Latest) • zlib 1.2.11

• Django 1.11 (Latest) • Python 3.6.6

• South (Latest) • Htslib

• Setuptools (Latest) • Spdlog 0.14.0

• Virtualenv 16.0.0 • Hayai
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Installing the SoftGenetics License Server
Before you install Geneticist Assistant, if you have a purchased version of Geneticist 
Assistant, then you must install the SoftGenetics license server. The license server is a 
central location either locally or on a network where software application licenses are stored 
and can be accessed by users of the application. After you install and open Geneticist 
Assistant for the first time, you will be prompted to configure Geneticist Assistant to connect 
to the SoftGenetics license server so that you can use Geneticist Assistant. The executable to 
install the SoftGenetics license server is named SrvSetup_<>_exe and it is available from 
SoftGenetics’s ftp site. Contact SoftGenetics for assistance in obtaining this file. 

If you are running a trial version of Geneticist Assistant, then you do not need to 
set up the SoftGenetics license server. You can simply indicate that you are 
running a trial version after you log in to Geneticist Assistant.
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Installing Geneticist Assistant on a Windows OS
SoftGenetics provides a single standard executable file, Geneticist AssistantSetup_<>.exe, 
for the installation of both the Geneticist Assistant client and the database server. You must 
have Administrator rights on the computer(s) on which you are installing Geneticist 
Assistant. You can install the client and the database server on the same computer or on 
different computers. The default installation location for both the Geneticist Assistant client 
and the database server is set to C:\Program Files\Softgenetics\Geneticist Assistant. You can 
leave the default locations as-is, or you can specify a different location. 
Figure 1-1:  Geneticist Assistant Installation wizard, Choose Components page

When you are installing Geneticist Assistant, note the following:

• If you are installing the client and database server on the same computer, then you must 
select Server. 

• If you are installing the client and database server on different computers, then:

• When you run the installer on the computer on which you are installing the Geneticist 
Assistant client, you must leave the Server option cleared and the Client option 
selected. 

• When you run the installer on the computer on which you are installing the database 
server, you must select the Server option and clear the Client option.

When you are installing the Geneticist Assistant server, you are prompted to create the 
Administrator role for the installation and you must configure the server reference directory, 
which is the database server directory that is to host the Geneticist Assistant reference files. 
For the Administrator role, by default, the Username is set to Administrator, but you can 
always enter a different value. The password cannot contain any spaces. If you intend to 
implement additional password requirements, then the password must also adhere to these 
planned requirements. The email address is the address that is linked to the Administrator 
account. See Figure 1-2 and Figure 1-4 on page 18.
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Figure 1-2:  Geneticist Assistant Installation wizard, Server Setup, Administrator 
Configuration page

Figure 1-3:  User password requirement options

Figure 1-4:  Geneticist Assistant Installation wizard, Server Setup, Configure Reference 
Directory page

Figure 1-3 below shows the requirements that you can specify for user passwords 
after you install Geneticist Assistant. For more information about specifying 
Geneticist Assistant password requirements, see “To specify the Geneticist 
Assistant password requirements” on page 73.
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You also have the option of setting the server reference directory when specifying 
your Geneticist Assistant settings. See “Specifying your Geneticist Assistant 
Settings” on page 59.
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Starting and Logging in to Geneticist Assistant
After you install Geneticist Assistant, a shortcut icon for the application is placed on the 
desktop. An option for the application is also available from the Start menu. 
Figure 1-5:  Geneticist Assistant desktop icon

The results after you start Geneticist Assistant vary, depending on the following:

• Scenario 1 - Whether this is the first time that Geneticist Assistant has been started on the 
client.

• Scenario 2 - Whether Geneticist Assistant has been started before on the client but the 
reference directory has not been configured.

• Scenario 3 - Whether Geneticist Assistant has been started before on the client and the 
reference directory has been configured, but no reference files have been downloaded to 
the directory.

All the steps in the following procedure are applicable for Scenario 1. The results that you 
obtain after you start Geneticist Assistant determine where you begin in the procedure for 
Scenarios 2 and 3. If you have already logged in to Geneticist Assistant, and the reference 
directory has been configured and reference files have been downloaded to the directory, 
then continue to “To log in to Geneticist Assistant” on page 22..

To start to Geneticist Assistant
1. Double-click the desktop icon, or select the option from the Start menu (Start > All 

Programs > SoftGenetics > Geneticist Assistant).

A References Directory Not Found message opens. 

Figure 1-6:  References Directory Not Found message

2. Do one of the following:

• To configure the client reference directory after you log in to Geneticist Assistant:

i Click Skip. 

The Geneticist Assistant Login dialog box opens.

ii. Continue to “To log in to Geneticist Assistant” on page 22.
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• To configure the client reference directory before you log in to Geneticist Assistant, 
do the following:

i Click Configure Now to open Windows Explorer. 

ii. Browse to and select the appropriate client reference directory. 

After selecting the directory, a Valid References Not Found message opens.

iii. Continue to Step 3.

Figure 1-7:  Valid References Not Found message

3. Do one of the following:

• To download the reference files to the client reference directory after you log in to 
Geneticist Assistant:

i Click Skip.

The message closes and the Geneticist Assistant Login dialog box opens. 

ii. Continue to “To log in to Geneticist Assistant” on page 22.

• To download the reference files to the client reference directory before you log in to 
Geneticist Assistant:

i Click Download.

The References Downloader dialog box opens. 

Figure 1-8:  References Downloader dialog box

If the Geneticist Assistant client and server reside on the same computer, then you 
can set the client reference directory and the server reference directory to the same 
directory.
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ii. Select the reference files that you are downloading, and then click Update.

A Close Geneticist Assistant message opens, indicating that downloading might 
require Geneticist Assistant to exit when finished, and asking you if you want to 
continue.

Figure 1-9:  Close Geneticist Assistant message

iii. Click Yes. 

The message closes and the selected reference files are downloaded to the client 
reference directory. If downloading any of these files requires Geneticist Assistant to 
close, then after all the selected reference files are downloaded, the Reference 
Downloader dialog box closes, and then Geneticist Assistant closes. You must start 
and log in to Geneticist Assistant again. See “To log in to Geneticist Assistant” 
below.

To log in to Geneticist Assistant
1. If you have not already done so, start Geneticist Assistant: Double-click the desktop 

icon, or select the option from the Start menu (Start > All Programs > SoftGenetics > 
Geneticist Assistant).

The Geneticist Assistant Login dialog box opens. The Server field is automatically 
populated with the URL for the database server. The first time that the Login dialog box 
opens, the Username field is automatically populated with the user name for the 
Administrator user that was set up during installation. For subsequent Geneticist 
Assistant sessions, the Username field is automatically populated with the user name for 
the user who last logged in to Geneticist Assistant. See Figure 1-10 on page 23.

Base and RefSeq are always selected for download and disabled so that you 
cannot clear these options. You can select any or all of the remaining reference 
files for downloading/updating. You can also download any of these other 
reference files at a later date. See “Updating References” on page 48.

Be patient. Depending on the download size, the download process can take up to 
several hours.
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Figure 1-10:  Geneticist Assistant Login dialog box

2. In the Username field, enter your username (if applicable), and then in the Password 
field, enter your password, and then click OK.

3. Continue to one of the following:

• If you are running a trial version of Geneticist Assistant, continue to “To run a trial 
version of Geneticist Assistant” below.

• If you are running a purchased version of Geneticist Assistant, continue to “To run a 
purchased version of Geneticist Assistant” on page 24.

To run a trial version of Geneticist Assistant
After you log into Geneticist Assistant, if you are running a trial version of Geneticist 
Assistant, then a Configure License message opens.
Figure 1-11:  Configure License message

1. Click Run Trial.

The Configure License message closes. 

2. Do one of the following:

• If you have already configured the reference directories, then continue in Geneticist 
Assistant as appropriate.

If your organization uses a proxy server for external connections, then to view 
data in the OMIM and LOVD external databases, you must configure the settings 
for this proxy server in your Geneticist Assistant instance. Before you log in to 
Geneticist Assistant, you can click Proxy Settings to open the Proxy pane on the 
General tab of the Settings dialog box and configure these settings. You can also 
configure these settings after you log in to Geneticist Assistant. See “To configure 
proxy server settings” on page 61.
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• If you have yet to configure the reference directories, then before you can continue 
in Geneticist Assistant, at a minimum, you must create your server and client 
reference directories, specify their locations, and then download reference files to 
the client reference directory. You must also specify the global Quality Control 
(coverage) settings for your data. See “Specifying your Geneticist Assistant 
Settings” on page 59. 

To run a purchased version of Geneticist Assistant
If you are running a purchased version of Geneticist Assistant, then the first time that you run 
Geneticist Assistant, a Configure License message opens. You must configure Geneticist 
Assistant to connect to the SoftGenetics license server. After you configure the license 
server, this message does not open again.
Figure 1-12:  Configure License message

1. Click Configure Now.

The Settings dialog box opens. The General tab is the only tab on the dialog box. 

Figure 1-13:  Settings dialog box

2. In the Server field, enter the fully qualified domain name (FQDN) for the server (where 
the license server manager is installed), or its IP address.
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3. Leave the Port value set to the default value of 50000.

4. Click OK.

The Settings dialog box closes.

5. Do one of the following:

• If you have already configured the reference directories, then continue in Geneticist 
Assistant as appropriate.

• If you have yet to configure the server reference directory, then before you can 
continue in Geneticist Assistant, at a minimum, you must create your server and 
client reference directories, specify their locations, and then download reference 
files to the client reference directory. You must also specify the global Quality 
Control (coverage) settings for your data. See “Specifying your Geneticist Assistant 
Settings” on page 59. 

To log out of Geneticist Assistant
To log out of Geneticist Assistant, on the main menu, click File > Exit.

If the SoftGenetics license server is running on the same computer on which 
Geneticist Assistant is running, then you can enter localhost or 127.0.0.1. 
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Upgrading Geneticist Assistant
If you are upgrading to a newer version of Geneticist Assistant, then you do not need to 
uninstall the current version. If you are upgrading from any version prior to Version 1.4, then 
after you have completed the upgrade, and log in to Geneticist Assistant for the first time, an 
Uncompressed References Detected message opens. The messages states that Geneticist 
Assistant first needs to compress all the associated reference files before you can work in 
Geneticist Assistant.
Figure 1-14:  Uncompressed References Detected message dialog box

1. Click Compress.

A dialog box opens, indicating the progress in compressing the reference files.

Figure 1-15:  Compressing reference files progress dialog box

2. After the Compression Progress dialog box indicates that the compression is 100% 
complete, click OK.

The Compression dialog box closes, and Geneticist Assistant is now ready for use.

This process can take anywhere from one to four hours based on your system’s 
available resources, and Geneticist Assistant is unavailable during this time. 
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The Geneticist Assistant Main Window
The Geneticist Assistant main window opens automatically after you successfully log in to 
Geneticist Assistant. 
Figure 1-16:  Geneticist Assistant main window

The Geneticist Assistant main window is your starting point for Geneticist Assistant. The 
window provides quick access to all of the Geneticist Assistant functions. From top to 
bottom, the Geneticist Assistant main window has five major permanent components—the 
title bar, the main menu, the toolbar, the tabs display area, and the status bar—and one 
transient component, the console.

Title bar
The name “Geneticist Assistant” is displayed in the title bar at the top of the Geneticist 
Assistant main window.
Figure 1-17:  Geneticist Assistant title bar

Main menu
The main menu is set up in a standard Windows menu format with menu commands grouped 
into menus (File, Panels, Tabs, Reports, Filters, Tools, Backup, and Help) across the menu 
bar. 
Figure 1-18:  Geneticist Assistant main menu
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Toolbar
The Geneticist Assistant main window toolbar is located below the main menu. It always 
contains a Refresh option, a Search feature, and Ref option. If the Runs tab or the Patients tab 
is open, it also contains options for limiting the display on the tab.

• You use the Refresh option to manually refresh a tab display after the tab opens in the 
main window and data is loaded, or after adding, editing, and/or deleting data on a tab. 
See “Main window tabs” below.

• You use the Search feature to search for samples, runs, panels, panel groups, sample 
groups, genes, or variants in your Geneticist Assistant database. See “Searching the 
Geneticist Assistant Database” on page 46.

• You use the Ref option to update any reference that has been downloaded to the Geneticist 
Assistant database to the most current version. See “Updating References” on page 48.

Figure 1-19:  Geneticist Assistant main window toolbar 

Figure 1-20:  Geneticist Assistant main window toolbar for the Runs tab

Main window tabs
When the Geneticist Assistant main window first opens, two tabs— Runs and Current 
Jobs—are displayed in the window. The Runs tab is the open tab. A run refers to loading a 
BAM file and a VCF file or just a VCF file into Geneticist Assistant for the purposes of 
importing a list of variants into the Geneticist Assistant database and/or reviewing a list of 
variants. The Runs tab has a single pane—the Runs pane. 
Figure 1-21:  Geneticist Assistant main window, Runs tab with Runs pane
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• If you are an Administrator user, then the Runs pane can display all the runs submitted by 
all users to your Geneticist Assistant database. By default, when the tab first opens, only 
the 30 most recently submitted runs are displayed and the runs are sorted based on the Run 
ID. You can limit the runs that are displayed by number and/or by a time and date range 
and you can also change the sort order of the data. 

• If you are a standard user, then the Runs pane can display all the runs that you have 
submitted to your Geneticist Assistant database as well as all the runs that have been 
submitted by other users and for which you have been granted at least the Can Read 
permission. By default, when the tab first opens, only the 30 most recently added runs that 
fit one of these two criteria are displayed and the runs are sorted based on the Run ID. You 
can limit the runs that are displayed by number and/or by a time and date range and you 
can also change the sort order of the data. 

The Current Jobs tab displays the progress of a run, or any other process that is currently 
being carried out in Geneticist Assistant. The tab opens automatically after a run is started. 
After the run is successfully completed (a BAM and a VCF file are loaded and read, or a 
VCF file is loaded and read), the Current Jobs tab is cleared and remains blank. Other tabs 
are available in the display area of the Geneticist Assistant main window depending on the 
actions that you carry out.

With the exception of the Current Jobs tab, every tab in Geneticist Assistant has at least one 
pane. The different panes display different information. Data is displayed in columns in the 
tab panes. A variety of options are available for setting preferences for the tab display and 
the data column display. See “Setting Display Preferences in the Geneticist Assistant Main 
Window.”

Status bar
The status bar is displayed at the bottom of the Geneticist Assistant main window. Summary 
information that is tab-specific is displayed in the left corner of the status bar. Release 
information (Version, Release Build, Revision, and Build Date) is displayed in the right 
corner of the status bar. This release information is identical to the release information that is 
displayed from the Help > About menu option.
Figure 1-22:  Geneticist Assistant main window, Status bar

Console
The console is displayed below the status bar at the bottom of the Geneticist Assistant main 
window. The console is a transient component of the main window and it is automatically 
opened and displayed whenever an error occurs in the software, for example., a required file 
is not specified. You can click the Close (“x”) button in the upper right corner of the console 

If you close the Runs tab, you can open it again from the Geneticist Assistant main 
menu: File > Runs.
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to close it. The console remains closed until another error occurs, and then it again opens 
automatically and displays the error.
Figure 1-23:  Geneticist Assistant main window, console
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Setting Display Preferences in the Geneticist 
Assistant Main Window

With the exception of the Current Jobs tab, every tab in Geneticist Assistant has at least one 
pane. The different panes display different information. Data is displayed in columns in the 
tab panes. A variety of options are available for setting preferences for the tab and tab pane 
displays and the data column display. You can:

• Navigate multiple open tabs/minimized window. See “To navigate multiple open tabs/
Navigate tabs with a minimized main window” below.

• Close multiple tabs in a single step. See “To close multiple tabs in a single step” on page 
32.

• Filter the data that is displayed in a tab pane. See “To filter the data that is displayed in a 
tab pane” on page 32.

• Show/hide data columns in a tab pane. See “To show/hide columns in a tab pane” on page 
39.

• Manage tab pane configurations. See “To manage tab pane configurations” on page 41.

• Change the widths of a data columns. See “To change the widths of data columns” on 
page 44.

• Rearrange the order of data columns. See “To rearrange the order of data columns” on 
page 44.

• Change the sort order of data. See “To change the sort order of data” on page 44.

• Rename column headers. See “To rename column headers” on page 45.

• Select the data that is to be included in a custom report. See “To select data to be included 
in a custom report” on page 45.

Any preferences that you set for a tab display remain in effect regardless if you log out of and 
then log back into Geneticist Assistant. You can set the preferences for any Variants pane or 
tab, for example, the Sample Variant Data sub-tab on the Sample tab, and then apply these 
same settings to all the other Variants panes and tabs in Geneticist Assistant. You can also 
return the tab displays to their default displays (all tab panes shown, all data columns shown, 
and so on) in a single step. See “To apply shared preferences or to clear all tab preferences” 
on page 69.

To navigate multiple open tabs/Navigate tabs with a minimized 
main window

If you open multiple tabs, or if you have reduced the size of the main window, then you 
might not be able to see all the tabs at the top of the main window. The display options at the 
top of the Runs tab or the Patients tab might also be hidden. You can use the Back and Next 
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arrows  that are displayed in the top right corner of the main window to move through 
all open tabs and change the display focus, and/or view the hidden display options. 

To close multiple tabs in a single step
If you have opened multiple tabs, then you close each tab individually, or you can close all 
tabs in a single step, or you can close all tabs other than a selected tab in a single step. To 
close all tabs in a single step, right-click the title bar for any of the opened tabs, and on the 
context menu that opens, click Close All. To close all tabs other than a selected tab, 
right-click the title bar of the tab that is to remain open, and on the context menu that opens, 
click Close All Except This.

To filter the data that is displayed in a tab pane
By default, when a tab first opens, all data in all available panes is displayed. You can open a 
Table Filters pane for a selected tab pane which displays all the data (fields) for the pane, and 
then select from the fields that are listed to filter the pane display to only the data (fields) that 
meet specific criteria. You can specify the filters for the data that is displayed in a tab pane on 
a one time only basis, or you can save the filters to a template, and then load the template to 
filter the data that is displayed in the tab pane anytime as needed. You can also delete a saved 
filter template.

1. Open the appropriate tab.

2. On the Geneticist Assistant main menu, click Filters > <Tab Pane>. For example, if you 
clicked Filters with the Sample tab open, then the menu options would be Filters > 
Sample’s Variants, Filters > Sample’s Status Changes, and so on. 

The Table Filters pane opens to the right of the tab. The pane is docked to the right side 
of the Geneticist Assistant main window. The pane consists of two sub-panes. The left 
sub-pane displays all the fields for the selected tab pane. The right sub-pane is blank.

3. Repeat Step 2 as many times as needed to open multiple Table Filters panes for the tab.

Figure 1-24:  Multiple Table Filters panes opened for a tab
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4. Click and drag the field by which to filter the data from the list of available fields to the 
blank pane that is to the right of the list. 

An Edit Filter dialog box opens. The name of the selected field is displayed in the 
Column Name field on the dialog box. The Edit Filter dialog box displays different 
options depending on the selected filter. 

Figure 1-25:  Edit Filter dialog box example - Zygosity column selected

For example:

• If you are filtering data based on a date/time field, then a Relative option is displayed 
on the Edit Filter dialog box. You select this option to display data from a specified 
time period that is relative to the current date and time. For example, to display data 
that has been generated within the last 30 days of the current date and time, select the 
< operator, select Relative, and then in the Relative field, enter -30 days. (You must 
enter the minus sign.) See Figure 1-26 on page 34.

The Table Filters panes are docked from top to bottom in the order in which you 
opened them. Optionally, to make a Table Filters pane a floating pane, you can 
click the Undock icon that is in the top right corner of the pane (the icon that is to 
the left of the Close (x) icon), and then drag the pane. A floating pane is a pane 
that is visible in the Geneticist Assistant main window, but its location is not 
confined to a specific area of the window. Instead, you can independently change 
its size and/or position, including moving the pane outside the main window.To 
redock the Table Filters pane, click the Close (x) icon to close the pane, and then 
on the Geneticist Assistant main menu, click Filters and select the tab pane again.

The remainder of this procedure describes how to set up new a data filter. 
Optionally, below a Table Filters pane, you can click Load Filters to open the 
Load Filter Template dialog box and select from a list of saved filter templates for 
the pane. 

The Column Name is a dropdown list that contains all the available fields for the 
opened tab. You can always select a different field on this list before continuing to 
Step 5.
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Figure 1-26:  Edit Filter dialog box, Date/Time selected as filter

• If you select to filter by Gene, then a Load by phenotype option is displayed on the 
Edit Filter dialog box. Enter a phenotype to filter by genes that are associated with 
this phenotype. As you enter the search string, a dropdown list opens. The list is 
dynamically updated with the phenotypes that are found in the Human Phenotype 
Ontology database that match the search string.

Figure 1-27:  Edit Filter dialog box, Gene selected as filter

5. On the Operator dropdown list, select the operator for the filter.

The search string is not case-sensitive, and the string can be found anywhere in 
the search results. For example, a search string of “thyroid” returns phenotypes of 
thyroid adenoma and secondary hyperthyroidoism.

The operators that are available on the Operator dropdown list are specific to the 
type of field that is selected - text, numeric, and so on. Not all operators are 
available for all field types. 

Filter Operator Description
= Equals. Must be an exact match to return data. 

≠ Does not equal. Only data that does not match the value specified is 
returned.

> Greater than. Only data that exceeds the value specified is returned.

< Less than. Only data that is less than the value specified is returned.
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6. In the Edit Filter dialog box, enter the values for the filter. The dialog box displays 
different options depending on the selected filter. For example:

• You might have only the option of entering a value in the Value field. If you enter 
multiple values, then you use a comma to separate multiple values.

• You might have the option of entering a value in the Value field, or clicking a Load 
Values option to open the Open Text or CSV file dialog box, and then browsing to 
and selecting the appropriate file.

7. Click OK.

The Edit Filter dialog box closes. The selected field, its operator, and its value are 
displayed in the right sub-pane. The filter is applied immediately to the pane.

8. Repeat Step 4 through Step 7 for each field by which the data is to be filtered. When you 
filter the data by multiple fields, two options are possible:

• You can drag additional fields for filtering on top of an existing filter field to apply 
the filters on an “and” basis. For example, for the Sample Variant Data sub-tab on 
the Sample tab, you can add the filter for Coverage >= 300 and then drag the filter 
for Gene = MSH6 onto the Coverage filter. The results are filtered to show only 
those variants that have a coverage that is greater than or equal to 300 and that are 

>= Greater than or equal to. Only data that is an exact match for or exceeds the 
value specified is returned.

<= Less than or equals to. Only data that is an exact match for or is less than 
the value specified is returned.

contains Returns data that not only contains the value specified, but also might 
contain other information. The search string is not case-sensitive.

does not contain Returns only the data that does not contain the value specified. The search 
string is not case-sensitive.

On Only data with a date stamp that is the same as the specified date is 
returned. Identical to the = operator, but used specifically for dates.

Earlier than Only data with a date stamp that falls before the specified date is returned. 
Identical to the < operator, but used specifically for dates.

Earlier than or on Only data with a date stamp that is the same as the specified date or that 
falls before the specified date is returned. Identical to the <= operator, but 
used specifically for dates.

Later than Only data with a date stamp that falls after the specified date is returned. 
Identical to the > operator, but used specifically for dates.

Later than or on Only data with a date stamp that is the same as the specified date or that 
falls after the specified date is returned. Identical to the >= operator, but 
used specifically for dates.

A text file contains a single value. A Comma-Separated Values (CSV) file contains 
multiple values that are separated by commas.

Filter Operator Description
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found in the MSH6 gene. 

• You can drag separate additional fields for filtering into the blank pane to apply 
filters on an “or” basis. For example, for the Sample Variant Data sub-tab on the 
Sample tab, you can add filters for Coverage >= 300 and a filter for Gene = MSH6. 
The results are filtered to show those variants that have a coverage that is greater 
than or equal to 300 or variants that are found in the MSH6 gene.

Figure 1-28:  And and Or filters

9. Do any of the following as needed for a specific Table Filter:

• To highlight the results in bright yellow that pass the filtering criteria instead of 
removing data that fails the filtering criteria, select Highlight.

• The On/Off option is a toggle. 

• To remove the applied filters, click On/Off.

• To apply all the filters and view the results onscreen, click On/Off again. 
(“*Filters Applied” is displayed in the title bar of the affected tab pane.) 

• To remove all the filters that have been applied for the tab pane, click Clear. The 
filters remain displayed in the Table Filters pane.

• To edit a filter, right-click the filter and on the context menu that opens, click Edit to 
open the Edit Filter dialog box. Edit the filter (Column, Operator, and/or Value) as 
needed, and then click OK to close the dialog box and immediately save and apply 
the edited filter.

• To delete a filter, right-click the filter and on the context menu that opens, click 

If the results are not as expected, then this toggling allows you to make the 
necessary adjustments to a filter before saving it.

To clear all filters for all tabs in a single step, on the Geneticist Assistant main 
menu, click Filters > Clear All Filters.

And filter

Or filter
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Remove. The pane display is immediately updated.

• To save your filter settings, click Save Filters to open the Save Filter Template 
dialog box and then do the following:

Figure 1-29:  Save Filter Template dialog box

i Enter a name for the filter template.

ii. If this template is to be available to other users, then select Make template 
available to other users; otherwise, the template is available only to you.

iii. Click Save.

A Template Save Result message opens, indicating that the new template was 
saved.

Figure 1-30:  Template Save Result

iv. Click OK to close the message and save the filter template to the Geneticist 
Assistant database.

You, and if applicable, other users, can use this saved filter template to filter the 
data for this specific tab pane for another project based on the template settings.

10. After you are done filtering the data, you can click Close (x) in the upper right corner of 
a Table Filter pane to close it.
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To load a saved filter template
You can load any filter template that you have added to the Geneticist Assistant database and 
you can open any filter template that another user has added and made available to all users.

1. Open the appropriate tab.

2. On the Geneticist Assistant main menu, click Filters > <Tab Pane>. For example, if you 
clicked Filters pane with the Sample tab open, then the menu options would be Filters > 
Sample’s Variants, Filters > Sample’s Status Changes, and so on. 

The Table Filters pane opens to the right of the tab. See Figure 1-24 on page 32.

3. Click Load Filters.

The Load Filter Template dialog box opens. The dialog box displays all the filter 
templates that have been saved and made available to all users for the selected tab pane. 

Figure 1-31:  Load Filter Template dialog box

4. Select the filter template that you are loading, and then click Load.

The Load Filter Template dialog box closes and the selected filter is applied 
immediately. The data in the tab pane is updated to reflect the filtering.

To delete a saved filter template
You can delete filter templates that have been saved by any user for any tab pane.

1. Open the appropriate tab.

2. On the Geneticist Assistant main menu, click Filters > <Tab Pane>. For example, if you 
clicked Filters pane with the Sample tab open, then the menu options would be Filters > 
Sample’s Variants, Filters > Sample’s Status Changes, and so on. 

The Table Filters pane opens to the right of the tab. See Figure 1-24 on page 32.
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3. Click Load Filters.

The Load Filter Template dialog box opens. The dialog box displays all the filter 
templates that have been saved by all users for the selected tab pane. 

Figure 1-32:  Load Filter Template dialog box

4. Select the filter template that you are deleting, and then click Delete.

The filter is deleted immediately. The Load Filter Template dialog box remains open.

To show/hide columns in a tab pane
You specify the columns that you are showing or hiding in a tab pane in the Select Columns 
dialog box. By default, when the dialog box first opens for a tab pane, the columns that are 
currently displayed are selected, and Select/deselect/restore all is either selected or 
completely filled. The Select/deselect/restore all option on the Select Columns dialog box is 
a tri-state checkbox. When the dialog box is opened for the first time for a tab pane, all the 
columns are selected for display, and the Select/deselect/restore option is also selected. After 
you make your column selections, then each subsequent time that the dialog box opens, the 
columns that have been selected for display are selected, those that have been hidden are 
deselected, and the Select/deselect/restore option is completely filled. If you click this option 
once, then all columns are shown in the tab pane in a single step and the select/deselect/
restore option is selected. If you click the Select/deselect/restore option a second time, then 
all columns are hidden in the tab pane in a single step, and the option is cleared. If you click 
the Select/deselect/restore option a third time, then the last specified settings are restored, 
and a completely filled checkbox is displayed for the option.

1. Right-click the tab pane anywhere, and on the context menu that opens, click Load 
Columns.

A sub-menu opens that displays up to three options: Manually, Compact, and all the 
available configurations for the pane. The name of the user who created a configuration 
is displayed next to the configuration.
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2. Click Manually.

The Select Columns dialog box opens. 

Figure 1-33:  Select Columns dialog box

3. If a column is to be hidden from view in the pane, then clear its selection; otherwise, 
leave it selected.

4. Optionally, to rearrange the column display, click the column number for a column, and 
then drag it to a new location in the list of columns.

5. Click Apply to update the column display.

6. Click OK to close the dialog box.

The column preferences remain in effect even if you log out of and then log back into 
Geneticist Assistant. To restore the last specified settings, or display all columns in a 
single step, click the Select/deselect/restore all option as needed.

     

Compact displays the data columns in the pane in a more condensed view. To 
toggle the display, click Compact as needed.

This is identical to rearranging the data columns directly in a tab pane. See “To 
rearrange the order of data columns” on page 44.
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To manage tab pane configurations
Instead of selecting individual columns to show or hide, you can use pane configurations to 
manage your data column displays. You can load an existing pane configuration, you can 
create your own pane configurations, and you can delete pane configurations. See:

• “To load a pane configuration” below.

• “To create/edit a pane configuration” below.

• “To delete a pane configuration” on page 43.

To load a pane configuration
1. Right-click the tab pane anywhere, including the column headers, and on the context 

menu that opens, click Load Columns. 

A sub-menu opens that displays up to three options: Manually, Compact, and all the 
available configurations for the pane. The name of the user who created each 
configuration displayed next to the configuration.

2. Select the configuration that you are loading.

The context menu closes. The pane display is updated dynamically after the 
configuration is loaded.

To create/edit a pane configuration
When you create and save a configuration for a tab pane, the configuration is available and 
applicable only for this specific tab pane. You can edit only the configurations that you have 
created.

1. Right-click the tab pane anywhere, including the column headers, and on the context 
menu that opens, click Load Columns. 

A sub-menu opens that displays up to three options: Manually, Compact, and all the 
available configurations for the pane. The name of the user who created each 
configuration displayed next to the configuration.

     

Compact displays the data columns in the pane in a more condensed view. To 
toggle the display, click Compact as needed.

Compact displays the data columns in the pane in a more condensed view. To 
toggle the display, click Compact as needed.
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2. Do one of the following:

3. Clear the options for the columns that you are hiding from the pane view, and select the 
options for the columns that you are displaying in the pane view. 

4. Click Apply to update the column display.

     

Option Description
To create an entirely new 
pane configuration

1. Click Manually.
The Select Columns dialog box opens. By default, when the dialog 
box first opens for a tab pane, the columns that are currently 
displayed are selected, and Select/deselect/restore is either selected 
or completely filled. See Figure 1-33 on page 40.

2. Continue to Step 3.

To create a new pane 
configuration by editing 
an existing configuration

1. Click Manually.
The Select Columns dialog box opens. See Figure 1-33 on page 40.

2. Click Load Configuration.
The Load Configuration dialog box opens. The dialog box displays all 
your private and public configurations as well as all the 
configurations that other users have made public.

Figure 1-34:  Load Configuration dialog box

3. Select the configuration that is to be modified.
The pane display is dynamically updated according to the loaded 
configuration

4. Right-click the tab pane anywhere, and on the context menu that 
opens, click Load Columns > Manually.
The Select Columns dialog box opens again. The settings on the 
dialog box reflect the loaded configuration. 

5. Continue to Step 3.
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5. Click Save Configuration. 

The Save Configuration dialog box opens.

Figure 1-35:  Save Configuration dialog box

6. Enter a name for the configuration.

7. If this configuration is to be available to all other users of this Geneticist Assistant 
instance (a public configuration), then select Make configuration available to all users; 
otherwise, to make the configuration available only to you (a private configuration), 
leave this option blank.

8. Click Save.

The Save Configuration dialog box closes. The Select Columns dialog box remains 
open.

9. Click OK to close the Select Columns dialog box.

To delete a pane configuration
You can delete only those pane configurations that you have created, and you cannot delete 
the default System configuration.

1. Right-click the tab pane anywhere, including the column headers, and on the context 
menu that opens, click Load Columns. 

A sub-menu opens that displays up to three options: Manually, Compact, and all the 
available configurations for the pane. The name of the user who created each 
configuration displayed next to the configuration.

2. Click Manually.

The Select Columns dialog box opens. See Figure 1-33 on page 40.

3. Click Load Configuration.

The Load Configuration dialog box. The dialog box displays all your private and public 
configurations as well as all the configurations that other users have made public. See 
Figure 1-36 on page 44.

If you are editing a configuration, then you must save it with exactly the same 
name as the original configuration. 
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Figure 1-36:  Load Configuration dialog box

4. Right-click the configuration that you are deleting, and on the context menu that opens, 
click Delete Column Configuration.

The Column Configuration is deleted.

5. Click Close (x) to close the Load Configuration dialog box.

6. Click OK to close the Select Columns dialog box.

To change the widths of data columns
To change the width of a data column, rest the mouse pointer on the right side of a column 
heading until the pointer changes to a double-headed arrow, and then drag the boundary until 
the column is the width that you want.

To rearrange the order of data columns
You can rearrange the order of the data columns in a tab pane by clicking and holding the 
mouse pointer on a column header, and then dragging the column to a new location.

To change the sort order of data
When a tab first opens, data is sorted in ascending order based on the IDs of the data. To 
change the sort order of the data in a column, click a column header to sort the display based 
on the descending order of data in the column. A Sort Order icon is displayed in the column 
header. You can click this Sort Order icon to toggle between an ascending sort and a 
descending sort of the data based on the column heading.

If you select a configuration that you did not create, then the Delete Column 
Configuration option is not available on the context menu.

You can also rearrange the order of data columns in a tab pane using the function 
that is available in the Select Columns dialog box. See “To show/hide columns in a 
tab pane” on page 39.
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To rename column headers
Every data column is titled with a default column header. To rename a column header to 
better suit your working needs, right-click the column header, and on the context menu that 
opens, click Rename Header. The column header is selected, and you can then edit the 
column header as needed.

To select data to be included in a custom report
You can include just specific data in a custom report, or you can include all data in a pane in 
a custom report.

• To include just specific data, right-click the data (CTRL-click to select multiple rows of 
data), and on the context menu that opens, select Add Selected to Custom Report. All data 
in all columns that are currently shown in the selected rows is included in the custom 
report. Data in hidden columns is not included in the report.

• To include all data that is currently shown in a tab pane in a custom report, right-click 
anywhere in the pane and on the context menu that opens, click Add All to Custom 
Report. All data in all columns that are currently shown in the tab pane is included in the 
custom report. Data in hidden columns is not included in the report.

For detailed information about generating a custom report after you have selected 
the necessary data, see “Generating a Custom Report” on page 271.
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Searching the Geneticist Assistant Database
You use the Search feature that is available on the Geneticist Assistant main window toolbar 
to search for samples, runs, panels, panel groups, sample groups, genes, and variants in your 
Geneticist Assistant database. 
Figure 1-37:  Geneticist Assistant main window toolbar, Search feature

Important points to note about a search are the following:

• As you enter a search string, the list of search results that match the string is dynamically 
updated, and the type of search result that matches the string is indicated in bold above 
the list (Run, Variant, and so on). 

• With the exception of searching by HGVS, the search for any item is not case-sensitive, 
and the search string can be found anywhere in the search results. For example, if you 
enter “Mayo” as the search string, then the search results can include a run named “Mayo 
Clinic” or a run named “Clinic Run:Mayo.”

• If you search for a variant, the search is not carried out relative to any sample, and 
multiple search options are available. 

• You can use the variant description in the format of chrom:start position:ref:alt. You 
must separate multiple variant search strings with a comma (,) or a semi-colon (;). 

• You can search for a single position on a single chromosome (for example, 1:123) or 
for a range of positions on a single chromosome (for example, 1:1-1000).

• You can search by the partial or complete gene name; for example, MSH or MSH2, 
respectively. 

• You can search by HGVS variant nomenclature.

Search results for any entity in your Geneticist Assistant database are displayed on a Search 
Results tab. 
Figure 1-38:  Search feature and results example

Searching by HGVS supports only a perfect match to the search string, for 
example, p.Asn1983Ser.
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You can double-click any search result on a Search Results tab to “drill down” into the 
search result, and review the associated data. For example, you can:

• Double-click a Run search result to open the associated Run tab.

• Double-click a Gene search result to open the list of variants for the gene, and then 
double-click a variant in this list to open the associated Variant tab. 

You can also right-click any search result to open a context menu that has options that are 
specific for the search result.
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Updating References 
The reference directory contains the information for the reference that was used for aligning 
the data and/or detecting variants in sample. References are stored in their own folders in the 
references directory. SoftGenetics initially provides the necessary references files for your 
Geneticist Assistant installation. You use the Ref function that is available on the toolbar of 
the Geneticist Assistant main window to update to the most recent version of any reference 
in the reference directory. You can select multiple references for updating at the same time. 

To update a reference
1. On the toolbar of the Geneticist Assistant main window, click Ref.

The Reference Downloader dialog box opens. The dialog box lists the following 
information for each reference that is currently installed for your Geneticist Assistant 
instance:

• The reference name.

• The Local Version, which is the version of the currently installed reference.

• The Remote Version, which is the most recent version that is available on the 
SoftGenetics server.

• The Update Size, which is the difference in size between the Local Version and the 
Remote Version.

• The Total Size of the downloaded reference.

The location of the Reference Directory that has been specified for your Geneticist 
Assistant instance is displayed at the top of the dialog box. A checkbox is displayed next 
to each reference for which the Local Version and Remote Version are different. 

Figure 1-39:  References Downloader dialog box
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2. Select the references that you are updating, and then click Update.

After the selected references are updated, the Local Version and the Remote Version are 
identical.

The first time that you download reference files, Base and RefSeq are always 
selected for download and disabled so that you cannot clear these options. You 
can select any or all the remaining reference files for downloading/updating. You 
can also download any of these other reference files at a later date. When you are 
updating references, because Base and RefSeq have already been downloaded, 
they are not selected and disabled.

Be patient. Depending on the update size, the update process can take up to 
several hours.
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Reviewing the Database Log
Geneticist Assistant tracks all actions that have occurred for its database, such as user logins, 
data additions, data edits, data deletions, and so on, in a database log. This database log is 
displayed on the Database Log tab. The log shows all the actions that have occurred in the 
Geneticist Assistant database in reverse chronological order. For each action, the following 
information is displayed: the date/time of the database action, the user who carried out the 
action, the type of action, and the data type that was affected by the action. A detailed 
description of the action is also supplied. To review the database log, on the Geneticist 
Assistant main menu, click File > Database Log. 
Figure 1-40:  Database Log tab
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Backing up the Geneticist Assistant Database
For data protection, you can manually back up the Geneticist Assistant database at any time 
of your choosing.

To back up the Geneticist Assistant database
1. On the Geneticist Assistant main menu, click Backup > Database Backup.

The Database Backup dialog box opens. In the Output field, the default name and 
location for saving the database backup file is set to C:\Program 
Files\SoftGenetics\Geneticist Assistant\ga_exe\softgenetics_backup_<current 
year>_<current month_day>_<current_time>. You have the option of changing one or 
both of these default values.

Figure 1-41:  Database Backup dialog box

2. Next to the Dump path field, click the Browse button  to open the Select dump tool 
dialog box, and then browse to and select pg_dump.exe file.

3. Optionally, do one or both of the following:

• To change the name of the database backup file, in the Name field, enter the new 
value.

For example, to change the name from “softgenetics_backup_<current 
year>_<current month_day>_<current_time>” to 
“geneticist_assistant_backup_<current year>_<current 
month_day>_<current_time>”, enter geneticist_assistant in the Name field.

• To change the location for the database backup file, next to the Output field, click the 
Browse button  to open the Select Output directory dialog box, and then select a 

The default installation directory for the Postgres dump tool is C:/Program Files/
Softgenetics/Softgenetics Server/pgsql/bin/pg_dump.exe.
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different location for the database backup file. 

4. Enter your Postgres username and password.

5. Click OK.

After the Geneticist Assistant database is successfully backed up, the Database Backup 
dialog box closes. The Geneticist Assistant main window remains open.

Make sure to enter your Postgres login credentials, and NOT your Geneticist 
Assistant login credentials. Unless you have customized your Postgres 
installation, the username is postgres and the password is softgeneticssetup.
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Before you use Geneticist Assistant for the first time, you must add and/or edit the necessary 
objects and specify the settings for your installation. Optionally, you can specify quality 
metrics for monitoring runs and ensuring that the runs results are meeting your 
organization’s performance standards. 

This chapter covers the following topics:

• “Managing Objects in the Geneticist Assistant Database” on page 55.

• “Specifying your Geneticist Assistant Settings” on page 59.

• “Managing Quality Metrics” on page 77.
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Managing Objects in the Geneticist Assistant 
Database

An object in Geneticist Assistant holds a value or variable that can be applied for carrying 
out a run in Geneticist Assistant, or for processing and interpreting the resulting run data. 
Managing objects in Geneticist Assistant consists of adding and editing the values for these 
objects as well as deleting values that are no longer valid or required. Twelve objects are 
available in Geneticist Assistant: Chemistry, Instrument, Pathogenicity, Pathogenicity Status, 
Sample Status, Panel Group, Coverage Region Status, Sample Status, Run Status, Artifact 
Type, Phenotype, and Ethnicity. Geneticist Assistant is installed with default values for five 
of these objects: Pathogenicity, Pathogenicity Status, Sample Status, Coverage Region 
Status, and Run Status. You have the option of adding custom values for these objects, and 
then selecting a custom value in lieu of a default value. You must manually add values for all 
other objects.

Object Default Values Description
Chemistry No Refers to the chemistry that was used to prepare the 

samples for sequencing. 

Instrument No Refers to the instrument that was used to sequence the 
samples.

Pathogenicity Yes The pathogenicity for a selected variant. Default values 
are Deleterious, Likely Deleterious, Unknown, Likely 
Benign, and Benign.

Pathogenicity Status Yes Indicates the status for changing the pathogenicity for a 
selected variant. Default values are Pending and 
Confirmed.

Sample Status Yes The status for a sample. Default values are New, QC 
Passed, Reviewed, and Complete

Panel Group No Separately tracks the pathogenicities of variants that 
might be found in multiple panels. For example, the 
pathogenicity of a selected variant is set to Deleterious 
for multiple cancer panels; however, the pathogenicity 
can be set to Benign for a cardiac panel. You can 
create a group for each panel, and then assign the 
appropriate panels to each group.

Coverage Region 
Status

Yes The Coverage Regions tab (via the Run tab) lists the 
coverage information for every region in your panel as 
well as a status for each region. Default values are 
Passed or Failed to indicate whether a region passed 
or failed the coverage settings that were set for the run. 
Note: See “Coverage Regions tab” on page 200.

Sample Group No Used for a group of samples that are to be processed 
repeatedly over a period of time, for example, a group 
of control samples for which the coverage or variant 
frequency is to be tracked. 
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To add a value for an object
1. On the Geneticist Assistant main menu, click File > Add/Edit Objects.

The Add/Edit Objects dialog box opens. 

Figure 2-1:  Add/Edit Objects dialog box

2. On the Object dropdown list, select the object for which you are adding a value.

If the selected object has default values, or custom values have already been added for 
the selected object, then these values are displayed in the Current Values pane.

3. In the Value field, enter the value for the object, and then click Add.

The newly added value is displayed in the Current Values pane.

     

Run Status Yes The status for a run. Default values are New, QC 
Passed, Reviewed, and Complete.

Artifact No The artifact type for the sample variant, for example, a 
Sequencing artifact. A single default value, None, is 
supplied for artifact type.

Phenotype No The phenotype for a patient.

Ethnicity No The ethnicity for a run patient, for example, Caucasian 
(Non-Hispanic).

Object Default Values Description

The value can have a maximum of 255 characters. Spaces and special characters 
are allowed.
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4. Do one of the following:

• If you did not add a new pathogenicity value, then go to Step 5.

• If you added a new pathogenicity value, then to correctly order the pathogenicity 
values from least severe to most severe, select a value in the Current Values pane, 
and then click Move Up or Move Down as needed. Go to Step 5.

5. Click OK.

The message “Saving new objects” is displayed on the Add/Edit Objects dialog box. The 
dialog box closes after the value is added successfully.

To edit an object
When you edit an object, you edit the object value. Any previous runs that use the edited 
object value are not affected. The “old” (previous) value remains displayed in Geneticist 
Assistant on the Runs tab. Going forward, only the “new” value is available for selection for 
new runs. 

1. On the Geneticist Assistant main menu, click File > Add/Edit Objects.

The Add/Edit Objects dialog box opens. See Figure 2-1 on page 56.

2. On the Object dropdown list, select the object for which you are editing a value.

The currently available values for the selected object are displayed in the Current Values 
pane.

3. In the Current Values pane, double-click the object value that you are editing.

The value is highlighted in a blue rectangle.

4. Edit the value as needed.

5. Click OK.

The message “Saving new objects” is displayed on the Add/Edit Objects dialog box. The 
dialog box closes after the value is edited successfully.

     

If you add a value for pathogenicity, then you can also specify a highlighting color 
for variants of this type in all the variant panes and sub-tabs. See “To specify the 
highlighting colors for variants of a pathogenicity” on page 65.

The value can have a maximum of 255 characters. Spaces and special characters 
are allowed.
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To delete a value from an object
1. On the Geneticist Assistant main menu, click File > Add/Edit Objects.

The Add/Edit Objects dialog box opens. See Figure 2-1 on page 56.

2. On the Object dropdown list, select the object from which you are deleting values.

The currently available values for the selected object are displayed in the Current Values 
pane.

3. In the Current Objects pane, right-click the object value that you are deleting, and then 
click Remove Selected.

The value is deleted immediately. The Add/Edit Objects dialog box remains open.

4. Click OK.

The Add/Edit Objects dialog box closes.
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Specifying your Geneticist Assistant Settings
When specifying the settings for your Geneticist Assistant installation, if you did not 
configure the server reference directory before the first time that you logged into Geneticist 
Assistant, at a minimum, you must create your server and client reference directories and 
specify their locations, and then download reference files to the client reference directory. 
You must also specify the global Quality Control (coverage) settings for your data. See:

• “To configure Geneticist Assistant directories” below.

• “To specify the global Quality Control settings” on page 64.

Optionally, you can also:

• Configure your proxy server settings. See “To configure proxy server settings” on page 
61.

• Edit the SoftGenetics license server settings. See “To edit the SoftGenetics license server 
settings” on page 62.

• Specify an encryption key for patient data. See “To specify an encryption key for patient 
data” on page 63.

• Specify the colors for highlighting variants of a specific pathogenicity in all the variant 
panes and variant sub-tabs. See “To specify the highlighting colors for variants of a 
pathogenicity” on page 65.

• Specify the font for column headers and/or column content. See 

• Specify the same column display preferences for variants in all the variant panes and 
variant sub-tabs and/or clear the preferred settings for all the data tabs. See “To apply 
shared preferences or to clear all tab preferences” on page 69.

• Specify the preferred settings for variants, which determines how the information is 
displayed for variants in all the variant panes and variant sub-tabs, and/or clear the 
preferred settings for all the data tabs. See “To specify variant preferences” on page 70.

• Specify the requirements for all user passwords for Geneticist Assistant. See “To specify 
the Geneticist Assistant password requirements” on page 73.

• Specify your third-party settings. See “To specify third-party (Alamut, IGV, OMIM) 
settings” on page 74.

To configure Geneticist Assistant directories
Before you run Geneticist Assistant for the first time, if you have yet to create your client 
reference directory, which is the directory contains the information for the reference that are 
used for aligning the data and/or detecting variants, then you must do so. References are 
stored in their own folders in this directory. If you have yet to configure the server reference 
directory, which is the directory on the database server that is to host the reference files, then 
you must also specify this directory location. Optionally, if you have already configured the 
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client reference directory, but you have not yet submitted data to the Geneticist Assistant 
database, then you can change the location of the reference directory. Optionally, you can 
also change the location of the server reference directory and/or specify a report directory.

1. On the Geneticist Assistant main menu, click File > Settings.

The Settings dialog box opens. The General tab is the open tab. 

Figure 2-2:  Settings dialog box, General tab

2. Optionally, in the Directories (top) pane, do any or all of the following as appropriate:

• To specify the location of the client reference directory, or change the location of the 
directory, next to the Reference Directory field, click the Browse button , and 
then browse to and select the appropriate directory.

• To specify the directory in which all Geneticist Assistant reports are to be saved, 
next to the Report Directory field, click the Browse button , and then browse to 
and select the directory.

• If your organization also has NextGENe installed, then to use the interactive 
functionality that is available for Geneticist Assistant and NextGENe, Geneticist 
Assistant must be able to locate your NextGENe installation. If your Geneticist 

Although not required, SoftGenetics recommends that you create the reference 
directory on the same computer and drive on which you installed the Geneticist 
Assistant client.

If you have previously specified the location for the client reference directory and 
submitted data to the Geneticist Assistant database, then you cannot change its 
location.
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Assistant instance is installed on the same client as your NextGENe instance, then 
leave Locate on Startup selected; otherwise, clear Locate on Startup, and then next to 
the NextGENe Directory field, click the Browse button , and then browse to and 
select the appropriate directory.

• To specify the location of the server reference directory, or change the location of the 
current directory, in the Server Reference Directory field, enter the full path to the 
appropriate directory, and then click Set.

3. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any this tab or any of the other tabs as appropriate. 

To configure proxy server settings
If your organization uses a proxy server for external connections, then to view data from 
external databases such as OMIM or LOVD in Geneticist Assistant, you must configure the 
settings for the proxy server.

1. On the Geneticist Assistant main menu, click File > Settings

The Settings dialog box opens. The General tab is the open tab. By default, the Proxy 
Type is set to No Proxy. 

Figure 2-3:  Settings dialog box, General tab

2. On the Type dropdown list, select the proxy type.

No message opens after you click Set. Also, if you inadvertently clear the path to 
the server reference directory, then you can click the Refresh icon to immediately 
repopulate the Server Reference Directory field with the full path and directory 
name.
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3. In the Proxy pane, configure your proxy server settings. 

4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any this tab or any of the other tabs as appropriate. 

To edit the SoftGenetics license server settings
If you are running a purchased version of Geneticist Assistant, the first time that you run the 
program, you must configure Geneticist Assistant to connect to the SoftGenetics license 
server. (See “To run a purchased version of Geneticist Assistant” on page 24.) If you change 
the location of this license server, then you must edit the license server settings so that 
Geneticist Assistant can still connect to the server.

1. On the Geneticist Assistant main menu, click File > Settings to open the Settings dialog 
box.

The Settings dialog box opens. The General tab is the open tab. The current information 
(name or IP address) for the SoftGenetics license server is displayed in the Server field. 

Figure 2-4:  Settings dialog box, General tab

2. In the License Server pane, in the Server field, enter the fully qualified domain name 
(FQDN) for the server, or its IP address.

3. Leave the Port value set to the default value of 50000.

If you selected DefaultProxy for Type, then the proxy settings for Internet Explorer 
are used for the connection and you can leave all other proxy settings blank.

If the License Server is running on the same computer on which Geneticist 
Assistant is running, then you must enter 127.0.0.1. 
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4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any this tab or any of the other tabs as appropriate. 

To specify an encryption key for patient data
You can specify an encryption key for the patient data in your Geneticist Assistant database. 
If encryption is enabled for patient data, then no data is displayed in specific Patient fields 
such as First Name, Last Name, and so on. Instead, *encrypted* is displayed. To set up 
encryption for patient data, two files are required: 

• Cert.pem file, which you must save in C:\Program Files\SoftGenetics\SoftGenetics 
Server\ga on the Geneticist Assistant server.

• Cert.pfx, which you can save anywhere on the Geneticist Assistant client. You must 
double-click this file to launch the Certificate Import Wizard and import the encryption 
key for your Geneticist Assistant installation.

1. On the Geneticist Assistant main menu, click File > Settings to open the Settings dialog 
box.

The Settings dialog box opens. The General tab is the open tab. 

Figure 2-5:  Settings dialog box, General tab

2. In the Encryption pane, select the appropriate Windows certificate.

If your organization already uses encryption for patient data, then these files 
should already be configured and available for use; otherwise, work with your 
organization’s System Administrator to create and configure these files, or you can 
contact.tech_support@softgenetics.com for assistance.
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3. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any this tab or any of the other tabs as appropriate. 

To specify the global Quality Control settings
The settings on the Quality Control tab are the minimum required coverage values (coverage 
threshold values) that a panel region must meet, or it is flagged as failed region for a run. The 
coverage values that you specify here are global settings, which means that, by default, they 
are automatically applied to all panel regions in all runs.

1. On the Geneticist Assistant main menu, click File > Settings.

The Settings dialog box opens. The General tab is the open tab. 

2. Open the Quality Control tab.

Figure 2-6:  Settings dialog box, Quality Control tab

3. Specify the value for the Quality Control settings.

• Minimum Coverage – The minimum number of reads that are required for a panel 
region.

• Average Coverage – The average number of reads that are required for a panel 
region.

• Percent Covered (%) – The minimum percentage of the panel region that has reads 
aligned to it.

4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any of the other tabs as needed. 
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To specify the highlighting colors for variants of a pathogenicity
By default, variants for any of the five system-supplied pathogenicity values—Deleterious, 
Likely Deleterious, Unknown, Likely Benign, and Benign—are highlighted in a specific 
color on the various variant sub-tabs and panes in your Geneticist Assistant instance. You 
can use these default colors, or you can specify other colors on the Colors tab that better meet 
your business needs. 

1. On the Geneticist Assistant main menu, click File > Settings.

The Settings dialog box opens. The General tab is the open tab.

2. Open the Colors tab. 

The first time that the tab opens, the default highlighting colors for the five 
system-supplied pathogenicity values are displayed on the tab. If applicable, any custom 
pathogenicity values are also displayed, but without any highlighting colors. Going 
forward, the pathogenicity values are highlighted in their specified colors.

Figure 2-7:  Settings dialog box, Default colors shown on the Colors tab

3. Do one of the following:

• To specify or change the highlighting color for a pathogenicity, double-click the 
pathogenicity.

• To specify or change the highlighting color for a case priority, double-click the case 
priority.

The Select Highlight Color dialog box opens. The pathogenicity or case priority that you 
selected is displayed in the title bar of the dialog box. See Figure 2-8 on page 66.

For information about adding a custom pathogenicity value, see “Managing 
Objects in the Geneticist Assistant Database” on page 55),
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Figure 2-8:  Select Highlight Color dialog box

4. Continue to one of the following:

• “To specify a basic highlighting color for a pathogenicity” below.

• “To specify a custom highlighting color for a pathogenicity” on page 67.

To specify a basic highlighting color for a pathogenicity 
1. Click a basic color.

2. Click OK.

The Select Highlight Color dialog box closes. The Colors tab on the Settings dialog box 
remains open. The selected pathogenicity is highlighted in the basic color.

3. Continue selecting pathogenicities or case priorities and specifying basic colors as 
needed.

4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any of the other tabs as needed. 

     

Multiple ways are available for selecting a highlighting color for a pathogenicity. 
The following are for example purposes only. You can select whichever method or 
combination of methods best suits your working needs.

Color Spectrum

Gradient Bar
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To specify a custom highlighting color for a pathogenicity 
1. Click in a blank custom color box.

2. Click the color in the Color Spectrum to select an approximate color.

A set of crosshairs is displayed where you clicked and the corresponding color is 
displayed below the spectrum. The HSV and RGB values are also displayed for the 
color. 

3. Do one of the following:

• Manually set the HSV or RGB values for the color.

• Drag and drop the crosshairs to a new location in the Color Spectrum.

• Point and hold your cursor on the Gradient arrow to the right of the Color Spectrum 
and move the arrow up and down until the appropriate color is displayed.

4. Click Add to Custom Colors.

5. Click OK.

The Select Highlight Color dialog box closes. The Colors tab on the Settings dialog box 
remains open. The selected pathogenicity or case priority is highlighted in the custom 
color.

6. Continue selecting pathogenicities or case priorities and specifying custom colors as 
needed.

7. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any of the other tabs as needed. 

To set the font for data column headers and/or content
When Geneticist Assistant is installed, by default, the font for data column headers and data 
column content is set MS Shelf Dlg2, Normal, Size 8. You can specify a different font, 
including the style and size, for all your data column headers, for your data column content, 
or both. You can also apply effects to the font and/or specify the Writing System, which is 
the operating language for the client on which Geneticist Assistant is installed. 

1. On the Geneticist Assistant main menu, click File > Settings.

The Settings dialog box opens. The General tab is the open tab.
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2. Open the Font tab. 

When the tab opens, Header is selected and the current font information (font, style, and 
size) for data column headers is displayed. A preview of the selections is displayed in the 
Sample (lower right) pane. The Writing System is set to the default value of Any.

Figure 2-9:  Settings dialog box, Font tab

3. Do any or all of the following:

• To set the font for the data column headers, leave Headers selected, and then choose 
a different font, font style, and /or size. You can also select or clear a font Effect 
(Strikeout or Underline).

• To set the font for the data column contents, select Content, and then choose a 
different font, font style, and /or size. You can also select or clear a font Effect 
(Strikeout or Underline).

• On the Writing System dropdown list, select a different writing system.

4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any of the other tabs as needed.
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To apply shared preferences or to clear all tab preferences
Remember, a variety of options are available for settings preferences for a tab display, 
including resizing data columns, rearranging the order of data columns, and so on. (See 
“Setting Display Preferences in the Geneticist Assistant Main Window” on page 31.) Any 
preferences that you set for a tab display remain in effect regardless if you log out of and then 
log back into Geneticist Assistant. With the exception of the Sample Group columns on the 
Sample Variant Data sub-tab on the Sample tab and the Variant pane on the Variant tab, 
you can use an option on the Tab Preferences tab to apply the same column display 
preferences for variants in all the variant sub-tabs and panes in a single step. You can also 
use an option on the Tab Preferences tab to clear all the preferred settings for all the data tabs 
in a single step, or you can clear only the column preferences. Finally, if you have applied a 
variant filter to a selected sample, then you also have the option of making this filter a 
persistent filter, which means that if you close and then open the tab again, the filter is 
“remembered” and is applied again to the sample variants. When you apply a variant filter to 
a sample, the filter is specific only for this particular sample. Variants of any other sample 
are not filtered. For example, in Figure 2-10 below, the Variant filter is persistent specifically 
to Sample 800463.igv.
Figure 2-10:  Variant filter, persistent specifically for a sample

1. On the Geneticist Assistant main menu, click File > Settings.

The Settings dialog box opens. The General tab is the open tab.

2. Open the Tab Preferences tab. 

By default, Remember Applied Variant Filters is selected.

Figure 2-11:  Settings dialog box, Tab Preferences tab
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3. Do one of the following:

• To return all tab displays to their default displays (all custom display preferences 
such as column header names are reset) in a single step, click Clear All Preferences.

• To remove only those column preferences that have been specified for all variant 
sub-tabs or panes in a single step, click Clear Variant Panel View Column 
Preferences.

• After you set the column display preferences for a specific variant sub-tab or pane, 
do one or both of the following:

4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any of the other tabs as needed. 

To specify variant preferences
Variant preferences determine how the information about variants is displayed on all the 
variant tabs, sub-tabs, and panes in Geneticist Assistant.

1. On the Geneticist Assistant main menu, click File > Settings.

The Settings dialog box opens. The General tab is the open tab.

2. Open the Variant Preferences tab. See Figure 2-12 on page 71.

Option Description
Apply Shared Preferences to Variant 
Panel Views.

Select to apply the same preferences that were set for this 
single variant sub-tab or pane to all the variant sub-tabs or 
panes on all the other tabs; otherwise, if you clear this 
option, then you can set display preferences individually for 
each variant sub-tab or pane.

Remember Applied Variant Filters Selected by default. Leave selected to make the variant 
filters persistent for their samples; otherwise, clear this 
option.
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Figure 2-12:  Settings dialog box, Variant Preferences tab

3. Set the variant preferences.

If you edit any variant preferences, then at any time, you can click Restore Default 
Settings to reset all values to their default values in a single step.

Option Description
Zygosity
Heterozygosity Upper Bound (%) Default value is 80. The maximum variant frequency for a 

variant to be considered heterozygous.

Heterozygosity Lower Bound (%) Default value is 20. The minimum variant frequency for a 
variant to be considered heterozygous.
Note: To report low frequency variants, reduce this value.

Variant Annotation
• Use GFF3 file • The default value. Use the annotation information in the 

reference files that SoftGenetics provides.

• Use GTF file • Use the annotation information in the reference files that 
ENSEMBL provides.

Note: If you select this option, then you must download the 
correct references files from ENSEMBL and place 
them in the Reference directory that is defined for your 
Geneticist Assistant installation. See “To configure 
Geneticist Assistant directories” on page 59.

Highlight user-modified fields Select this option to highlight any field that a user has 
modified on all the variant tabs and sub-tabs. This same field 
is not highlighted on the Variant tab.
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Variant Artifact Default
• Assign globally • Sets the default option for assigning an artifact type for a 

variant to assigning the artifact type for all samples. You 
can edit this default value when assigning the artifact type.

• Assign to specific sample • Sets the default option for assigning an artifact type for a 
variant to assigning the artifact type only for the specific 
sample. You can edit this default value when assigning the 
artifact type.

Note: The value that you set here determines the default value for Variant Classification on the 
Update Variant Artifact Type dialog box. See “Patient tab, Variants sub-tab context menu” on 
page 160, “Variant annotation information” on page 213, and “Sample Variant Data sub-tab 
context menu” on page 222.

Variant Submission
Derive AF from GT if AF not found Not selected by default. Derive allele frequency (AF) from 

genotype (GT) if allele frequency not found. If the AF is not 
found for a variant in the VCF file, then its value is derived 
from the GT, where:
• AF = 0.5 if GT = 0/1, 1/0, 0|1. 1|0
• AF = 1 of GT = 1|1
• AF = 0 if GT = 0|0

Submit Hotspots Not selected by default. Any variants that are included in a 
VCF file that have an allele frequency value = 0 and/or 
genotype = 0/0 in the file are submitted to the Geneticist 
Assistant database.

Show warnings if a variant is not 
submitted due to missing AF or GT

Selected by default. A warning is displayed in the console if a 
variant cannot be submitted to the Geneticist Assistant 
database because the allele frequency (AF) or genotype (GT) 
is missing for the variant in the VCF file.

Figure 2-13:  Sample missing AFGT warning

HGVS Nomenclature - Determines which transcript is used for the HGVS nomenclature columns if a 
gene has multiple transcripts.

• Preferred Selected by default. Show only a single transcript, either the 
transcript that is selected by default as the preferred 
transcript or the transcript that is defined as the preferred 
transcript in a preferred transcript list. See “To set or delete a 
preferred transcript list for a panel” on page 110.

• Unique Translation Show multiple transcripts if the translation varies among the 
transcripts.

• Unique Exon region Show multiple transcripts if the exon regions vary among the 
transcripts. 

Option Description
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4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any of the other tabs as needed. 

To specify the Geneticist Assistant password requirements
When Geneticist Assistant is first installed, by default, the Username is set to Administrator, 
and you must specify an administrator password. The only requirement is that the password 
cannot contain any spaces. You can also specify the following minimum requirements for 
your user passwords: Length, Number of upper and lower case characters, Number of 
numeric characters, and/or Number of special characters.

1. On the Geneticist Assistant main menu, click File > Settings.

The Settings dialog box opens. The General tab is the open tab.

2. Open the Password Settings tab. 

A default value is provided for each password setting.

Figure 2-14:  Settings dialog box, Password Settings tab

• All Shows the HGVS nomenclature based on all the transcripts 
that are included for the gene.

Hide predicted if known transcripts 
exist

Selected by default. If known transcripts exist for the gene, 
then do not include any predicted transcripts in the HGVS 
columns. 

Use short description for 
frameshifts

Option Description
Geneticist Assistant User’s Manual 73



Chapter 2
Geneticist Assistant Setup and Maintenance
3. Modify any or all of the default values for the user password requirements.

4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any of the other tabs as needed. 

To specify third-party (Alamut, IGV, OMIM) settings
You can view variants that were imported in to Geneticist Assistant in Alamut and in the 
Integrative Genomics Viewer (IGV). You can also view information from OMIM in 
Geneticist Assistant. You specify the information for these third-party options on the 
Third-Party Settings tab on the Settings dialog box.

1. On the Geneticist Assistant main menu, click File > Settings.

The Settings dialog box opens. The General tab is the open tab.

2. Open the Third-Party Settings tab. 

Figure 2-15:  Settings dialog box, Third-Party Settings tab

3. Continue to one of the following:

• “To specify the Alamut settings” on page 75.

• “To specify the IGV settings” on page 75.

• “To specify the OMIM settings” on page 76.

     

You can click Reset Defaults at any time to reset all password settings to their 
default values in a single step.
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To specify the Alamut settings
To view variants that were imported in to Geneticist Assistant in Alamut, the following is 
required:

• HTTP-based access must be enabled in Alamut. To enable this in Alamut, select Tools > 
Options > Api, select Enable HTTP-based access, and then set the port to 10000.

• Geneticist Assistant must be able to connect to Alamut and Alamut must be installed on 
the same computer as the Geneticist Assistant client. 

• Alamut must be open to jump to the variant position from Geneticist Assistant. 

1. Enter the information for the Alamut server. (The default value is http://localhost).

2. Leave the Port value set to 10000.

3. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any this tab or any of the other tabs as appropriate. 

To specify the IGV settings
1. Select or clear your IGV viewing options.

2. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any this tab or any of the other tabs as appropriate. 

     

For more information about this value, or to change the value, contact 
SoftGenetics (tech_support@softgenetics.com).

Option Description
Automatically clear existing samples 
when new samples are added

When you open a sample in IGV, if other samples are also 
being displayed, then leave this option cleared to view all 
samples; otherwise, select it to clear all other samples from 
the display other than the currently loaded sample.

Also load variants’ samples Selected by default. When viewing a variant in IGV, if you 
have selected this option, then the sample information for 
the variant, such as coverage distribution, read pile-up, is 
also loaded and viewable in IGV.

Automatically search and load 
missing bam files 

 If you did not import a BAM file for a sample, then to view 
the BAM file in IGV, select this option. Geneticist Assistant 
then looks for the BAM file that matches the VCF file name 
either in the VCF directory/sub-directory or, if applicable, in 
the NextGENe project file directory/sub-directory.
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To specify the OMIM settings
To view information from OMIM in Geneticist Assistant, Geneticist Assistant must be able 
to connect to OMIM and use an OMIM API key to log you in automatically.

1. In the OMIM (middle) pane, click Request an OMIM API key.

You are directed to the API Access to OMIM webpage.

2. Complete the necessary information to obtain an OMIM API Access key.

3. Upon receipt of the key, enter the value in the API field.

4. Indicate the connectivity for the API Host (Europe or United States).

5. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any this tab or any of the other tabs as appropriate. 
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Managing Quality Metrics
Quality metrics are crucial in project management, where these metrics are defined as the 
description of the attributes of the product or project. Every quality metric is an objective 
number that can be quantified and confirmed. In Geneticist Assistant, you have the option of 
specifying quality metrics for monitoring and reporting on the NGS data that are you adding 
to your historical NGS database. In Geneticist Assistant, these quality metrics are grouped in 
to metric profiles. Geneticist Assistant comes pre-populated with three AMP/CAP-
recommended metric profiles, with each profile containing the performance metrics that 
CAP and AMP recommend for monitoring and reporting on NGS bioinformatics pipelines. 
The majority of these pre-loaded metrics are metrics that are defined in a VCF file.

• AMP/CAP guidelines for all samples

• AMP/CAP guidelines for germline samples

• AMP/CAP guidelines for tumor samples

You can use an AMP/CAP profile as-is, you can add a completely new metric profile (a user-
defined profile), you can edit and save an existing user-defined profile as a new profile, or 
you can import a profile that has been saved in .json format. You can also delete a 
user-defined metric profile. When you add a new run to the Geneticist Assistant database, 
you can select the appropriate metric profile for the run, and after the run is complete, the 
results of this metric monitoring are reported on the Quality Metric Report sub-tab for the 
Sample tab. (See “Quality Metric Report Sub-Tab” on page 242.)
.

Data Source template file
When you are adding a new metric profile, if a pre-loaded metric is one that is commonly 
defined in a VCF file, then the location of the metric in the sample VCF file is known and the 
Data Source field on the Manage Quality Metrics dialog box displays this location; however, 
for the remainder of these pre-loaded metrics, or any user-defined metric, the Data Source 
field is blank. When you are adding a new metric profile, the locations of all the metrics in 
the sample VCF file must be explicitly defined. You must create and load a Data Source 
template file that defines the locations for any pre-loaded metrics that do not have a Data 
Source value and for all user-defined metrics.
Figure 2-16:  Data Source field indicating metric location

For the relevant article that details these AMP/CAP guidelines, see https://
jmd.amjpathol.org/article/S1525-1578(17)30373-2/fulltext.
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A Data Source template file is simply a sorted VCF file. You load and work with a Data 
Source template file in the Edit Data Source dialog box.
Figure 2-17:  Edit Data Source dialog box

Option Description
1 Quality Metric Name of the selected quality metric.

2 Category Category for the selected quality metric (Run, Sample, Variant.)

3 Template File Name and full directory path to the loaded Data Source template 
file. To browse to and load a Data Source template file, click the 
Browse button next to the Template File field.

4 Sample The name of the sample in the VCF file.

5 Variant A selected variant in the VCF file.

6 Variant Field/Description The information that is displayed in this pane depends on the 
quality metric category (Run, Sample, Variant) that is selected 
and the VCF file that is loaded. If the data source is not yet 
defined for a metric, then you can select the appropriate field 
from this list.
Note: If the selected metric is not found in the loaded VCF file, 

then the message “<metric> does not exist in the template 
file” is displayed.

7 Operators Operators for creating a formula. Parentheses are also available 
for setting the order of operations in the formula. If your metric 
requires combining multiple fields from the VCF file, then you 
can use these operators to define the metric calculation.

8 () Data Source Defines how the quality metric is to be derived from a sample 
VCF file - Primary Data Source, Secondary Data Source, and so 
on. Click the (+) tab for each data source that is to be used in a 
calculation. 

9 Value Displays an example value for the metric based on the selected 
variant.
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To add a new metric profile
1. On the Geneticist Assistant main menu, click File > Manage Quality Metrics.

The Manage Quality Metrics dialog box opens.

Figure 2-18:  Manage Quality Metrics dialog box

2. Click New. 

The New Metric Profile dialog box opens.

Figure 2-19:  New Metric Profile dialog box

3. Enter a name for the new metric profile, and then click OK.

The New Metric Profile dialog box closes and the Manage Quality Metrics dialog box 
remains open. The name of the new profile is displayed in the Edit profile field, and the 
lower (Metrics) pane is blank.

4. The Used for field identifies the samples types for which the metric profile should be 
used. When you are creating a new metric profile, the default value is the value for the 
last loaded metric profile. You can leave this value as-is, or optionally, in the Used for 
field, enter the sample type for which the profile applies, and then click the Confirm icon 
that is displayed to the right of the Used for field.

Figure 2-20:  Adding a new metric profile, name and Used for information
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5. In the Select or type new metric field, open the dropdown list and select a pre-loaded 
metric, or manually enter a metric name. If you manually enter the metric name, you can 
enter the name for a pre-loaded metric, or you can enter a user-defined metric (one that is 
not available on the pre-loaded metric list), for example, NextGENe Score. Note the 
following if you enter the name for a pre-loaded metric:

• As you enter the metric name, a dropdown list opens. The list is dynamically 
updated with the names of the pre-loaded metrics that match the search string that 
you are entering.

• The search string is not case-sensitive, and the string can be found anywhere in the 
metric name. For example, a search string of “alle” returns Allele fraction, % of 
bases called that are variants, and so on.

6. Click Add.

• If the metric is a metric that is commonly defined in a VCF file, then the metric with 
its attributes (Category, Use, and Data Type) and default threshold placeholders is 
added to the profile and displayed in the lower (Metric) pane of the Manage Quality 
Metrics dialog box. The Data Source field displays the location in the sample VCF 
file where the metric is found. Go to Step 8.

• If the metric is a user-defined metric, then you must select the Category, Use, and 
Data Type values for the metric. You select these values from a list of pre-defined 
values and you cannot add a new value, or edit the available values. The Use is 
always set to a default value of REQ (required), but you can select OPT (optional), 
or OHR (Optiona1but Highly Recommended). The Data Source field is blank. Go to 
Step 7.

7. Double-click in the Data Sources field to open the Edit Data Source dialog box, and then 
browse to and select the appropriate template file and define the data source.

As you enter a value in the Used for field, a Reset icon is displayed to the right of 
the Confirm icon. If you decide that you would rather use the value that had 
previously been displayed in the field instead of your new value, click the Reset 
icon.

You must repeat Step 5 through Step 9 for each quality metric that you are adding 
to the metric profile.

If you are having difficulty locating your user-defined metric in the metric list, 
remember, you can click a column header to sort the display. See “To change the 
sort order of data” on page 44.

To remove a metric from the profile, right-click the metric, and on the context 
menu that opens, click Remove Metric.
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8. Set the metric thresholds. To set a threshold, make sure that the checkbox for the 
threshold is selected, and then double-click the threshold placeholder to select it and then 
change the value.

O

9. If applicable, define the calculation for the metric.

10. Optionally, to save the metric profile in .json format, click Save as json, and then specify 
a name for the quality metric profile and the location in which to save it.

11. Click OK. 

The Manage Quality Metrics dialog box closes and the profile is saved to your Geneticist 
Assistant database. The profile is now available for selection when adding a new run. 

To add a new metric profile by copying an existing profile
Instead of adding an entirely new metric profile, you can copy an existing profile, edit the 
profile, and then save the profile with a new name.

1. On the Geneticist Assistant main menu, click File > Manage Quality Metrics.

The Manage Quality Metrics dialog box opens.

Figure 2-21:  Manage Quality Metrics dialog box

2. On the Edit Profile dropdown list, select the metric profile that you are duplicating and 
editing.

     

You can always set a Minimum threshold value, a Maximum threshold value, and/
or Warning threshold values for a metric; however, not all thresholds are 
applicable for all metrics. 

This option is useful for sharing your metric profiles with other users. You can 
send this file to Geneticist Assistant users, and they can use the From json function 
to import the file and use the profile in their Geneticist Assistant instances.
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3. Click Duplicate.

The New Profile dialog box opens.

Figure 2-22:  New Profile dialog box

4. Enter the name for the new metric profile, and then click OK.

The New Profile dialog box closes and the Manage Quality Metrics dialog box remains 
open. The name of the new profile is displayed in the Edit profile field, and the lower 
(Metrics) pane is populated with the metrics and thresholds from the copied profile.

5. Edit the profile as needed, and then save the profile. See Step 4 through Step 11 of “To 
add a new metric profile” on page 79.

To delete a metric profile
You can delete only a non-preloaded metric profile. If you delete a metric profile, any runs 
that used this profile are not affected. Going forward, the profile is simply not available for 
selection for a new run.

1. On the Geneticist Assistant main menu, click File > Manage Quality Metrics.

The Manage Quality Metrics dialog box opens.

Figure 2-23:  Manage Quality Metrics dialog box

2. On the Edit Profile dropdown list, select the user-defined profile that is to be deleted.
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3. Click Delete.

A Delete profile message opens, asking you if you are sure that you want to delete the 
profile.

Figure 2-24:  Delete Profile message

4. Click Yes.

The Delete profile message closes. The Metric Profile is deleted immediately from the 
Geneticist Assistant database and the Manage Quality Metrics dialog box remains open.
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Management

In addition to specifying some of the basic settings for Geneticist Assistant, such as the 
Reference directories, or the global Quality Control settings, you must configure the users, 
and optionally, the groups, who are to have access to Geneticist Assistant.

This chapter covers the following topics:

• “Managing Users” on page 87.

• “Managing Groups” on page 93.

• “Managing Web Users” on page 98.
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Managing Users
Users are the people who log into Geneticist Assistant, whether they are adding and 
reviewing content, or just using Geneticist Assistant in a read-only capacity. Remember, 
when Geneticist Assistant is first installed, it is installed with a default Administrator user. 
As the Geneticist Assistant administrator, you must manage all the necessary users for your 
Geneticist Assistant installation, which includes adding new users, deleting users, and 
editing user permissions. 

To add a new user
A user in Geneticist Assistant is one of three types:

• Administrator user - All available permission types (User, Chemistry, Instrument, and so 
on) are automatically assigned to an Administrator user. An Administrator user can view 
all the runs that have been submitted to the Geneticist Assistant database by any user and 
all the patients that have been added to the Geneticist Assistant database by any user.

• Staff user - A Staff user can log into the django web administrator site. The actions that a 
staff user can carry out on this site are determined by the permission types that are 
assigned to the user. 

• (Standard) user - For a standard user, you do not select either the Administrator Privileges 
option or the Staff option. Standard users can view all the runs that they have submitted 
to the Geneticist Assistant database as well as any runs that have been submitted by other 
users and for which they have been granted at least the Can Read permission. Standard 
users can also view all the patients that they have added to the Geneticist Assistant 
database as well as any patients that have been added by others users and for which they 
have been granted at least the Can Read permission.

.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. The User tab is the open tab. The tab displays 
all the users who are currently configured for your Geneticist Assistant installation, their 
status, and if applicable, their permissions level (Staff or Administrator). See Figure 3-1 
on page 88.

Instead of assigning permissions to each user on an individual basis, optionally, 
you can assign users to a group and apply the same permissions to all the users in 
the group in a single step. See “Managing Groups” on page 93.

For a detailed description of the permission types that you can assign to a user, 
contact SoftGenetics.
Geneticist Assistant User’s Manual 87



Chapter 3
Geneticist Assistant User Management
Figure 3-1:  User Management dialog box, User tab

2. Click Add New User.

The Add New User dialog box opens.

Figure 3-2:  Add New User dialog box

3. Add the information for the new user.

Field Description
Username Required. The login name for the user. Uppercase and lowercase are 

allowed. No special characters are allowed.
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4. In the Permissions pane, add or remove the permissions for the user as needed. You can 
add or remove permissions individually, or you can add or delete all permissions of a 
specific type in a single step.

• To add all permissions of a specific type (for example, View), select the check box 
next to the type.

• To remove all permissions of a specific type, clear the check box for the type.

5. Click OK.

The Add New User dialog box closes. The User Management dialog box remains open.

To delete a user
When you delete a user, the user profile remains in the Geneticist Assistant database. If any 
comments, changes, and so on are associated with the user, then the username for the deleted 
user is still shown in the appropriate panes, fields, and so on; however, the user profile is not 
displayed on any user list in Geneticist Assistant, for example, in the All Users pane on the 
Add New Group dialog box. To reactivate the user profile, you must add the user again with 
the same user name.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. The User tab is the open tab. The tab displays 
all the users who are currently configured for your Geneticist Assistant installation, their 
status, and if applicable, their permissions level. See Figure 3-3 on page 90.

Password Required. The login password for the user. The password cannot contain 
any spaces. If additional password requirements have been set, then the 
password must also adhere to these requirements. See “To specify the 
Geneticist Assistant password requirements” on page 73.

Confirm Password Required. Enter the password exactly as you entered it in the Password 
field.

First Name (optional) The first name for the user. Displayed only here in the application.

Last Name (optional) The last name for the user. Displayed only here in the application.

Email Required. The email address for the user.

• Administrator 
Privileges

• Staff 

You can assign both Administrator Privileges and Staff status to the same 
user. Do not assign either option for a standard user.

Active Selected by default and you cannot change this. The user is added as an 
Active user. The user can log into Geneticist Assistant and carry out all the 
activities available to him/her based on the assigned permissions. You can 
inactivate a user when you edit a user. See “To edit a user” on page 90.

Be aware of the dependencies for these permissions. For example, if a user is to be 
able to add chemistries, then the user must also be able to view chemistries.

Field Description
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Figure 3-3:  User Management dialog box, User tab

2. Right-click the user that you are deleting, and on the context menu that opens, click 
Disable User.

The user is deleted.

To edit a user
When you edit a user, you can edit the user password, the user first and last names, the user 
email address, the user status, the user level (Administrator and/or Staff) and the user 
permissions. You cannot edit a user name. To edit a user name, you must delete the existing 
user (see “To delete a user” on page 89), and then add the user with a new user name.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. The User tab is the open tab. The tab displays 
all the users who are currently configured for your Geneticist Assistant installation, their 
status, and if applicable, their permissions level. 

Figure 3-4:  User Management dialog box, User tab

No confirmation message opens asking you if you are sure that you want to delete 
a selected user. Instead, the user is deleted immediately, so be very sure that you 
want to delete a user before doing so.
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2. Do one of the following:

• Double-click the user that you are deleting.

• Right-click the user that you are editing, and on the context menu that opens, click 
Edit User.

The Edit User dialog box opens. With the exception of the password, the dialog displays 
all the current information for the user, including the currently assigned permissions. 

Figure 3-5:  Edit User dialog box

3. Edit any or all of the following information as needed—the user password, the user first 
and last names, the user email address, the user status (Active), or the user level (Staff or 
Administrator).

4. In the Permissions pane, add or delete the permissions for the user as needed. You can 
add or delete permissions individually, or you can add or delete all permissions of a 
specific type in a single step.

• To add all permissions of a specific type (for example, View), select the check box 
next to the type.

• To clear all permissions of a specific type, clear the check box for the type.

If you edit the user level, do not forget to manually edit the permissions as needed. 
See Step 4 below.

Be aware of the dependencies for these permissions. For example, if a user is to be 
able to add chemistries, then the user must also be able to view chemistries.
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5. Click OK.

The Edit Permissions dialog box closes. The User tab of the User Management dialog 
box remain open.
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Managing Groups
Instead of assigning permissions to each user on an individual basis, optionally, you can 
assign users to a group and apply the same permissions to all the users in the group in a 
single step. As the Geneticist Assistant administrator, you must manage all the necessary 
groups for your Geneticist Assistant installation, which includes adding new groups, deleting 
groups, and editing group permissions. 

To add a new group
When you add a group, you must name the group, add to users to the group, and assign 
permissions to the group. If a user has different privileges assigned than the group 
permissions, then the complete set of user permissions is the user permissions plus the group 
permissions. If a user is assigned to multiple groups, then the user’s permissions are a sum of 
all the groups’ permissions.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. The User tab is the open tab. See Figure 3-1 on 
page 88.

2. Click the Group tab to open it.

The tab displays all the groups by name that are currently configured for your Geneticist 
Assistant installation.

Figure 3-6:  User Management dialog box, Group tab

3. Click Add New Group.

The Add New Group dialog box opens. All users who can be added to a group are 
displayed in the All Users pane. See Figure 3-7 on page 94.
Geneticist Assistant User’s Manual 93



Chapter 3
Geneticist Assistant User Management
Figure 3-7:  Add New Group dialog box

4. Enter the name for the new group.

5. In the All Users pane, select the users whom you are adding to the group (CTRL-click to 
select multiple users in a single step), and then click Add. 

6. In the Permissions pane, add or delete the permissions for the group as needed. You can 
add or delete permissions individually, or you can add or delete all permissions of a 
specific type in a single step.

• To add all permissions of a specific type (for example, View), select the check box 
next to the type.

• To clear all permissions of a specific type, clear the check box for the type.

7. Click OK.

The Add New Group dialog box closes. The User Management dialog box remains 
opens.

Uppercase and lowercase and spaces are allowed. No special characters are 
allowed. 

If you add a user in error, you can remove them. Select the user in the Current 
Users pane (CTRL-click to select multiple users in a single step), and then click 
Remove. 

Be aware of the dependencies for these permissions. For example, if a group is to 
be able to add chemistries, then the group must also be able to view chemistries.
94 Geneticist Assistant User’s Manual



Chapter 3
Geneticist Assistant User Management
To delete a group
When you delete a group, only the group is deleted. All the users remain configured (with 
their user permissions, if applicable), in Geneticist Assistant.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. The User tab is the open tab. See Figure 3-1 on 
page 88.

2. Click the Group tab to open it.

The tab displays all the groups by name that are currently configured for your Geneticist 
Assistant installation.

Figure 3-8:  User Management dialog box, Group tab

3. Right-click the group that you are deleting, and on context menu that opens, click 
Remove Group.

The group is deleted.

To edit a group
When you edit a group, you can edit the users who belong to the group and the group 
permissions. You cannot edit the group name. To edit a group name, you must delete the 
existing group (see “To delete a group” on page 95), and then add the group with a new 
group name.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. The User tab is the open tab. See Figure 3-1 on 
page 88.

     

No confirmation message opens asking you if you are sure that you want to delete 
a selected group. Instead, the group is deleted immediately, so be very sure that 
you want to delete a group before doing so.
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2. Click the Group tab to open it.

The tab displays all the groups by name that are currently configured for your Geneticist 
Assistant installation.

Figure 3-9:  User Management dialog box, Group tab

3. Do one of the following:

• Double-click the group that you are editing.

• Right-click the group that you are editing, and on the context menu that opens, click 
Edit Group.

The Edit Group dialog box opens. The dialog displays all the current information for the 
group—the group name, the users who are currently assigned to the group, and the 
permissions for the group. 

Figure 3-10:  Edit Group dialog box
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4. To edit the users who belong to the group, do one or both of the following:

• To add users to the group—In the All Users pane, select the users whom you are 
adding to the group (CTRL-click to select multiple users in a single step), and then 
click Add. 

• To remove users from a group—In the Current Users pane, select the users whom 
you are removing from the group, (CTRL-click to select multiple users in a single 
step), and then click Remove. 

5. In the Permissions pane, add or delete the permissions for the group as needed. You can 
add or delete permissions individually, or you can add or delete all permissions of a 
specific type in a single step.

• To add all permissions of a specific type (for example, View), select the check box 
next to the type.

• To clear all permissions of a specific type, clear the check box for the type.

6. Click OK.

The Edit Group dialog box closes. You return to the Group tab of the User Management 
dialog box.

Be aware of the dependencies for these permissions. For example, if a group is to 
be able to add chemistries, then the group must also be able to view chemistries.
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Managing Web Users
A web user is a user who has login and read/write permissions to the Geneticist Assistant 
customer portal. A web user can enter your organization’s patient and sample information in 
to the Geneticist Assistant customer portal without ever having to log in to an instance of 
Geneticist Assistant and accessing your Geneticist Assistant database. As the Geneticist 
Assistant administrator, you must manage all the necessary web users for the Geneticist 
Assistant customer portal, which includes adding, deleting, and editing web users.

To add a new web user
1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. The User tab is the open tab. See Figure 3-1 on 
page 88.

2. Click Web User.

The Web User tab opens. The tab displays all the web users that are currently configured 
to access your instance of the Geneticist Assistant customer portal. 

Figure 3-11:  User Management dialog box, Web User tab

3. Click Add New Web User.

The Add New User dialog box opens. See Figure 3-12 on page 99.

For detailed information about the Geneticist Assistant customer portal, see 
Chapter 12, “The Geneticist Assistant Customer Portal and Submissions,” on 
page 305.
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Figure 3-12:  Add New User dialog box (for a web user)

4. Add the information for the new web user.

5. Click OK.

The Add New User dialog box closes. The User Management dialog box remain open.

To delete a web user
1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. The User tab is the open tab. See Figure 3-1 on 
page 88.

2. Click Web User.

The Web User tab opens. The tab displays all the web users that are currently configured 
to access your instance of the Geneticist Assistant customer portal. See Figure 3-13 on 
page 100.

Field Description
Username Required. The login name for the user. Uppercase and lowercase are 

allowed. No special characters are allowed.

Password Required. The login password for the user. The password cannot contain 
any spaces. If additional password requirements have been set, then the 
password must also adhere to these requirements. See “To specify the 
Geneticist Assistant password requirements” on page 73.

Confirm Password Required. Enter the password exactly as you entered it in the Password 
field.

First Name (optional) The first name for the user. Displayed only here in the application.

Last Name (optional) The last name for the user. Displayed only here in the application.

Email Required. The email address for the user.

When you add a new web user, the user is added with a status of Active, and the 
user levels of Staff and Administrator are set to No. You cannot edit any of this 
information.
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Figure 3-13:  User Management dialog box, Web User tab

3. Right-click the web user that you are deleting, and on the context menu that opens, click 
Disable User.

The web user is deleted.

To edit a web user
When you edit a web user, you can edit the user password, the user first and last names, and 
the user email address, but you cannot edit the username. To edit a user name, you must 
delete the existing web user (see “To delete a web user” on page 99), and then add the web 
user with a new user name.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. The User tab is the open tab. See Figure 3-1 on 
page 88.

2. Click Web User.

The Web User tab opens. The tab displays all the web users that are currently configured 
to access your instance of the Geneticist Assistant customer portal. 

Figure 3-14:  User Management dialog box, Web User tab

No confirmation message opens asking you if you are sure that you want to delete 
a selected user. Instead, the user is deleted immediately, so be very sure that you 
want to delete a user before doing so.
100 Geneticist Assistant User’s Manual



Chapter 3
Geneticist Assistant User Management
3. Double-click the web user that you are editing.

The Edit User dialog box opens. With the exception of the password, the dialog box 
displays the current information for the selected web user. 

Figure 3-15:  Edit User dialog box (for a web user)

4. Edit any or all of the following information as needed—the user password, the user first 
and last names, or the user email address.

5. Click OK.

The Edit User dialog box closes. You return to the Web User tab of the User 
Management dialog box.

The tab also displays the status (Active) and user levels (Staff and Administrator 
set to No) for every user. Although this information is displayed for a web user, 
you cannot edit it.
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A panel is a collection of genomic regions that are targeted for a specific genomic test or 
study. You add panels to Geneticist Assistant by providing a BED file that defines the 
targeted regions, known as panel regions. Each sample that you submit to Geneticist 
Assistant is assigned to a specific panel. Managing panels consists of importing, editing, and 
deleting panels, and reviewing panel statistics. A subpanel contains a fixed number of 
regions that are contained within a selected panel. To verify coverage for a smaller number 
of regions that are within the panel that has been selected for a run, you can use a subpanel. 
Managing subpanels consists of adding, editing, and deleting subpanels.

This chapter covers the following topics:

• “Importing a Panel” on page 105.

• “Editing a Panel” on page 115.

• “Deleting a Panel” on page 117.

• “Reviewing Panel Statistics” on page 118.

• “Adding a Subpanel” on page 119.

• “Deleting a Subpanel” on page 122.
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Importing a Panel
A panel is a collection of genomic regions that are targeted for a specific genomic test or 
study. You add a panel to Geneticist Assistant by importing a BED file that defines the 
targeted regions, known as panel regions.

To import a panel
1. On the Geneticist Assistant main menu, click Panels > Manage Panels.

The Manage Panels dialog box opens. The number of panels that have already been 
imported into your Geneticist Assistant instance is displayed at the bottom of the dialog 
box. By default, Import from Panel File is selected.

Figure 4-1:  Manage Panels dialog box

2. Next to Import from Panel File, click the Browse button , and then browse to and 
select the appropriate BED file.

Geneticist Assistant creates a panel name that is the same as the selected BED file.

     

If the correct BED file is not available for a panel, then you can create a new BED 
file for it, either from a BED file that was loaded for another panel (see “To create 
a new BED file for a panel by adding or deleting regions” on page 113), or by 
clicking Bed File Builder to open the BED File Builder tool and create a BED file 
that is based on the information that you specify. See “Building a BED File with 
the BED File Builder Tool” on page 289.
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3. Optionally, in the Panel Name field, change the name of the panel.

4. If the correct panel group is not selected, then click Change Associated Panel Group to 
open the Panel Group Association dialog box, and then select a new panel group or click 
Add New Panel Group to open the Add New Panel Group dialog box and create it.

Figure 4-2:  Panel Group Association dialog box

Figure 4-3:  Add New Panel Group dialog box

5. Click Import Panel.

The Manage Panels dialog box display is updated to show all the panel regions by name 
for the panel. By default, the coverage thresholds that are initially displayed are the 
global values that are defined on the Quality Control tab on the Settings tab. See “To 
specify the global Quality Control settings” on page 64.

     

You can always click Default Name to change the name of the panel back to its 
default name.

 For information about panel groups, see “Managing Objects in the Geneticist 
Assistant Database” on page 55.

To track variant pathogenicities together for all panels, instead of creating custom 
panel groups, create a single panel group that is to be used for all panels, for 
example, a Global panel group.
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6. Do one of the following:

• If you are done with the configuration of the newly added panel, then click OK to 
close the Manage Panels dialog box and return to the Current Jobs tab of the 
Geneticist Assistant main window. The tab shows the progress of importing the new 
panel. After the panel is successfully imported, the tab is blank. 

• If you are not done with the configuration of the newly added panel, then continue to 
any of the following:

• “To manually set new coverage thresholds for panel regions” below.

• “To create a QC Threshold file for panel regions” on page 108.

• “To set new coverage thresholds for panel regions with a QC Threshold file” on 
page 110.

• “To set or delete a preferred transcript list for a panel” on page 110.

• “To set or delete a preferred gene for a panel” on page 112.

• “To create a new BED file for a panel by adding or deleting regions” on page 
113.

To manually set new coverage thresholds for panel regions
After you have imported a new panel, the coverage values that are initially displayed for 
each panel region are the global values that are defined on the Quality Control tab of the 
Settings dialog box. If needed, you can edit these values and save the values for the panel in 
the Geneticist Assistant database. You can edit the values for all the regions in a single step, 
or you can set different coverage thresholds on a per region basis.

1. If you have just imported a new panel, then the Manage Panels dialog box is already 
open and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. On the Select Existing Panel dropdown list, select the appropriate panel.

c. Click Download and Edit Panel Regions to display the panel regions in the bottom 
pane of the Manage Panels dialog box.

     

The time that it can take to import a BED file depends on the size of the BED file. 
Be patient as some BED files can take over an hour to be imported.

To confirm that the panel has been successfully imported, you can open the 
Manage Panels dialog box again, choose Select Existing Panel, and make sure 
that an entry for the imported panel is displayed on the dropdown list of existing 
panels.
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2. Do one of the following:

3. If you are done with the configuration of the newly added panel, then click OK to close 
the Manage Panels dialog box and return to the Geneticist Assistant main window. 
Otherwise, continue to any of the following: 

• “To create a QC Threshold file for panel regions” below.

• “To set or delete a preferred transcript list for a panel” on page 110.

• “To set or delete a preferred gene for a panel” on page 112.

• “To create a new BED file for a panel by adding or deleting regions” on page 113.

To create a QC Threshold file for panel regions
After you edit the coverage values for the regions of one panel, you can save these edited 
values to a QC Threshold text file. You can save this file as record of the QC thresholds that 
were used for the panel and you can also load this text file to apply these coverage thresholds 
to a different panel.

1. If you have just imported a new panel, then the Manage Panels dialog box is already 
open and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. On the Select Panel dropdown list, select the appropriate panel.

Action Steps
To edit the values for all 
regions in a single step

1. Click Update QC Threshold.
The Update QC Threshold for All Regions dialog box opens.

Figure 4-4:  Update QC Threshold for All Regions dialog box

2. For each coverage value that you are editing, double-click it to select 
it, and then manually enter a new value, or click the Up/Down arrows 
to change the value accordingly.

3. Click OK.

To edit the values on a 
per region basis

1. Double-click in the appropriate coverage field for a region.
The coverage value is selected, and Up/Down arrows are displayed.

2. Manually enter a new value, or click the Up/Down arrows to change 
the value accordingly.
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c. Click Download and Edit Panel Regions to display the panel regions on the Manage 
Panels dialog box.

2. Do one of the following:

3. Click Save QC Threshold File.

The Save File dialog box opens. By default, the QC Threshold file is named as <Panel 
Name>_qc_threshold, and it is saved in the same directory as the BED file for the panel. 
The file type is a text file, and you cannot change this.

4. Optionally, change the name for the QC Threshold file, and/or the directory in which to 
save the file, and then click Save. 

The Save File dialog box closes. The Manage Panels dialog box remains open. You can 
now load this text file to apply these coverage values to a different panel. See “To set 
new coverage thresholds for panel regions with a QC Threshold file” on page 110.

5. If you are done with the configuration of the newly added or edited panel, then click OK 
to close the Manage Panels dialog box and return to the Geneticist Assistant main 
window. (The edited coverage values are now saved for the panel in the Geneticist 
Assistant database.) Otherwise, continue to one or both of the following as needed:

• “To set or delete a preferred transcript list for a panel” on page 110.

• “To set or delete a preferred gene for a panel” on page 112.

Action Steps
To edit the values for all 
regions in a single step

1. Click Update QC Threshold.
The Update QC Threshold for All Regions dialog box opens.

Figure 4-5:  Update QC Threshold for All Regions dialog box

2. For each coverage value that you are editing, double-click it to select 
it, and then manually enter a new value, or click the Up/Down arrows 
to change the value accordingly.

3. Click OK.

To edit the values on a 
per region basis

1. Double-click in the appropriate coverage field for a region.
The coverage value is selected, and Up/Down arrows are also 
displayed.

2. Manually enter a new value, or click the Up/Down arrows to change 
the value accordingly.
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• “To create a new BED file for a panel by adding or deleting regions” on page 113.

To set new coverage thresholds for panel regions with a QC 
Threshold file
After you edit the coverage values for the regions of one panel, you can save these edited 
values to a QC Threshold text file (which saves these values in the Geneticist Assistant 
database), and then load this text file to apply these coverage values to a different panel.

1. If you have just imported a new panel, then the Manage Panels dialog box is already 
open and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. On the Select Panel dropdown list, select the appropriate panel.

c. Click Download and Edit Panel Regions to display the panel regions on the Manage 
Panels dialog box.

2. Click Load QC Threshold from File.

The Select a file to set QC threshold dialog box opens.

3. Browse to and select the appropriate QC Threshold file, and then click Open.

The Select a file to set QC threshold dialog box closes, and a QC Threshold Updated 
message opens. The message indicates the number of regions for which the QC 
threshold values were successfully updated. 

4. Click OK.

The message closes. The Manage Panels dialog box remains open.

5. If you are done with the configuration of the newly added or edited panel, then click OK 
to close the Manage Panels dialog box and return to the Geneticist Assistant main 
window. Otherwise, continue to one or both of the following as needed:

• “To set or delete a preferred transcript list for a panel” on page 110.

• “To set or delete a preferred gene for a panel” on page 112.

• “To create a new BED file for a panel by adding or deleting regions” on page 113.

To set or delete a preferred transcript list for a panel
A preferred transcript list is a tab-delimited text file that defines the specific transcript or 
isoform that is to be used for a gene. You can use different transcripts for different panels. 
The preferred transcript list contains two fields. The first column contains the gene name. 
The second column specifies the transcript by its nm_accession number. There are no 

If the correct QC Threshold file is not available, then you can create it. See “To 
create a QC Threshold file for panel regions” on page 108.
110 Geneticist Assistant User’s Manual



Chapter 4
Managing Panels and Subpanels
restrictions for the file name, but you must save the file as a tab-delimited text file.

1. If you have just created a new panel, then the Manage Panels dialog box is already open 
and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. On the Select Existing Panel dropdown list, select the appropriate panel.

2. Optionally, do any or all of the following as needed:

• To view the transcript list that is currently set as the preferred transcript list for the 
panel, click View Existing.

The Preferred Transcript for <Panel Name> dialog box opens. The dialog box 
displays the transcript list that is currently set as the preferred list for the panel. 

Figure 4-6:  Preferred Transcript dialog box

• To save the preferred transcript list as a text (.txt) file, click Save As in the Preferred 
Transcript dialog box; otherwise, click Close to close the dialog box.

The Manage Panels dialog box remain open.

• To set a preferred transcript list for the panel, then next to the Set Preferred 
Transcript from File field, click the Browse button  and in the Open File dialog 
box, browse to and select the appropriate transcript list, and then click Open.

The Open File dialog box closes. The full path to the selected transcript list is 
displayed in the Set Preferred Transcript from File field. 

• To delete the preferred transcript list for the panel, click Delete Existing, and then 
click Yes in the Delete Existing Preference message. 

The Save As option provides a quick way of copying the preferred transcript list so 
that you can make any needed changes to it, and then use it with this panel or 
another panel.
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The Manage Panels dialog box remain open.

3. If you are done with the configuration of the newly added or edited panel, then click OK 
to close the Manage Panels dialog box and return to the Geneticist Assistant main 
window. Otherwise, continue to any of the following as needed:

• “To manually set new coverage thresholds for panel regions” on page 107.

• “To create a QC Threshold file for panel regions” on page 108.

• “To set new coverage thresholds for panel regions with a QC Threshold file” on page 
110.

• “To set or delete a preferred gene for a panel” below.

• “To create a new BED file for a panel by adding or deleting regions” on page 113.

To set or delete a preferred gene for a panel
If a variant is found at a position where there are overlapping genes, then you can specify the 
gene that is to be used for the panel. The file that specifies the preferred gene is a text file that 
contains the complete gene name on a single line.

1. If you have just created a new panel, then the Manage Panels dialog box is already open 
and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. On the Select Existing Panel dropdown list, select the appropriate panel.

2. Optionally, do any or all of the following as needed:

• To view the genes that are currently set as the preferred genes for the panel, click 
View Existing.

The Preferred Gene for <Panel Name> dialog box opens. The dialog box displays 
the genes that are currently set as the preferred genes for the panel. 

Figure 4-7:  Preferred Gene dialog box
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• To save the preferred gene file as a text (.txt) file, click Save As in the Preferred 
Gene dialog box; otherwise, click Close to close the dialog box.

The Manage Panels dialog box remains open.

• To set preferred genes for the panel, then next to the Set Preferred Gene from File 
field, click the Browse button  and in the Open File dialog box, browse to and 
select the appropriate preferred gene file, and then click Open.

The Open File dialog box closes. The full path to the selected preferred gene file is 
displayed in the Set Preferred Gene from File field. 

• To delete the preferred genes for the panel, click Delete Existing, and then click Yes 
in the Delete Existing Preference message. 

The Manage Panels dialog box remain open.

3. If you are done with the configuration of the newly added or edited panel, then click OK 
to close the Manage Panels dialog box and return to the Geneticist Assistant main 
window. Otherwise, continue to any of the following as needed:

• “To manually set new coverage thresholds for panel regions” on page 107.

• “To create a QC Threshold file for panel regions” on page 108.

• “To set new coverage thresholds for panel regions with a QC Threshold file” on page 
110.

• “To set or delete a preferred transcript list for a panel” on page 110.

• “To create a new BED file for a panel by adding or deleting regions” below.

To create a new BED file for a panel by adding or deleting regions
Sometimes, you might need to use a panel that is a combination of two or more BED files. 
After you load a BED file for a panel, you can add regions from an existing BED file to it 
and then save the combined regions as either a new BED file or a panel. You can also delete 
regions from the loaded BED file and save the modified regions as a new BED file or panel.

1. If you have just imported a new panel, then the Manage Panels dialog box is already 
open and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

The Save As option provides a quick way of copying the preferred gene list so that 
you can make any needed changes to it, and then use it with this panel or another 
panel.

When you add regions from an existing BED file to another BED file, all the 
regions are added from the existing BED file. You cannot select specific regions to 
add; however, after all the regions are added, you can delete one or more regions.
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b. On the Select Panel dropdown list, select the appropriate panel.

c. Click Download and Edit Panel Regions to display the panel regions on the Manage 
Panels dialog box.

2. Do one or both of the following as needed:

3. On the Manage Panels dialog box, click Save Panel Regions to file.

The Save File dialog box opens. By default, the new BED file is named the same as the 
loaded BED file, and it is saved in the same directory as the loaded BED file. You can 
change one or both of these values.

4. Optionally, change the name for the new BED file, and/or the directory in which to save 
the file, and then click Save. 

The Save File dialog box closes. The Manage Panels dialog box remains open. 

5. If you are done with the configuration of the newly added or edited panel, then click OK 
to close the Manage Panels dialog box and return to the Geneticist Assistant main 
window. Otherwise, continue to any of the following as needed:

• “To manually set new coverage thresholds for panel regions” on page 107.

• “To create a QC Threshold file for panel regions” on page 108.

• “To set new coverage thresholds for panel regions with a QC Threshold file” on page 
110.

• “To set or delete a preferred transcript list for a panel” on page 110.

• “To set or delete a preferred gene for a panel” on page 112.

Action Steps
To add regions from an existing 
BED file

1. Click Add Regions from File.
The Select a file to add to the panel dialog box opens.

2. Browse to and select the appropriate BED file, and then 
click Open to close the dialog box and return to the 
Manage Panels dialog box.

To delete regions from the loaded 
BED file

1. Click the region that you are deleting. (CTRL-click to 
select multiple regions.)

2. Right-click the selected regions, and on the context 
menu that opens, click Remove Selected Regions.

Note: Deleting regions from a panel does not delete the 
panel. To delete the panel itself, see “Deleting a 
Panel” on page 117.
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Editing a Panel
Managing panels includes editing panels that will be used for studying your data in 
Geneticist Assistant.

To edit a panel
1. On the Geneticist Assistant main menu, click Panels > Manage Panels.

The Manage Panels dialog box opens.

Figure 4-8:  Manage Panels dialog box

2. On the Select Existing Panel dropdown list, select the panel that you are editing.

3. Click Download and Edit Panel regions.

The panel regions are displayed on the Manage Panels dialog box.

4. Do any or all of the following as needed:

• To change the associated panel group, click Change Associated Panel Group, and in 
the Panel Group Association dialog box, make the necessary change.

Figure 4-9:  Panel Group Association dialog box
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• To manually set new coverage thresholds for the panel regions, see “To manually set 
new coverage thresholds for panel regions” on page 107.

• To set new coverage thresholds for the panel regions with a QC Threshold file, see 
“To set new coverage thresholds for panel regions with a QC Threshold file” on page 
110.

• To set a preferred transcript list for the panel, or delete a preferred transcript list, see 
“To set or delete a preferred transcript list for a panel” on page 110.

• To set a preferred gene for the panel, see “To set or delete a preferred gene for a 
panel” on page 112.

• To create a new BED file for the panel, see “To create a new BED file for a panel by 
adding or deleting regions” on page 113.
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Deleting a Panel
Managing panels includes deleting panels that are no longer needed in Geneticist Assistant.

To delete a panel
1. On the Geneticist Assistant main menu, click Panels > Manage Panels.

The Manage Panels dialog box opens.

Figure 4-10:  Manage Panels dialog box

2. On the Select Existing Panel dropdown list, select the panel that you are deleting.

3. Click Delete.

A message opens asking you if you are sure that you want to delete the selected panel.

4. Click Yes.

The message closes. The entire panel is deleted, and a second message opens indicating 
that the panel was successfully deleted.

5. Click OK.

The message closes. The Manage Panels dialog box remains open.

When you delete a panel, you delete the entire panel. To simply delete regions from 
a panel, not the entire panel, see “To create a new BED file for a panel by adding 
or deleting regions” on page 113.
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Reviewing Panel Statistics
The Panel Statistics tab has options for reviewing specific information for a selected panel/
panel group. By default, all samples for the panel are included. You can edit the options for 
displaying panel statistics such as setting specific date range, or selecting specific samples or 
runs.

To review panel statistics
1. On the Geneticist Assistant main menu, click Panels > Panel Statistics.

The Panel Statistics tab opens.

2. On the Panels dropdown list, select the panel for which the statistics are to be viewed.

3. Change any of the display options for the Panel Statistics tab, and then click OK to load 
the panel statistics based on the specified options.

The Panel Statistics tab that opens from the Panels menu is identical to the Panel 
Statistics tab that opens from the context menu of the Runs tab, the Samples sub-
tab on the Patient tab, the Run tab, or the Variant tab. For a complete description 
of this tab, see “Reviewing Panel Statistics” on page 319.
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Adding a Subpanel
A subpanel contains a fixed number of regions that are contained within a selected panel. To 
verify coverage for a smaller number of regions that are within the panel that has been 
selected for a run, you can use a subpanel. Managing panels includes adding the new 
subpanels that are to be used for targeting a specific genomic test or study, and creating a 
new BED file for a subpanel.

To add a subpanel
1. On the Geneticist Assistant main menu, click Panels > Manage Panels.

The Manage Panels dialog box opens. See Figure 4-1 on page 105.

2. On the Select Existing Panel dropdown list, select the panel from which the subpanel is 
to be created.

3. Click Manage Subpanels.

The Manage Subpanels dialog box opens. The first time that the dialog box opens, all 
fields are blank; otherwise, it displays the information for the subpanel that was last 
viewed and/or modified. 

Figure 4-11:  Manage Subpanels dialog box

4. Select the panel for which you are adding the subpanel.
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5. Click New Subpanel.

The Add Subpanel dialog box opens.

Figure 4-12:  Add Subpanel dialog box

6. Next to the Subpanel File (.bed) field, click the Browse button , and then browse to 
and select the BED file for the subpanel that you are adding.

The Subpanel file field is populated with the full directory path to the selected BED file, 
and by default, the subpanel name is set to the name of the selected BED file.

7. Optionally, edit the name for the subpanel.

8. Click OK.

The Add Subpanel dialog box closes. The Manage Subpanels dialog box remains open. 
The information for all the regions (Region Name, Chromosome Number, Region Start, 
and Region End) is displayed in the lower pane of the dialog box.

9. If you are done with the configuration of the newly added subpanel, then click OK to 
close the Manage Subpanels dialog box and return to the Manage Panels dialog box; 
otherwise, continue to “To create a new BED file for a subpanel by adding or deleting 
regions” below.

To create a new BED file for a subpanel by adding or deleting 
regions

Sometimes, you might need to use a subpanel that is a combination of two or more BED 
files. After you load a BED file for a subpanel, you can add regions from an existing BED 
file to it and then save the modified regions as a new BED file or subpanel. You can also 
delete regions from the loaded BED file and save the modified regions as a new BED file or 
subpanel.

If the correct BED file is not available for a subpanel, then you can use the BED 
File Builder tool to create one based on the information that you specify. See 
“Building a BED File with the BED File Builder Tool” on page 289.

You can click Default Name to reset the BED file name to the default value.
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1. If you have just created a new subpanel, then the Manage subpanels dialog box is 
already open and all the panel regions for the subpanel are displayed; otherwise, do the 
following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. Choose Select existing panel, and then on the Panel dropdown list, select the 
appropriate panel.

c. Click Manage Subpanels.

d. On the Manage Subpanels dialog box, select the appropriate subpanel.

e. Click View subpanel regions.

2. Do one or both of the following as needed:

3. On the Manage Subpanels dialog box, click Save Panel Regions to a BED file.

The Save File dialog box opens. By default, the new BED file is named the same in the 
following format: <subpanel>_<Panel> and it is saved in the same directory as the 
loaded BED file. You can change one or both of these values.

4. Click OK.

The regions are saved as a subpanel.

When you add regions from an existing BED file to another BED file, all the 
regions are added from the existing BED file. You cannot select specific regions to 
add; however, after all the regions are added, you can delete one or more regions.

Action Steps
To add regions from an existing 
BED file

1.  Next to the Add Regions from BED File field, click the 

Browse button .

The Select a file to add to the panel dialog box opens.
2. Browse to and select the appropriate BED file, and then 

click Open to close the dialog box and return to the 
Manage Panels dialog box.

3. Click Add Regions.

To delete regions from the loaded 
BED file

1. Click the region that you are deleting. (CTRL-click to 
select multiple regions.)

2. Right-click the selected regions, and on the context 
menu that opens, click Remove Selected Regions.

Note: Deleting regions from a BED file does not delete the 
subpanel. To delete the subpanel itself, see “Deleting 
a Subpanel” on page 122.
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Deleting a Subpanel
Managing subpanels includes deleting subpanels that are no longer needed in Geneticist 
Assistant.

To delete a subpanel
1. On the Geneticist Assistant main menu, click Panels > Manage Panels.

The Manage Panels dialog box opens. See Figure 4-1 on page 105.

2. Choose Select existing panel, and then on the Panel dropdown list, select the appropriate 
panel.

3. Click Manage Subpanels.

The Manage Subpanels dialog box opens. 

Figure 4-13:  Manage Subpanels dialog box

4. Select the subpanel that you are deleting. 

     

When you delete a subpanel, you delete the entire subpanel. To simply delete 
regions from a BED file, not the entire subpanel, see “To create a new BED file for 
a subpanel by adding or deleting regions” on page 120.
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5. Click Delete.

A Delete Subpanel message opens, asking you if you are sure that you want to delete the 
selected subpanel from the database.

Figure 4-14:  Delete Subpanel message

6. Click Yes.

The Delete Subpanel message closes, and a Subpanel Deleted message opens, indicating 
that the selected subpanel was successfully deleted.

Figure 4-15:  Subpanel Deleted message

7. Click OK.

The Subpanel Deleted message closes. The Manage Subpanels dialog box remains open. 
The subpanel and its regions are no longer displayed in the dialog box.
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A patient refers to an individual from whom a sample was taken. A run refers to loading a 
BAM file and a VCF file or just a VCF file into Geneticist Assistant for the purposes of 
importing a list of variants into the Geneticist Assistant database and/or reviewing a list of 
variants in a sample. This chapter details how to manage patient settings for your runs and 
how to add a new run in Geneticist Assistant.

This chapter covers the following topics:

• “Adding Patients” on page 127.

• “Accessing and Reviewing Patient Records” on page 137.

• “Adding a Run” on page 170.

     

Geneticist Assistant supports only sorted VCF files.

For information about managing your run settings (chemistries, instruments, and 
so on), see “Managing Objects in the Geneticist Assistant Database” on page 55.
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Adding Patients
In addition to managing settings (chemistries, instruments, and so on) for your runs, you 
must manage the patients for your runs. A patient refers to an individual from whom a 
sample was taken. Managing patients for your runs consists of adding new patients to the 
Geneticist Assistant database or Customer Poral. You have three options available for adding 
a new patient. You can:

• Manually add one patient at a time.

• Import a Patient batch file to add multiple patients to the database in a single step. 

• Import a Submissions batch file to add multiple patients to the Customer Portal in a single 
step.

Moreover, if your VCF or BAM sample file names begin or end with the patient ID, then 
Geneticist Assistant can automatically associate the appropriate sample with the patient, or 
even create the patient record if needed, and then associate the sample with the record. If you 
are loading a standalone VCF file, then just the VCF file name must begin or end with the 
patient ID. If you are loading both a VCF file and a BAM file, then the names for both files 
must begin and/or end with the patient ID.

To add one patient at a time
When you add one patient at a time, you can specify the name, birthdate, gender, and 
ethnicity for the patient as well as a unique ID for the patient. You can also add relationships 
to the patient, and you can add one or more phenotypes for the patient.

1. On the Geneticist Assistant main menu, click File > New Patient.

The Add New Patient dialog box opens. The Add Patient tab is the opened tab. 

Figure 5-1:  Add New Patient dialog box, Add Patient tab
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2. Enter the information for the new patient.

3. If applicable, to specify relationships for the new patient, select Is Related to Existing 
Patient and then do the following:

a. Select the relationship type, for example, Father. (The available relationship options 
depend on the patient’s gender.)

b. Select the existing patient for this relationship. (Select the patient on the select 
existing patient list, or double-click the patient entry in the All Patients pane.)

c. Click Add.

The Relationships About to Be Added list displays the relationship that you have 
specified for the new patient.

Figure 5-2:  Add New Patient dialog box, Relationship options

Option Description
External ID A unique ID for the patient. 

First Name The first name for the patient.

Last Name The last name for the patient.

Date of Birth The patient’s date of birth. You must click in the field, and then manually enter a 
new value, or you can use the Up/Down arrows.

Gender Male or Female.

Ethnicity The ethnicity for a patient, for example, Caucasian (Non-Hispanic).
Note: If the appropriate ethnicity is not available, then you can click New 

Ethnicity and add it. You can also add ethnicities using the Manage 
Objects function. See “Managing Objects in the Geneticist Assistant 
Database” on page 55.
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4. Repeat Step 3 to add as many relationships for a patient as needed.

5. If applicable, to add a phenotype for the patient, do any of the following:

• On the Add Phenotype dropdown list, select the phenotype, and then click Add. You 
can repeat this step as many times as needed to add multiple phenotypes for the 
patient.

The added phenotype is displayed in the Phenotype pane.

• If the appropriate phenotype is not available, then you can click New Phenotype to 
open the New Phenotype dialog box and enter the phenotype. As you enter the 
search string, a dropdown list opens. The list is dynamically updated with the 
phenotypes that are found in the Human Phenotype Ontology database that match 
the search string.

Figure 5-3:  New Phenotype dialog box

6. Optionally, to add a comment for the phenotype, do one of the following; otherwise, go 
to Step 7.

• In the Comment field, single click twice, enter the comment, and then click 
anywhere outside the field.

• Right-click the phenotype and on the context menu that opens, click Add Patient 
Phenotype Comment.

7. Click OK.

Two results are possible:

• If you have encryption enabled for your Geneticist Assistant instance, then the Add 
New Patient dialog box closes. The new patient record is displayed on the Patients 
tab. For specific identifying information, asterisks (*) are displayed.

If you add a relationship in error, right-click the relationship, and then select 
Remove Selected Rows. CTRL-click to select multiple relationships for deletion.

The search string is not case-sensitive, and the string can be found anywhere in 
the search results. For example, a search string of “thyroid” returns phenotypes of 
thyroid adenoma and secondary hyperthyroidoism.

You can also add phenotypes using the Manage Objects function. See “Managing 
Objects in the Geneticist Assistant Database” on page 55.
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• If you do not have encryption enabled for your Geneticist Assistant instance, then an 
Invalid Encryption Certificate Setting dialog box opens, warning you that no 
Encryption Certificate is selected and that data will be submitted without encryption. 
Go to Step 8.

Figure 5-4:  Invalid Encryption Certificate Setting dialog box

8. Click Yes.

Both the Invalid Encryption Certificate Setting dialog box and the Add New Patient 
dialog box close. The new patient record is displayed on the Patients tab, with all 
identifying information fully visible.

To import a Patients batch file
You can import a Patients batch file to add multiple patients in a single step to the Geneticist 
Assistant database. The Patients batch file must be either a comma-separated values (.csv) 
file, a tab-delimited text (.txt) file, or a tab-separated values (.tsv) file. The first line of the 
file must be the pound/hashtag (#) symbol, followed by delimited column headers. The file 
must contain the following columns of information in the order listed—the External ID, the 
patient last name, the patient first name, the patient date of birth, and the patient gender. 
Multiple phenotypes and multiple relationships must be separated by semi-colons. In 
addition to the required columns, the Patients batch file can include other optional standard 
fields, such as ethnicity, phenotypes, and relationships, as well as custom fields. Patient 
relationships must be in the format ExternalID;Relationship, for example, ABS17;Father. 
When importing the patients, you can opt to add any custom patient fields to the Geneticist 
Assistant database. Figure 5-5 below is an example file that shows the required column order 
and column names for a Patients batch file. The example file also includes custom data 
columns.

Figure 5-5:  Patients batch file with required columns and custom unmatched columns

To view and edit the custom fields for a patient, you must edit the patient record 
(Edit Patient). See “To use the context menu for a patient (Patients tab)” on page 
141.
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1. On the Geneticist Assistant main menu, click File > New Patient.

The Add New Patient dialog box opens. The Add Patient tab is the opened tab. See 
Figure 5-1 on page 127.

2. Click the Import Patients tab to open it. 

Figure 5-6:  Add New Patient dialog box, Import Patients tab

3. Next to the Patient File field, click the Browse button , and then browse to and select 
your patient file.

4. Specify the properties of your patient file.

Property Description
Data Delimiter Indicate the delimiter used (Comma or Tab).

Date of Birth Format Select the format used for the patients’ dates of birth.

Add New Phenotype Terms Selected by default. If the patient file contains phenotypes in the 
Phenotypes column that have not already been added to the 
Geneticist Assistant database through either the Manage 
Objects function (see “Managing Objects in the Geneticist 
Assistant Database” on page 55), or the Add Phenotype option 
on the Add Patient tab (see “Patient tab, Patient sub-tab, 
Phenotype pane” on page 148), then leave this option selected 
to automatically add these phenotypes to the database. 
Otherwise, clear this option. 
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5. Click OK.

You results are determined by whether you have enabled encryption for your patient 
data. Continue to one of the following:

• “To add patients to the Geneticist Assistant database with encryption enabled” 
below.

• “To add patients to the Geneticist Assistant database with encryption enabled” on 
page 132.

To add patients to the Geneticist Assistant database with 
encryption enabled 
If you have encryption enabled for your Geneticist Assistant instance, then the Add New 
Patient dialog box closes. The new patient records are displayed on the Patients tab. For 
specific identifying information, asterisks (*) are displayed, and if:

• You have not imported custom fields, then the Add Patient dialog box closes, and a single 
message, the Patient Import message, opens, indicating the number of patients that were 
successfully added to the Geneticist Assistant database. Click OK to close the message, 
and then continue as appropriate in Geneticist Assistant.

Figure 5-7:  Patient Import message

     

Add unmatched columns as 
custom patient fields

In addition to the required information for the Patients batch file, 
the file can include any other information as needed, for 
example, Sample Type, Weight, Age at Death, and so on. Select 
this option to include this information in the Geneticist Assistant 
database for the patients.

The results below illustrate the most common scenarios for adding a new patient 
to the Geneticist Assistant database, and are meant only as guidelines for adding 
patients, and if applicable, custom fields, to the Geneticist Assistant database.

Property Description
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• You have imported custom fields and have selected them for addition to the Geneticist 
Assistant database, then a first message, a New Custom Fields message, opens indicating 
that these custom fields will be added to the Geneticist Assistant database. 

Figure 5-8:  Custom Fields message, Fields will be added

Click Yes to close the New Custom Fields message, and then a second message, a Patient 
Import message, opens. The message indicates the number of patients that were 
successfully added to the Geneticist Assistant database opens. Click OK to close the 
Patient Import message, and then continue as appropriate in Geneticist Assistant.

Figure 5-9:  Number of Patients added message

To add patients to the Geneticist Assistant database without 
encryption
If you do not have encryption enabled for your Geneticist Assistant instance, then an Invalid 
Encryption Certificate Setting dialog box opens, warning you that no Encryption Certificate 
is selected and that data will be submitted without encryption, and asking you to continue. 
Figure 5-10:  Invalid Encryption Certificate Setting dialog box

Click Yes.

• If you have not imported any custom fields, then both the Invalid Encryption Certificate 
Setting dialog box and the Add New Patient dialog box close. A single message, the 
Patient Import message, opens, indicating the number of patients that were successfully 
added to the Geneticist Assistant database. (See Figure 5-11 on page 134.) Click OK to 
close the message. The new patient records are displayed on the Patients tab, with all 
identifying information fully visible.
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Figure 5-11:  Number of Patients added message

• If you have imported custom fields and have selected them for addition to the Geneticist 
Assistant database, then the Invalid Encryption Certificate Setting dialog box closes and 
a first message, a New Custom Fields message, opens indicating that these custom fields 
will be added to the Geneticist Assistant database. 

Figure 5-12:  Custom Fields message, Fields will be added

Click Yes to close the New Custom Fields message, and then a second message, a Patient 
Import message, opens. The message indicates the number of patients that were 
successfully added to the Geneticist Assistant database opens. Click OK to close the 
Patient Import message. The new patient records are displayed on the Patients tab, with 
all identifying information fully visible. Continue as appropriate in Geneticist Assistant

Figure 5-13:  Number of Patients added message

To import a Submissions batch file
You use a batch import process to add multiple patients in a single step to the Geneticist 
Assistant Customer Portal. The batch import file must be either a comma-separated values 
(.csv) file, a tab-delimited text (.txt) file, or a tab-separated values (.tsv) file. The file must 
contain the following columns of information in the order listed—the patient ID, the patient 
last name, the patient first name, the patient date of birth, the patient gender, the patient race, 
the patient phenotypes, and the patient relationships. Patient relationships must in the format 
patient ID-Relationship, for example, ABS17-Father. Multiple phenotypes and multiple 
relationships must be separated by semi-colons. Figure 5-14 on page 135shows the standard 
column order and the standard column names. If your import file does not follow either the 
standard column order or the standard column names, then you must manually indicate the 
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order of the columns in your file. 
Figure 5-14:  Standard column order and names

1. On the Geneticist Assistant main menu, click File > New Patient.

The Add New Patient dialog box opens. The Add Patient tab is the opened tab. 

2. Click the Import Submissions tab to open it.

Figure 5-15:  Add New Patient dialog box, Import Submissions tab

3. Specify the properties of your Submissions file.

Property Description

Add New Phenotype Terms in 
File Automatically

Selected by default. If the patient file contains phenotypes that 
have not already been added to the Geneticist Assistant 
database either through the Manage Objects function (see 
“Managing Objects in the Geneticist Assistant Database” on 
page 55), or the Add Phenotype option on the Add Patient tab 
(see “Patient tab, Patient sub-tab, Phenotype pane” on page 
148), then leave this option selected to automatically add these 
phenotypes to the database. Otherwise, clear this option. 

Data Delimiter Indicate the delimiter used (Comma or Tab).

Date of Birth Format Select the format used for the patients’ birthdays.
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4. If your file follows the standard column order or the standard column names, go to Step 
7; otherwise, if your file does not follow either of these standards, go to Step 5.

5. In the Result pane, rearrange the column headers so that they are in the same order as the 
column headers in your patient file.

6. Click Check With File.

• The file is loaded and the patient information is displayed in the Result pane. If your 
file format is correct, go to Step 7.

• If your file format is incorrect then, you must click Incorrect, Redo, and then make 
the necessary changes to the column headers. Click Check With File again to verify 
that your file has the correct format. Only after you verify that your file has the 
correct format can you continue to Step 7.

7. Click OK.

The Add New Patient dialog box closes. The patients, and if applicable, any new 
phenotypes, are imported in to the Customer Portal.

File Column Format Select one of the following to indicate the file format. 
• File follows standard column order.
• File follows standard column names.
• File does not follow above standards. I want to specify.

For information about rearranging columns, see “To rearrange the order of data 
columns” on page 44.

Property Description
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Accessing and Reviewing Patient Records
In addition to managing settings (chemistries, instruments, and so on) for your runs, you can 
manage the patients for your runs. A patient refers to an individual from whom a sample was 
taken. Managing patients for your runs consists of a variety of different activities, including 
reviewing and editing information (such as adding comments relationships) for existing 
patients and related patients, and generating, and optionally, saving Patient reports to the 
Geneticist Assistant database. You can work with patient information from the Patients tab or 
from the Patient tab.

To review existing patient information on the Patients tab
The Patients tab has a single pane, the Patients pane, for displaying information for existing 
patients. When you review the information for an existing patient, a variety of options are 
available for working with the patient, such as editing the identifying information for a 
patient, and adding relationships and comments for the patient. 

1. On the Geneticist Assistant main menu, click Tabs > Patients.

The Patients tab opens.

• If you are an Administrator user, then the tab can display all the patients that have 
been added by all users to your Geneticist Assistant database. The patients are sorted 
in ascending order based on Patient ID. The sorting reflects the order in which the 
patients were added to the Geneticist Assistant database.

• If you are a standard user, then the tab can display all the patients that you have 
added to the Geneticist Assistant database as well as all the patients that others users 
have added to the database and for which you have been granted at least the Can 
Read permission. The patients are sorted in ascending order based on Patient ID. 
The sorting reflects the order in which the patients were added to the Geneticist 
Assistant database.

Figure 5-16:  Patients tab
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2. Do any or all of the following as needed for a patient on the Patients tab:

• Edit the identifying information and/or comment for a patient. See “To edit the 
identifying information and/or comment for a patient” below.

• Right-click a patient on the tab to open a context menu with options for working 
with the patient. See “To use the context menu for a patient (Patients tab)” on page 
141.

• Open the corresponding Patient tab. See “To review existing patient information on 
the Patient tab” on page 145.

To edit the identifying information and/or comment for a patient
You can edit the identifying information and/or a comment for a patient on the Patients tab.

1. If you have not already done so, open the Patients tab.

2. For the appropriate patient, do any or all of the following:

Action Steps
Edit patient gender 1. On the Gender dropdown list, select the appropriate gender.

The Edit Patient dialog box opens. The dialog box displays the 
Patient External ID, the current value for the gender, if applicable, 
and the new value.

Figure 5-17:  Edit Patient dialog box (Gender)

2. Click OK.
The Edit Patient dialog box closes. The Patients tab remains open. 
The patient record is displayed with the new information.
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Edit patient ethnicity 1. On the Ethnicity dropdown list, select the appropriate ethnicity.
The Edit Patient dialog box opens. The dialog box displays the 
Patient External ID, the current value for the ethnicity, if applicable, 
and the new value.

Figure 5-18:  Edit Patient dialog box (Ethnicity)

2. If needed, make any other changes to the new value, and then click 
OK.
The Edit Patient dialog box closes. The Patients tab remains open. 
The patient record is displayed with the new information.

Note: If the appropriate ethnicity is not available, you can add it. See 
“Managing Objects in the Geneticist Assistant Database” on page 
55.After you add the new ethnicity, you must click Refresh on the 
Patients tab to make the value available for selection.

Action Steps
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Edit patient identifying 
information

1. In any of the identifying information fields (External ID, First Name, 
Last Name, or Date of Birth), single-click twice, and then add or edit 
the information as needed.

Note: If you are changing the Date of Birth for the patient, then you must 
select one value (month, day, or year) at a time, and then you can 
manually enter a a new value, or you can use the Up/Down 
arrows to change the value.

2. Click anywhere on the tab that is outside the edited field.
The Edit Patient dialog box opens. For any value other than External 
ID, the dialog box displays the Patient External ID, the current value 
for the selected information, if applicable, and the new value; 
otherwise, the dialog box displays only the current Patient External 
ID, and if applicable, the new value.

Figure 5-19:  Edit Patient dialog box (Identifying information)

3. If needed, make any other changes to the new value, and then click 
OK.
The Edit Patient dialog box closes. The Patients tab remains open. 
The patient record is displayed with the new information.

Action Steps
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To use the context menu for a patient (Patients tab)
You can right-click any patient on the tab to open a context menu with the following options 
for reviewing and working with the patient record:
 

Edit patient comments 1. In the Last Comment field, single-click twice, and then add or edit the 
comment as needed.

2. Click anywhere on the tab that is outside the edited field.
The Add Patient Comment dialog box opens. The dialog box displays 
the comment.

Figure 5-20:  Add Patient Comment dialog box

3. If needed, make any other changes to the comment, and then click 
OK.
The Edit Patient dialog box closes. The Patients tab remains open. 
The patient record is displayed with the new information.

Action Steps

Table 5-1: Patients tab context menu

Option Description
Patient Detail Opens the Patient tab. 

Note: You can also double-click a patient to open the Patient tab. See “To review 
existing patient information on the Patient tab” on page 145.

Edit Patient Opens the Edit Patient dialog box. You can edit the custom information (fields) for the 
patient. You can also add new custom fields for the patient. See “To add or edit custom 
fields on a per patient basis” on page 143.

Add New Relationships Opens the Add New Patient dialog box so that you can add a relationship to the 
selected patient. By default, the Is Related to Existing Patient option is selected and 
unavailable. Repeat Step 3 of “To add one patient at a time” on page 127 as many 
times as needed to add all the necessary patient relationships to the patient.

Add All to Custom 
Report

Selects all the data that is displayed for the patients for inclusion in a custom report. 
See Chapter 10, “Geneticist Assistant Reports,” on page 265.

Delete Patient Deletes the selected patient from the Geneticist Assistant database. 
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Add Comment Opens the Add Patient Comment dialog box. You add a comment for the selected 
patient in the Add Comment field. The comment is displayed in the Last Comment field 
and in the Comments pane on the Patient sub-tab on the Patient tab. See “Patient tab, 
Patient sub-tab, Comments pane” on page 152.

Figure 5-21:  Add Patient Comment dialog box

Note: If multiple comments have been added for a patient, then the comment that was 
added last is displayed in the Last Comment field on the Patients tab. All 
comments that have been added for the patient are displayed in reverse 
chronological order in the Comments pane on the Patient tab.

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or edit 
the permissions (Can Read or Can Read and Can Write) that the specified users or 
groups are to have for the patient record. See “Setting Read and Write Permissions” on 
page 326.

Change Ownership Opens the Change Patient Ownership dialog box, which displays the name of the 
current owner for the patient, and an option (New Owner) for selecting a new owner for 
the patient from a list of all the currently available and active users for your Geneticist 
Assistant instance. If you are an Administrator user, the current owner of the patient, or 
if you have been granted Can Read and Can Write permissions for the patient, then 
you can the ownership for the patient.

Figure 5-22:  Change Patient Ownership dialog box

Copy Copies all the information that is displayed for the selected patient to your client’s 
clipboard. You can then use standard Paste commands to paste this copied information 
into a third-party application such as Notepad.

Table 5-1: Patients tab context menu (Continued)

Option Description
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To add or edit custom fields on a per patient basis
You use the Import Patients process to batch import patients in to the Geneticist Assistant 
database. If the batch import file has custom fields in it and you opt to add these fields to the 
database, then all the same custom fields are imported for all the patients in the batch file. To 
add or edit custom fields on a per patient basis, you must edit the patient from the Patients 
tab.

1. If you have not already done so, open the Patients tab.

2. Right-click any selected patient, and on the context menu that opens, click Edit Patient.

The Edit Patient dialog box opens. The top pane of the dialog displays the read-only 
identifying information for the patient and the Custom Fields (bottom) pane displays all 
the custom information (fields) for the patient and their values. See Figure 5-23 on page 
144.

Load Filters
Manually Opens the Filters table for the Patients pane. See “To filter the data that is displayed in 

a tab pane” on page 32.

<Filter Template Name> 
- Saved by <User 
Name>

Opens the saved Filter template for the Patients pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are to be 

shown and clear the columns that are to be hidden dynamically, or select a 
configuration from the list of available column configurations. This option is also 
available on the column header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To show/

hide columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display preferences for 

variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared 
preferences or to clear all tab preferences” on page 69.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the 
display, click Compact as needed.

<Saved Pane 
Configuration Name> - 
Saved by <User Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Table 5-1: Patients tab context menu (Continued)

Option Description
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Figure 5-23:  Edit Patient dialog box

3. Do any of the following as appropriate:

Option Description
To edit a custom field 
value

1. Double-click a value to select it, and then edit it as necessary.
2. Click Add/Save.

To clear a custom field 
value

1. Right-click the value, and on the context menu that opens, click 
Clear. 
The current value is deleted.*

2. Click Add/Save.

Note: *If you have imported custom field in to the Geneticist Assistant database through a Patients 
batch file, then you can leave the value field blank. If you have added a custom field to a 
patient through the Edit Patient dialog box, then you cannot leave the value field blank. After 
clearing the field, you must enter another value; otherwise, if you leave the value field blank, 
and then save the edited patient, when you open the Edit Patient dialog box again for the 
patient, the custom field is no longer displayed in the Custom Fields pane.

To add a custom field 
and value

1. Right-click anywhere in the Custom Fields pane, and on the context 
menu that opens, click New. 
An Add New Patient Field dialog box opens. 

2. Enter the new custom field name and then click OK. 
The Add New Patient Field dialog box closes, and the field without a 
value is displayed in the Custom Fields pane. 

Figure 5-24:  Add New Patient Field dialog box

3. Double-click in the Value field for the new custom field, and then 
enter its value. 

4. Click Add/Save.
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To review existing patient information on the Patient tab
The Patient tab has three sub-tabs: Patient, Samples, and Variants. Each sub-tab has different 
panes for displaying and working with patient information. 

1. If you have not already done so, open the Patients tab. 

2. Do one of the following to open the Patient tab:

• Right-click the patient record that you are reviewing, and on the context menu that 
opens, click Patient Detail.

• Double-click the patient record that you are reviewing.

3. Continue to one of the following:

• “Patient tab, Patient sub-tab” below.

• “Patient tab, Samples sub-tab” on page 155.

• “Patient tab, Variants sub-tab” on page 158.

Patient tab, Patient sub-tab
When a Patient tab first opens, the Patient sub-tab is the active tab.
Figure 5-25:  Patient tab, Patient sub-tab

The Patient sub-tab has six panes for displaying and working with patient information. 

Pane Available Options
Patient • Adding relationships to the patient.

• Creating a report for the patient.
• Adding comments for the patient.
• Settings permissions for the patient.
• Specifying the ownership for the patient.
See “Patient tab, Patient sub-tab, Patient pane” on page 146.
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Patient tab, Patient sub-tab, Patient pane
The Patient pane on the Patient sub-tab shows the identifying information for the patient (ID, 
name, and so on). You can edit any of the identifying information for the patient. (Begin at 
Step 2 of “To edit the identifying information and/or comment for a patient” on page 138.) 
You can also right-click any patient record in the pane to open a context menu with the 
following options:

Phenotypes Adding and removing phenotypes for the patient. See “Patient tab, Patient sub-tab, Phenotype 
pane” on page 148.

Related Patients • Adding relationships to a related patient.
• Removing relationships for a related patient.
• Adding comments for the related patient.
• Settings permissions for the related patient.
• Specifying the ownership for the related patient.
See “Patient tab, Patient sub-tab, Related Patients pane” on page 150.

Comments • Adding comments for a patient.
• Deleting comments for a patient.
See “Patient tab, Patient sub-tab, Comments pane” on page 152.

Reports • Viewing a Patient report that was saved to the Geneticist Assistant database.
• Deleting a Patient report that was saved to the Geneticist Assistant database.
See “Patient tab, Patient sub-tab, Reports pane” on page 154.

Barcodes Viewing all the barcodes that are associated with the patient in the Geneticist Assistant 
customer portal. 
See “Patient tab, Patient sub-tab, Barcodes pane” on page 155.

Pane Available Options

Table 5-1: Patient tab, Patient sub-tab, Patient pane context menu

Option Description
Add New 
Relationships

Opens the Add New Patient dialog box so that you can add a relationship to the selected 
patient. By default, the Is Related to Existing Patient option is selected and unavailable. 
Repeat Step 3 of “To add one patient at a time” on page 127 as many times as needed to 
add all the necessary patient relationships to the patient.

Add All to Custom 
Report

Selects all the data that is displayed for the patient for inclusion in a custom report. See 
Chapter 10, “Geneticist Assistant Reports,” on page 265.
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Add Comment Opens the Add Comment dialog box. You add a comment for the selected patient in the 
Add Comment field. The comment is displayed in the Last Comment field in the pane and 
in the Comments pane. See “Patient tab, Patient sub-tab, Comments pane” on page 152.

Figure 5-26:  Add Comment dialog box

Note: If multiple comments have been added for a patient, then the comments are 
displayed in reverse chronological order in the Comments pane. Only the last 
comment added is displayed in the Last Comment field. 

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or edit the 
permissions (Can Read or Can Read and Can Write) that the specified users or groups are 
to have for the patient record.. See “Setting Read and Write Permissions” on page 326.

Change Ownership Opens the Change Patient Ownership dialog box, which displays the name of the current 
owner for the patient, and an option (New Owner) for selecting a new owner for the patient 
from a list of all the currently available and active users for your Geneticist Assistant 
instance. You can change the ownership for any patient if you are an Administrator user, 
the current owner of the patient, or if you have been granted Can Read and Can Write 
permissions for the patient.

Figure 5-27:  Change Patient Ownership dialog box

Copy Copies all the information that is displayed in the Patient pane for the patient to your 
client’s clipboard. You can then use standard Paste commands to paste this copied 
information into a third-party application such as Notepad.

Table 5-1: Patient tab, Patient sub-tab, Patient pane context menu (Continued)

Option Description
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Patient tab, Patient sub-tab, Phenotype pane
The Phenotype pane on the Patient sub-tab shows all the phenotypes that have been added 
for the patient, and if applicable, the associated comments that have been added for each 
phenotype. You can right-click in the pane to open a context menu with the following 
options:

Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are to be 

shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To show/hide 

columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display preferences for 

variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 69.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters
Manually Opens the Filters table for the Patient pane. See “To filter the data that is displayed in a tab 

pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Patient pane. Limits the display in the pane to only 
the data (fields) that are defined by the template. See “To filter the data that is displayed in 
a tab pane” on page 32.

Table 5-1: Patient tab, Patient sub-tab, Patient pane context menu (Continued)

Option Description

Table 5-2: Patient tab, Patient sub-tab, Phenotypes pane context menu

Option Description
Add All to Custom 
Report

Selects all the data that is displayed in the Phenotype pane for inclusion in a custom 
report. See Chapter 10, “Geneticist Assistant Reports,” on page 265.
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Add Phenotype Opens the Add Phenotype dialog box. The Phenotypes dropdown list contains all the 
phenotypes that are currently available in the Geneticist Assistant database that you can 
add for the patient. You can add multiple phenotypes for the patient. You can also add a 
comment for each phenotype that you add for the patient.

Figure 5-28:  Add Phenotype dialog box

Note: If the appropriate phenotype is not available, then you can click New to add it to the 
Geneticist Assistant database. You can also use the Manage Objects function to 
add a phenotype to the Geneticist Assistant database. See “Managing Objects in 
the Geneticist Assistant Database” on page 55.

Delete Phenotype Deletes the selected phenotype from the patient record. The phenotype is not deleted from 
the Geneticist Assistant database.

Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are to be 

shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To show/hide 

columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display preferences for 

variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 69.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters
Manually Opens the Filters table for the Phenotypes pan. See “To filter the data that is displayed in a 

tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Phenotypes pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 5-2: Patient tab, Patient sub-tab, Phenotypes pane context menu (Continued)

Option Description
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Patient tab, Patient sub-tab, Related Patients pane
The Related Patients pane on the Patient sub-tab shows all the current relationships for the 
patient, and the last comment that was added for each related patient. You can 
double-click a patient on the Related Patients pane to display the information for the related 
patient in a new Patient tab. The currently opened Patient tab remains open, but the focus is 
changed to the new Patient tab. You can also right-click in the Related Patients pane to open 
a context menu with the following options:

Table 5-3: Patient tab, Patient sub-tab, Related Patients pane context menu

Option Description
Reload in Current 
Tab

Displays the information for the selected related patient in the currently opened Patient 
tab. 

Open in New Tab Displays the information for the selected related patient in a new Patient tab. The currently 
opened Patient tab remains open, but the focus is changed to a new Patient tab that 
displays the information for the related patient.

Add New 
Relationships

Opens the Add New Patient dialog box so that you can add a relationship to the selected 
related patient. By default, the Is Related to Existing Patient option is selected and 
unavailable. Repeat Step 3 of “To add one patient at a time” on page 127 as many times as 
needed to add all the necessary patient relationships to the related patient.

Remove Selected 
Relationship

Removes the selected relationship for the patient.

Add All to Custom 
Report

Selects all the data that is displayed for all the related patients for inclusion in a custom 
report. See Chapter 10, “Geneticist Assistant Reports,” on page 265.

Add Comment Opens the Add Comment dialog box. You add a comment for the selected related patient 
in the Add Comment field. The comment is displayed in the Last Comment field in the 
pane. 

Figure 5-29:  Add Comment dialog box

Note: If multiple comments have been added for a related patient, then only the last 
comment added is displayed in the Last Comment field. To see all the comments 
that have been added for a related patient, you must open the related patient in a 
new Patient tab.
150 Geneticist Assistant User’s Manual



Chapter 5
Managing Patients and Runs
Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or edit the 
permissions (Can Read or Can Read and Can Write) that the specified users or groups are 
to have for the patient record. See “Setting Read and Write Permissions” on page 326.

Change Ownership Opens the Change Patient Ownership dialog box, which displays the name of the current 
owner for the related patient, and an option (New Owner) for selecting a new owner for the 
related patient from a list of all the currently available and active users for your Geneticist 
Assistant instance. You can change the ownership for any patient if you are an 
Administrator user, the current owner of the patient, or if you have been granted Can Read 
and Can Write permissions for the patient.

Figure 5-30:  Change Patient Ownership dialog box

Copy Copies all the information that is displayed for the related patient to your client’s clipboard. 
You can then use standard Paste commands to paste this copied information into a 
third-party application such as Notepad.

Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are to be 

shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To show/hide 

columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display preferences for 

variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 69.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters
Manually Opens the Filters table for the Related Patients pane. See “To filter the data that is 

displayed in a tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Related Patients pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 5-3: Patient tab, Patient sub-tab, Related Patients pane context menu (Continued)

Option Description
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Patient tab, Patient sub-tab, Comments pane
The Comments pane on the Patient sub-tab shows all the comments that have been added for 
the patient in reverse chronological order. If one or more comments are displayed in the 
pane, then you can right-click in the pane to open a context menu with the following options:

The context menu for the Comments pane is not enabled if the pane is blank. To a 
comment for the patient and enable this context menu, see “To use the context 
menu for a patient (Patients tab)” on page 141.

Table 5-4: Patient tab, Patient sub-tab, Comments pane context menu

Option Description
Add Comment Opens the Add Comment dialog box. You add a comment for the selected patient in the 

Add Comment field. The Comments are displayed in reverse chronological order in the 
pane.

Figure 5-31:  Add Comment dialog box
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Delete Comment Opens the Delete Comment dialog box. Click OK to delete the comment for the patient and 
close the dialog box.

Figure 5-32:  Delete Comment dialog box

Copy Copies all the information that is displayed for the selected comment to your client’s 
clipboard. You can then use the standard Paste commands to paste this copied 
information into a third-party application such as Notepad.

Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are to be 

shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To show/hide 

columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display preferences for 

variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 69.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters
Manually Opens the Filters table for the Comments pan. See “To filter the data that is displayed in a 

tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Comments pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 5-4: Patient tab, Patient sub-tab, Comments pane context menu (Continued)

Option Description
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Patient tab, Patient sub-tab, Reports pane
The Reports pane on the Patient sub-tab lists all the reports that have been generated for the 
selected patient and saved to the Geneticist Assistant database. 

You can right-click a report entry to open a context menu with the following options:

You can also select Reports > Saved Reports on the Geneticist Assistant main 
menu to open a (Patient) Reports tab that includes these same reports.

Table 5-5: Patient tab, Patient sub-tab, Reports pane context menu

Option Description
View Report Opens the Report Browser dialog box, which displays the report in plain text.

Note: You can also double-click the report entry to open the Report Browser dialog box.

Figure 5-33:  Report Browser dialog box

The following options are available for the report:
• View XML - Toggles the onscreen display of the report between XML and plain text.
• Save As - Saves the report as a .csv file. By default, the report is named as <External 

ID>.csv but you can always change the name and you can also select the location in 
which to save the report.

• Print—Prints the onscreen report to a printer of your choice.

Delete Report Deletes the selected report from the Geneticist Assistant database.

Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are to be 

shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To show/hide 

columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display preferences for 

variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 69.
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Patient tab, Patient sub-tab, Barcodes pane
The Barcodes pane on the Patient sub-tab lists all the barcodes that are associated with the 
patient in the Geneticist Assistant customer portal. You can use these barcodes to validate 
that the correct patient/sample combination was submitted to the customer portal and to 
confirm sample identity when you are reviewing a sample in Geneticist Assistant. See 
Chapter 12, “The Geneticist Assistant Customer Portal and Submissions,” on page 305.

Patient tab, Samples sub-tab
The Samples sub-tab on the Patient tab has a single pane, the Samples pane, that displays all 
the samples that are associated with the patient as well as information about the samples. 
Figure 5-34:  Patient tab, Samples sub-tab

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters
Manually Opens the Filters table for the Reports pane. See “To filter the data that is displayed in a 

tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Reports pane. Limits the display in the pane to only 
the data (fields) that are defined by the template. See “To filter the data that is displayed in 
a tab pane” on page 32.

Table 5-5: Patient tab, Patient sub-tab, Reports pane context menu (Continued)

Option Description

For detailed information about generating and saving both standard and custom 
Patient reports, see Chapter 10, “Geneticist Assistant Reports,” on page 265.
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You can do the following on the Samples sub-tab:

• View the details for an individual patient sample.

• View the sample variants filtered by a selected panel.

• View the coverage information for all regions in a sample panel.

• Calculate the panel statistics for a patient sample.

• Set sample permissions.

• View the patient samples in a third-party viewer (NextGENe or IGV).

• Export the patient samples to a VCF file.

• Generate Sample reports for one or more selected samples.

• Generate a Batch Variants report for a selected sample or samples.

• Generate a Batch Coverage report for a selected sample or samples.

You can right-click a sample in the Samples pane to open a context menu with the following 
options for working with the sample:

Table 5-6: Patient tab, Samples sub-tab, Samples pane context menu

Option Description

Sample Details Opens the Sample tab, which contains detailed information about the associated sample, 
including the variant list. See Chapter 8, “Geneticist Assistant Data Review - Sample Tab,” 
on page 209.
Note: You can also double-click the sample to open the Sample tab.

Show Sample 
Variants Filtered by 
Panel

Opens the Select Panel to Filter Variants dialog box. Select a panel in the dialog box to 
show the variants in the patient’s sample filtered by the selected panel or panels.

Figure 5-35:  Select Panel to Filter Variants dialog box

Coverage Regions Opens the Coverage Regions tab, which lists the coverage information for every region in 
the panel for the associated sample. See “Coverage Regions tab” on page 200.

Panel Statistics Opens the Panel Statistics tab. The tab has options for displaying specific information 
based on the panel that was used for the sample. See “Reviewing Panel Statistics” on 
page 319.
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Copy Copies all the information that is displayed for the selected associated sample to your 
client’s clipboard. You can then use standard Paste commands to paste this copied 
information into a third-party application such as Notepad.

Permissions Opens the Permissions dialog box. You use the options on this dialog box to set or edit the 
permissions (Can Read or Can Read and Can Write) that the specified users or groups are 
to have for the patient sample. See “Setting Read and Write Permissions” on page 326.

External - Contains all the sub-menu options for viewing the sample variants in a tool that is outside Geneticist 
Assistant.

View in NextGENe Requires you to have your NextGENe installation specified in your Geneticist Assistant 
settings. (See “To configure Geneticist Assistant directories” on page 59.) If selected, then 
Geneticist Assistant browses for the folder where the VCF file for the sample is located. If 
the NextGENe project file is found in the same directory as the VCF file, then the 
NextGENe project is opened in the NextGENe Viewer. 

View in IGV Applicable if there is a corresponding BAM file (and not a NextGENe project file) in the 
same folder as the VCF file for the sample. Opens the BAM file in the third-party 
Integrative Genomics Viewer (IGV).

Export - Contains all the sub-menu options for exporting a variant.

Export to VCF Exports all the variants in the selected sample or samples (CTRL-click to select multiple 
samples) to a VCF file. You must specify both the file name and the location in which to 
save the file.

Save Sample 
Reports

Applicable for one or more samples. CTRL-click to select multiple samples. Generates an 
individual sample report for each selected sample. If a single sample is selected, then a 
default location, report name, and report type (.csv) are provided, but you can change any 
or all of these values. If multiple samples are selected, then you can select only the 
location in which to save the report. Each report is named the same as the sample and the 
report format is .csv, and you cannot change either of these values.
Note: For more information about standard reports, see Chapter 10, “Geneticist Assistant 

Reports,” on page 265.

Create Batch 
Variants Report

Generates the Batch Variants report for the selected sample or samples. (CTRL-click to 
select multiple samples.) See “Managing a Batch Variants Report” on page 329.

Create Batch 
Coverage Report

Generates the Batch Coverage report for the selected sample or samples. (CTRL-click to 
select multiple samples.) See “Generating a Batch Coverage Report” on page 335.

Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are to be 

shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To show/hide 

columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display preferences for 

variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 69.

Table 5-6: Patient tab, Samples sub-tab, Samples pane context menu (Continued)

Option Description
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Patient tab, Variants sub-tab
The Variants sub-tab on the Patient tab has a single pane, the Variants pane, that displays all 
the variants in all the samples that are associated with the patient. With the exception of a 
few omitted columns, the information that is available in the Variants pane is identical to the 
information that is available for a variant on the Sample Variant Data sub-tab on the Sample 
tab. (See “Sample Variant Data Sub-Tab” on page 212.) 
Figure 5-36:  Patient tab, Variants sub-tab

You can specify how the information about the variants is to displayed on the Variants sub-
tab. See “To specify variant preferences” on page 70. You can also do the following for an 
individual variant that is displayed on the Variants sub-tab:

• Select a different gene for a variant: If the variant is located where there are overlapping 
genes, then you can select a different gene for the variant on the Gene dropdown list. If 
you select a different gene, then the gene that is used on the current tab for the current 
Geneticist Assistant session is temporarily changed. After you close and then re-open 
Geneticist Assistant, the selected gene is reset to the preferred gene. To permanently 
change the gene that is used for variant, you can add a preferred gene for the panel. See 

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters
Manually Opens the Filters table for the Samples pane. See “To filter the data that is displayed in a 

tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Samples pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 5-6: Patient tab, Samples sub-tab, Samples pane context menu (Continued)

Option Description
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“To set or delete a preferred gene for a panel” on page 112.

• Select a different transcript for a variant: You can select a different transcript for the 
variant on the Transcript dropdown list. If you select a different transcript, then the 
transcript that is used on the current tab for the current Geneticist Assistant session is 
temporarily changed. After you close and then re-open Geneticist Assistant, the selected 
transcript is reset to the preferred transcript. 

• Add or edit a comment for a variant: You can single click twice in the Variant Comment 
field to select the current comment in the field and edit it, or if the field is blank, enter a 
new comment. After you add or edit a comment, and then click out of the field, the Add 
Variant Comment dialog box opens. 

Figure 5-37:  Add Variant Comment dialog box

The dialog box displays the variant for which you are adding or editing the comment, 
and if applicable, any current comment. You can add a new comment or make edits to 
the current comment, and then click OK to close the dialog box and save the new or 
modified comment for the variant.

     

To permanently change the transcript that is used for a gene or genes, you can do 
one of two things: You can right-click the variant, and on the context menu that 
opens, click Edit Variant > Update Preferred Transcript (see “Patient tab, 
Variants sub-tab context menu” on page 160), or you can add a preferred 
transcript list for the panel. See “To set or delete a preferred transcript list for a 
panel” on page 110.

You can also use the Add Variant Comment option that is available on the context 
menu for the variant to add a new variant comment. 
Geneticist Assistant User’s Manual 159



Chapter 5
Managing Patients and Runs
• Edit the type and/or the HGVS information (Genomic, Coding, and/or Protein) for a 
variant: You can click once in the Type field, the HGVS Genomic field, the HGVS 
Coding field, or the HGVS Protein field to select the current value in the field and edit it.

• You can single click twice in the Interpretation field to select the current interpretation in 
the field and edit it, or if the field is blank, enter a new interpretation. After you add or 
edit an interpretation and then click out of the field, the Add Variant Interpretation dialog 
box opens. 

Figure 5-38:  Add Variant Comment dialog box

The dialog box displays the variant for which you are adding or editing the interpretation 
and the current interpretation. You can edit the current interpretation, or leave it as-is, 
and then click OK to close the dialog box and save the variant interpretation.

Patient tab, Variants sub-tab context menu
You can right-click a variant on the Variants sub-tab to open a context menu with the 
following options: 

If you make a change to any of these values for the variant, then these changes are 
recorded for the variant on the Variant Changes pane on the Variant tab. See 
“Variant Changes pane” on page 251. These changes are also reflected in the 
appropriate fields on all the variant tabs, sub-tabs, and panes in Geneticist 
Assistant.

Table 5-7: Patient tab, Variants sub-tab context menu

Option Description
Variant Details Opens the Variant tab for the selected variant. See “Overview of the Variant Tab” on 

page 245.
Note: You can also double-click the variant to open the Variant tab. 
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Show Variants Filtered 
by Panel

Displays all the variants in all the associated samples for the selected patient filtered by 
a selected panel or panels. If you select this option, then the Select Panel to Filter 
Variants dialog box opens. You must select a panel or panels in this dialog box by 
which to filter the variants for the selected patient. 

Figure 5-39:  Select Panel to Filter Variants dialog box

Show Samples with Selected Variants

All Variants Select a variant, or CTRL-click to select multiple variants and then select this option to 
open the Samples with all variants pane, which displays a list of all the samples in your 
Geneticist Assistant database that contain all the selected variants. You can right-click 
a sample in the list to open a context menu with sample-specific options. See “The 
Samples Pane (Run tab) Context Menu” on page 191.

Any Variants Select a variant, or CTRL-click to select multiple variants and then select this option to 
open the Samples with all variants pane, which displays a list of all the samples in your 
Geneticist Assistant database that contain one or more of the selected variants. You 
can right-click a sample in the list to open a context menu with sample-specific options. 
See “The Samples Pane (Run tab) Context Menu” on page 191.

Table 5-7: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Edit Variant - Contains all the sub-menu options for editing and deleting a variant.

Add Variant Comment Opens the Add Variant Comment dialog box. You can add a comment for a selected 
variant in the Add Comment field, and then click OK. You can also CTRL-click to select 
multiple variants and add the same comment to all the selected variants in a single 
step. The comment is displayed in the Variant Comment field in the Variants pane on 
the Search Results tab, the Variant Comment field on the Variants sub-tab on the 
Patient tab, the Sample Variant Data sub-tab on the Sample tab, the Variant Comment 
field in the Variant pane on the Variant tab, and the Variant Comments pane on the 
Variant tab.

Figure 5-40:  Add Variant Comment dialog box

Note: If multiple comments have been added for a variant, then with the exception of 
the Variant Comments pane on the Variant tab, only the last added comment is 
displayed in all the locations that are detailed above. All the comments that have 
been added for a variant, including the last added, are displayed in reverse 
chronological order in the Variant Comments pane on the Variant tab.

<Add Variant 
Interpretation>

Select a variant, or CTRL-click to select multiple variants. 
• If a single variant is selected, then the option is Add Single Variant Interpretation, 

and the Add Single Variant Interpretation dialog box opens.
• If two or more variants are selected, then the option is Add Compound Variant 

Interpretation and the Add Compound Variant Interpretation dialog box opens.
See “Adding a Variant Interpretation” on page 342.

Table 5-7: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Update Pathogenicity The pathogenicity of the variant, which is the potential for the variant to cause disease. 
By default, the pathogenicity is always set to an initial value of Unassigned. You must 
review the information for the variant and then decide what the pathogenicity should be; 
for example, Deleterious. (If you cannot determine the pathogenicity of the variant, then 
you can set the status to Unknown.) When you update the pathogenicity and/or status, 
you can apply the changes to:
• the panel group - Applies the changes to the variant for the indicated panel 

group.The next time that the variant is detected in another sample that has been 
assigned to this panel group, then this is the pathogenicity that is displayed for the 
variant.

• the sample only - Applies the changes to the variant only for the currently selected 
sample.

You can also update the pathogenicity status and/or add comments for the changes. By 
default, the status is always set to an initial value of Pending. 

Figure 5-41:  Submit Pathogenicity dialog box

Note: You can also double-click in the Pathogenicity column to open the Submit 
Pathogenicity dialog box.

The following information is relevant to updating the pathogenicity and/or pathogenicity 
status for a variant:
• By default, only five pathogenicities—Deleterious, Likely Deleterious, Unknown, 

Likely Benign, and Benign—are available. You have the option of adding custom 
pathogenicities, either by clicking New to open the Add New Pathogenicity dialog 
box and entering a new value, or from the Manage Objects function. See “Managing 
Objects in the Geneticist Assistant Database” on page 55.

• By default, only two statuses—Pending and Confirmed—are available. You have the 
option of adding custom statuses, either by clicking New to open the Add New 
Pathogenicity Status dialog box and entering a new value, or from the Manage 
Objects function. See “Managing Objects in the Geneticist Assistant Database” on 
page 55.

• Optionally, you can add supporting information for this pathogenicity change. See 
“To add supporting information for a variant” on page 256.

• You always have the option of updating just the pathogenicity status for a variant. 
See “Update Pathogenicity Status” on page 164.

• You can also update the pathogenicity on the Sample tab, Sample Variant Data sub-
tab. See “Sample Variant Data Sub-Tab” on page 212. 

Table 5-7: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Update Pathogenicity 
Status

Select a variant, or CTRL-click to select multiple variants and then select this option to 
open the Submit Pathogenicity Status dialog box. You can update the pathogenicity 
status for the selected variants in this dialog box. When you update the pathogenicity 
status, you can apply the changes to:
• the panel group - Applies the changes to the variant for the indicated panel group. 

The next time that the variant is detected in another sample that has been assigned 
to this panel group, then this is the pathogenicity status that is displayed for the 
variant.

• the sample only - Applies the changes to the variant only for the currently selected 
sample.

• You can also add a comment for the status change. By default, the pathogenicity 
status is always set to an initial value of Pending. You must review the information 
for the variant and then decide what the pathogenicity status should be. By default, 
only two statuses—Pending and Confirmed—are available. You have the option of 
adding custom statuses, either by clicking New to open the Add New Pathogenicity 
Status dialog box and entering a new value, or from the Manage Objects function. 
See “Managing Objects in the Geneticist Assistant Database” on page 55.

Figure 5-42:  Submit Pathogenicity Status dialog box

The following information is relevant to updating the pathogenicity status for a variant:
• You can also double-click in the Pathogenicity Status column to open the Update 

Variant Pathogenicity Status dialog box.
• You can also update the Pathogenicity Status for a variant on the Sample tab, 

Variant Data sub-tab. See “Sample Variant Data Sub-Tab” on page 212.

Table 5-7: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Update Artifact Type Select a variant, or CTRL-click to select multiple variants and then select this option to 
open the Update Artifact Type dialog box. You specify the artifact type (for example, 
Sequencing) for the variant in this dialog box. When you specify the artifact type, you 
can set the artifact type as the following:
• Set globally—Set this artifact type for the variant, regardless of the sample in which 

the variant is detected.
• Set for Sample—Set this artifact type for this variant only for the indicated sample.
You also have the option of adding comments for the variant artifact type.
Note: The default value for Variant Classification is determined by the setting on the 

Variant Preferences tab on the Settings dialog box. See “To specify variant 
preferences” on page 70.

You have the option of adding custom artifact types, either by clicking New to open the 
Add New Artifact dialog box and entering a new value, or from the Manage Objects 
function. See “Managing Objects in the Geneticist Assistant Database” on page 55.

Figure 5-43:  Update Variant Artifact Type dialog box

Note: You can also define artifact types and set the artifact type for a variant in the 
Variants pane, on the Variants sub-tab on the Panel Statistics tab from the Runs 
tab or the Run tab, or on the Sample Variant Data sub-tab on the Sample tab.

Table 5-7: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Update Preferred 
Transcript

Opens the Set Preferred Gene/Transcript dialog box. You can select a different 
preferred gene and/or transcript for the variant. When you select a different gene/
preferred transcript, you can set the preferences for one of the following:
• globally - for all panels and panel groups.
• of panel - for only the indicated panel.
• of Variant - only for this particular variant and not for any other positions within this 

panel or panel group.

Figure 5-44:  Set Preferred Gene/Transcript dialog box

Note: When you select a different transcript here for a panel, then the preferred 
transcript that is used for a gene or genes is permanently changed for the panel. 
You can also permanently change the preferred transcript by adding a preferred 
transcript list for the panel. See “To set or delete a preferred transcript list for a 
panel” on page 110. To temporarily change the preferred transcript for a gene or 
genes, you simply select the transcript on the Transcript dropdown list on a tab 
or sub-tab.

Delete Variant from This 
Patient

Deletes the selected variant from all samples for the selected patient in which it was 
found.

Figure 5-45:  Delete Selected Variant dialog box

Table 5-7: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Delete Variant from All 
Samples

Deletes the selected variant from all samples in which it was found.

Figure 5-46:  Delete Selected Variant dialog box

External - Contains all the sub-menu options for viewing the sample variants in a tool that is outside Geneticist 
Assistant.

View in IGV Opens the variant for viewing in the Integrated Genomics Viewer.
Note: To view a variant in IGV, your IGV settings must be specified. See “To specify the 

IGV settings” on page 75.

View in Alamut Opens the variant for viewing in Alamut.
Note: To view a variant in Alamut, your Alamut settings must be specified. See “To 

specify third-party (Alamut, IGV, OMIM) settings” on page 74.

View in UCSC Opens the variant for viewing in the UCSC Genome Browser. 

View PubMed Abstract Searches PubMed for the variant and displays the appropriate abstract in the PubMed 
Abstract window. 

Figure 5-47:  PubMed Abstract window

You can do the following for the abstract:

• In the Link field, enter a different PubMed URL, and then click the Go To icon  to 
navigate to abstract.

• Click Save As to save the abstract as a PDF with a name and in a location of your 
choosing.

• Click Print to print the abstract.

Table 5-7: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Export - Contains all the sub-menu options for exporting a variant.

Export Selected Variants 
to VCF

Exports the selected variants to a VCF file. CTRL-click to select multiple variants. You 
must specify both the file name and the location in which to save the file.

Export All Variants to 
VCF

Exports all the variants to a VCF file. You must specify both the file name and the 
location in which to save the file.

Reports - Contains all the sub-menu options for generating a report that includes the variant.

Add Selected Variants to 
Custom Report

Selects all the data that is displayed for the selected variant for inclusion in a custom 
report. CTRL-click to select multiple variants. See Chapter 10, “Geneticist Assistant 
Reports,” on page 265.

Add All Variants to 
Custom Report

Selects all data that is displayed for all the variants for inclusion in a custom report. See 
Chapter 10, “Geneticist Assistant Reports,” on page 265.

Copy Copies the information for the selected variant to your client’s clipboard. You can use 
standard Paste commands to paste the copied information in to a third-party application 
such as Notepad.

Create Variant Filter from 
Selected Variants

Create a filter based on the selected variants. You can select a single variant, or CTRL-
click to select multiple variants to open the Create Variant Filter dialog box. Name the 
filter and indicate if the filter is to be available to all users. You, and if applicable, other 
users can use the Load Filter Template function to apply this variant filter to a selected 
sample or samples. (See “To load a saved filter template” on page 38.)

Figure 5-48:  Create Variant Filter dialog box

When the Sample tab opens for a sample to which the filter has been applied, then the 
Sample Variant Data sub-tab displays only those variants that meet the filter criteria. 

Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are to be 

shown and clear the columns that are to be hidden dynamically, or select a 
configuration from the list of available column configurations. This option is also 
available on the column header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To show/

hide columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display preferences for 

variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared 
preferences or to clear all tab preferences” on page 69.

Table 5-7: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the 
display, click Compact as needed.

<Saved Pane 
Configuration Name> - 
Saved by <User Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters
Manually Opens the Filters table for the Variants pane. See “To filter the data that is displayed in 

a tab pane” on page 32.

<Filter Template Name> 
- Saved by <User 
Name>

Opens the saved Filter template for the Variants pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 5-7: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Adding a Run
A run refers to loading a BAM file and a VCF file or just a VCF file into Geneticist 
Assistant. for the purposes of importing a list of variants into the Geneticist Assistant 
database and/or reviewing a list of variants. When you add a run, you must specify the run 
and sample settings, which include the chemistry, the instrument, the reference, the panel, 
and the panel group. You must also select the files that are to be loaded. Optionally, you can 
choose to edit the run date/time and/or assign the run to a sample group. You specify these 
settings on a per run basis, or you specify these settings on a per sample basis. At a 
minimum, you must always load a VCF file. Optionally, you can also load a BAM file to 
include coverage information for the panel regions.

To add a run
1. On the Geneticist Assistant main menu, click File > New Run.

The New Run dialog box opens.

Figure 5-49:  New Run dialog box

2. Enter the name for the new run.

     

Geneticist Assistant supports only sorted VCF files.

The name can have a maximum of 255 characters. Spaces are allowed.
170 Geneticist Assistant User’s Manual



Chapter 5
Managing Patients and Runs
3. Specify the run settings. 

Setting Description
Required Settings
Chemistry If the correct chemistry is not available, then you can add it. Click New to 

open the Add New Chemistry dialog box and add the new chemistry. 

Instrument If the correct instrument is not available, then you can add it. Click New to 
open the Add New Instrument dialog box and add the new instrument. 

Reference If the correct references are not available, then you might need to specify 
the reference directory and/or add the necessary references to the 
directory. For information about specifying the reference directory, see 
“Specifying your Geneticist Assistant Settings” on page 59. For information 
about downloading the most recent references, see “Updating References” 
on page 48.
Note: This is a run-specific option. You also have the option of setting this 

option on a per sample basis later in the process.

Panel After you select a panel, the panel group is automatically selected and the 
name is displayed in the Panel Group field.
Note: If the correct panel is not available, then you can add it. Click New to 

open the Manage Panels dialog box and import the needed panel. 
See “Importing a Panel” on page 105. 

Note: This is a run-specific option. You also have the option of setting this 
option on a per sample basis later in the process.

Panel Group Read-only field that displays the name of the group to which the selected 
panel belongs.

Quality Metric Profile If the correct quality metric profile is not available, then you can add it. 
Click New to open the Manage Quality Metrics dialog box and add the 
profile. See “Managing Quality Metrics” on page 77.

Owner By default, Owner is set to your user name. Optionally, you can select a 
different owner for the run. If the appropriate user is not available, and you 
are an Administrator user or a user with the correct permissions, then you 
can add the new user. Click New to open the Add New User dialog box and 
add the new user. See “Managing Users” on page 87.

Multiple Samples in 
VCF

Select this option if you are loading a VCF file that contains variants from 
multiple samples. 

Optional Settings
Run Date/Time The default value for the Run Date and Time is the current day’s date and 

time, but you can change one or both values as needed. To change a 
value, select the value, for example, the month, and then you can manually 
enter the new value, or you can use the Up/Down field arrows to change 
the value. 
Note: You must select each value that you are changing one at a time. If 

you set the Run Date/Time here, then this is a run-specific option. 
You also have the option of setting this option on a per sample basis 
later in the process.

User Group By default, non-administrative users have read/write access to only those 
runs that they submitted. If other non-administrator users are to have read/
write access to this run, then select the appropriate user group.
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Sample Group Optional. Used for a group of samples that are to be processed repeatedly 
over a period of time, for example, a group of control samples for which the 
coverage or variant frequency is to be tracked. If the correct Sample Group 
is not available, then you can add it. Click New to open the Add New 
Sample Group dialog box and add the new sample group.
Note: This is a run-specific option. You also have the option of setting this 

option on a per sample basis later in the process.

Subpanel To verify coverage for a smaller number of regions that are within the panel 
that has been selected for the run, select the appropriate subpanel.
Note: If no subpanels have been created for the selected panel, then no 

options are available on the Subpanel dropdown list. For information 
about creating subpanels, see “Adding a Subpanel” on page 119.

Submit Coverage Selected by default. If BAM files are included in the run, then select this 
option to import coverage information for the panel regions from the BAM 
files. Clear this option to skip the coverage import.

Import from VCF Selected by default.If you are loading a VCF file that contains pathogenicity 
information (pathogenicity and status) and variant comments, then by 
default, this information is imported into the Geneticist Assistant database.
• Pathogenicity and status - Selected by default.
Note: This is a run-specific option. You also have the option of setting this 

option on a per sample basis later in the process.
• Comment - Selected by default.
• Artifact type - Select to submit any artifact any information that the 

loaded VCF file contains.

Submit Hotspots If any variants in the loaded VCF file have an allele frequency value = 0, 
then select this option to submit these variants to the Geneticist Assistant 
database.

Accepted VCF filters Applicable after you load sample files. See Step 5.

Identify Patient ID
Add New Patient If the correct patient is not available to associate with a sample for a run, 

then you can click this option to open the Add New Patient dialog box and 
add the patient. See Step 6.

• from Sample 
Name

• Automatically match a patient ID based on the sample file name and the 
selected separator. For example, if the separator is a period, then all text 
up to the first period in the sample file name is used as the patient ID.

• from File • Match the sample with the patient ID as defined in the provided tab-
separated values file, with 1 patient/sample per line in the file containing 
two fields: sample name followed by a tab, and then patient ID.

Split Sample Name 
by Separator

Selected by default. If you clear this option, then the entire VCF sample file 
name is used as the patient ID. Select the separator that you are using to 
define the patient ID from the sample file name.

Setting Description
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4. Do one of the following:

• To automatically load all the applicable sample files (VCF only or VCF and BAM 
files) that are in the same folder in a single step, do the following:

• Click Select Directory to open the Select Directory dialog box, 

• In the Select Directory dialog box, browse to and select the appropriate 
directory, and then click Select Folder.

• To manually select sample files, do the following:

• Click Select Variant and/or Coverage Files to open the Select Files dialog box. 

• In the Select Files dialog box, browse to and select the BAM coverage file and/
or variant (VCF) files that are to be loaded, and then click Open. 

When selecting the files that are to be loaded, note the following:

• You can load a VCF or BAM file for a new run that has been submitted previously 
for another run. You can keep the sample name the same, or you can edit the sample 
name as needed.

• You can use the same run name to load additional sample files (BAM and/or VCF) 
for a previously submitted run. The additional sample files are processed and 
appended to the run. 

• At a minimum, you must always load a VCF file. Optionally, you can also load a 
BAM file to include coverage information for the panel regions.

• If you have a single sample to load, and the VCF and BAM file names do not contain 
corresponding fields in the file names, then select the VCF or BAM file, and then 
after you click Open, the file is placed in the appropriate field for the sample entry. 
You can then click the Browse button  next to the appropriate file type to load 
the corresponding file for the sample. For example, if you loaded a BAM file, then 
you can click the Browse button  next to the Variant File (*.vcf) field for the 
sample entry to load the needed VCF file for the sample.

• If you have multiple samples to load and the VCF and BAM files do not contain 
corresponding fields in the file names, then CTRL-click as you select only the VCF 
files or the BAM files, and then after you click Open, each file is placed in its own 
sample entry. For each sample entry, you can then click the Browse button  next 
to the appropriate file type to load the corresponding file. For example, if you loaded 
a BAM file, then you can click the Browse button  next to the Variant File 
(*.vcf) field for the sample entry to load the needed VCF file for the sample.

• If you are loading both a VCF file and a BAM file, and the files do contain 
corresponding fields in the file names, then CTRL-click as you select both the VCF 
and BAM files, and then after you click Open, both files are loaded into the 
appropriate fields for the same sample entry in a single step. You can load a single 
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VCF/BAM file combination this way, or you can load multiple VCF/BAM file 
combinations. Each correspondingly named VCF/BAM file combination is placed in 
its own sample entry.

• If you have multiple BAM files for a sample, you do not need to submit each file as 
an individual sample, and then assign each file to the same patient. Instead, you can 
use the Merge BAM Files tool to merge all the BAM files into one file and then 
submit the file as a single sample. See “Merging BAM Files with the Merge BAM 
Files Tool” on page 303.

• By default, the sample name is set to the VCF file name. The name is displayed at 
the top of the sample entry. You can edit the sample name.

• If you load a sample file in error, then you can right-click anywhere in the sample 
entry area, and then click Remove this sample.

After the files are loaded for a sample, the full directory paths (directory and file name) 
for the loaded files are displayed in the appropriate fields for each sample entry at the 
bottom of the New Run dialog box. 

Figure 5-50:  New Run dialog box with loaded sample files

     

After you load sample files from a specific directory, if BAM files are included, 
then the BAM files must remain in this directory. You cannot move these BAM files 
to a different directory after you have successfully submitted the files for a run.
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5. After you load your sample VCF files, do one of the following:

• To import only those sample variants that have been flagged as passing (Pass) the 
filter values in the loaded VCF files into your Geneticist Assistant database, leave 
Accepted VCF filters set to the default value of Pass.

• To set additional filter types to be imported from the VCF, click Edit to open the 
Select Accepted Filters dialog box, and then select the values from the list of 
available filters. The options that are available depend on the filter values that are 
included in the loaded VCF files.

Figure 5-51:  Selected Accepted Filters dialog box

After you select the filters, and then click OK, the Select Accepted Filters dialog box 
closes. The selected filters replace the default value of All.

Figure 5-52:  Selected filters specified for a VCF file on the New Run dialog box

6. Optionally, for each sample, do any or all of the following:

• Edit the sample name.

• By default, the Reference, Panel, Run Date/Time, Sample Group, and Import 
Pathogenicity from VCF values that are indicated for a sample are the run-specific 
values that you specified in Step 3. You can edit any or all these values on a per 
sample basis. 

     

This is a run-specific option. You also have the option of setting this option on a 
per sample basis later in the process.

You can click Default at any time to return the sample name to its default value.

If you edit the panel on per sample basis, then the panel group might also be 
modified, but you cannot edit the panel group directly.
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• To associate a patient with a sample, select a patient on the Patients dropdown list.

• By default, if you have specified variant filters, then these filters are applied at the 
run level. To edit the accepted variant filters for a sample, click Edit, and then in the 
Select Accepted Filters dialog box, edit the filter selection.

7. Click OK.

The Current Jobs tab opens and a progress bar that shows the progress of loading the 
files is displayed on the Current Jobs tab. After the files are successfully loaded, the 
progress bar is removed from the Current Jobs tab. You return to the Runs tab. The new 
run is displayed on the Runs tab. You can now review the data for the run. See Chapter 6, 
“Geneticist Assistant Data Review - Runs Tab,” on page 177.

If the correct patient is not available, then you can click Add New Patient to add 
the patient. See “Adding Patients” on page 127.
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Many options are available from the Runs tab for reviewing your data in Geneticist 
Assistant.

This chapter covers the following topics:

• “Overview of the Runs Tab” on page 179.

• “The Runs Tab Context Menu” on page 181.
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Overview of the Runs Tab
When the Geneticist Assistant main window first opens, the Runs tab is displayed in the 
Geneticist Assistant main window. The Runs tab has a single pane, the Runs pane, that 
displays information about the runs that have been carried out in your Geneticist Assistant 
installation. 

• If you are an Administrator user, then the Runs pane can display all the runs submitted by 
all users to your Geneticist Assistant database. By default, when the tab first opens, only 
the 30 most recently submitted runs are displayed and the runs are sorted based on the Run 
ID. 

• If you are a standard user, then the Runs pane can display all the runs that you have 
submitted to your Geneticist Assistant database as well as all the runs that have been 
submitted by other users and for which you have been granted at least the Can Read 
permission. By default, when the tab first opens, only the 30 most recently added runs that 
fit one of these two criteria are displayed and the runs are sorted based on the Run ID. 

Figure 6-1:  Runs tab

You can do the following on the Runs tab:

• Change the number of runs that are displayed on the tab. See “To change the number of 
runs displayed on the Runs tab” on page 180.

• Edit certain values that are displayed for a run. See “To edit values for a selected run” on 
page 180.

• Open a context menu with a variety of options for working wit h and displaying 
run-specific data. See “The Runs Tab Context Menu” on page 181.

You can also open the Runs tab from the Tabs option on the Geneticist Assistant 
main menu: Tabs > Runs.
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To change the number of runs displayed on the Runs tab
You can do the following for the display on the Runs tab:

• Limit the runs that are displayed by number. The default value is 30.

• Limit the runs that are displayed by a range for the run date and time. The default value 
is the last 30 days, with the ending date/timestamp set to the current day’s date and time.

To edit values for a selected run
For any run that is displayed on the Runs tab, you can:

• Click in any of the following fields—Name or Run Date/Time—to select the current 
value, and edit it as necessary, and then click out of the field.

• Select a different Chemistry and/or Instrument for the run. 

After you edit the value for Name or Run Date/Time and click out of the field, or select a 
different chemistry or instrument for the run, an Edit Run dialog box opens. The dialog 
box displays the name of the run for which you are editing a value, the current (old) run 
value, and the new run value. You can make any further changes to the new run value as 
needed, and then click OK to close the dialog box, and save the new value for the run.

Figure 6-2:  Edit Run dialog box

• Set the status for the run. When a run is first submitted, the status is set to New. You can 
change the status from New to one of three default values (QC Passed, Reviewed, or 
Complete) for the run, or if custom values have been added for the run, then you can also 
select one of these values. 

For information about adding a custom value, see “Managing Objects in the 
Geneticist Assistant Database” on page 55.
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The Runs Tab Context Menu
You can right-click any run entry on the Runs tab to open a context menu with the following 
options:

Table 6-1: Runs tab, Runs pane context menu

Option Description

Run • Open – Opens the Run tab for the selected run. See Chapter 7, “Geneticist Assistant 
Data Review - Run Tab,” on page 187.

Note: You can also double-click a run entry to open the Run tab.
• Open all Samples with <Filter>: Select a filter for the samples. One or more Sample 

tabs open. The Sample Variant Data sub-tab is the open tab and the selected filter is 
applied to each tab. For each sample, only those sample variants that meet the filter 
criteria are displayed on the tab. The selected filter is persistent within this Geneticist 
Assistant instance and across instances. To clear the filter only for the current instance 
of Geneticist Assistant, click Clear at the bottom of the Table Filters pane. To select a 
different filter for the samples, or to permanently clear the filter for the samples, see 
“Apply Variant Filter” under “Edit Sample” on page 193.

Note: For information about creating a filter template, see “To filter the data that is 
displayed in a tab pane” on page 32. For information about the Sample Variant Data 
sub-tab, see “Sample Variant Data Sub-Tab” on page 212.

Show Run Variants Displayed for one or more runs. CTRL-click to select multiple runs. You can select only 
one of the four options. All options open the Sample Variant Data sub-tab for the Sample 
tab, which displays variants for one or more samples.

• All • Displays all the variants for all the samples in all the selected runs.

• Distinct • Displays all the variants that are different among all the samples in all the selected runs.

• All Filtered by 
Panel

• Displays all the variants among all the samples in all the selected runs filtered by the 
selected panel.

• Distinct Filtered by 
Panel

• Displays all the variants that are different among the selected samples filtered by the 
selected panel.

Add All to Custom 
Report

Selects all the data that is displayed for the run for inclusion in a custom report. See 
Chapter 10, “Geneticist Assistant Reports,” on page 265.

Compare Samples Applicable only for runs with two or more samples. Opens the Sample Comparison dialog 
box. You use the options on this dialog box to compare the coverage, frequency, and read 
balance information for each sample that is being compared. See “Comparing Samples in 
a Run” on page 340.

Panel Statistics Opens the Panel Statistics tab. The tab has options for displaying specific information 
based on the panel that was used for the run. See “Reviewing Panel Statistics” on page 
319.

Copy Copies all the information that is displayed for the selected run to your client’s clipboard. 
You can then use standard Paste commands to paste this copied information into a 
third-party application such as Notepad.

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or edit the 
permissions (Can Read or Can Read and Can Write) that the specified users or groups are 
to have for the run. See “Setting Read and Write Permissions” on page 326.
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Change Ownership Opens the Change Run Ownership dialog box, which displays the name of the current 
owner for the run, and an option (New Owner) for selecting a new owner for the run from a 
list of all the currently available and active users for your Geneticist Assistant instance.You 
can change the ownership for any run if you are an Administrator user, the current owner 
of the run, or if you have been granted Can Read and Can Write permissions for the run.

Figure 6-3:  Change Run Ownership dialog box

Note: If the run was added to your Geneticist Assistant prior to V1.4, then the first time the 
dialog box opens, the Current Owner field is blank.

Edit Run

Apply Variant Filter • <Filter>: Applies the selected variant filter to all the samples in the run. When you open 
the Sample tab for any sample in the run, the variant filter is automatically applied. Only 
those sample variants that meet the filter criteria are displayed on the Sample Variant 
Data sub-tab of the Sample tab. The selected filter is persistent within this Geneticist 
Assistant instance and across instances. To clear the filter only for the current instance 
of Geneticist Assistant, click Clear at the bottom of the Table Filters pane. 

• Deactivate Filters: Permanently clears all filters that been applied for all the samples in 
the run for all instances of Geneticist Assistant. All variants for a selected sample are 
again displayed on the Sample Variant Data sub-tab.

Table 6-1: Runs tab, Runs pane context menu (Continued)

Option Description
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Add Comment Opens the Add Run Comment dialog box. You add a comment for the selected run in the 
Add comment field. The comment is displayed in the Comment field on the Runs tab and 
the Comment field in the Comments pane on the Run tab. 

Figure 6-4:  Add Run Comment dialog box

Note: If multiple comments have been added for a run, then only the last added comment 
is displayed in the Comment field on the Runs tab. All the comments that have been 
added for a run, including the last added, are displayed in reverse chronological 
order in the Comments pane on the Run tab.

Add Samples to Run Opens the New Run dialog box so that you can add more samples to the selected run. 
See “Adding a Run” on page 170.

Table 6-1: Runs tab, Runs pane context menu (Continued)

Option Description
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Set Subpanels of 
Selected Runs

Applicable only if you select a run for which a subpanel was not selected during the setup 
of the run. CTRL-click to select multiple runs. If you select multiple runs, then all the runs 
must use the same panel. Opens the Select a Subpanel dialog box. The dialog box 
displays the samples and the panel for the selected runs and a Subpanel dropdown list 
with all the available subpanels. 

Figure 6-5:  Set Sample Subpanel dialog box

Select a different subpanel on the Subpanel dropdown list, and then click OK. The 
subpanel is applied to all the samples in all the selected runs.

Delete Run Delete the selected run from the Geneticist Assistant database.

Export - Contains all the sub-menu options for exporting a variant.

Export to VCF Exports all the variants in the selected run to a VCF file. You must specify both the file 
name and the location in which to save the file.

Save Sample 
Reports

Applicable for one or more runs. CTRL-click to select multiple runs. Generates an 
individual sample report for each sample in all the selected runs. If a single sample is 
selected, then a default location, report name, and report type (.csv) are provided, but you 
can change any or all of these values. If multiple samples are selected, then you can 
select only the location in which to save the report. Each report is named the same as the 
sample and the report format is .csv, and you cannot change either of these values.
Note: For more information about standard reports, see Chapter 10, “Geneticist Assistant 

Reports,” on page 265.

Create Batch 
Variants Report

Opens the Batch Variants Report dialog box for generating the Batch Variants report for all 
the samples in a selected run. See “Managing a Batch Variants Report” on page 329.

Create Batch 
Coverage Report

Opens the Batch Coverage Report dialog box for generating the Batch Coverage report for 
all the samples in the selected run or runs. See “Generating a Batch Coverage Report” on 
page 335.

Sample PDF Report

Applicable for one or more runs. CTRL-click to select multiple runs. Opens a list of Sample PDF report templates 
that you created and saved, or that other users created and made available to all users. Select a report template to 
generate an individual sample report for each sample in all selected runs. Each sample report is saved in a PDF 
format and is named the same as the sample for which it was generated. See “Designing a Sample PDF Report 
Template” on page 274 and “Generating a Sample PDF Report” on page 286.

Table 6-1: Runs tab, Runs pane context menu (Continued)

Option Description
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Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are to be 

shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To show/hide 

columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display preferences for 

variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 69.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters
Manually Opens the Filters table for the Runs pane. See “To filter the data that is displayed in a tab 

pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Run pane. Limits the display in the pane to only the 
data (fields) that are defined by the template. See “To filter the data that is displayed in a 
tab pane” on page 32.

Table 6-1: Runs tab, Runs pane context menu (Continued)

Option Description
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Run Tab

Many options are available from the Run tab for reviewing your data in Geneticist Assistant.

This chapter covers the following topics:

• “Overview of the Run Tab” on page 189.

• “Samples pane (Run tab)” on page 190.

• “Coverage Regions tab” on page 200.

• “The Samples Pane (Run tab) Context Menu” on page 191.

• “Status Changes pane (Run tab)” on page 204.

• “Reports pane (Run tab)” on page 207.
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Overview of the Run Tab
The Run tab displays information for a selected run. To open the Run tab, do one of the 
following:

• Right-click a run on the Runs tab, and on the context menu that opens, select Run > Open.

• Double-click a run on the Runs tab. 

Figure 7-1:  Run tab

The Run tab has four panes. From top to bottom, these panes are the following:

• The Samples pane. See “Samples pane (Run tab)” on page 190.

• The Run’s Status Changes pane. See “Status Changes pane (Run tab)” on page 204.

• The Comments pane. See “Comments pane (Run tab)” on page 205.

• The Reports pane. See “Reports pane (Run tab)” on page 207.
Geneticist Assistant User’s Manual 189



Chapter 7
Geneticist Assistant Data Review - Run Tab
Samples pane (Run tab)
The Samples pane on the Run tab displays an entry for each sample (VCF/BAM file 
combination or single VCF file) that was loaded for the run. The following options are 
available for a sample in the Samples pane on the Run tab:

• Setting the sample status. See “To set the sample status” on page 190.

• Using the context menu. See “The Samples Pane (Run tab) Context Menu” on page 191.

To set the sample status
By default, after a sample is initially submitted, the status of the sample is set to New on the 
Run tab. 

1. If you have not done so already, open the Run tab. (See “Overview of the Run Tab” on 
page 189.)

2. On the Samples pane, on the Status dropdown list, select a different sample status.

The Update Sample Status dialog box opens. The dialog box displays the Current status 
and the New status, which is the status that you are changing the sample to.

Figure 7-2:  Update Sample Status dialog box

3. Optionally, in the Comment field, enter an explanation/reason for changing the sample 
status.

The status change and the comment for the status change are displayed in the Status 
Changes pane on the Sample tab. See “Status Changes pane (Sample tab, Sample Data 
sub-tab)” on page 232.

4. Click OK.

The Update Sample Status dialog box closes. The Run tab remains open. The newly 
selected sample status is displayed in the Status field on the tab.

You can select a different value from one of the available default values (New, QC 
Passed, Reviewed, or Complete), or if needed, you can create custom statuses, and 
then select one of these custom statuses instead. See “Managing Objects in the 
Geneticist Assistant Database” on page 55. 
190 Geneticist Assistant User’s Manual



Chapter 7
Geneticist Assistant Data Review - Run Tab
The Samples Pane (Run tab) Context Menu
You can right-click a sample (CTRL-click to select multiple samples) in the Samples pane on 
the Run tab to open a context menu with the following options:

Table 7-1: Run tab, Samples pane context menu

Option Description

Open with <variant filter > Select a filter for the sample. The Sample tab opens for the selected sample. 
The Sample Variant Data sub-tab is the open tab and the selected filter is 
applied to the tab. Only those sample variants that meet the filter criteria are 
displayed on the tab. The selected filter is persistent within this Geneticist 
Assistant instance and across instances. To clear the filter only for the current 
instance of Geneticist Assistant, click Clear at the bottom of the Table Filters 
pane. To select a different filter for the sample, or to permanently clear the for 
the sample, see “Apply Variant Filter” under “Edit Sample” on page 193.
Note: For information about creating a filter template, see “To filter the data that 

is displayed in a tab pane” on page 32. For information about the Sample 
Variant Data sub-tab, see “Sample Variant Data Sub-Tab” on page 212.

Sample Details Displayed only if a single sample is selected. Opens the Sample tab, which 
contains detailed information about the sample, including the variant list. See 
Chapter 8, “Geneticist Assistant Data Review - Sample Tab,” on page 209.

Show Sample Variants Filtered 
by Panel

Displayed only if a single sample is selected. Displays all the variants in the 
selected sample filtered by a selected panel or panels. If you select this option, 
then the Select Panel to Filter Variants dialog box opens. You must select a 
panel or panels in this dialog box by which to filter the variants for the selected 
run.

Figure 7-3:  Select Panel to Filter Variants dialog box

Coverage Regions Displayed only if a single sample is selected. Opens the Coverage Regions tab, 
which lists the coverage information for every region in your panel. The Status 
indicates whether the region passed or failed the Quality Control (coverage) 
settings that were set for the run. See “Coverage Regions tab” on page 200.
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Show Sample Variants Displayed only if two or more samples are selected. You can select only one of 
the four options. All options open the Sample Variant Data sub-tab for the 
Sample tab.

• All • Displays all the variants for all selected samples.

• Distinct • Displays all the variants that are different among the selected samples.

• All Filtered by Panel • Displays all the variants for all selected samples filtered by the selected 
panel.

• Distinct Filtered by Panel • Displays all the variants that are different among the selected samples 
filtered by the selected panel.

Compare Samples Displayed only if two or more samples are selected. Opens the Sample 
Comparison dialog box. You use the options on this dialog box to compare the 
coverage, frequency, and read balance information for each sample that is 
being compared. See “Comparing Samples in a Run” on page 340.

Family Comparison Displayed only if three or more samples are selected. At a minimum, you must 
select two parent samples and one child sample. You can always select more 
than one child sample. Opens the Family Comparison dialog box, in which you 
can specify the options to compare the variant calls in family (relation and 
phenotype) data. See “To compare family data” on page 197.

Panel Statistics Opens the Panel Statistics tab. The tab has options for displaying specific 
information for the panel that was used for the run. See “Reviewing Panel 
Statistics” on page 319.

Add All to Custom Report Selects all the data that is displayed for all the samples in the run for inclusion 
in a custom report. See Chapter 10, “Geneticist Assistant Reports,” on page 
265.

Copy Copies all the information that is displayed for the selected sample to your 
client’s clipboard. You can then use standard Paste commands to paste this 
copied information into a third-party application such as Notepad.

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set 
or edit the permissions (Can Read or Can Read and Can Write) that the 
specified users or groups are to have for the sample. See “Setting Read and 
Write Permissions” on page 326.

Change Ownership Opens the Change Sample Ownership dialog box, which displays the name of 
the current owner for the selected sample, and an option (New Owner) for 
selecting a new owner for the sample. You can change the ownership for any 
sample if you are an Administrator user, the current owner of the sample, or if 
you have been granted Can Read and Can Write permissions for the sample.

Figure 7-4:  Change Sample Ownership dialog box

Table 7-1: Run tab, Samples pane context menu (Continued)

Option Description
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Edit Sample

Apply Variant Filter • <Filter>: Select a variant filter for the sample. The Sample tab opens for the 
selected sample. The Sample Variant Data sub-tab is the open tab and the 
selected variant filter is applied to the tab. Only those sample variants that 
meet the filter criteria are displayed on the tab. The selected filter is 
persistent within this Geneticist Assistant instance and across instances. To 
clear the filter only for the current instance of Geneticist Assistant, click Clear 
at the bottom of the Table Filters pane. 

• Deactivate Filters: Permanently clears all applied variant filters for the 
selected sample for all instances of Geneticist Assistant. All variants for the 
selected sample are again displayed on the Sample Variant Data sub-tab.

Add Comment Opens the Add Sample Comment dialog box. You add a comment for the 
associated sample in the Add Comment field. The comment is displayed in the 
Comments field on the Samples sub-tab on the Patient tab, the Comments field 
in the Samples pane on the Run tab, and in the Comments pane on the Sample 
Data sub-tab on the Sample tab. 

Figure 7-5:  Add Sample Comment dialog box

Note: If multiple comments have been added for a sample, then with the 
exception of the Comments pane on the Sample Data sub-tab on the 
Sample tab, only the last added comment is displayed in all the locations 
detailed above. All the comments that have been added for a sample, 
including the last added, are displayed in reverse chronological order in 
the Comments pane on the Sample Data sub-tab for the Sample tab.

Table 7-1: Run tab, Samples pane context menu (Continued)

Option Description
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Set Subpanel/Set Subpanel of 
Selected Samples

Applicable for one or more samples for which a subpanel was not selected 
during the setup of the run. CTRL-click to select multiple samples. Opens the 
Select a Subpanel dialog box. The dialog box displays the selected sample or 
samples, the panel for the currently selected sample, and a Subpanel 
dropdown list with all the available subpanels. 

Figure 7-6:  Set Sample Subpanel dialog box

Select a subpanel on the Subpanel dropdown list, and then click OK. The 
subpanel is applied to sample or samples.

Set Patient Opens the Set Patient dialog box. Select the patient that you are associating 
with the sample, and then click OK.

Figure 7-7:  Set Patient dialog box

Note: You also have the option of associating a patient with a sample from the 
Sample tab. See “Patient pane (Sample Data sub-tab for the Sample 
tab)” on page 236.

Table 7-1: Run tab, Samples pane context menu (Continued)

Option Description
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Edit Sample Groups Opens the Edit Sample Group dialog box. You use the options on this dialog 
box to add a sample to a selected sample group, or to remove a sample from a 
selected sample group.
Note: If the appropriate sample group is not available, you can add it. See 

“Managing Objects in the Geneticist Assistant Database” on page 55.

Figure 7-8:  Edit Sample Group dialog box

Move Samples to Run Applicable for one or more samples. CTRL-click to select multiple samples. 
Opens the Move Selected Samples to Run dialog box. Enter a search string to 
search for the existing run in your Geneticist Assistant database that you are 
moving the samples to. As you enter the search string, a dynamically updated 
list of runs that meet your search criteria opens. You can select the appropriate 
run from this list.

Figure 7-9:  Move Selected Samples to Run dialog box

Note: The search string is not case-sensitive, but the string must begin with the 
run name. For example, a search string of “May” or “ma” returns a run 
named Mayo Clinic Run II, but a search string of “clinic” does not.

Delete Sample/Delete Selected 
Samples

Applicable for one or more samples. CTRL-click to select multiple samples. 
Deletes the selected samples from the run. The samples are NOT deleted from 
the Geneticist Assistant database.

External - Contains all the sub-menu options for viewing the sample variants in a tool that is outside Geneticist 
Assistant.

View in NextGENe Requires you to have your NextGENe installation specified in your Geneticist 
Assistant settings. (See “To configure Geneticist Assistant directories” on page 
59.) If selected, then Geneticist Assistant browses for the folder where the VCF 
file for the sample is located. If the NextGENe project file is found in the same 
directory as the VCF file, then the NextGENe project is opened in the 
NextGENe Viewer. 

Table 7-1: Run tab, Samples pane context menu (Continued)

Option Description
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View in IGV Applicable if there is a corresponding BAM file (and not a NextGENe project 
file) in the same folder as the VCF file for the sample. Opens the BAM file in the 
third-party Integrative Genomics Viewer (IGV).

Export - Contains all the sub-menu options for exporting a variant.

Export to VCF Exports all the variants in the selected sample to a VCF file. You must specify 
both the file name and the location in which to save the file.

Save Sample Reports Applicable for one or more samples. CTRL-click to select multiple samples. 
Generates an individual sample report for each selected sample. If a single 
sample is selected, then a default location, report name, and report type (.csv) 
are provided, but you can change any or all of these values. If multiple samples 
are selected, then you can select only the location in which to save the report. 
Each report is named the same as the sample and the report format is .csv, and 
you cannot change either of these values.
Note: For more information about standard reports, see Chapter 10, “Geneticist 

Assistant Reports,” on page 265.

Create Batch Variants Report Opens the Batch Variants Report dialog box for generating the Batch Variants 
report for the selected sample or samples. (CTRL-click to select multiple 
samples.) See “Managing a Batch Variants Report” on page 329.

Create Batch Coverage Report Opens the Batch Coverage Report dialog for generating the Batch Coverage 
report the selected sample or samples. (CTRL-click to select multiple 
samples.). See “Generating a Batch Coverage Report” on page 335.

Reports
Add All to Custom Report Adds only the data that you select to the custom report. You must CTRL-click to 

select multiple items for inclusion in the report. See “Generating a Custom 
Report” on page 271.

Add Selected Samples to 
Custom Report

Adds all the data that is currently displayed in the pane to the custom report. 
See “Generating a Custom Report” on page 271.

Sample PDF Report

Applicable for one or more samples. CTRL-click to select multiple samples. Opens a list of custom report templates 
that you created and saved, or that other users created and made available to all users. Select a report template to 
generate an individual sample report for each selected sample. Each sample report is saved in a PDF format and is 
named the same as the sample for which it was generated. See “Designing a Sample PDF Report Template” on 
page 274 and “Generating a Sample PDF Report” on page 286.

Load Filter
Manually Opens the Filters table for the Samples pane. See “To filter the data that is 

displayed in a tab pane” on page 32.

<Filter Template Name> - Saved 
by <User Name>

Opens the saved Filter template for the Samples pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the 
data that is displayed in a tab pane” on page 32.

Table 7-1: Run tab, Samples pane context menu (Continued)

Option Description
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To compare family data
If the samples for a run are from a family, then you can use the Family Comparison option to 
compare the samples based on the relationships and phenotypes for each sample. At a 
minimum, you must select two parent samples and one child sample. You can always select 
more than one child sample. 

1. If you have not done so already, open the Run tab for the appropriate run. 

2. In the Samples pane, CTRL-click to select the family data that you are comparing. 

3. Right-click any selected sample, and on the context menu that opens, click Family 
Comparison.

The Family Comparison dialog box opens. If a patient is associated with a selected 
sample, then patient Relationship (Father, Mother, or so on) is displayed on the 
Relationship dropdown list; otherwise, you must select the appropriate relationship for 
the patient. Likewise, if the phenotype was included with the patient information, then 
the phenotype is automatically displayed on the Phenotype dropdown list for the sample, 
where Affected indicates that the patient has the phenotype and Unaffected indicates that 
the patient does not have the phenotype. If the phenotype is not automatically displayed 
for a sample, then you must select the appropriate value. See Figure 7-10 on page 198.

Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are 

to be shown and clear the columns that are to be hidden dynamically, or select 
a configuration from the list of available column configurations. This option is 
also available on the column header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To 

show/hide columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display 

preferences for variants in all the variant sub-tabs and panes (with the 
exception of the Sample Group columns on the Sample Variant Data 
sub-tab on the Sample tab and the Variant pane on the Variant tab) in a 
single step. See “To apply shared preferences or to clear all tab 
preferences” on page 69.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle 
the display, click Compact as needed.

<Saved Pane Configuration 
Name> - Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a 
pane configuration is displayed next to the configuration name.

Table 7-1: Run tab, Samples pane context menu (Continued)

Option Description

At a minimum, you must select two parent samples and one child sample. You can 
always select more than one child sample.
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Figure 7-10:  Family Comparison dialog box

4. Do any or all of the following:

• On the Phenotype dropdown list at the top of the dialog box, select a different 
phenotype.

• On the Inheritance pattern dropdown list, select the appropriate value for the family, 
and if applicable, based on the selected Inheritance pattern, select Compound 
heterozygous.

• Indicate which columns to show or hide in addition to the default columns that are 
displayed for the family data comparison results: AF (Allele Frequency), Cov 
(Coverage), and/or RB (Read Balance).

• To display all the variants in each sample filtered by a selected panel, select Filter 
variants by panel, and then on the Panels dropdown list, select the appropriate panel.

• To display all the variants in each sample filtered by a selected pathogenicity, select 
Filter variants by pathogenicity, and then on the Pathogenicities dropdown list, select 
the appropriate pathogenicity.

Select Compound heterozygous to carry out compound heterozygous filtering. The 
filtering results are displayed in the Family Data Comparison Results pane. the 
results show all possible combinations of two heterozygous variants in a gene if 
the variants meet the relationship and phenotype settings for the parent samples. 
For example, if both the Mother and Father are Unaffected but a Son is Affected, 
then one heterozygous variant in the affected son must come from each parent.

After you select an Inheritance pattern, the zygosity for each sample is 
automatically adjusted based on the selected inheritance pattern and the 
relationship and phenotype for the sample. If you select an incorrect Inheritance 
pattern based on the relationships and phenotypes, then “Error” is displayed 
instead of a valid zygosity value.
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5. Click OK.

The family data comparison is carried out. The Family Comparison tab opens. The left 
side of the Family Comparison Results pane shows sample-specific information. The 
results are shown using standard pedigree symbols. If the patient that is associated with a 
sample is affected, then the pedigree symbol is shaded; otherwise, the symbol is not 
shaded. You can hover your cursor over a column header to view specific details for the 
selected sample. The right side of the tab shows variant detail information. See Figure 7-
11 and Figure 7-12 below.

Figure 7-11:  Viewing information for a family comparison result

Figure 7-12:  Family Comparison Results pane

     

Comparison of family data can take 30 minutes or more depending on a variety of 
factors, including the number of the samples that are being compared and the 
number of variants for each sample.
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Coverage Regions tab
The Coverage Regions tab has a single pane, the Coverage Regions pane, that displays the 
coverage information for every region in your panel. The Status column indicates whether 
the panel region passed or failed the Quality Control (coverage) settings that were set for the 
run’s panel. 
Figure 7-13:  Coverage Regions tab

Table 7-2: Coverage Regions tab

Column Description
ID System-generated ID for the region.

Region Name The region description from Column 4 of the BED file that was used to create the panel.

Chrom The chromosome on which the region is located.

ChromRegionStart The starting chromosome position for the region.

ChromRegionEnd The ending chromosome position for the region.

Note: Together, the ChromRegionStart and ChromregionEnd make up the chromosome position range.

Chrom:Start-End The chromosome position range appended to the chromosome number.

% Covered The percentage of the region that has reads aligned to it.

Average Coverage The average coverage (average number of aligned reads) for the region.

Minimum Coverage The minimum coverage (number of reads aligned) for any position within the region.

% Covered 
Threshold

The percentage of the region that must have reads aligned to it, or the region does not 
pass the Quality Control settings that have been set for the run’s panel. See “To specify the 
global Quality Control settings” on page 64.

Average Coverage 
Threshold

The average coverage (average number of aligned reads) required for the region, or the 
region does not pass the Quality Control settings that have been set for the run’s panel. 
See “To specify the global Quality Control settings” on page 64..
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Minimum Coverage 
Threshold

The minimum coverage (number of reads aligned) that is required for any position within 
the region, or the region does not pass the Quality Control settings that have been set for 
the run’s panel. See “To specify the global Quality Control settings” on page 64.

Status Indicates if the region passed or failed the Quality Control (coverage) settings that were 
specified for the run’s panel. You can manually change the status for a region. If you 
manually change the status for a region, then the Update Panel Region dialog box opens. 
The dialog box lists the new status for the region, and you have the option of adding 
comments for the status change. The comments are displayed in the Status Comment 
field.

Figure 7-14:  Update Panel Region Status dialog box

Note: By default, only two statuses, Passed or Failed, are available, and one of these two 
statuses is always automatically selected for the region. You have the option of 
adding custom Panel Region statuses and manually selecting a status for a region. 
See “Managing Objects in the Geneticist Assistant Database” on page 55.

Average % Covered Average of the percent covered for the region across all samples for the panel.

Average Average 
Coverage

The average of the average coverage values for the region across all samples for the 
panel.

Average Minimum 
Coverage

The average minimum coverage for the region across all samples for the panel.

Passed The total number of samples for the panel for which the status of the region is Passed.

Passed Percent The percent of the samples for the panel for which the status of the region is Passed.

Failed The total number of samples for the panel for which the status of the region is Failed.

Total The total number of samples that were submitted for the panel.

Gene The gene on which the region is located.

Transcript The accession number for the mRNA transcript.

Protein The accession number for the protein transcript.

Exon Number The coding exon number for the region.

SD % Covered The standard deviation for the “% Covered” value across all samples for the panel.

SD Average 
Coverage

The standard deviation for the “Average Coverage” value across all samples for the panel.

Table 7-2: Coverage Regions tab (Continued)

Column Description
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The context menu for the Coverage Regions tab title bar has the Manage Sample Group 
Statistics option which you can select if you used sample groups for a run and you want to 
calculate statistics for the run. (This option is also available on the tab title bar context menu 
for the Sample Variant Data sub-tab on the Sample tab. See “Sample Variant Data Sub-Tab” 
on page 212.) You can also right-click anywhere on the Coverage Regions tab to open a 
context menu with the following options:
 

SD Minimum 
Coverage

The standard deviation for the “Minimum Coverage” value across all samples for the 
panel.

Table 7-2: Coverage Regions tab (Continued)

Column Description

Table 7-3: Coverage Regions tab context menu

Option Description

Add Selected 
Regions to Action 
List

Adds the selected panel region to an Action List. CTRL-click to select multiple regions. 
See “Creating an Action List” on page 338.

Add Selected 
Regions to Custom 
Report

Selects all the data that is displayed for the selected panel region for inclusion in a custom 
report. CTRL-click to select multiple regions. See Chapter 10, “Geneticist Assistant 
Reports,” on page 265.

Copy Copies all the coverage information that is displayed for the selected run to your client’s 
clipboard. You can then use standard Paste commands to paste this copied information 
into a third-party application such as Notepad.

Add All to Custom 
Report

Selects all the data that is displayed for all the panel regions for inclusion in a custom 
report. See Chapter 10, “Geneticist Assistant Reports,” on page 265.

Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are to be 

shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To show/hide 

columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display preferences for 

variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 69.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters
Manually Opens the Filters table for the Coverage Regions pane. See “To filter the data that is 

displayed in a tab pane” on page 32.
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<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Coverage Regions pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 7-3: Coverage Regions tab context menu (Continued)

Option Description
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Status Changes pane (Run tab)
The Run’s Status Changes pane shows the history of all the status changes that have been 
made for the run in chronological order. A New status entry is always displayed for a first 
run. You can right-click anywhere on this pane to open a context menu with the following 
options:

Option Description
Add All to Custom 
Report

Selects all the information that is displayed for all the statuses for inclusion in a custom 
report. See Chapter 10, “Geneticist Assistant Reports,” on page 265.

Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are to be 

shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To show/hide 

columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display preferences for 

variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 69.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters
Manually Opens the Filters table for the Run Status Changes pane. See “To filter the data that is 

displayed in a tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Run Status Changes pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.
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Comments pane (Run tab)
The Comments pane on the Run tab shows all the comments that have been added for the run 
in reverse chronological order. If one or more comments are displayed in the Comments 
pane, then you can right-click anywhere on this pane to open a context menu with the 
following options:

The context menu for the Comments pane is not enabled if the pane is blank. To 
add a comment for the run and enable this context menu, see “The Runs Tab 
Context Menu” on page 181.

Option Description
Add Run Comment Opens the Add Comment dialog box. You add a comment for the selected run in the Add 

comment field. The comment is displayed in the Comment field on the Runs tab and the 
Comment field in the Comments pane on the Run tab. 

Figure 7-15:  Add Run Comment dialog box

Note: If multiple comments have been added for a run, then only the last added comment 
is displayed in the Comment field on the Runs tab. All the comments that have been 
added for a run, including the last added, are displayed in reverse chronological 
order in the Comments pane on the Run tab.
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Delete Run 
Comment

Opens the Delete Comment dialog box. The dialog box displays the name of the selected 
run and the comment that is being deleted. Click OK to delete the selected comment.

Figure 7-16:  Delete Comment dialog box

Add All to Custom 
Report

Selects all the information that is displayed for all the statuses for inclusion in a custom 
report. See Chapter 10, “Geneticist Assistant Reports,” on page 265.

Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are to be 

shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To show/hide 

columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display preferences for 

variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 69.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters
Manually Opens the Filters table for the Run Status Changes pane. See “To filter the data that is 

displayed in a tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Run Status Changes pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Option Description
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Reports pane (Run tab)
The Reports pane displays all the reports that were generated for the selected run and saved 
to the Geneticist Assistant database.

You can right-click anywhere on this pane to open a context menu with options that are 
identical to the options that are on context menu for the Reports pane on the Patient sub-tab 
on the Patient tab. See “Patient tab, Patient sub-tab, Reports pane” on page 154.

You can also select Reports > Saved Reports on the Geneticist Assistant main 
menu to open a Reports tab that includes these same reports.

For detailed information about generating and saving both standard and custom 
Run reports, see Chapter 10, “Geneticist Assistant Reports,” on page 265.
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Many options are available from the Sample tab for reviewing your data in Geneticist 
Assistant.

This chapter covers the following topics:

• “Overview of the Sample Tab” on page 211.

• “Sample Variant Data Sub-Tab” on page 212.

• “Sample Data Sub-Tab” on page 232.

• “Compound Variant Interpretation Sub-Tab” on page 240.

• “Submission Sub-Tab” on page 241.

• “Quality Metric Report Sub-Tab” on page 242.
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Overview of the Sample Tab
The Sample tab displays information for a selected sample. To open the Sample tab, do one 
of the following:

• Right-click a run on the Runs tab, and on the context menu that opens, click Run > Open 
all Samples with, and then select a filter template. After the Sample tab is populated based 
on the selected filter template, you can clear the template to display all sample variant data 
for the run.

• Right-click a sample in the Samples pane on the Run tab, and on the context menu that 
opens, select Sample Details.

• Double-click a sample in the Samples pane on the Run tab.

• Right-click a sample on the Samples sub-tab on the Patient tab, and on the context menu 
that opens, select Sample Details.

• Double-click a sample on the Samples sub-tab on the Patient tab.

• Right-click a sample in the Associated Samples pane on the Variant tab, and on the 
context menu that opens, select Sample Details.

• Double-click a sample in the Associated Samples pane on the Variant tab.

Figure 8-1:  Sample tab, Sample Variant Data sub-tab

The Sample tab has four sub-tabs:

• The Sample Variant Data sub-tab. See “Sample Variant Data Sub-Tab” on page 212.

• The Sample Data sub-tab. See “Sample Data Sub-Tab” on page 232.

• The Compound Variant Interpretation sub-tab. See “Compound Variant Interpretation 
Sub-Tab” on page 240.

• The Submission sub-tab. See “Submission Sub-Tab” on page 241.
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Sample Variant Data Sub-Tab
The Sample Variant Data sub-tab is the sub-tab that opens after you open the Sample tab 
Figure 8-2:  Sample tab, Sample Variant Data sub-tab

The Sample Variant Data sub-tab has a single pane, the Variants pane, that displays 
information about all the variants that were identified in the selected sample. By default, two 
types of information are always displayed on the sub-tab: variant annotation information and 
global variant count and frequency information. The pane also displays statistical 
information if a sample group was used for the run and statistics were calculated for the 
sample group. A variety of options are available for working with a variant that is displayed 
on this sub-tab, and a context menu is also available. See:

• “Variant annotation information” on page 213.

• “Global variant count and frequency information” on page 218.

• “Sample group statistical information” on page 219.

• “Variant options on the Sample Variant Data sub-tab” on page 220.

• “Sample Variant Data sub-tab context menu” on page 222.

The information that is displayed on the Sample Variant Data sub-tab was divided 
into three separate tables simply for ease of reading in this manual and locating 
and identifying the information on the sub-tab. There is no visible division of this 
information on the sub-tab itself.
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Variant annotation information
The following table lists the variant annotation information that is displayed on the Sample 
Variant Data sub-tab.

• Remember, you can select which columns to show and which columns to hide in 
a pane. See “To show/hide columns in a tab pane” on page 39. 

• Remember, you can specify how the information about the variants is displayed 
on the sub-tab. See “To specify variant preferences” on page 70. 

• Selected columns from the various reference information panes on the Variant 
tab can also be displayed here. See Chapter 9, “Geneticist Assistant Data 
Review - Variant Tab,” on page 243.

Many of the options that are listed in the variant annotation information columns 
are also available on the Sample Variant Data sub-tab context menu.

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information

Column Description
ID System-generated value that identifies the variant. 

Chromosome The chromosome on which the variant is located.

Chromosome 
Position

The chromosome position where the variant is located.

Chr:ChrPos The chromsome:chromosome position for the variant location.

Rs The dbSNP database identification for the variant. 
Note: If a value other than N/A is displayed, then it is a hyperlink to the NCBI dbSNP web 

page for the variant.

Ref The reference nucleotide at the variant position.

Ref AA The reference amino acid coded for by the codon that includes the variant position.

Alt The variant nucleotide at the variant position.

Alt AA The variant amino acid coded for by the codon that includes the variant position.

Type The type of variant based on the amino acid change that the variant caused. Values are 
Missense, Synonymous, Frameshift, or Nonsense.

Coverage The coverage (number of reads) aligned to the variant location in the sample.
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Pathogenicity The pathogenicity of the variant, which is the potential for the variant to cause disease. By 
default, the pathogenicity is always set to an initial value of Unassigned. You must review 
the information for the variant and then decide what the pathogenicity should be; for 
example, Deleterious. (If you cannot determine the pathogenicity of the variant, then you 
can set the status to Unknown.) When you update the pathogenicity and/or status, you can 
apply the changes to:
• the panel group - Applies the changes to the variant for the indicated panel group.The 

next time that the variant is detected in another sample that has been assigned to this 
panel group, then this is the pathogenicity that is displayed for the variant.

• the sample only - Applies the changes to the variant only for the currently selected 
sample.

You can also update the pathogenicity status and/or add comments for the changes. By 
default, the status is always set to an initial value of Pending. 

Figure 8-3:  Submit Pathogenicity dialog box

Note: You can also double-click in the Pathogenicity column to open the Submit 
Pathogenicity dialog box, or use the context menu option. See “Sample Variant Data 
sub-tab context menu” on page 222.

The following information is relevant to updating the pathogenicity and/or pathogenicity 
status for a variant:
• By default, only five pathogenicities—Deleterious, Likely Deleterious, Unknown, Likely 

Benign, and Benign—are available. You have the option of adding custom 
pathogenicities, either by clicking New to open the Add New Pathogenicity dialog box 
and entering a new value, or from the Manage Objects function. See “Managing Objects 
in the Geneticist Assistant Database” on page 55.

• By default, only two statuses—Pending and Confirmed—are available. You have the 
option of adding custom statuses, either by clicking New to open the Add New 
Pathogenicity Status dialog box and entering a new value, or from the Manage Objects 
function. See “Managing Objects in the Geneticist Assistant Database” on page 55.

• Optionally, you can add supporting information for this pathogenicity change. See “To 
add supporting information for a variant” on page 256.

• You always have the option of updating just the pathogenicity status for a variant. See 
“Pathogenicity Status” on page 215.

• You can also update the pathogenicity on the Patient tab, Variants sub-tab. See “Patient 
tab, Variants sub-tab” on page 158. 

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information (Continued)

Column Description
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Pathogenicity Date 
Time

The date and time that the currently displayed pathogenicity value was assigned to the 
variant.

Pathogenicity Status The status of the selected pathogenicity. You must manually set this value. By default, only 
two statuses—Pending and Confirmed—are available, and the pathogenicity status is 
always set to an initial value of Pending. You must review the information for the variant 
and then decide what the pathogenicity status should be. To open the Submit Pathogenicity 
dialog box, double-click in this column for a selected variant.You can update the 
pathogenicity status for the selected variant in this dialog box. When you update the 
pathogenicity status, you can apply the changes to:
• the panel group - Applies the changes to the variant for the indicated panel group.The 

next time that the variant is detected in another sample that has been assigned to this 
panel group, then this is the pathogenicity status that is displayed for the variant.

• the sample only - Applies the changes to the variant only for the currently selected 
sample.

You can also add a comment for the status change.
You have the option of adding custom statuses, either by clicking New to open the Add 
New Pathogenicity Status dialog box and entering a new value, or from the Manage 
Objects function. See “Managing Objects in the Geneticist Assistant Database” on page 55. 

Figure 8-4:  Update Variant Pathogenicity Status dialog box

The following information is relevant to updating the pathogenicity status for a variant:
• You can also double-click in the Status column to open the Update Variant Pathogenicity 

Status dialog box or use the option that is available on the context menu for the sub-tab. 
See “Sample Variant Data sub-tab context menu” on page 222.

• You can also update the Pathogenicity Status for a variant on the Patient tab, Variants 
sub-tab. See “Patient tab, Variants sub-tab” on page 158.

Pathogenicity Status 
Date Time

The date and time that the currently displayed pathogenicity status was assigned to the 
variant.

Zygosity Indicates whether the variant is heterozygous or homozygous.
Note: The selected zygosity is based on the Zygosity settings that you have specified on 

the Variant Preferences tab of the Settings dialog box. See “To specify variant 
preferences” on page 70.

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information (Continued)

Column Description
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Artifact Type The artifact type for the selected variant. You must manually set this value. Double-click in 
this column for the selected variant to open the Update Artifact Type dialog box. You 
specify the artifact type (for example, Sequencing) for the variant in this dialog box. If the 
appropriate artifact type is not available, then an option is provided to create a new type.

Figure 8-5:  Update Variant Artifact Type dialog box

When you specify the artifact type, you can set the artifact type as the following:
• Set globally—Selected by default. Set this artifact type for the variant, regardless of the 

sample in which the variant is detected.
• Set for Sample—Set this artifact type for this variant only for the indicated sample.
You also have the option of adding comments for the variant artifact type.
Note: The default value for Variant Classification is determined by the setting on the 

Variant Preferences tab on the Settings dialog box. See “To specify variant 
preferences” on page 70.

The following information is relevant to updating the artifact type for a variant:
• You can also define artifact types and set the artifact type for a variant on the Variants 

sub-tab on the Patient tab, on the Variants sub-tab on the Panel Statistics tab from the 
Runs tab or the Run tab, or on the Sample Variant Data sub-tab on the Sample tab.

• You can also double-click in the Artifact Type column to open the Update Variant Artifact 
Type dialog box, or use the context menu option. See “Sample Variant Data sub-tab 
context menu” on page 222.

• You have the option of adding custom artifact types, either by clicking New to open the 
Add New Artifact dialog box and entering a new value, or from the Manage Objects 
function. See “Managing Objects in the Geneticist Assistant Database” on page 55.

Patient Variant 
Frequency

The frequency at which the variant was detected in the sample. Any value < 1 is allowed, 
with 1 = 100%, 0.5 = 50%, and so on.

Gene The gene on which the variant is located.

Gene Strand The strand (+ or -) for the gene in which the variant is located.

Read Balance The balance in forward and reverse oriented reads with the variant as reported in the VCF 
file.

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information (Continued)

Column Description
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Exon Number The exon within the gene in which the variant is located. Includes non-coding exons. 
“Intron” is displayed for intronic variants. 

Transcript The accession number for the preferred mRNA transcript that is used for the HGVS 
nomenclature columns.

Protein The accession number for the protein transcript that is associated with the preferred mRNA 
transcript and is used for the HGVS nomenclature columns.

Coding Base The position in the coding regions for the gene where the variant is located.

Codon Position The position within the codon where the variant is located (1, 2, or 3).

AA Position The amino acid number within the gene for the amino acid coded for by the codon that 
includes the variant position.

HGVS Genomic The HGVS genomic nomenclature for the variant. (www.hgvs.org/mutnomen).

HGVS Coding The HGVS coding DNA nomenclature for the variant relative to the reference accession 
that is shown in the Transcript column. (www.hgvs.org/mutnomen).

HGVS Protein The HGVS protein nomenclature for the variant relative to the reference accession that is 
shown in the Protein column. (www.hgvs.org/mutnomen).

Variant Comment The last added comment for the variant. You can also single-click twice in this field, and 
then add or edit a comment as needed. After you click out of the field, the Add Variant 
Comment dialog box opens. The comment is displayed in the Variant Comment field in the 
Variants pane on the Search Results tab, the Variant Comment field on the Sample Variant 
Data sub-tab on the Sample tab, the Variant Comment field in the Variant pane on the 
Variant tab, and the Variant Comments pane on the Variant tab.

Figure 8-6:  Add Variant Comment dialog box

Note: If multiple comments have been added for a variant, then with the exception of the 
Variant Comments pane on the Variant tab, only the last added comment is 
displayed here and on the Variants sub-tab on the Patient tab, the Sample Variant 
Data sub-tab in the Sample tab, the Variant pane on the Variant tab, and the Variant 
Comments pane on the Variant tab. All the comments that have been added for a 
variant, including the last added, are displayed in reverse chronological order in the 
Variant Comments pane on the Variant tab. You can also add comments for a variant 
with an option on the context menu for this sub-tab. See “Add Variant Comment” on 
page 224.

Comment Date Time The date and time that the currently displayed comment (The last added comment for the 
variant) was added for the variant.

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information (Continued)

Column Description
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Global variant count and frequency information
The following table lists the global variant count and frequency information that is displayed 
on the Sample Variant Data sub-tab.

Panel The panel that was used for the run.

Panel Group The panel group to which the panel is assigned.

Trans Indicates whether the variant is Transition (Ti) or Transversion (Tv).

Sample The sample name.

CDS number The coding exon number. 

Genotype The variant genotype. 

Report Displays a checkbox. For each variant that is to be included in a report, click in the 
checkbox to select the variant. 

Tip: You can define variant filtering options to filter for variants only where Report = true or 
Report = false.

Interpretation If an interpretation has been defined for this single variant, then the full interpretation is 
displayed in this column. If more than one interpretation has been defined for the variant, 
then the last defined interpretation is displayed.

Coverage Region 
Status

Indicates whether the region passed or failed the Quality Control (coverage) settings that 
were specified for the run’s panel. 

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information (Continued)

Column Description

Table 8-2: Sample Variant Data sub-tab: Global Variant Count and Frequency information

Column Description
Samples Per Panel The total number of samples submitted per panel.

Note: Any of the following values that can also be reported as real or related to the artifact type for the variant are 
marked with an asterisk. For example, for Times Observed Per Panel, two additional columns are also 
displayed—Times Observed As Real Per Panel and Times Observed As Artifact Per Panel, where the 
number of samples for which the Artifact Type is set to None is reported for any Observed as Real value and 
the number of samples for which the Artifact Type is set to any other value, such as Sequencing, is reported 
for any Observed as Artifact value.

Times Observed Per 
Run

The number of times that the variant was detected across all samples in the run.

Times Observed Per 
Panel*

The number of times that the variant was detected across all samples per panel.

Frequency Observed 
Per Panel*

The frequency at which the variant was detected across all samples per panel.

Samples Per Panel 
Group

The number of samples that are included in the panel group that include the panel that is 
assigned to the selected sample.

Times Observed Per 
Panel Group*

The number of samples that include the variant and that are assigned to any panel that is 
included in the same panel group as the panel for the selected sample.

Frequency Observed 
Per Panel Group*

The frequency at which the variant was detected in all samples that are assigned to any 
panel that is included in the same panel group as the panel for the selected sample.
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Sample group statistical information
The following table lists the sample group statistical information that is displayed on the 
Sample Variant Data sub-tab.

Patient Variant 
Frequency

The frequency of the variant found in the patient sample. If multiple samples for a patient 
have been loaded, then all samples are considered.

Samples With 
Passed Regions Per 
Panel

The number of samples that are assigned to the panel for the selected sample where the 
panel region in which the variant is located has a status of Passed for the sample.

Times Observed In 
Passed Regions Per 
Panel

The number of samples that are assigned to the panel for the selected sample where the 
variant is reported and the panel region in which the variant is located has a status of 
Passed for the sample.

Frequency Observed 
In Passed Regions 
Per Panel

The frequency at which the variant was detected considering only those samples that are 
assigned to the same panel as the selected sample and where the panel region in which 
the variant is located has a status of Passed.

Samples With 
Passed Regions Per 
Panel Group

The number of samples that are assigned to any panel that is included in the same panel 
group as the panel for the selected sample where the panel region in which the variant is 
located has a status of Passed.

Times Observed In 
Passed Regions Per 
Panel Group

The number of samples that are assigned to any panel that is included in the same panel 
group as the panel for the selected sample where the variant is found and the panel region 
in which the variant is located has a status of Passed.

Frequency Observed 
In Passed Regions 
Per Panel Group

The frequency at which the variant was detected in all samples that are assigned to any 
panel that is included in the same panel group as the panel for the selected sample where 
the panel region in which the variant is located has a status of Passed.

Table 8-2: Sample Variant Data sub-tab: Global Variant Count and Frequency information (Continued)

Column Description

To calculate the statistics for the sample group, use the Manage Sample Group 
Statistics option on the column header context menu for the sub-tab. See “Sample 
Variant Data sub-tab context menu” on page 222.

Table 8-3: Sample Group Statistics Columns on the Sample Variant Data sub-tab

Column Description
Number of Samples Number of samples that.have been submitted for the sample group to which this sample is 

assigned.

Number of Samples 
Having the Variant

Number of samples in the group that contained the variant.

Coverage Min The minimum coverage (number of reads) for the variant in the sample group.

Coverage Max The maximum coverage (number of reads) for the variant in the sample group.

Coverage Median The median coverage (number of reads) for the variant in the sample group.

Coverage Mean The mean coverage (number of reads) for the variant in the sample group.

Coverage Standard 
Deviation

The variation from the Coverage mean for the variant in the sample group.
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Variant options on the Sample Variant Data sub-tab
You can do the following for a variant that is displayed on the Sample Variant Data sub-tab 
on the Sample tab:

• You can specify how the information about the variants is to be displayed on this sub-tab. 
See “To specify variant preferences” on page 70.

• If the variant is located where there are overlapping genes, then you can select a different 
gene for the variant on the Gene dropdown list. If you select a different gene, then the 
gene that is displayed on the tab for the current Geneticist Assistant session is temporarily 
changed. After you close and then re-open Geneticist Assistant, the selected gene is reset 
to the preferred gene. To permanently change the gene that is used for variant, you can 
add a preferred gene for the panel. See “To set or delete a preferred gene for a panel” on 
page 112.

• You can select a different transcript for the variant on the Transcript dropdown list. If you 
select a different transcript, then the transcript that is displayed on the tab for the current 
Geneticist Assistant session is temporarily changed. After you close and then re-open 
Geneticist Assistant, the selected transcript is reset to the preferred transcript. 

Variant Frequency 
Min

The minimum frequency at which the variant was detected in the sample group. Any value 
< 1 is allowed, with 1 = 100%, 0.5 = 50%, and so on.

Variant Frequency 
Max

The maximum frequency at which the variant was detected in the sample group. Any value 
< 1 is allowed, with 1 = 100%, 0.5 = 50%, and so on.

Variant Frequency 
Median

The median frequency at which the variant was detected in the sample group. Any value < 
1 is allowed, with 1 = 100%, 0.5 = 50%, and so on.

Variant Frequency 
Mean

The mean frequency at which the variant was detected in the sample group. Any value < 1 
is allowed, with 1 = 100%, 0.5 = 50%, and so on.

Variant Frequency 
Standard Deviation

The variation from the Frequency mean for the variant in the sample group.

Read Balance Min The minimum value for the balance in forward and reverse oriented reads with the variant 
in the sample group as reported in the VCF file.

Read Balance Max The maximum value for the balance in forward and reverse oriented reads with the variant 
in the sample group as reported in the VCF file.

Read Balance 
Median

The median value for the balance in forward and reverse oriented reads with the variant in 
the sample group as reported in the VCF file.

Read Balance Mean The mean value for the balance in forward and reverse oriented reads with the variant in 
the sample group as reported in the VCF file.

Read Balance 
Standard Deviation

The variation from the Read Balance mean for the variant in the sample group.

Table 8-3: Sample Group Statistics Columns on the Sample Variant Data sub-tab (Continued)

Column Description
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• You can single click twice in the Variant Comment field to select the current comment in 
the field and edit it, or if the field is blank, enter a new comment. After you add or edit a 
comment, and then click out of the field, the Add Variant Comment dialog box opens. 

Figure 8-7:  Add Variant Comment dialog box

The dialog box displays the variant for which you are adding or editing the comment and 
the current comment. You can edit the current comment, or leave it as-is, and then click 
OK to close the dialog box and save the variant comment.

• You can single click twice in the Type field, the Zygosity field, the HGVS Genomic field, 
the HGVS Coding field, and/or the HGVS Protein field to select the current value in the 
field and edit it. If the Type field is blank, then you can enter a value.

• You can single click twice in the Interpretation field to select the current interpretation in 
the field and edit it, or if the field is blank, enter a new interpretation. After you add or 
edit an interpretation and then click out of the field, the Add Variant Interpretation dialog 

To permanently change the transcript that is used for a gene or genes, you can do 
one of two things: You can right-click the variant, and on the context menu that 
opens, click Edit Variant > Update Preferred Transcript (see “Sample Variant 
Data sub-tab context menu” on page 222), or you can add a preferred transcript 
list for the panel. See “To set or delete a preferred transcript list for a panel” on 
page 110.

You can also use the Add Variant Comment option that is available on the context 
menu for the variant to add a new variant comment. See “Add Variant Comment” 
on page 224.

If you make a change to any of these values for the variant, then these changes are 
recorded for the variant on the Variant Changes pane on the Variant tab. See 
“Variant Changes pane” on page 251. These changes are also reflected in the 
appropriate fields on all the variant tabs, sub-tabs, and panes in Geneticist 
Assistant.
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box opens. 

Figure 8-8:  Add Variant Comment dialog box

The dialog box displays the variant for which you are adding or editing the interpretation 
and the current interpretation. You can edit the current interpretation, or leave it as-is, 
and then click OK to close the dialog box and save the variant interpretation.

Sample Variant Data sub-tab context menu
You can right-click any column header on the Sample Variant Data sub-tab to open a context 
menu that, in addition to the standard column header context menu options, contains a 
Manage Sample Group Statistics Columns option. This option opens the Select Sample 
Groups dialog box.
Figure 8-9:  Select Sample Groups dialog box

• If you used sample groups for a run, then you can indicate the date range for which to 
calculate statistics based on the added samples.

• If you did not use specific sample groups for a run, then do not select these sample groups, 
or if applicable, clear the selections for these groups, which hides the corresponding 
Sample Group Statistics columns from the sub-tab display. 
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You can also right-click a variant in the Variants pane on the sub-tab to open a context menu 
with the following options:

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu

Option Description

Variant Details Opens the Variant tab, which displays detailed information about the variant. See 
Chapter 9, “Geneticist Assistant Data Review - Variant Tab,” on page 243.

Show Variants Filtered 
by Panel

Displays all the variants in the selected sample filtered by a selected panel or panels. If 
you select this option, then the Select Panel to Filter Variants dialog box opens. You 
must select a panel or panels in this dialog box by which to filter the variants for the 
selected run.

Figure 8-10:  Select Panel to Filter Variants dialog box

Show Samples with 
Selected Variants

Applicable for one or more variants. CTRL-click to select multiple variants. Two options 
available:
• All variants - Opens the Samples with all variants pane, which displays a list of all the 

samples in your Geneticist Assistant database that contain all the selected variants. 
You can right-click a sample in the list to open a context menu with sample-specific 
options. See “The Samples Pane (Run tab) Context Menu” on page 191.

• Any variant - Opens the Samples with any variants pane, which displays a list of all 
the samples in your Geneticist Assistant database that contain any of the selected 
variants. You can right-click a sample in the list to open a context menu with sample-
specific options. See “The Samples Pane (Run tab) Context Menu” on page 191.
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Edit Variant - Contains all the sub-menu options for editing and deleting a variant.

Add Variant Comment Opens the Add Variant Comment dialog box. You can add a comment for the variant in 
the Add Comment field, and then click OK. You can also CTRL-click to select multiple 
variants and add the same comment to all the selected variants in a single step. The 
comment is displayed in the Variant Comment field in the Variants pane on the Search 
Results tab, the Variant Comment field on the Sample Variant Data sub-tab on the 
Sample tab, the Variant Comment field in the Variant pane on the Variant tab, and the 
Variant Comments pane on the Variant tab.

Figure 8-11:  Add Variant Comment dialog box

Note: If multiple comments have been added for a variant, then with the exception of 
the Variant Comments pane on the Variant tab, only the last added comment is 
displayed in all the locations that are detailed above. All the comments that have 
been added for a variant, including the last added, are displayed in reverse 
chronological order in the Variant Comments pane on the Variant tab.

<Add Variant 
Interpretation>

Select a variant, or CTRL-click to select multiple variants. 
• If a single variant is selected, then the option is Add Single Variant Interpretation, 

and the Add Single Variant Interpretation dialog box opens.
• If two or more variables are selected, then the option is Add Compound Variant 

Interpretation and the Add Compound Variant Interpretation dialog box opens.
See “Adding a Variant Interpretation” on page 342.

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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Update Pathogenicity The pathogenicity of the variant, which is the potential for the variant to cause disease. 
By default, the pathogenicity is always set to an initial value of Unassigned. You must 
review the information for the variant and then decide what the pathogenicity should be; 
for example, Deleterious. (If you cannot determine the pathogenicity of the variant, then 
you can set the status to Unknown.) When you update the pathogenicity and/or status, 
you can apply the changes to:
• the panel group - Applies the changes to the variant for the indicated panel 

group.The next time that the variant is detected in another sample that has been 
assigned to this panel group, then this is the pathogenicity that is displayed for the 
variant.

• the sample only - Applies the changes to the variant only for the currently selected 
sample.

You can also update the pathogenicity status and/or add comments for the changes. By 
default, the status is always set to an initial value of Pending. 

Figure 8-12:  Submit Pathogenicity dialog box

Note: You can also double-click in the Pathogenicity column to open the Submit 
Pathogenicity dialog box.

The following information is relevant to updating the pathogenicity and/or pathogenicity 
status for a variant:
• By default, only five pathogenicities—Deleterious, Likely Deleterious, Unknown, 

Likely Benign, and Benign—are available. You have the option of adding custom 
pathogenicities, either by clicking New to open the Add New Pathogenicity dialog 
box and entering a new value, or from the Manage Objects function. See “Managing 
Objects in the Geneticist Assistant Database” on page 55.

• By default, only two statuses—Pending and Confirmed—are available. You have the 
option of adding custom statuses, either by clicking New to open the Add New 
Pathogenicity Status dialog box and entering a new value, or from the Manage 
Objects function. See “Managing Objects in the Geneticist Assistant Database” on 
page 55.

• Optionally, you can add supporting information for this pathogenicity change. See 
“To add supporting information for a variant” on page 256.

• You always have the option of updating just the pathogenicity status for a variant. 
See “Pathogenicity Status” on page 215.

• You can also update the pathogenicity on the Patient tab, Variants sub-tab. See 
“Patient tab, Variants sub-tab” on page 158. 

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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Update Pathogenicity 
Status

Select a variant, or CTRL-click to select multiple variants and then select this option to 
open the Submit Variant Pathogenicity Status dialog box. You can update the 
pathogenicity status for the selected variants in this dialog box. When you update the 
pathogenicity status, you can apply the changes to:
• the panel group - Applies the changes to the variant for the indicated panel group. 

The next time that the variant is detected in another sample that has been assigned 
to this panel group, then this is the pathogenicity status that is displayed for the 
variant.

• the sample only - Applies the changes to the variant only for the currently selected 
sample.

You can also add a comment for the status change.
You have the option of adding custom statuses, either by clicking New to open the Add 
New Pathogenicity Status dialog box and entering a new value, or from the Manage 
Objects function. See “Managing Objects in the Geneticist Assistant Database” on 
page 55. 

Figure 8-13:  Submit Variant Pathogenicity Status dialog box

The following information is relevant to updating the pathogenicity status for a variant:
• You can also double-click in the Pathogenicity Status column to open the Update 

Variant Pathogenicity Status dialog box.
• You can also update the Pathogenicity Status for a variant on the Patient tab, 

Variants sub-tab. See “Patient tab, Variants sub-tab” on page 158.

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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Update Artifact Type The artifact type for the selected variant. You must manually set this value. Double-click 
in this column for the selected variant to open the Update Artifact Type dialog box. You 
specify the artifact type (for example, Sequencing) for the variant in this dialog box. If 
the appropriate artifact type is not available, then an option is provided to create a new 
type.

Figure 8-14:  Update Variant Artifact Type dialog box

When you specify the artifact type, you can set the artifact type as the following:
• Set globally—Selected by default. Set this artifact type for the variant, regardless of 

the sample in which the variant is detected.
• Set for Sample—Set this artifact type for this variant only for the indicated sample.
You also have the option of adding comments for the variant artifact type.
Note: The default value for Variant Classification is determined by the setting on the 

Variant Preferences tab on the Settings dialog box. See “To specify variant 
preferences” on page 70.

The following information is relevant to updating the artifact type for a variant:
• You can also define artifact types and set the artifact type for a variant on the 

Variants sub-tab on the Patient tab, on the Variants sub-tab on the Panel Statistics 
tab from the Runs tab or the Run tab, or on the Sample Variant Data sub-tab on the 
Sample tab.

• You have the option of adding custom artifact types, either by clicking New to open 
the Add New Artifact dialog box and entering a new value, or from the Manage 
Objects function. See “Managing Objects in the Geneticist Assistant Database” on 
page 55.

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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Update Preferred 
Transcript

Opens the Set Preferred Gene/Transcript dialog box. You can select a different 
preferred gene and/or transcript for the variant. When you select a different gene/
preferred transcript, you can set the preferences for one of the following:
• globally - for the variant in all panels and panel groups.
• of panel - for the variant only when in the indicated panel.
• of Variant - only for this particular variant and not for any other positions within this 

panel or panel group.

Figure 8-15:  Set Preferred Gene/Transcript dialog box

Note: When you select a different transcript here for a panel, then the preferred 
transcript that is used for a gene or genes is permanently changed for the panel. 
You can also permanently change the preferred transcript by adding a preferred 
transcript list for the panel. See “To set or delete a preferred transcript list for a 
panel” on page 110. To temporarily change the preferred transcript for a gene or 
genes, you simply select the transcript on the Transcript dropdown list on a tab 
or sub-tab.

Delete Variant from This 
Sample

Deletes the selected variant from this sample only.

Figure 8-16:  Delete Selected Variant dialog box

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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Delete Variant from All 
Samples

Deletes the selected variant from all samples in which it was found.

Figure 8-17:  Delete Selected Variant dialog box

External - Contains all the sub-menu options for viewing the sample variants in a tool that is outside Geneticist 
Assistant.

View in NextGENe Requires you to have your NextGENe installation specified in your Geneticist Assistant 
settings. (See “To configure Geneticist Assistant directories” on page 59.) If selected, 
then Geneticist Assistant browses for the folder where the VCF file for the sample is 
located. If the NextGENe project file is found in the same directory as the VCF file, then 
the NextGENe project is opened in the NextGENe Viewer, with the focus set to the 
position for the selected variant. 

View in IGV Applicable if there is a corresponding BAM file (and not a NextGENe project file) in the 
same folder as the VCF file for the sample. Opens the BAM file in the third-party 
Integrative Genomics Viewer (IGV) with the focus set to the selected variant.

View in Alamut Opens the variant for viewing in Alamut.
Note: To view a variant in Alamut, your Alamut settings must be specified. See “To 

specify third-party (Alamut, IGV, OMIM) settings” on page 74.

View in UCSC Opens the variant for viewing in the UCSC Genome Browser. 

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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View PubMed Abstract Searches PubMed for the variant and displays the appropriate abstract in the PubMed 
window. 

Figure 8-18:  PubMed window

You can do the following for the abstract:

• In the Link field, enter a different PubMed URL, and then click the Go To icon  to 
navigate to abstract.

• Click Save As to save the abstract as a PDF with a name and in a location of your 
choosing.

• Click Print to print the abstract.

Export - Contains all the sub-menu options for exporting a variant.

Export Selected Variants 
to VCF

Exports the selected variants to a VCF file. CTRL-click to select multiple variants. You 
must specify both the file name and the location in which to save the file.

Export All Variants to 
VCF

Exports all the variants to a VCF file. You must specify both the file name and the 
location in which to save the file.

Reports - Contains all the sub-menu options for generating a report that includes the variant.

Add Selected Variants to 
Action List

Adds the selected variant to an Action List. CTRL-click to select multiple variants. See 
“Creating an Action List” on page 338.

Add Selected Variants to 
Custom Report

Selects all the data that is displayed for the selected variants for inclusion in a custom 
report. CTRL-click to select multiple variants. See Chapter 10, “Geneticist Assistant 
Reports,” on page 265.

Add All Variants to 
Custom Report

Selects all the data that is displayed for all the variants for inclusion in a custom report. 
See Chapter 10, “Geneticist Assistant Reports,” on page 265.

Copy Copies all the information that is displayed for the selected variant to your client’s 
clipboard. You can use standard Paste commands to paste this copied information into 
a third-party application such as Notepad.

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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Create Variant Filters 
from Selected Variants

Create a filter based on the selected variants. You can select a single variant, or CTRL-
click to select multiple variants to open the Create Variant Filter dialog box. Name the 
filter and indicate if the filter is to be available to all users. You, and if applicable, other 
users can use the Load Filter Template function to apply this variant filter to a selected 
sample or samples. (See “To load a saved filter template” on page 38.)

Figure 8-19:  Create Variant Filter dialog box

When the Sample tab opens for a sample to which the filter has been applied, then the 
Sample Variant Data sub-tab displays only those variants that meet the filter criteria. 

Load Filters
Manually Opens the Filters table for the Variants pane. See “To filter the data that is displayed in 

a tab pane” on page 32.

<Filter Template Name> 
- Saved by <User 
Name>

Opens the saved Filter template for the Variants pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are to be 

shown and clear the columns that are to be hidden dynamically, or select a 
configuration from the list of available column configurations. This option is also 
available on the column header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To show/

hide columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display preferences for 

variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared 
preferences or to clear all tab preferences” on page 69.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the 
display, click Compact as needed.

<Saved Pane 
Configuration Name> - 
Saved by <User Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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Sample Data Sub-Tab
The Sample Data sub-tab contains six panes—Status Changes, Comments, Patient, Related 
Patients, Variant Interpretations, and Reports—that provide different information about the 
selected sample. 
Figure 8-20:  Sample tab, Sample Data sub-tab

With the exception of the Compound Variant Interpretations pane, a context menu is 
available for each pane. See:

• “Status Changes pane (Sample tab, Sample Data sub-tab)” below.

• “Comments pane (Sample Data sub-tab on the Sample tab)” on page 234.

• “Patient pane (Sample Data sub-tab for the Sample tab)” on page 236.

• “Related Patients pane (Sample Data sub-tab for the Sample tab)” on page 237.

• “Compound Variant Interpretations pane” on page 238.

• “Reports pane (Sample data sub-tab on the Sample tab)” on page 238.

Status Changes pane (Sample tab, Sample Data sub-tab)
The Status Changes pane lists an entry for each time the status was changed for the sample. 
Each entry details the value for the sample status, the name of the user who changed the 
sample status, the date and time of the status change, and any comments that the user entered 
in support of the change. The pane always contains an entry for the initial submission of the 
sample with the sample status set to New. 
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You can-right click a status change in the pane to open a context menu with the following 
options:

     

Remember, you can change the status for a sample on the Run tab. See “To set the 
sample status” on page 190.

Table 8-5: Sample tab, Sample Data sub-tab, Status Changes pane context menu

Option Description
Add All To Custom 
Report

Selects all the information that is displayed for the selected patient for inclusion in a 
custom report. See Chapter 10, “Geneticist Assistant Reports,” on page 265.

Copy Copies all the information that is displayed for the selected sample to your client’s 
clipboard. You can use standard Paste commands to paste this copied information into a 
third-party application such as Notepad.

Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are to be 

shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To show/hide 

columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display preferences for 

variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 69.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters
Manually Opens the Filters table for the Status Changes pane. See “To filter the data that is 

displayed in a tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Status Changes pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.
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Comments pane (Sample Data sub-tab on the Sample tab)
The Comments pane displays all the comments that have been added for the sample in 
reverse chronological order. If one or more comments are displayed in the Comments pane, 
then you can-right click a comment in the pane to open a context menu with the following 
options:

The context menu for the Comments pane is not enabled if the pane is blank. To 
add a comment for the sample and enable this context menu, see “The Samples 
Pane (Run tab) Context Menu” on page 191.

Table 8-6: Sample tab, Sample Data sub-tab, Comments pane context menu

Option Description
Add Sample 
Comment

Opens the Add Sample Comment dialog box. You add a comment for the sample in the 
Add Comment field.

Figure 8-21:  Add Sample Comment dialog box

Note: If multiple comments have been added for a sample, then these comments are 
displayed in reverse chronological order in the Comments pane on this tab. Only the 
last added comment is displayed in the Comments field in the Samples pane on the 
Samples data sub-tab on the Patient tab and in the Samples pane on the Run tab.
234 Geneticist Assistant User’s Manual



Chapter 8
Geneticist Assistant Data Review - Sample Tab
Delete Sample 
Comment

Opens the Add Delete Comment dialog box. Click OK to delete the comment for the 
sample and close the dialog box.

Figure 8-22:  Delete Comment dialog box

Add All To Custom 
Report

Selects all the information that is displayed for the selected patient for inclusion in a 
custom report. See Chapter 10, “Geneticist Assistant Reports,” on page 265.

Copy Copies all the information that is displayed for the selected sample to your client’s 
clipboard. You can use standard Paste commands to paste this copied information into a 
third-party application such as Notepad.

Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are to be 

shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To show/hide 

columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display preferences for 

variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 69.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters
Manually Opens the Filters table for the Comments pane. See “To filter the data that is displayed in a 

tab pane” on page 32.

Table 8-6: Sample tab, Sample Data sub-tab, Comments pane context menu (Continued)

Option Description
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Patient pane (Sample Data sub-tab for the Sample tab)
The Patient pane displays information about the patient who is associated with the sample. 
You can right-click anywhere on the information for the associated patient to open a context 
menu with the following options:

     

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Comments pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 8-6: Sample tab, Sample Data sub-tab, Comments pane context menu (Continued)

Option Description

Table 8-7: Sample tab, Sample Data sub-tab, Patient pane context menu

Option Description
Set Patient Opens the Set Patient dialog box. Select the patient that you are associating with the 

sample, and then click OK.

Figure 8-23:  Set Patient dialog box

Note: You also have the option of associating a patient with a sample from the Run tab. 
See “The Samples Pane (Run tab) Context Menu” on page 191.

Add All To Custom 
Report

Selects all the information that is displayed for the selected patient for inclusion in a 
custom report. See Chapter 10, “Geneticist Assistant Reports,” on page 265.

Add Patient External 
ID to Custom Report

Selects only the External ID for the patient for inclusion in a custom report. See Chapter 
10, “Geneticist Assistant Reports,” on page 265.

View Details Opens the Variants sub-tab on the Patient tab for the selected patient. See “Patient tab, 
Variants sub-tab” on page 158.
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Related Patients pane (Sample Data sub-tab for the Sample tab)
The Related Patients pane displays all the relatives of the patient who is associated with the 
sample. You can right-click anywhere on a related patient record to open a context menu 
with the following options for working with the patient record:

The context menu for the Related Patients pane is not enabled if the pane is blank. 
To add a patient relationship and enable this context menu, see “To use the context 
menu for a patient (Patients tab)” on page 141.

Table 8-8: Sample tab, Sample Data sub-tab, Related Patients pane context menu

Option Description
Patient Details Opens the Patient tab for the selected related patient. All the options on the Patient tab are 

now available for the related patient. See “Accessing and Reviewing Patient Records” on 
page 137.
Note: You can also double-click a patient entry to open the Patient tab.

Add New 
Relationships

The Add New Patient dialog box opens. By default, the Is Related to Existing Patient 
option is selected and unavailable. Add the needed relationships for the patient. See Step 
3 of “To add one patient at a time” on page 127.

Remove Selected 
Relationship

Deletes the selected relationship for the patient. To remove multiple relationships, 
CTRL-click as you select the relationships.

Add All To Custom 
Report

Selects all the information that is displayed for the selected patient for inclusion in a 
custom report. See Chapter 10, “Geneticist Assistant Reports,” on page 265.

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or edit the 
permissions (Can Read or Can Read and Can Write) that the specified users or groups are 
to have for the patient record. See “Setting Read and Write Permissions” on page 326.

Change Ownership Opens the Change Patient Ownership dialog box, which displays the name of the current 
owner for the patient, and an option (New Owner) for selecting a new owner for the patient 
from a list of all the currently available and active users for your Geneticist Assistant 
instance. You can change the ownership for any patient if you are an Administrator user, 
the current owner of the patient, or if you have been granted Can Read and Can Write 
permissions for the patient.

Figure 8-24:  Change Patient Ownership dialog box

Copy Copies all the information that is displayed for the selected patient to your client’s 
clipboard. You can then use standard Paste commands to paste this copied information 
into a third-party application such as Notepad.
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Compound Variant Interpretations pane
If all the variants that are included in a compound variant interpretation that has been defined 
in your Geneticist Assistant database are present in the sample, then this variant 
interpretation is displayed by name in the Compound Variant Interpretations pane. Multiple 
variant interpretations can be applicable for a given sample. To refresh the pane with the 
most recent matching interpretations at any time, click Reload. To view the details for all the 
variants that define a given variant interpretation, double-click the interpretation to open the 
Compound Variant Interpretation sub-tab. See “Compound Variant Interpretation Sub-Tab” 
on page 240.

Reports pane (Sample data sub-tab on the Sample tab)
The Reports pane displays all the reports that were generated for the selected sample and 
saved to the Geneticist Assistant database.

You can right-click anywhere on this sub-tab to open a context menu with options that are 

Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are to be 

shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To show/hide 

columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display preferences for 

variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 69.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters
Manually Opens the Filters table for the Related Patients pane. See “To filter the data that is 

displayed in a tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Related Patients pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 8-8: Sample tab, Sample Data sub-tab, Related Patients pane context menu (Continued)

Option Description

You can also select Reports > Saved Reports on the Geneticist Assistant main 
menu to open a Sample Reports tab that includes these same reports.
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identical to the options that are on context menu for the Reports pane on the Patient sub-tab 
on the Patient tab. See “Patient tab, Patient sub-tab, Reports pane” on page 154.

For detailed information about generating and saving both standard and custom 
Sample reports, see Chapter 10, “Geneticist Assistant Reports,” on page 265.
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Compound Variant Interpretation Sub-Tab
If all the variants that are included in a compound variant interpretation that has been defined 
in your Geneticist Assistant database are present in the sample, then this variant 
interpretation is displayed by name in the Compound Variant Interpretations pane on the 
Sample Data sub-tab on the Sample tab. Multiple variant interpretations can be applicable 
for a given sample. To view the details for all the variants that were used to define a given 
variant interpretation, double-click the interpretation to open the Compound Variant 
Interpretation sub-tab. 

The Compound Variant Interpretation sub-tab has the exactly the columns as the Sample 
Variant Data sub-tab and an identical context menu, but instead of displaying all the variants 
in the sample, it displays only those variants that define the given variant interpretation. (See 
“Sample Variant Data Sub-Tab” on page 212.)

Figure 8-25:  Compound Variant Interpretation sub-tab on the Sample tab

The Compound Variant Interpretation sub-tab is opened for the Sample tab only 
after you double-click a variant interpretation in the Compound Variant 
Interpretations pane on the Sample Data sub-tab on the Sample tab.
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Submission Sub-Tab
If the selected sample was part of a submission to the Geneticist Assistant customer portal, 
then the details of the submission are displayed on the Submission sub-tab. The information 
that is displayed on the Submission sub-tab and the options that are available such as 
Download Packing Slip are identical to the information that is displayed for the submission 
and the options that are available on the Submission tab that is accessed from the 
Submissions tab. 

Figure 8-26:  Submission sub-tab on the Sample tab

For detailed information about the Geneticist Assistant customer portal and the 
Submissions tab, see Chapter 12, “The Geneticist Assistant Customer Portal and 
Submissions,” on page 305.
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Quality Metric Report Sub-Tab
If a sample was included in a run for which a quality metric profile was selected, then the 
Quality Metric Report sub-tab is displayed. The sub-tab details the result metrics for the 
sample and how they compared to the specified quality metric thresholds.

• If a result metric met or exceeded a Minimum and/or Maximum quality metric threshold 
limit, then the successful value is not highlighted in the Quality Metric report.

• If a metric failed a Minimum and/or Maximum quality metric threshold, then the failed 
value is highlighted in red in the Quality Metric report.

• If a metric failed a Warning quality metric threshold limit, then this value is highlighted 
in yellow in the Quality Metric report.

Figure 8-27:  Sample tab, Quality Metric Report sub-tab
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Many options are available from the Variant tab for reviewing your data in Geneticist 
Assistant.

This chapter covers the following topics:

• “Overview of the Variant Tab” on page 245.

• “Working with Reference Information Panes on the Variant Tab” on page 256.
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Overview of the Variant Tab
The Variant tab displays detailed information for a selected variant. To open the Variant tab, 
do one of the following:

• Double-click a variant on the Variants sub-tab on the Patient tab.

• Double-click a variant on the Variant sub-tab on the Panel Statistics tab.

• Right-click a variant on the Sample Variant Data sub-tab on the Sample tab, and on the 
context menu that opens, select Variant Details.

• Double-click a variant on the Sample Variant Data sub-tab on the Sample tab.

Figure 9-1:  Variant tab

The Variant tab has two types of panes: variant information panes, which display 
user-specified information for a variant such as its pathogenicity, any comments, its artifact 
type, and so on, and reference information panes, which display information about the 
variant that has been culled from a specific reference database such as the dbSNP database. 
Every pane has a context menu associated with it. Some of the menu commands that are 
available are common to all the pane context menus, and some are pane-specific. See:

• “Variant information panes” on page 246.

• “Reference information panes” on page 254.

If any of the reference information panes are not displayed, contact SoftGenetics 
to download the latest reference files.
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Variant information panes
Variant information panes display user-specified information for a variant such as its 
pathogenicity, any comments, its artifact type, and so on. The following ten variant 
information panes are displayed on the Variant tab when it opens:

• “Variant pane” on page 247.

• “Supporting Information pane” on page 249.

• “Variant Comments pane” on page 250.

• “Variant Interpretations pane” on page 251.

• “Pathogenicity Changes pane” on page 251.

• “Artifact Changes pane” on page 251.

• “Variant Changes pane” on page 251.

• “Associated Samples pane” on page 252.

• “Variant’s Reports pane” on page 254.

• “Gene Phenotypes pane” on page 254.

With the exception of the Variant Interpretations pane, the following commands are 
displayed on the context menu for every variant information pane:

The context menu for a variant information pane is not enabled if the pane is 
blank.

Option Description
Add All To Custom 
Report

Selects all the information that is displayed in the pane for inclusion in a custom report. 
See Chapter 10, “Geneticist Assistant Reports,” on page 265.

Load Columns
Manually Opens the Select Columns dialog box in which you can select columns that are to be 

shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.
Note: For information about showing and hiding columns dynamically, see “To show/hide 

columns in a tab pane” on page 39.
Note: If you set column display preferences here, then you can display preferences for 

variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 69.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.
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Variant pane
The Variant pane is a read-only pane that lists all the same information that is displayed by 
default for the variant on the Sample Variant Data sub-tab. (See “Sample Variant Data Sub-
Tab” on page 212.) You can right-click in the pane to open a context menu that, in addition to 
the common pane commands, has the following pane-specific commands: 

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters
Manually Opens the Filters table for the pane. See “To filter the data that is displayed in a tab pane” 

on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the pane. Limits the display in the pane to only the 
data (fields) that are defined by the template. See “To filter the data that is displayed in a 
tab pane” on page 32.

Option Description

Option Description
Submit Supporting 
Hyperlink

Opens the Add Supporting Info dialog box, which, by default, displays the dbSNP web 
page for the variant. You can use the browser in this dialog box to select this web page as 
supporting information for the variant, or navigate to a different page. 

Figure 9-2:  Add Supporting Info dialog box

Note: See Step 9 of “To add supporting information for a variant” on page 256.
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Add Comment Opens the Add Variant Comment dialog box. You can add a comment for the variant in the 
Add Comment field, and then click OK. The comment is displayed in the Variant Comment 
field in the Variant pane on the Variant tab, the Variant Comments pane on the Variant tab, 
the Variant Comment field in the Variants pane on the Search Results tab, the Variant 
Comment field on the Variants sub-tab on the Patient tab, and the Variant Comment field 
on the Sample Variant Data sub-tab on the Sample tab.

Figure 9-3:  Add Variant Comment dialog box

Note: If multiple comments have been added for a variant, then with the exception of the 
Variant Comments pane on the Variant tab, only the last added comment is 
displayed in all the locations that are detailed above. All the comments that have 
been added for a variant, including the last added, are displayed in reverse 
chronological order in the Variant Comments pane on the Variant tab.

Option Description
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Supporting Information pane
The Supporting Information pane displays all the reference information and/or links that you 
have submitted as supporting information for a variant. (See “To add supporting information 
for a variant” on page 256.) You can right-click in the pane to open a context menu that, in 
addition to the common pane commands, has the following pane-specific commands: 

     

Option Description
Submit Supporting 
Hyperlink

Opens the Add Supporting Info dialog box, which, by default, displays the dbSNP web 
page for the variant. You can use the browser in this dialog box to select this web page as 
supporting information for the variant, or navigate to a different page. 

Figure 9-4:  Add Supporting Info dialog box

Note: See Step 9 of “To add supporting information for a variant” on page 256.

Delete Supporting 
Info

Deletes the supporting information. The deleted information is stored in the Geneticist 
Assistant database log. See “Reviewing the Database Log” on page 50.
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Variant Comments pane
The Variant Comments pane displays all the comments that have been added for the variant 
in reverse chronological order. If one or more comments are displayed in the Comments 
pane, then you can right-click in the pane to open a context menu that, in addition to the 
common pane commands, has the following pane-specific commands: 

The context menu for the Comments pane is not enabled if the pane is blank. To 
add a comment for this variant and enable the pane, see “Variant pane” on page 
247.

Option Description
Add Comment Opens the Add Variant Comment dialog box. You can add a comment for the variant in the 

Add comment field, and then click OK. The comment is displayed in the Variant Comment 
field in the Variant pane on the Variant tab, the Variant Comments pane on the Variant tab, 
the Variant Comment field in the Variants pane on the Search Results tab, the Variant 
Comment field on the Variants sub-tab on the Patient tab, and the Variant Comment field 
on the Sample Variant Data sub-tab on the Sample tab.

Figure 9-5:  Add Variant Comment dialog box

Note: If multiple comments have been added for a variant, then with the exception of the 
Variant Comments pane on the Variant tab, only the last added comment is 
displayed in all the locations that are detailed above. All the comments that have 
been added for a variant, including the last added, are displayed in reverse 
chronological order in the Variant Comments pane on the Variant tab.
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Variant Interpretations pane
The Variant Interpretations pane is a read-only pane that displays all the single 
interpretations that have been added for the variant. The Variant Interpretations pane does 
not have a context menu.

Pathogenicity Changes pane
The Pathogenicity Changes pane displays the history of the changes that have been made to 
the pathogenicity for the variant in reverse chronological order. When a variant is first added 
to the Geneticist Assistant database, the Pathogenicity is set to Unassigned and the 
Pathogenicity Status does not have a value. If the Pathogenicity is changed to Deleterious, 
and the Status is set to Confirmed, for example, then this change and the name of the user 
who made the change, and the date and the time of the change are recorded and displayed in 
this pane. 

Artifact Changes pane
The Artifact Changes pane displays the history of the changes that have been made to the 
artifact type for the variant in reverse chronological order. If the Artifact Type is set to 
Sequencing, for example, then this change and the name of the user who made the change, 
and the date and the time of the change are recorded and displayed in this pane. 

Variant Changes pane
The Variant Changes pane displays the history of the changes that have been made to the 
variant in reverse chronological order, for example, a change in the zygosity of the variant 
from heterozygous to homozygous. The value that was changed for the variant, the name of 

Delete Comment Opens the Delete Comment dialog box. Click OK to delete the comment for the variant 
and close the dialog box.

Figure 9-6:  Delete Comment dialog box

Option Description
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the user who made the change, and the date and the time of the change are recorded and 
displayed in this pane. 

Associated Samples pane
The Associated Samples pane lists all the samples in which the variant has been identified. 
You can right-click in the pane to open a context menu that, in addition to the common pane 
commands, has the following pane-specific commands: 

Option Description
Sample Detail Opens the Sample tab for the sample. See Chapter 8, “Geneticist Assistant Data Review - 

Sample Tab,” on page 209.

Show Samples 
Filtered by Panel

Displays all the variants in the selected samples filtered by a selected panel or panels. If 
you select this option, then the Select Panel to Filter Variants dialog box opens. You must 
select a panel or panels in this dialog box by which to filter the variants for the selected 
samples.

Figure 9-7:  Select Panel to Filter Variants dialog box

Coverage Regions Opens the Coverage Regions tab, which lists the coverage information for every region in 
the panel for the associated sample. See “Coverage Regions tab” on page 200.

Panel Statistics Opens the Panel Statistics tab. The tab has options for displaying specific information 
based on the panel that was used for a sample’s run. See “Reviewing Panel Statistics” on 
page 319.

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or edit the 
permissions (Can Read or Can Read and Can Write) that the specified users or groups are 
to have for selected samples. See “Setting Read and Write Permissions” on page 326.
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Change Ownership Opens the Change Sample Ownership dialog box, which displays the name of the current 
owner for the selected sample, and an option (New Owner) for selecting a new owner for 
the sample. You can change the ownership for any sample if you are an Administrator 
user, the current owner of the sample, or if you have been granted Can Read and Can 
Write permissions for the sample.

Figure 9-8:  Change Sample Ownership dialog box

External - Contains all the sub-menu options for viewing the sample variants in a tool that is outside Geneticist 
Assistant.

View in NextGENe Requires you to have your NextGENe installation specified in your Geneticist Assistant 
settings. (See “To configure Geneticist Assistant directories” on page 59.) If selected, then 
Geneticist Assistant browses for the folder where the VCF file for the sample is located. If 
the NextGENe project file is found in the same directory as the VCF file, then the 
NextGENe project is opened in the NextGENe Viewer. 

View in IGV Applicable if there is a corresponding BAM file (and not a NextGENe project file) in the 
same folder as the VCF file for the sample. Opens the BAM file in the third-party 
Integrative Genomics Viewer (IGV).

Export - Contains all the sub-menu options for exporting a variant.

Export to VCF Exports all the variants in the selected sample or samples (CTRL-click to select multiple 
samples) to a VCF file. You must specify both the file name and the location in which to 
save the file.

Save Sample 
Reports

Applicable for one or more samples. CTRL-click to select multiple samples. Generates an 
individual sample report for each selected sample. If a single sample is selected, then a 
default location, report name, and report type (.csv) are provided, but you can change any 
or all of these values. If multiple samples are selected, then you can select only the 
location in which to save the report. Each report is named the same as the sample and the 
report format is .csv, and you cannot change either of these values.
Note: For more information about standard reports, see Chapter 10, “Geneticist Assistant 

Reports,” on page 265.

Create Batch 
Variants Report

Generates the Batch Variants report for the selected associated sample or samples. 
(CTRL-click to select multiple samples.) See “Managing a Batch Variants Report” on page 
329.

Create Batch 
Coverage Report

Generates the Batch Coverage report for the selected associated sample or samples. 
(CTRL-click to select multiple samples.) See “Generating a Batch Coverage Report” on 
page 335.

Option Description
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Variant’s Reports pane
The Reports pane displays all the reports that were generated for the selected variant and 
saved to the Geneticist Assistant database.

You can right-click anywhere on this sub-tab to open a context menu with options that are 
identical to the options that are on context menu for the Reports pane on the Patient sub-tab 
on the Patient tab. See “Patient tab, Patient sub-tab, Reports pane” on page 154.

Gene Phenotypes pane
The Gene Phenotypes pane displays all the associated phenotypes for the gene in which the 
variant was found as pulled from the Human Phenotype Ontology database (https://
hpo.jax.org/app/).

Reference information panes
Up to the following ten reference information panes can be displayed when the Variant tab 
opens:

You can also select Reports > Saved Reports on the Geneticist Assistant main 
menu to open a Reports tab that includes these same reports.

For detailed information about generating and saving both standard and custom 
Run reports, see Chapter 10, “Geneticist Assistant Reports,” on page 265.

Database Description

OMIM Data pane Displays the information for the variant from the OMIM (Online Mendelian Inheritance in 
Man) database. 
Note: To view OMIM data, OMIM settings must be configured for your Geneticist Assistant 

installation. See “Backing up the Geneticist Assistant Database” on page 51.) 

LOVD Data pane Displays the information for the variant from the LOVD (Leiden Open Variation Database) 
database. 

World-Wide LOVD 
Data pane

Displays information for the variant from the world-wide LOVD (Leiden Open Variation 
Database) world-wide database. 

CIViC Data pane Displays information for the variant from the CIViC (Clinical Interpretations of Variants in 
Cancer) database. 

gnomAD Data pane Displays information for the variant from the gnomAD (Genome Aggregation Database) 
database.

dbSNP (*/00-All.vcf) 
pane

Displays the information for the variant from the dbSNP database.

Exome Variant 
Server (*/ESP*.vcf) 
pane

Displays the information for the variant from the Exome Variant Server database for the 
NHLBI GO Exome Sequencing Project (ESP).
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You can right-click any information in any of these reference information panes to open a 
context menu with the following options:

Exome Aggregation 
Consortium 
(ExAC.r*.*.sites.vep.
vcf) pane

Displays the information for the variant from the Exome Aggregation Consortium database 
for selected global sequencing projects.

ClinVar (*/clinvar_00-
latest.vcf) pane

Displays the information for the variant from the ClinVar database.

dbNSFP pane Displays the information for the variant from the dbNSFP database.

Database Description

The context menu for a reference information pane is not enabled if the pane is 
blank.

Option Description
Submit as 
Supporting Info

Submits the information in the field as supporting information for a variant. See “To add 
supporting information for a variant” on page 256.

Add Values to Variant 
Table

Adds values from a selected field in the Reference database to the Variant pane and the 
Variants pane on the Sample Variant Data sub-tab on the Sample tab. You can also create 
a custom formula based on multiple fields and add the resulting value to the these same 
variant panes and tables. See “To add fields from a reference database to variant tables 
and panes” on page 259 or “To add a custom field to variant tables and panes” on page 
261.
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Working with Reference Information Panes on 
the Variant Tab

A variety of options are available for working with the information that is displayed in the 
various reference information panes on the Variant tab. You can do the following:

• Add supporting information for a variant. See “To add supporting information for a 
variant” below.

• Add fields from a reference database to variant tables and panes. See “To add fields from 
a reference database to variant tables and panes” on page 259.

• Add a custom field to variant tables and panes. See “To add a custom field to variant 
tables and panes” on page 261.

To add supporting information for a variant
You can add supporting information for a variant. Typically, this is information that you used 
to determine the appropriate pathogenicity for the variant. You can reference information 
from an external database or from a web page as supporting information. The supporting 
information is displayed in the Supporting Information pane on the Variant tab. (See 
“Supporting Information pane” on page 249.) 

1. If you have not done so already, do one of the following to open the Variant tab:

• Double-click a variant on the Variants sub-tab on the Patient tab.

• Double-click a variant on the Variant sub-tab on the Panel Statistics tab.

• Right-click a variant on the Sample Variant Data sub-tab on the Sample tab, and on 
the context menu that opens, select Variant Details.

• Double-click a variant on the Sample Variant Data sub-tab on the Sample tab.

2. Do one of the following:

• To reference information from any reference track, go to Step 3. 

• To reference a specific web page, go to Step 8.

3. In the appropriate reference information pane, review the information that you are using 
for supporting information. See “Reference information panes” on page 254.

 

     

This information is included in the References folder. Use the scroll bar at the 
bottom of the pane to view the available reference information for the variant. 
Note that all reference information is not available for all variants. 
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4. Right-click any information in a pane, and on the context menu that opens, click Submit 
As Supporting Info.

The Supporting Info Submit dialog box opens. The dialog box lists all the reference 
information and the corresponding values that can be selected from the pane as 
supporting information. 

Figure 9-9:  Supporting Info Submit dialog box

5. Select the information that you are using as supporting information, and then click OK.

The Add Supporting Info dialog box closes. The information is displayed in the 
Supporting Information pane. See “Supporting Information pane” on page 249.

6. Repeat Step 3 through Step 5 for each piece of reference information that you are adding 
as supporting information.

7. Optionally, continue to Step 8 to also add supporting information for the variant from a 
web page.

8. Right-click anywhere on the Variant pane or the Supporting Information pane, and on 
the context menu that opens, click Submit Supporting Hyperlink.

The Add Supporting Info (for a web page) dialog box opens. By default, the dialog box 
displays the dbSNP page for the variant. See Figure 9-10 on page 258.
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Figure 9-10:  Add Supporting Info dialog box

9. Do one of the following:

• Click the Use This Link icon  to accept the NCBI dbSNP page. The URL is 
added under Supporting Info on the dialog box.

• Enter a new URL, click the Go To icon  to navigate to the web page, and then 
click the Use This Link icon  to accept the web page. The URL is added under 
Supporting Info on the dialog box.

10. Click OK.

The Add Supporting Info dialog box closes. The URL is displayed in the Supporting 
Information pane on the Variant tab. See “Supporting Information pane” on page 249.

     

You can also use the Add Supporting Info dialog box like a standard web browser 
and search for the necessary URL.
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To add fields from a reference database to variant tables and 
panes

You can add fields from a reference database to the Variant pane and the Variants pane on the 
Sample Variant Data sub-tab on the Sample tab. Fields in the reference database can contain 
single values, or they can contain multiple values. For example, the Allele Frequency (AF) 
field in the ExAC Reference database contains a frequency value for the variant nucleotide 
and a frequency value for the reference nucleotide. Depending on the options that you 
specify, the field can be added with a just a single value (for example, the value for just the 
variant nucleotide), or the field can be added with multiple values (the values for both the 
variant nucleotide and the reference nucleotide). 

1. If you have not done so already, do one of the following to open the Variant tab:

• Double-click a variant on the Variants sub-tab on the Patient tab.

• Double-click a variant on the Variant sub-tab on the Panel Statistics tab.

• Right-click a variant on the Sample Variant Data sub-tab on the Sample tab, and on 
the context menu that opens, select Variant Details.

• Double-click a variant on the Sample Variant Data sub-tab on the Sample tab.

2. Right-click in the appropriate reference information pane, for example, the ExAC Data 
pane, and on the context menu that opens, click Add Values to Variant Table.

The Add Values to Variant Table dialog box opens. The dialog box lists all the fields in 
the selected Reference database. It also provides a description of the value that is 
contained in each field.

Figure 9-11:  Add Values to Variant Table dialog box
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3. Do one of the following to select a field:

• Double-click the field.

• Right-click the field, and on the context menu that opens, click Add Value(s).

The Field Configuration dialog box opens. You use the options on the dialog box to 
specify which values in the selected field are to be added to the various variant panes and 
tables. 

Figure 9-12:  Field Configuration dialog box

4. Select the values in the field that are to be added to the various panes and tables. The 
value that is selected by default is determined by how the field is defined in the VCF file 
for the database.

Value Description and Options
R (one value for each possible 
allele including the reference)

The field contains multiple values, with one value for each 
possible allele, including the reference allele.
• All alleles - Add all values for all possible alleles (multiple 

values)
• Matching Alt allele - Add the value only for the matching 

alternate allele (single value)
• Ref allele - Add the value only for the reference allele (single 

value)

A (one value per alternate allele The field can contain multiple values, with one value for each 
alternate allele.
• All alt alleles - Add all values for all alternate alleles (multiple 

values possible if more than one alternate allele exists)
• Match Alt allele - Add the value only for the matching 

alternate allele (single value)

Fixed Value • All - Add all values (multiple values)
• Fixed - Add only the specified number of fixed values, 

specified value - 1 for the first value, 2 for the second, and so 
on.

. (number of possible values 
varies, is unknown, or is 
unfounded)

Based on different variants, the number of values in the field can 
vary. 
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5. Click OK.

The Field Configuration dialog box closes. The Add Values to Variant Table dialog box 
remains open.

6. Optionally, to change the name of a Field tab, select the tab to make it the active tab, and 
then in the Column Name field, enter a new name.

7. Optionally, to add another field, click the (+) tab to open a new blank Field tab, and then 
repeat Step 3 through Step 6 to add the field to the various panes and tables for the 
selected variant. Repeat these steps as many times as needed to add all the necessary 
fields.

8. Click OK on the Add Values to Variant Table dialog box.

The selected field is added to the various variant tables and panes. The dialog box closes. 
The Variant tab remains open.

To add a custom field to variant tables and panes
You can combine multiple fields in a reference database to create a custom field, and then 
add the custom field and its value to the Variant pane and the Variants pane on the Sample 
Variant Data sub-tab on the Sample tab. When you select a reference database field to use for 
creating a custom field, if the field contains multiple values, then you can select only a single 
value from the field. For example, the Allele Frequency (AF) field in the ExAC Reference 
database contains a frequency value for the variant nucleotide and a frequency value for the 
reference nucleotide. If you select the AF field, then you must select either the frequency 
value for the variant nucleotide or the frequency value for the reference nucleotide. You 
cannot select both values.

1. If you have not done so already, do one of the following to open the Variant tab:

• Double-click a variant on the Variants sub-tab on the Patient tab.

• Double-click a variant on the Variant sub-tab on the Panel Statistics tab.

• Right-click a variant on the Sample Variant Data sub-tab on the Sample tab, and on 
the context menu that opens, select Variant Details.

After you select the values that are to be added, the following happens:
• A tab that is named the same as the selected field, a Field tab, opens below the 

list of available fields.
• A preview of the selected field and its values is displayed in the Work Area of the 

dialog box (the blank area below the Field tab).
• A preview of the selected field and its values is also displayed in the Preview 

pane (the bottom pane of the dialog box).

If you add a field in error, then right-click it in the Work Area, and on the context 
menu that opens, click Remove. 
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• Double-click a variant on the Sample Variant Data sub-tab on the Sample tab.

2. Right-click in a Reference pane, and on the context menu that opens, click Add Values to 
Variant Table.

The Add Values to Variant Table dialog box opens. The dialog box lists all the fields in 
the selected Reference database. It also provides a description of the value that is 
contained in each field. 

Figure 9-13:  Add Values to Variant Table dialog box

3. Do one of the following to select a field:

• Double-click the field.

• Right-click the field, and on the context menu that opens, click Add Value(s).

The Field Configuration dialog box opens. You use the options on the dialog box to 
specify the field value that you are using for the custom formula.

Figure 9-14:  Field Configuration dialog box
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4. Select the value in the field that you are using in the formula for the custom field. The 
value that is selected by default is determined by how the field is defined in the VCF file 
for the database.

5. Click OK.

6. Do one of the following:

• Click in the Add Text field, enter the needed text (for example, if you are creating a 
field to show a ratio, you might select a forward slash), and then click Add Text.

The text is displayed on the Field tab and in the Work Area and the Preview pane.

• To create a formula, select Formula, and then select the operator for the formula. 
Parentheses are also available for setting the order of operations in the formula.

As you create the formula, the following happens:

Value Description and Options
R (one value for each 
possible allele 
including the 
reference)

The field contains multiple values, with one value for each possible allele, 
including the reference allele. Therefore, the values that you can select 
are the following:
• Matching Alt allele - Add the value only for the matching alternate allele 

(single value)
• Ref allele - Add the value only for the reference allele (single value)

A (one value per 
alternate allele

The field can contain multiple values, with one value for each alternate 
allele. Therefore, the values that you can select are the following:
• All alt alleles - Add all values for all alternate alleles (A single value if 

only one alternate allele exists; however, multiple values possible if 
more than one alternate allele exists)

• Match Alt allele - Add the value only for the matching alternate allele 
(single value)

Fixed Value • Fixed - Add only the specified number of fixed values specified value - 1 
for the first value, 2 for the second, and so on.

. (number of possible 
values varies, is 
unknown, or is 
unfounded)

Based on different variants, the number of values in the field can vary. 

After you select the value that you are adding, the following happens:
• A tab that is named the same as the selected field, a Field tab, opens below the 

list of available fields.
• A preview of the selected field and its value is displayed in the Work area of the 

dialog box (the blank area below the Field tab).
• A preview of the selected field and its value is also displayed in the Preview 

pane (the bottom pane of the dialog box).
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• A preview of the formula, including the selected fields, their values, and the 
operators, is displayed on the Field tab and in the Work area of the dialog box 
(the blank area below the tabs).

• The Preview pane displays the current value for the formula. 

7. Repeat Step 3 through Step 6 as needed to produce the final custom field.

As you select multiple fields for the custom field, the display on the Field tab and in the 
Work Area and the Preview pane are dynamically updated.

8. Optionally, to add another custom field, click the (+) tab to open a new blank tab, and 
then repeat Step 3 through Step 7. Repeat these steps as many times as needed to add all 
the necessary custom fields.

9. Optionally, to change the name of the Field tab, select the tab to make it the active tab, 
and then in the Column Name field, enter a new name for the tab.

10. Click OK.

The Field Configuration dialog box closes. The Add Values to Variant Table dialog box 
remains open. 

11. Click OK on the Add Values to Variant Table dialog box.

The custom fields are added to the various variant tables and panes. The dialog box 
closes. The Variant tab remains open.

If you add a field, a text separator, or an operator in error, then right-click it in the 
Work Area, and on the context menu that opens, click Remove. 
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As discussed in the various data review chapters in this manual, after a run is successfully 
completed, many options are available for reviewing the data on the various tabs and panes 
on the Geneticist Assistant main window. Two options are available for generating an output 
file of the data: you can generate a standard report, or you can select some or all of the data 
for inclusion in a custom report. You can also use the Report Designer to create a Sample 
PDF Report template. A Sample PDF Report template not only specifies the data that a 
Sample PDF report is to contain, but also the layout of the report.

This chapter covers the following topics:

• “Generating a Standard Report” on page 267.

• “Generating a Custom Report” on page 271.

• “Designing a Sample PDF Report Template” on page 274.

• “Generating a Sample PDF Report” on page 286.
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Generating a Standard Report
To generate an output file of the data after a run is successfully completed, you generate a 
standard report. A standard report includes all the data that is displayed in a selected pane or 
panes on a data tab, for example, the Samples pane on the Run tab. Six different standard 
reports are available in Geneticist Assistant:

• Run report—You generate the standard Run report from the Run tab. The report includes 
all the information that is displayed in the Samples pane and/or the Run's Status Changes 
pane on the tab.

• Coverage Regions report—You generate the Coverage Regions report from the Coverage 
Regions tab. The report includes all the information that is displayed on the tab.

• Panel Statistics reports—You generate a standard Panel Statistics report from the Panel 
Statistics tab. The report includes all the information that is displayed in any of the 
following four sub-tabs that you specify—Coverage Regions, Samples, Variants, and/or 
Patients.

• Sample report—You generate a standard Sample report from the Sample tab. The report 
includes all the information that is displayed in the panes that you specify— the Variants 
pane on the Sample Variant Data sub-tab and/or any of the four panes (Status Changes, 
Patient, Related Patients, or Comments) on the Sample Data sub-tab.

• Variant report—You generate a standard Variant report from the Variant tab. The report 
includes all the information that is displayed in any of the following five panes that you 
specify—Variant, Pathogenicity Changes, Artifact Changes, Variant Changes, Variant 
Comments, Supporting Information, and/or Associated Samples.

• Action List report—You generate the Action List report from the Action List tab. The 
report includes all the information that is displayed in the panes that you specify—the 
Variants pane and/or the Coverage Regions pane.

To generate a standard report
1. Open the appropriate tab. See:

• Chapter 7, “Geneticist Assistant Data Review - Run Tab,” on page 187.

• “Coverage Regions tab” on page 200.

• The Panel Statistics tab. See “Reviewing Panel Statistics” on page 319.

• Chapter 8, “Geneticist Assistant Data Review - Sample Tab,” on page 209.

• Chapter 9, “Geneticist Assistant Data Review - Variant Tab,” on page 243.

To generate an Action List report, you must first create the Action List to open the 
Action List tab. See “Creating an Action List” on page 338.
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2. Do one of the following:

The appropriate report dialog box, for example, the Run Report or Sample dialog box, 
opens. All the data that can be selected for inclusion in the report is displayed in the 
Sections and Tables pane of the dialog box. 

Figure 10-1:  Run Report dialog box

3. Optionally, to remove a sub-tab or pane from the report, right-click the row for the 
sub-tab or pane, and then click “Remove Selected Row” to remove the data from the 
indicated pane or sub-tab from inclusion in the report.

Table 10-1: Available standard reports

Report to be Generated Action
Run On the Geneticist Assistant main menu, click Reports > Run 

Report.

Coverage Regions On the Geneticist Assistant main menu, click Reports > 
Coverage Regions Report.

Panel Statistics On the Geneticist Assistant main menu, click Reports > Panel 
Statistics Report.

Sample On the Geneticist Assistant main menu, click Reports > Sample 
Report.

Variant On the Geneticist Assistant main menu, click Reports > Variant 
Report.

Action List On the Geneticist Assistant main menu, click Reports > Action 
List report.
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4. Leave the report type set to the default value of ..csv, or select .xml.

5. Optionally, to include active hyperlinks in the saved reports, select Export Hyperlinks.

6. Optionally, for reports that contain variants, such as the Sample report, the Variant 
report, or the Action List report, select one or both of the following:

• HGVS Coding/Translation: separate row, separate columns: If multiple transcripts 
are shown for the HGVS Coding or HGVS Protein for a variant, then select this 
option to create a separate row for each transcript and two separate columns—one 
for the transcript ID and one for the actual call—within each row.

• Report Supporting Info For Variants: If supporting information has been added for 
any of the variants for which you are generating the report, then select this option to 
include this supporting information in a separate Supporting Information section in 
the report.

7. Do any or all of the following:

Only the data columns that are shown in the selected sub-tabs or panes at the time 
that the report is generated are included in the report. Hidden data columns are 
not included. See “To show/hide columns in a tab pane” on page 39.

Table 10-2: Standard report options

Option Description
Click Preview To preview the report in the Preview pane on the Report dialog box before you 

print it and/or save it. After you click Preview, two new options become available:
• Close Preview—Close the Preview and leave a blank Report dialog box 

open.
• Refresh—Refresh the preview in real time.

Click Save As To save the report. You must specify the name of the report and the location for 
the saved report.

Click Print To print the report.
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8. Click Close to close the Report dialog box.

Save to 
Database

To save the report to the Geneticist Assistant database. When you select this 
option, a Report Name dialog box opens. Regardless of the options that were 
selected for the report, the same default name is displayed for the report. For 
example, if you generate a standard Sample report, then the default report name 
is always the sample name.

Figure 10-2:  Report Name dialog box

Note: If you have previously saved a report with the default name, then you can 
enter a new name to distinguish the new report from the previously saved 
report.

Note: If filters were applied to the data for which you are generating the report, then these filters 
are explicitly displayed in a separate Filters Applied section in the report. 

Table 10-2: Standard report options (Continued)

Option Description
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Generating a Custom Report
To generate a custom output file of the data after a run is successfully completed, you can 
generate a custom report. A custom report contains only selected data that you specify from a 
data tab or tabs. 

To generate a custom report
1. Open the appropriate tab. See:

• Chapter 7, “Geneticist Assistant Data Review - Run Tab,” on page 187.

• “Coverage Regions tab” on page 200.

• The Panel Statistics tab: See “Reviewing Panel Statistics” on page 319.

• Chapter 8, “Geneticist Assistant Data Review - Sample Tab,” on page 209.

• Chapter 9, “Geneticist Assistant Data Review - Variant Tab,” on page 243.

2. Right-click the data that are you including in a custom report, and then select an 
appropriate option: 

• Add Selected < > to Custom Report—Adds only the data that you select to the 
custom report. You must CTRL-click to select multiple items for inclusion in the 
report.

• Add All to Custom Report—Adds all the data that is currently displayed in the pane 
to the custom report.

     

When you generate custom report, you specify the data that you are including in 
the report, but the report is generated according to a standard layout and format. 
You also have the option of using the Report Designer to generate a custom PDF 
report for which you not only select the data, but also specify the layout and 
format. See “Designing a Sample PDF Report Template” on page 274.

To generate an Action List report, you must first create the Action List to open the 
Action List tab. See “Creating an Action List” on page 338.

For both options, only the columns that are shown in the pane can be selected for 
inclusion in the report. Hidden data columns cannot be selected. See “To show/
hide columns in a tab pane” on page 39.
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3. On the Geneticist Assistant main menu, click Reports > Custom Report.

The Custom Report dialog box opens. All the data that you are including in the report is 
displayed in the Sections and Tables pane of the dialog box. 

Figure 10-3:  Custom Report dialog box

4. Optionally, if data has been selected in error for the custom report, or you want to 
remove some selected data before you generate the report, right-click the entry in the 
Sections and Tables pane, and on the context menu that opens, click Remove Selected 
Row.

5. Leave the report type set to the default value of ..csv, or select .xml.

6. Optionally, to include active hyperlinks in the saved reports, select Export Hyperlinks.

7. Optionally, for reports that contain variants, such as the Sample report, the Variant 
report, or the Action List report, select one or both of the following:

• HGVS Coding/Translation: separate row, separate columns: If multiple transcripts 
are shown for the HGVS Coding or HGVS Protein for a variant, then select this 
option to create a separate row for each transcript and two separate columns—one 
for the transcript ID and one for the actual call—within each row.

• Report Supporting Info For Variants: If supporting information has been added for 
any of the variants for which you are generating the report, then select this option to 

If you previously generated a custom report, and you did not click Clear All before 
you clicked Cancel, or closed the report dialog box, then any new information that 
you select on any tab for inclusion in a custom report is simply appended to this 
existing report. 
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include this supporting information in a separate Supporting Information section in 
the report.

8. Do any or all of the following:

9. Click Clear All.

10. Click Close to close the Report dialog box.

Table 10-3: Custom report options

Option Description
Click Preview To preview the report in the Preview pane on the Report dialog box before you 

print it and/or save it. After you click Preview, two new options become available:
• Close Preview—Close the Preview and leave a blank Report dialog box 

open.
• Refresh—Refresh the preview in real time.

Click Save As To save the report. You must specify the name of the report and the location for 
the saved report.

Click Print To print the report.

Save to 
Database

To save the report to the Geneticist Assistant database. When you select this 
option, a Report Name dialog box opens. Regardless of the options that were 
selected, the report name is always given the same default name, 
Custom_Report.

Figure 10-4:  Report Name dialog box

1. Rename the report.
2. Click OK.
Note: You should rename the report, even though you are not required to do so. 

Each custom report is saved at its own entry with a unique date and 
timestamp in the Geneticist Assistant database; however, if you do not 
change the report name, then each entry is also displayed with the same 
name in the appropriate Reports pane and therefore, one entry is not 
distinguishable from another.

This ensures that information that is selected for a new custom report is not simply 
appended to an existing report.
Geneticist Assistant User’s Manual 273



Chapter 10
Geneticist Assistant Reports
Designing a Sample PDF Report Template
A Sample PDF report template specifies not only the data that a Sample PDF report is to 
contain, but also the layout of the report. The PDF Report Designer provides a user-friendly 
interface for building and saving a robust custom report template.You can then select this 
template to generate the corresponding Sample PDF report for specific data in your 
Geneticist Assistant database. The PDF Report Designer option is available from the Reports 
menu only from an open Sample tab: Open a Sample tab, and then on the Geneticist 
Assistant main menu, select Reports > PDF Report Designer.

The PDF Report Designer user interface

When you are designing a Sample PDF report template, you have two parts to the design. 
You must specify the filters and sort order for the table of variants that is contained in a 
Sample PDF report that is based on the template, and then you must design the report 
template. You specify the filters and sort order in the PDF Report Designer Data Sources 
dialog box, and you design the report template in the PDF Report Designer dialog box. The 
PDF Report Designer Data Sources dialog box opens first after you select the PDF Report 
Designer option on the Reports menu. It displays a placeholder for the table of variants with 
the following default values:

• Filter - None. The table of variants is not filtered in the Sample PDF report.

• First sort and Sort Order - The table of variants is sorted first by Chromosome and 
Chromosome Position (Chr:ChrPos) in ascending order (Asc).

• Second Sort and Sort Order - The table of variants is sorted second by Pathogenicity in 
ascending order.

Figure 10-5:  PDF Report Designer Data Sources dialog box

     

This section is designed to provide an introduction to the basics of using the PDF 
Report Designer to design a Sample PDF Report template. For assistance with 
advanced functions and/or designing a report template, contact 
tech_support@softgenetics.com.
274 Geneticist Assistant User’s Manual

mailto:tech_support@softgenetics.com?subject=Customer Support Inquiry


Chapter 10
Geneticist Assistant Reports
You can leave the default values as-is, or you can change any or all of the values. To change 
the Filter option, a Sort option, or a Sort Order option, double-click in the appropriate field to 
open a dropdown list, and then select a new value. 

• Filter - Select from a list of Variant Filters (displayed by name) that you have added to 
the Geneticist Assistant or that other users have added to the database and made available 
to all users. 

• Sort - The available sort options are pulled from the variant annotation columns of the 
Sample Variant Data sub-tab columns.

• Sort Order - Two values are available, ascending (Asc) and descending (Desc).

After you have set the values for the table of variants, then at the bottom of the PDF Report 
Designer Data Sources dialog box, click Show Designer to open the PDF Report Designer. 
When the PDF Report Designer opens, all panes other than the Data Browser pane and Script 
pane are blank. The Report Structure pane displays a placeholder for adding a new object to 
the first page of the report template.
Figure 10-6:  PDF Report Designer

Table 10-1: PDF Report Designer user interface

Option Description
1 Object Inspector toolbar. Contains options for adding objects, such as a text field, to a 

report page. Hold your mouse pointer over an icon on the toolbar to open a tooltip 
that explains the icons’ function. See “Object Inspector toolbar” on page 276.

2 Object toolbar. Contains options for working with objects on a report page, such as 
aligning objects or snapping objects to the grid. Hold your mouse pointer over an icon 
on the toolbar to open a tooltip that explains the icons’ function. See “To add and 
arrange Data band items” on page 278.
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Object Inspector toolbar
The Object Inspector toolbar contains options for adding objects such as a text field to a 
report template page. Hold your mouse pointer over an icon on the toolbar to open a tooltip 
that explains the icon’s function. Table 10-2 below provides an overview of the some of the 
relevant icons on the toolbar.

     

3 Report Structure pane. Lists all the bands and objects that are displayed on a 
currently opened page of a Sample PDF Report template.

4 Work Area. You build a Sample PDF Report template in the Work Area. See “Sample 
PDF Report template layout” on page 277.

Table 10-2: Object Inspector toolbar

Icon Description
Report bands icon - Opens a Bands dropdown list which displays all the different 
types of bands that you can add to a Sample PDF Report template.

Text Item icon - Use this icon to add a text field to a Data band.

Chart Item icon - Use this icon to add a chart to a Data band.

Image Item icon - Use this icon to add an image to a Data band. Allowed image 
formats are .png, .bmp, and .jpeg/.jpg.

Delete Item icon - Use this icon to delete a selected item or image placeholder from a 
Data band.
Note: To delete an image from a Data band, but leave the image placeholder, you 

must use the Delete Image icon in the Object Inspector. See “To add an image 
to a Data band” on page 281.

Table 10-1: PDF Report Designer user interface

Option Description
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Sample PDF Report template layout
A Sample PDF Report template is built around a single data table or multiple data tables 
referred to as Data bands. Any Data band can have an associated Data header band and/or a 
Data footer band. Other optional components of a custom report template include the 
following: Report Header, Report Footer, Page Header, Page Footer, SubDetail, 
SubDetailHeader, SubDetail Footer, GroupHeader, and GroupFooter.
Figure 10-7:  Sample PDF Report template in the Work Area of the Report Designer

After you add the Data bands for a custom report template, you then specify the database and 
or/ text fields that are to be included in each band. You can also add one or more images to a 
band. You can also arrange the items in a Data band as you are adding them to the band or 
after you have added them to the band. For example, you can align all text fields vertically. 
After you have designed the template, you can then save the report template to the Geneticist 
Assistant database. See any of the following for a high-level description of building a 
Sample PDF Report template:

• “To add Data bands to a Sample PDF Report template” below.

• “To add and arrange Data band items” on page 278.

• “To save a new Sample PDF Report template” on page 283.

To add Data bands to a Sample PDF Report template
You can add all the required Data bands for a report template, and then add the required 
fields and/or images to each Data band, or you can add one Data band at a time and then the 
fields and/or images for the band. Before you can add a Data band header or Data band 
footer, you must have the Data band added to the template and you must select it. 
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1. If you have not done so already, open the Sample tab.

2. On the Geneticist Assistant main menu, select Reports > Report Designer.

The PDF Report Designer Data Sources dialog box opens.

3. Leave the default data source values as-is, or edit or all of the values as appropriate, and 
then at the bottom of the dialog box, click Show Designer. 

The PDF Report Designer opens. When the Report Designer opens, it is blank. The 
Work Area displays the first page (Page 1) for the report. 

4. For each Data band that you are adding to the report template, do the following: 

a. If you are adding a Data header or Data footer to a Data band, then click the Data 
band to select it.

The band is highlighted in red, with “grab” handles (red circles) displayed on its 
outline.

b. On the Object Inspector toolbar, click the Report bands icon.

A Bands menu opens.

c. On the Band menu that opens, click the appropriate band type, for example, Data.

The band is added to Page 1 of the report in the Work Area, and it is automatically 
selected. The band is labeled as <band type(n)>, for example, ReportHeader1.

Figure 10-8:  Data band added for a Sample PDF Report template

5. Continue to “To add and arrange Data band items” below.

To add and arrange Data band items
After you add a Data band to a Sample PDF Report template, you can add a variety of 
different items to the band, such as a database field, a text field, and/or an image. Options are 
also available for arranging the items as you add them to the Data band and/or after you add 
them to the Data band, for example, aligning items to the grid, or horizontally aligning all 
objects in the Data band. The following sections provide a high-level overview of adding and 
arranging these various Data band items.

For information about the PDF Report Designer Data Sources dialog box, and the 
values that you can set in this dialog box, see “The PDF Report Designer user 
interface” on page 274.
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To add a database field to a Data band
The Data Browser pane displays all the data sources (fields) that are stored in the Geneticist 
Assistant database that you can include in a Sample PDF Report template. The data sources 
are organized by data type (tabs), with each data source further organized based on the 
information that is available for the data type. Five data types are available: Panel, Patient, 
Run, Sample, and Variants. To add a database field to a report template, do the following:

In the Data Browser pane, expand the data type to see its available fields, and then drag and 
drop a selected field on to a Data band.
Figure 10-9:  Adding a database field to a Data band

You can add multiple database fields to the Data band, as well as text fields and/or images. 
You can also arrange the fields as you add them or after you add them. If you are done 
designing the report template, then you can save the template. See:

• “To add a text field to a Data band” below.

• “To add an image to a Data band” on page 281.

• “To arrange items in a Data band” on page 282.

• “To save a new Sample PDF Report template” on page 283.

To add a text field to a Data band
A Text item is a text field in which you can enter free text. To add a text field to a report 
template, to the following:

1. On the Object toolbar, click the Text Item icon, and then move your mouse pointer to the 
appropriate location in the Data band. 

A blank Text item placeholder is displayed.

Figure 10-10:  Blank text item placeholder 
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2. Click to place the text field in the selected location.

The text field is automatically selected, and resizing handles are displayed on its outline.

Figure 10-11:  Placed text field

3. Double-click the selected text field.

The Text Item Editor dialog box opens. 

Figure 10-12:  Text Item Editor dialog box

4. In the blank Content pane, enter the text for the field, and then click OK.

The Text Item Editor dialog box closes. The content that you entered for the text field is 
displayed in the field on the report template.

Figure 10-13:  Text in text field

You can add multiple text fields to the Data band, as well as database fields and/or images. 
You can also arrange the fields as you add them or after you add them. If you are done 
designing the report template, then you can save the template. See:

• “To add a database field to a Data band” on page 279.

• “To add an image to a Data band” on page 281.

• “To arrange items in a Data band” on page 282.

• “To save a new Sample PDF Report template” on page 283.
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To add an image to a Data band
In addition to database fields and free text fields, you can add images in a PNG (.png) 
format, BMP (.bmp) format or JPEG/JPG (.jpeg/.jpg), to a report band. 

1. On the Objects toolbar. click the Image Item icon, and then move your mouse pointer to 
the appropriate location in the Data band. 

An Image item placeholder is displayed.

2. Click to place the image placeholder in the selected location.

The image placeholder is automatically selected, and resizing handles are displayed on 
its outline.

Figure 10-14:  Image placeholder in a Data band

3. In the Object Inspector pane, scroll to the image field, and then click in the field. 

Two icons are displayed in the image field: The left icon is the Open Image icon and the 
right icon is the Delete Image icon.

Figure 10-15:  image field icons in the Object Inspector

4. Click the Open Image icon, and then in the Open dialog box, browse to and select the 
image that you are adding.

The Open Image dialog box closes, and the selected image replaces the “Image” 
placeholder text.

     

If you add an incorrect image, or want to remove an image from a Data band, then 
click the image to select it, and in the image field in the Object Inspector pane, 
click the Delete Image icon. To delete the image placeholder, select it, and then on 
the Object toolbar, click the Delete Item icon.
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You can add multiple images to the Data band, as well as add database fields and/or text 
fields. You can also arrange the fields as you add them or after you add them. If you are done 
designing the report template, then you can save the template. See:

• “To add a database field to a Data band” on page 279.

• “To add a text field to a Data band” on page 279.

• “To arrange items in a Data band” below.

• “To save a new Sample PDF Report template” on page 283.

To arrange items in a Data band
The Object toolbar contains options for working with objects on a report template page, such 
as aligning objects or snapping objects to the grid. You can hold your mouse pointer over an 
icon on the toolbar to open a tooltip that explains the icons’ function. Table 10-3 below 
describes the icons on this toolbar.

Table 10-3: Object toolbar icons

Icon Description
Use Grid icon - Displays a grid in each Data band with dimensions that are based on 
the size of the Data band. Limits the size and position of items in the Data band to the 
grid’s dimensions.

Use Magnet icon - Aligns objects in the Data band to each other based on the height, 
width, and vertical and horizontal position of a selected object. The first item that you 
select in a Data band with this icon selected is the object to which all other objects are 
aligned. 

Bring to top icon - If two or more items overlap in a Data band, then select the item 
that you are bringing to the top, and then click this icon.

Send to back icon - If two or more items overlap in a Data band, then select the item 
that you are sending to the back, and then click this icon.

Align to left icon - CTRL-click to select multiple items, and then click this icon to align 
the left edges of all selected items to the left edge of the first selected item. 

Align to right icon - CTRL-click to select multiple items, and then click this icon to align 
the right edges of all selected items to the right edge of the first selected item.

Align to vertical center - CTRL-click to select multiple items, and then click this icon to 
align the vertical centers of all selected items to the vertical center of the first selected 
item.

Align to top icon - CTRL-click to select multiple items, and then click this icon to align 
the top edges of all selected items to the top edge of the first selected item.

Align to bottom icon - CTRL-click to select multiple items, and then click this icon to 
align the bottom edges of all selected items to the bottom edge of the first selected 
item.
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After you have arranged the items in a report template, you can continue adding other items 
as needed, or if you are done designing the report template, then you can save the template. 
See:

• “To add a database field to a Data band” on page 279.

• “To add a text field to a Data band” on page 279.

• “To add an image to a Data band” on page 281.

• “To save a new Sample PDF Report template” below.

To save a new Sample PDF Report template
After you have designed the Sample PDF Report template, you can then save the report 
template to the Geneticist Assistant database as new template.

1. On the PDF Report Designer dialog box main menu, click File > Save Report.

The Save Report Template dialog box opens. The dialog box displays all the saved 
Sample PDF Report templates by name.

Figure 10-16:  Save Report Template dialog box

Align to horizontal center - CTRL-click to select multiple items, and then click this icon 
to align the horizontal centers of all selected items to the horizontal center of the first 
selected item.

Set same height icon - CTRL-click to select multiple items, and then click this icon to 
set the heights of all selected items to the height of the first selected item.

Set same width icon - CTRL-click to select multiple items, and then click this icon to 
set the widths of all selected items to the width of the first selected item.

For other options for working with a report template, such as editing an existing 
report template, see “Other PDF Sample Report Template options” on page 284.

Table 10-3: Object toolbar icons (Continued)

Icon Description
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2. In the Template Name field, enter a name for the report template.

3. Click Save.

The Save Report Template dialog box closes. The report template is saved to the 
Geneticist Assistant database. The PDF Report Designer dialog box remains open.

4. In the upper right corner of the PDF Report Designer dialog box, click the Close (x) 
button to close the dialog box.

The PDF Report Designer Data Source dialog box remains open.

5. In the upper right corner of the PDF Report Designer Data Sources dialog box, click the 
Close (x) button to close the dialog box, and return to the Geneticist Assistant main 
window.

Other PDF Sample Report Template options
In addition to saving a PDF Sample Report template as a new template, the following options 
are available from the File menu on the PDF Report Designer dialog box:

• New Report - Clears all items from the Work Area and leaves the Work Area blank in 
preparation for designing a new Sample PDF Report template.

• Load Report - Opens the Load Report Template dialog box. The dialog box displays all 
the saved Sample PDF Report templates by name. You can select a report template from 
this list of saved templates, and then click Load to close the dialog box and load the report 
in the PDF Report Designer Report dialog box.

Figure 10-17:  Load Report Template dialog box

• Save Report - Saves the currently loaded Sample PDF Report template without changing 
its name. Any changes that you make and save overwrite the existing report template.

• Save as - Opens the Save Report Template dialog box. The current name for the report 
template is displayed in the Template name field. You can enter a new template name to 
save the report template as a new template. 
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• Render report - Generates an onscreen preview of the Sample PDF report. The report 
demonstrates the format and the contents of any Sample PDF report that will be generated 
based on this report template. A toolbar is displayed at the top of the Preview dialog box 
with icons for working with the preview, such as zooming in or zooming out the preview. 
Hold your mouse pointer over an icon on the toolbar to open a tooltip that explains the 
icons’ function. 

Figure 10-18:  Sample PDF Report Template preview

Save As is a useful option for creating a new report template by editing an existing 
template, and then saving the template with a new name. You do not have to create 
an entirely new report template.
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Generating a Sample PDF Report
A Sample PDF Report details specific information about the variants that are found in the 
sample based on a Sample PDF Report template. You can generate a Sample PDF report 
from the following locations:

• Sample tab. (From the Reports menu with the Sample tab open.)

• Runs tab context menu.

• Run tab context menu.

When you generate the report, the report is saved in as a PDF, and you cannot change this 
format. You must specify a name and location in which to save the report.

To generate a Sample PDF report
1. Open the Sample tab for the appropriate sample. See “Overview of the Sample Tab” on 

page 211.

2. On the Geneticist Assistant main menu, click Reports > Sample PDF Report.

A sub-menu opens that displays all the Sample PDF Report templates that have been 
saved to the Geneticist Assistant database. See “Designing a Sample PDF Report 
Template” on page 274.

3. Select the Sample PDF Report template.

The Save Sample PDF Report dialog box opens. 

4. Select a location in which to save the report, enter a file name, and then click Save.

The Save Sample PDF Report dialog box closes and the report is generated and saved in 
the selected location.
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Geneticist Assistant contains several tools for working with and analyzing your sample data, 
including a tool for building a BED file, a tool for converting a VCF file to a BED file, a tool 
for managing pathogenicity changes, a tool for specifying pathogenicities for specific 
variants in a panel, a tool for finding samples in your Geneticist Assistant that contain 
specific variants, and a tool for combining BAM files into a single sample.

This chapter covers the following topics:

• “Building a BED File with the BED File Builder Tool” on page 289.

• “Convert VCF File to a BED File Tool” on page 293.

• “Deleting Pathogenicity Changes with the Delete Pathogenicity Changes Tool” on page 
295.

• “Importing Variants with the Import Variants Tool” on page 297.

• “Find Samples with Variants Tool” on page 301.

• “Merging BAM Files with the Merge BAM Files Tool” on page 303.
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Building a BED File with the BED File Builder 
Tool

You use BED files to create panels for Geneticist Assistant. A BED file defines the genomic 
regions that are targeted for your particular study or test, which are referred to as panel 
regions. If do not have a BED file for a panel, you can use the BED File Builder tool to build 
one based on the information that you specify. 

To build a BED file with the BED File Builder tool
1. On the Geneticist Assistant main menu, click Tools > Build BED file.

The BED File Builder dialog box opens.

Figure 11-1:  BED File Builder dialog box

2. Do one of the following:

• To manually specify the gene name, in the Gene Name field, enter the name for the 
gene that is in the panel, and then click Add Gene. Repeat this step for each gene that 
is in the panel.

As you enter the gene name, a list of all genes in the database that meet the search 
criteria is dynamically updated. You can select the gene from this list. The search 
is not case-sensitive, but the search string must begin with the gene name. For 
example, a search string of “as” returns ASH1L-AS1 but a search string of “as1” 
does not.
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• To load the gene names from a file, click the Browse button  to open the Select a 
gene file dialog box, browse to and select the correct file, and then click Load Genes.

The following information is displayed for all the different transcripts that are available 
for the gene in the top pane of the dialog box—Region Name, Chromosome, Region 
Start position, Region End position, and Region Length.

3. If you are building a BED file for genes that are associated with a specific phenotype, 
then do the following; otherwise, go to Step 4.

In the Phenotype field, enter a search string for the phenotype. As you enter the search 
string, a dropdown list opens. The list is dynamically updated with the phenotypes that 
are found in the Human Phenotype Ontology database that match the search string.

4. Select the mode, which determines the information that is available for creating the BED 
file.

5. Do one of the following:

• For Exon mode and All Exon mode—Select a transcript, or click the Expand icon  
next to the transcript, and then select the coding region and/or untranslated regions 
for building the BED file.

Figure 11-2:  BED File Builder tool, Exon mode

• For Transcript mode—Select a transcript.

The file must be a text file with one line per gene. Optionally, you can specify a 
transcript for each gene, with a tab between the gene name and the transcript.

The search string is not case-sensitive, and the string can be found anywhere in 
the search results. For example, a search string of “thyroid” returns phenotypes of 
thyroid adenoma and secondary hyperthyroidoism.

Mode Description
Exon The default mode. You can include only the coding regions in the BED file, 

only the untranslated regions, or both. Introns are not included in Exon mode.

Transcript mode Adds the full transcript, including introns, to the BED file.

All Exon Mode Includes all the specified exons from all the selected transcripts in the BED 
file. You can include only the coding regions in the BED file, only the 
untranslated regions, or both. Introns are not included in Exon mode.

Select an entire 
transcript, or click the 
Expand icon.

Specify the coding 
region and/or 
untranslated regions. 
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6. If you are building a BED file for genes that are associated with a specify phenotype, 
then click Add Gene; otherwise, go to Step 7.

The appropriate regions are added for the BED file based on the selected Mode. See Step 
4.

7. Optionally, do any or all of the following:

Option Steps
To open the Preview pane and view 
a preview of the BED file

Click Preview. The information for each region 
(Chromosome, Region Start, Region End, Region Name, 
Score, and Strand) is displayed in the preview.
Note: For detailed information about the fields that are 

displayed in the preview, see https://
genome.ucsc.edu/FAQ/FAQformat.html#format1. 

You can leave the Preview pane open, or you can close it 
after viewing the BED file. If you leave the pane open, and 
then make any changes to any of the BED file settings, you 
must click Refresh to update the preview.

To adjust the region start and end 
positions

Enter a different Region Start and/or Region End value (the 
default value is zero). For example, to include 20 bases at 
the end of each exon, enter 20 for both the Region Start 
value and the Region End value

To apply the current settings (the 
selected mode and the Start/End 
Region values) to all genes, 
including any previously added 
genes

1. Click Apply Settings to All. 
An Overwrite warning message opens, indicating that all 
your gene-specific settings will be lost and asking you if 
you want to continue.

Figure 11-3:  Overwrite warning message

2. Click Yes to close the message and overwrite all the 
current gene-specific settings with the current gene 
settings.
Geneticist Assistant User’s Manual 291

https://genome.ucsc.edu/FAQ/FAQformat.html#format1
https://genome.ucsc.edu/FAQ/FAQformat.html#format1


Chapter 11
Geneticist Assistant Tools
8. Click OK.

The Save As dialog box opens. By default, the BED file is named default.bed.

9. Edit the name of the BED file as needed, and save it in a location of your choosing.

To immediately use the BED file as a 
panel

1. Click Import as Panel.
The Panel Name dialog box opens.

Figure 11-4:  Panel Name dialog box

2. Enter the name for the panel, and then click OK.
The Panel Name dialog box closes, and the Manage 
Panels dialog box opens. The full directory path to the 
imported panel, including the panel name, is displayed in 
the Import from Panel File field.

3. Continue to “Importing a Panel” on page 105.

Option Steps
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Convert VCF File to a BED File Tool
If you do not have a needed BED file for a panel, you can use the Convert VCF to BED tool 
to convert a sample VCF file to the required BED file. The BED file contains the appropriate 
regions for the variants that are found in the VCF file.

To convert a VCF file to a BED file
1. On the Geneticist Assistant main menu, click Tools > Convert VCF File to BED File.

The Convert VCF to BED dialog box opens.

Figure 11-5:  Convert VCF to BED dialog box

2. Next to the Source field, click the Browse button  to open the Open dialog box, and 
then browse to and select the appropriate VCF file.

3. Indicate how the regions are to created in the BED file.

4. Click OK.

The Save as dialog box opens.

     

Option Description
Gene Adds the entire region for the gene in which each variant is found to the 

BED file. For example, if the variant is found in the BRCA1 gene, then 
the entire BRCA1 region is added to the BED file.

Exons Coding Adds the coding exon for each variant in the VCF file as a region in the 
BED file.

Exons All Adds both the coding exons and the non-coding exons for each variant 
in the VCF file as a region in the BED file.

Region Creates a region for each variant found in the VCF file, based on the 
variant’s position. If you select Region, then you must also specify the 
total number of bps that are to be found in each region (the Group by 
Bases value) with one half of the total number of bps found on each side 
of the variant position. For example, if you specify 10,000 for Group by 
Bases, then 5000 bps are found on either side of the variant position for 
the BED file region.
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5. In the Save as dialog box, enter a name and select a location in which to save the BED 
file, and then click Save.

A Convert VCF to BED file message opens, indicating that the conversion is completed.

Figure 11-6:  Convert VCF to BED file message

6. Click OK.

The message closes. The Convert VCF to BED dialog box remains open.

7. Click “x” to close the Convert VCF to BED tool.

The default name for the BED file is default.BED and the default location in which 
to save the BED file is the same directory as the source VCF file, but you can 
change one or both of these values. The file type is .bed and you cannot change 
this.
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Deleting Pathogenicity Changes with the Delete 
Pathogenicity Changes Tool

Sometimes, you might determine that a pathogenicity change or changes might not be valid. 
You use the Delete Pathogenicity Changes tool to delete all the historical pathogenicity 
changes for all variants that were made during a certain time period. After you delete a 
historical pathogenicity change for a variant, the pathogenicity of the variant might be reset. 
For example, if the pathogenicity of a variant was changed from Unknown to Likely 
Deleterious on January 13, 2013, and you delete all the historical pathogenicity changes that 
were made from January 1, 2013 to January 31, 2013, then the pathogenicity of the variant is 
reset to Unassigned. If you changed the pathogenicity of the same variant from Likely 
Deleterious to Deleterious on February 1, 2013, and you delete all the historical 
pathogenicity changes that were made from January 1, 2013 to January 31, 2013, then the 
pathogenicity change from Unassigned to Likely Deleterious is deleted for the variant, but 
the pathogenicity of the variant remains Deleterious.

To delete historical pathogenicity changes with the Delete 
Pathogenicity Changes tool

1. On the Geneticist Assistant main menu, click Tools > Delete Pathogenicity Changes.

The Delete Pathogenicity Changes dialog box opens.

Figure 11-7:  Delete Pathogenicity Changes dialog box

2. Change the From value, the To value, or both values as needed. To change the value, 
select the value that you are changing, for example, the month, and then you can 
manually enter the new value, or you can use the Up/Down field arrows to change the 
value. 

     

You must select each value that are you changing one at a time. If you need to 
confirm the time period, remember that the Pathogenicity Changes pane on the 
Variant tab displays the date and time that a pathogenicity change was made. See 
“Pathogenicity Changes pane” on page 251.
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3. Click OK.

A Confirm Deleting Pathogenicity Changes message opens, asking you if you are sure 
that you want to delete “x” number of pathogenicity changes within the date range.

Figure 11-8:  Confirm Deleting Pathogenicity Changes message

4. Click Yes.

All the historical pathogenicity changes that were made during the specified time period 
are deleted from the Geneticist Assistant database. If applicable, the pathogenicities for 
some variants are reset. 
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Importing Variants with the Import Variants Tool
You can use the Import Variant tool to import all the variants that are contained in a VCF file 
into your Geneticist Assistant database. If the VCF file contains the pathogenicity and 
pathogenicity status for the variants, variants comments and/or variant artifact types, then 
you can also import this information. If the VCF file’s INFO fields do not contain this 
information, then you can still use the tool to import the variants that are contained in the 
file, but then you can manually set the pathogenicity and/or pathogenicity status for the 
variants, as well as add a comment for the variants and/or set the artifact types. For either 
situation, this means that if multiple variants have the same pathogenicity and/or artifact type 
for a panel group, you do not have to set the pathogenicity of each variant individually. 
Instead, you can use this tool to set the same pathogenicity and/or artifact type for all the 
variants at once.

To import variants with the Import Variants tool
1. On the Geneticist Assistant main menu, click Tools > Import Variants.

The Import Variants dialog box opens.

Figure 11-9:  Import Variants dialog box

2. Next to the Sample File field, click the Browse button  to open the Select a Variant 
File dialog box, and then browse to and select the appropriate VCF file.

3. On the Reference dropdown list, select the appropriate reference.

4. On the Panel dropdown list, select the panel for which you are settings the variants’ 
pathogenicities, comments, and/or artifact types.

The Panel group name is displayed for Panel Group. 
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5. Optionally, to create a filter based on the variants in the VCF file, do the following:

a. Select Submit as Variant Filter, and then in the Filter name field, enter a name for the 
filter. 

b. To make the filter available only to you, then leave Available to all users cleared; 
otherwise, to make the filter available to any and all users, select this option.

6. Continue to one of the following:

• “To import the variants’ pathogenicities, pathogenicity statuses, comments, and/or 
artifact types” below.

• “To manually define the variants’ pathogenicities, pathogenicity statuses, comments, 
and/or artifact types” on page 299.

To import the variants’ pathogenicities, pathogenicity statuses, 
comments, and/or artifact types
1. Leave Import from VCF’s INFO fields selected.

2. Do either or both of the following:

• If the VCF file contains the pathogenicity and pathogenicity status for each variant, 
then to import this information, leave the Pathogenicity and Pathogenicity Status 
option selected; otherwise, if the VCF file does not contain this information, or you 
do not want to import this information, then clear this option.

• If the VCF file contains comments for the variants, then to import this information, 
leave the Variant Comment option selected; otherwise, if the VCF file does not 
contain this information, or you do not want to import this information, then clear 
this option.

• If the VCF file contains the artifact types for the variants, then to import this 
information, select this option; otherwise, if the VCF file does not contain this 
information, or you do not want import this information, then leave this option 
cleared.

3. Click OK.

The Import Variants dialog box closes. A Current Jobs tab opens that shows the progress 
of importing the VCF file. The tab remains open after the import is complete. The 
variants with the selected information are now imported into the Geneticist Assistant 
database. These variants will now be displayed with the imported information (such as 
the pathogenicity) in any samples that contain these variants.

     

Remember, you apply this variant filter through the Load Filters option. See “To 
filter the data that is displayed in a tab pane” on page 32.
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To manually define the variants’ pathogenicities, pathogenicity 
statuses, comments, and/or artifact types
When you manually define the pathogenicities, statuses, and/or artifact types for the variants, 
these properties are set to the same values for all the variants in the file. If you add a 
comment, then the same comment is added for all the variants.

1. Select the Select Manually option.

The Import Variants dialog box is updated with options for setting the pathogenicity and 
the pathogenicity status for the variants as well entering a common comment and/or 
setting the artifact type for the variants. 

Figure 11-10:  Import Variants dialog box, Select manually option

2. Do any or all of the following:

• On the Pathogenicity dropdown list, select the pathogenicity for the variants.

• On the Pathogenicity Status dropdown list, select the pathogenicity status for the 
variants.

• In the Pathogenicity Comment field, enter a common comment for all the variants.

• Select Artifact Type, and then on the Artifact Type dropdown list, select a common 
artifact type for all the variants.

     

Remember, you have the option of specifying custom pathogenicity types. Also, by 
default, only two statuses are available—Pending or Confirmed. You have the 
option of adding custom pathogenicity statuses. See “Managing Objects in the 
Geneticist Assistant Database” on page 55.
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3. Click OK.

The Import Variants dialog box closes. A Current Jobs tab opens that shows the progress 
of importing the VCF file. The tab remains open after the import is complete. The 
variants with the selected information are now imported into the Geneticist Assistant 
database. These variants are now displayed with the specified information (such as the 
pathogenicity) in any samples that contain these variants.
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Find Samples with Variants Tool
You can use the Find Samples with Variants tool to find all the samples in your Geneticist 
Assistant database that contain specific variants. You can search for the variants based on the 
Variant database ID, the variant rs identification from dbSNP, or the variant description. 

To find samples with specific variants with the Find Samples with 
Variants tool

1. On the Geneticist Assistant main menu, click Tools > Find Samples with Variants.

The Find Samples with Variants dialog box opens.

Figure 11-11:  Import Variants dialog box

2. Indicate which samples that the database search is to return:

• All variants - Selected by default. Return only those samples in which all the 
indicated variants were found.

• Any variants - Return any sample in which at least one of the indicated variants was 
found.

3. Indicate how to search for the variants based on one of the following:

• The Variant database ID, which is displayed in the ID column in the various Variant 
tables in Geneticist Assistant.

• The variant rs identification from dbSNP, which is displayed in the rs column of the 
various Variant tables in Geneticist Assistant.

• The variant description, which includes the following four fields separated by 
colons: chromosome, chromosome position, reference allele, and alt allele.
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4. Enter the variant search criteria. 

5. Click OK.

A list of all the samples that contain the specified variants is displayed on a Samples with 
Variants tab. 

Figure 11-12:  Samples with Variants tab

When searching for multiple variants, you must separate the variant search 
criteria by a comma or a semi-colon, or place each search criterion on its own 
line.

The context menu for this tab is identical to the context menu for the Samples pane 
on the Run tab. See “The Samples Pane (Run tab) Context Menu” on page 191.
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Merging BAM Files with the Merge BAM Files 
Tool

If you have multiple BAM files for a sample, you do not need to submit each file as an 
individual sample, and then assign each file to the same patient. Instead, you can use the 
Merge BAM Files tool to merge all the BAM files into one file and then submit the file as a 
single sample.

To merge BAM files
1. On the Geneticist Assistant main menu, click Tools > Merge BAM Files.

The Merge BAM Files dialog box opens.

Figure 11-13:  Merge BAM Files dialog box

2. At the top of the dialog box, click the Browse button  to open the Select a file to add 
dialog box, and browse to and select the BAM files that are to be merged.

3. Next to the Save As field, click the Browse button  to open the Select file to save 
dialog box, and do the following:

• In the File name, enter the name for the merged BAM file. (The extension is .bam 
and you cannot change this.

• Browse to and select the directory in which to save the merged BAM files. 

     

CTRL-click to select the multiple BAM files.
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4. Click Save.

The Select file to save dialog box closes, and you return to the Merge BAM files dialog 
box.

5. Click Merge.

The message “Merging files now” is displayed at the top of the Merge BAM files dialog 
box. After the BAM files are successfully merged, the message “Merge complete” is 
displayed at the top of the Merge BAM files dialog box.

6. Click Close (x) to close the Merge BAM Files dialog box and return to the Geneticist 
Assistant main window.

Be patient during the merging of the BAM files. Depending on the number of files 
selected and the sizes of the files, merging might take several minutes.
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The Geneticist Assistant customer portal is a web-based platform that serves as a dedicated 
hub for tracking and managing your organization’s patient and sample information and the 
tests that have been carried out for each patient/sample combination (referred to as a 
submission). You designate specific users, known as web users, to have login and read/write 
permissions to this platform. These web users can enter your organization’s patient and 
sample information without ever having to log in to an instance of Geneticist Assistant. The 
patient and sample information is directly linked between the Geneticist Assistant database 
and the customer portal. Any patient that is in the Geneticist Assistant database is 
automatically available for selection in the portal, and if a new patient must be created to 
submit information, then this patient is automatically added to the Geneticist Assistant 
database. A barcode is generated for each submitted patient/sample combination, and you 
can use this barcode to validate that the correct patient and sample combination was 
submitted to the customer portal and to confirm sample identity when you are reviewing a 
sample in Geneticist Assistant. A full record of every submission that any user has ever made 
through your organization’s secure access point to the Geneticist Assistant customer portal is 
displayed on the Submissions tab.

This chapter covers the following topics:

• “Logging in to the Geneticist Assistant Customer Portal” on page 307.

• “The Geneticist Assistant Customer Portal Layout” on page 310.

• “Submitting Patient/Sample Tracking Information through the Geneticist Assistant 
Customer Portal” on page 312.

• “The Submissions Tab” on page 315.
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Logging in to the Geneticist Assistant Customer 
Portal

To log in and use the customer portal, two files are required: 

• Cert.pem file, which you must save in C:\Program Files\SoftGenetics\SoftGenetics 
Server\ga on the Geneticist Assistant server.

• Cert.pfx, which you can save anywhere on the Geneticist Assistant client. You must 
double-click this file to launch the Certificate Import Wizard and import the encryption 
key for your Geneticist Assistant installation.

By default, your Geneticist Assistant Administrator account (the Administrator role that you 
were prompted to create for the installation of Geneticist Assistant) is designated as a user of 
the customer portal. The username and password for logging in to the customer portal are 
identical to the username and password that were specified for the Administrator role. All 
other users of the customer portal must be specified as web users. (See “Managing Web 
Users” on page 98.)
Figure 12-1:  Geneticist Assistant Login dialog box with credentials for the Geneticist 

Assistant customer portal

The login URL for the Geneticist Assistant customer portal is set to the following:

https://<server name>/samplesub

where <server_name> is the name of your Geneticist Assistant server, for example, 
localhost.

     

If your organization already uses encryption for patient data, then these files 
should already be configured and available for use; otherwise, work with your 
organization’s System Administrator to create and configure these files, or you can 
contact.tech_support@softgenetics.com for assistance.

Server name
Administrator role user name
Administrator role password
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To log in to the Geneticist Assistant customer portal
1. Open a browser of your choice.

2. In the URL field, enter the login URL for your Geneticist Assistant customer portal.

The Customer Portal Login page opens.

Figure 12-2:  Customer Portal Login page

3. Enter your username and password, and then click Submit.

The Customer Portal opens. The Patients and Samples page is the open page. All the 
patients that are currently saved in your Geneticist Assistant database are listed in the 
Patients pane on the left side of the page. Any patient/sample combination that has been 
submitted to the customer portal is displayed in the Samples pane on the right side of the 
page. See Figure 12-3 on page 309.

The login URL for the Geneticist Assistant customer portal is set to the following: 
https://<server name>/samplesub, where <server_name> is the name of your 
Geneticist Assistant server, for example, localhost.

By default, your Geneticist Assistant Administrator account (the Administrator 
role that you were prompted to create for the installation of Geneticist Assistant) is 
designated as a user of the customer portal. The username and password for 
logging in to the customer portal are identical to the username and password that 
were specified for the Administrator role. If you are not the Administrator, then 
you must be specified as a web user. (See “Managing Web Users” on page 98.)
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Figure 12-3:  Geneticist Assistant Customer portal, Patients and Samples page

4. Continue to “The Geneticist Assistant Customer Portal Layout” on page 310.
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The Geneticist Assistant Customer Portal 
Layout

Figure 12-4:  Geneticist Assistant customer portal, Patients and Samples page

The customer portal main menu is displayed at the top of every customer portal page. The 
main menu has the following options:

Main Menu Option Description
Patients Opens the Patients and Samples page. This is the page that opens after 

you log in to the Geneticist Assistant customer portal. All the patients 
that are currently saved in your Geneticist Assistant database are listed 
in the Patients pane on the left side of the page. Any patient/sample 
combination that has been submitted to the customer portal for tracking 
purposes is displayed in the Samples pane on the right side of the page. 

Submit Opens the Submit Sample page. This is the page on which you enter 
the information for the patient and sample combination that you are 
submitting to the Geneticist Assistant customer portal. This page has 
seven distinct sections for entering the information for the patient and 
sample combination that you are submitting to the Geneticist Assistant 
customer portal. Your organization’s Administrator is responsible for 
customizing the fields that are displayed in these sections, including 
whether a field is enabled or disabled, and whether a field is required or 
optional. See “Admin” on page 311.

Review Opens the Review page, where you can review a patient and sample 
combination and verity that the information that has been entered for it 
is correct before you submit the information to the customer portal. 
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User Opens the User page. You use this page to enter the contact details for 
the providers and institutions that are to be available for inclusion with 
any submission including the ordering provider, the genetic counselor, 
the referring hospital or laboratory, and the institutional billing. Your 
organization’s Administrator is responsible for customizing the fields 
that are displayed in these sections, including whether a field is enabled 
or disabled, and whether a field is required or optional. See “Admin” 
below.

Admin Available only to the default Administrator user for your Geneticist 
Assistant installation. Opens the Admin page where the Administrator of 
your organization's customer portal specifies the fields that are to be 
enabled/disabled on the Submit and User pages, and whether an 
enabled field is to be required or optional. In addition to specifying the 
field rules for the Submit and User pages, an Admin can also customize 
the barcode that is automatically generated for a submission. This 
barcode can be used to validate that the correct patient and sample 
information combination was submitted to the customer portal and to 
confirm sample identity when you are reviewing a sample in Geneticist 
Assistant. “Submitting Patient/Sample Tracking Information through the 
Geneticist Assistant Customer Portal” on page 312.
Note: If you need assistance with customizing your Geneticist Assistant 

customer portal interface, contact tech_support@softgenetics.

Main Menu Option Description
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Submitting Patient/Sample Tracking Information 
through the Geneticist Assistant Customer 
Portal

You must be the Administrator of Geneticist Assistant, or designated as a web user to log in 
and submit information through Geneticist Assistant customer portal. A full record of every 
submission that any user has ever made through organization’s secure access point to the 
Geneticist Assistant customer portal is displayed on the Submissions tab. 

To submit patient/sample tracking information through the 
customer portal

1. Log in to the customer portal.

2. On the Patients and Samples page, click New Patient/Sample, or on the main menu, click 
Submit.

The Submit Sample page opens. The Patient and Specimen section is displayed. The 
Sections pane on the left side of the page lists the seven sections for the page by name in 
which you can enter the patient/sample tracking information. 

Figure 12-5:  Geneticist Assistant customer portal, Submit Sample page, Patient and 
Specimen section

By default, your Geneticist Assistant Administrator account (the Administrator 
role that you were prompted to create for the installation of Geneticist Assistant) is 
designated as a user of the customer portal. The username and password for 
logging in to the customer portal are identical to the username and password that 
were specified for the Administrator role. If you are not the Administrator, then 
you must be specified as a web user. (See “Managing Web Users” on page 98.)
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3. In the Patient and Specimen section, on the Saved Patients dropdown list, do one of the 
following:

• Leave the list set to Add New, and then enter the new patient information.

• Select a patient from your organization’s Geneticist Assistant database.

4. Continue opening each section on the page, and then enter the appropriate information 
for the patient/sample combination.

5. Optionally, after you have entered all the patient/sample tracking information, in the 
Sections pane on the Submit Samples page, click Review to open the Review 
Submission page and review the information and make any necessary changes before 
submitting it.

6. On the Submit Samples page, in the Sections pane, click Submit.

The patient/sample information is submitted to the customer portal. The submission is 
automatically recorded on the Submissions tab in Geneticist Assistant. The Submit 
Sample page remains open. A Submission Successful message is displayed on the page 
along with two options: Download Packing Slip and Download Submission Details. 

Figure 12-6:  Submission Successful message with options

     

Your organization’s Administrator is responsible for customizing the fields that are 
displayed in all the sections on the Submit Sample page, including whether a field 
is enabled or disabled, and whether a field is required or optional.

The patient and sample information is directly linked between the Geneticist 
Assistant database and the customer portal. Any patient that is in the Geneticist 
Assistant database is automatically available for selection on the Saved Patients 
dropdown list. If you add a new patient, then this new patient is automatically 
added to your organization’s Geneticist Assistant database and going forward, is 
available for selection in the portal. 
Geneticist Assistant User’s Manual 313



Chapter 12
The Geneticist Assistant Customer Portal and Submissions
7. Optionally, click either one or both options to download the needed information for the 
submission:

• Download a packing slip: Generates a packing slip in PDF format that includes a 
barcode.

If your organization uses barcodes, then you can scan this barcode and validate that 
the correct patient and sample combination was submitted to the customer portal and 
to confirm sample identity when you are reviewing a sample in Geneticist Assistant.

Figure 12-7:  Packing slip with barcode for patient/sample information submitted to the 
Geneticist Assistant customer portal

• Download Submission Details: Generates a full record of the submission in PDF 
format. The information that is displayed on the Submissions Detail form is identical 
to the information that is displayed on the Packing Slip form, but without the 
barcode.

The prompt that opens and the location in which the file is automatically saved is 
dependent on the browser that you are using to access the customer portal.

You can always choose to generate a packing slip with a barcode for this or any 
other submission at a later date. To do so, on the customer portal main menu, click 
Review to open the Review Sample page, select the appropriate patient/sample 
combination, and then click Download Submission Packing Slip.

You can always view the full record of any submission on the Submissions tab in 
Geneticist Assistant. See “The Submissions Tab” on page 315.
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The Submissions Tab
A full record of every submission that any user has ever made through your organization’s 
secure access point to the Geneticist Assistant customer portal is displayed on the 
Submissions tab in Geneticist Assistant. To open the Submissions tab, on the Geneticist 
Assistant main menu, click Tabs > Submissions.
Figure 12-8:  Submissions tab

To open and view all the details for an individual submission, double-click the submission on 
the Submissions tab. Each pane on the Submission tab corresponds to specific information 
that was entered for the submission, for example, Patient, Specimen, and so on. The 
information always includes the barcode for the submission, which you can use to comfirm 
sample identity.
Figure 12-9:  Submission tab
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To use the barcode to confirm sample identity
If a packing slip has been generated for a submission, then two options are available for 
using the barcode to validate that the correct patient/sample combination was submitted to 
the customer portal and to confirm sample identity when you are reviewing a sample in 
Geneticist Assistant:

• On the Submission tab, click Verify Barcode, and then use a barcode scanner to scan the 
barcode on the physical packing slip.

• On the Submission tab, click Verify Barcode, and then enter the barcode number that is 
displayed on the packing slip in the field. If the barcode number that you enter matches 
the barcode number for the submission, then “Match” is displayed in green above the 
Verify Barcode number field.

Figure 12-10:  Verifying submissions using a manually entered barcode number
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Regardless of the entity with which you are working in Geneticist Assistant (a run, a patient, 
a sample, or a variant), there are several procedures common to all these entities. This 
appendix describes these common procedures and where appropriate, details the slight 
differences that can exist based on the entity for which you are carrying out the procedure. 

This appendix covers the following topics:

• “Reviewing Panel Statistics” on page 319.

• “Setting Read and Write Permissions” on page 326.

• “Managing a Batch Variants Report” on page 329.

• “Generating a Batch Coverage Report” on page 335.

• “Creating an Action List” on page 338.

• “Comparing Samples in a Run” on page 340.

• “Adding a Variant Interpretation” on page 342.
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Reviewing Panel Statistics
Panel statistics are displayed on the Panel Statistics tab. The information that is displayed on 
the Panel Statistics tab is the same (using all samples by default) except if you have selected 
multiple samples from the Run tab or multiple associated samples on the Variant tab. You 
can open and review the information on the Panel Statistics tab from the following locations 
in Geneticist Assistant:

• The Panel Statistics tab from the Panels menu.

• A patient sample when viewed from the Samples sub-tab on the Patient tab.

• A panel that was used for a run when viewed from the Runs tab. 

• A panel that was used for a run when viewed from Samples pane on the Run tab.

• A sample’s run when viewed from the Associated Panels pane on the Variant tab. 

To review panel statistics
When reviewing the information on the Panel Statistics tab, you can filter the information by 
the following criteria:

• All panel samples, or selected panel samples.

• Samples that have been added to the panel within the last 30 days of the current day’s date, 
or a custom date range.

• Selected runs for the panel.

When the Panel Statistics tab first opens, the Coverage Regions sub-tab is the open tab. You 
can select a different panel from the Panel dropdown list to view statistics for a different 
panel. You can also select a different panel to change the panel group, but you cannot change 
the panel group directly. 
Figure A-1:  Coverage Regions sub-tab (Panel Statistics tab)
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1. To display data on the Panel Statistics tab, do one of the following:

     

To display Panel Statistics 
information from:

Steps

The Panel Statistic tab from the Panels 
menu

1. On the Geneticist Assistant main menu, click Panels > Panel 
Statistics.
The Panel Statistics tab opens.

2. On the Panels dropdown list, select the panel for which the statistics 
are to be viewed.

The Samples sub-tab on the Patient tab In the Samples pane, select a sample or CTRL-click to select multiple 
samples, and then right-click on any selected sample and on the context 
menu that opens, click Panel Statistics.

The Runs tab 1.  Select a run, or CTRL-click to select multiple runs.
2. Right-click any selected run, and on the context menu that opens, 

click Panel Statistics. 

The Run tab In the Samples pane, select a sample or CTRL-click to select multiple 
samples, and then right-click on any selected sample and on the context 
menu that opens, click Panel Statistics. 
Note: If you select a small number of samples, such as two to four, then, 

by default, the panel statistics are calculated based only on the 
selected samples and before the statistics are calculated, a Very 
few samples message dialog box opens, warning you of this and 
asking you if you want to continue. You can click Yes, or you can 
click Cancel to return to the Run tab and select more samples.

The Associated Samples pane on the 
Variant tab

1. Select a sample, or CTRL-click to select multiple samples.
2. Right-click any selected sample, and on the context menu that 

opens, click Panel Statistics. 
Note: If you select multiple samples from multiple runs for different 

panels, then a Select Panel dialog box opens. You must first 
select the appropriate panel before the statistics can be 
calculated.

Note: If you select a small number of samples, such as two to four, then, 
by default, the panel statistics are calculated based only on the 
selected samples and before the statistics are calculated, a Very 
few samples message dialog box opens, warning you of this and 
asking you if you want to continue. You can click Yes, or you can 
click Cancel to return to the Variant tab and select more samples.
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2. Optionally, edit any or all of the calculation criteria as needed, and then click OK to 
recalculate the panel statistics and update the display accordingly. 

Option Description
All panel samples If you select this option, then all samples that have been added to the panel 

are displayed. To specify a custom date range, select added between, and 
then change one or both dates as needed. To change the dates, you can do 
either of the following:
• You can select any part of the date that you want to change, or the entire 

date, and then manually enter the new value. (The default date range is 
the last 30 days).

• You can select any part of the date that you want to change, and then use 
the Up/Down arrows to change the date accordingly.

Selected runs To select specific runs for the panel, choose Selected runs, and then next to 

Selected runs, click the Browse button  that to open the Select Runs 
dialog box. All the runs for the selected panel are displayed in the dialog box. 
Select a run, or CTRL-click to select multiple runs, and then click OK.

Figure A-2:  Select Runs dialog box
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3. Optionally, after calculating the panel statistics, continue to any of the following needed 
to view information on any of the five sub-tabs that are available for the Panel Statistics 
tab:

• Coverage Regions sub-tab. See “Coverage Regions sub-tab (Panel Statistics tab)” on 
page 323.

• Samples sub-tab. See “Samples sub-tab (Panel Statistics tab)” on page 323.

• Variants sub-tab. See “Variants sub-tab (Panel Statistics tab)” on page 324.

• Patients sub-tab. See “Patients sub-tab (Panel Statistics tab)” on page 324.

• Reports sub-tab. See “Reports sub-tab (Panel Statistics tab)” on page 325.

     

Selected samples To select only specific samples for the panel, choose Selected samples, and 

then next to Selected samples, click the Browse button  that to open the 
Select Samples dialog box. All the samples for the selected panel are 
displayed in the dialog box. Select a sample, or CTRL-click to select multiple 
samples, and then click OK.

Figure A-3:  Select Samples dialog box

Option Description
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Coverage Regions sub-tab (Panel Statistics tab)
The Coverage Regions sub-tab has a single pane, the Coverage Regions pane, that lists the 
coverage information across all the samples, for the selected run or runs, or for the selected 
sample or samples for every region in the selected panel and panel group. See “Coverage 
Regions tab” on page 200 for a detailed discussion of the information that is displayed on 
this sub-tab.
Figure A-4:  Coverage Regions sub-tab (Panel Statistics tab)

Samples sub-tab (Panel Statistics tab)
The Samples sub-tab has a single pane, the Samples pane, that lists all the samples that were 
imported for the panel or in the selected run or runs or for the selected sample or samples for 
the selected panel and panel group. You can double-click a sample on this sub-tab to open the 
Sample tab. (See Chapter 8, “Geneticist Assistant Data Review - Sample Tab,” on page 209.) 
You can also right-click a sample on the sub-tab to open a context menu that has options that 
are identical to options that are on the context menu for the Samples pane on the Run tab. See 
“The Samples Pane (Run tab) Context Menu” on page 191.
Figure A-5:  Panel Statistics tab, Samples sub-tab
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Variants sub-tab (Panel Statistics tab)
The Variants sub-tab has a single pane, the Variants pane, that lists all the variants that were 
detected for the panel in all the samples that were imported in the selected run or runs or for 
the selected sample or samples for the selected panel and panel group. The information that 
is displayed on this sub-tab is identical to the information that is displayed on the Variants 
sub-tab on the Patient tab. You can double-click a variant on this sub-tab to open the Variant 
tab. (See Chapter 9, “Geneticist Assistant Data Review - Variant Tab,” on page 243.) You 
can also right-click a variant on this sub-tab to open a context menu that has options that are 
identical to options that are on the context menu for the variant on the Sample Variant Data 
sub-tab. (See “Sample Variant Data Sub-Tab” on page 212.) 
Figure A-6:  Panel Statistics tab, Variants sub-tab

Patients sub-tab (Panel Statistics tab)
The Patients sub-tab has a single pane, the Patients pane, that lists all the patients who were 
associated with all the samples the panel or the selected sample or samples or for the selected 
run or runs that were imported for the selected panel and panel group. You can double-click a 
patient in the pane to open the corresponding Patient tab. You can also right-click a patient 
on this sub-tab to open a context menu with options that are identical to options that are on 
the context menu for the Patients tab. See “Accessing and Reviewing Patient Records” on 
page 137.
Figure A-7:  Panel Statistics tab, Patients sub-tab
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Reports sub-tab (Panel Statistics tab)
The Reports sub-tab contains a single pane, the Reports pane, that lists all the reports that 
were generated for the panel or for the selected run or runs or selected sample or samples for 
the selected panel/panel group and saved to the Geneticist Assistant database. 

Figure A-8:  Panel Statistics tab, Reports sub-tab

You can right-click anywhere on this sub-tab to open a context menu with options that are 
identical to the options that are on context menu for the Reports pane on the Patient sub-tab 
on the Patient tab. See “Patient tab, Patient sub-tab, Reports pane” on page 154.

You can also select Reports > Saved Reports on the Geneticist Assistant main 
menu to open a Reports tab that includes these same reports.

For detailed information about generating and saving Panel Statistics reports, see 
Chapter 10, “Geneticist Assistant Reports,” on page 265.
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Setting Read and Write Permissions
Permissions determine the Read and/or Write functions that are available to selected users or 
groups for a patient, sample, or run. You can set Read/Write permissions for these Geneticist 
Assistant entities from the following locations:

• Patient: The Patients tab and the Patient sub-tab on the Patient tab. 

• Patient Sample - The Sample sub-tab on the Patient tab. 

• Run - The Runs tab.

• Run Sample - The Samples pane on the Run tab (per sample basis).

• Sample in which a selected variant was found - Associated Samples pane on the Variant 
tab.

You can set permissions for any entity if you are an Administrator user. If you are a standard 
user, then set the permissions for an entity that you added to the Geneticist Assistant database 
or to which you have been granted read/write permissions.

To set Read and Write permissions for a patient, sample, or run
1. Open the location from which you are setting the permissions:

• The Patients tab.

• The Samples sub-tab on the Patient tab.

• The Runs tab. 

• The Samples pane on the Run tab.

• The Associated Samples pane on the Variant tab.

2. Do one of the following:

• Select the patient or CTRL-click to select the multiple patients for which you are 
setting the permissions, and then right-click any selected patient, and on the context 
menu that opens, click Permissions.

• Select the sample or CTRL-click to select the multiple samples for which you are 
setting the permissions, and then right-click any selected sample, and on the context 
menu that opens, click Permissions.

• Select the run or CTRL-click to select the multiple runs for which you are setting the 
permissions, and then right-click any selected run, and on the context menu that 
opens, click Permissions.

The Permissions dialog box opens. The first field on the dialog box indicates the entity 
(Patient, Sample, or Run) for which you are setting the permissions. The dialog box also 
displays the names of all the users and/or groups and their assigned permissions for the 
patient, sample, or run. If you opened the Permissions dialog box from the Runs tab, then 
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an additional option, Apply permission settings to samples, is displayed. 

Figure A-9:  Permissions dialog box (Patient or Sample)

Figure A-10:  Permissions dialog box (Runs tab)

3. Edit the permissions for any user or group as needed and then click OK; otherwise, to 
add permissions for a new user or group, go to Step 4.

You can add or remove the Can Write permission for a user or group, or you can 
remove both the Can Read and Can Write permissions. Removing the Can Read 
permission but leaving the Can Write permission selected for a user or group has 
no effect.
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4. Enter a user name (the login name for the user), or to assign the same permissions to 
multiple users in a single step, enter a group name. Note the following about the search 
string:

• The search string is not case-sensitive, but the string must begin with the user or 
group name. For example, a search string of “Ja” or “ja” returns a user with the name 
of Jane Doe, but a search string of “Doe” does not.

• As you enter a user name or a group name, a dropdown list opens. The list is 
dynamically updated with user names or group names that are in your Geneticist 
Assistant database and that match the search string that you are entering.

5. Select a user name or group name from the list, and then click Add.

The user name or group name is displayed in the lower pane of the dialog box. The Can 
Read permission is already assigned for the selected user or group. If just this permission 
is selected, then the user or group can simply view the patient records, samples, or runs. 
They cannot edit them.

6. Optionally, if the user or group must be able to edit the patient records, samples, or runs 
as well, then select the Can Write permission.

7. If you are setting the permissions for one or more runs, then optionally, if all users and 
groups are to have their same run permissions applied to all the samples in all the 
selected runs, then select Apply the permission settings to Samples; otherwise, leave this 
option cleared, or clear it if necessary.

8. Click OK.

A Permission Updated message opens. 

9. Click OK. 

Both the message and the Permissions dialog box close. The specified permissions are 
set for the patient records, samples, or runs.
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Managing a Batch Variants Report
A Batch Variants report is a report that includes information for variants in a selected sample 
or samples. You can create multiple reports for multiple samples in a single step. A Batch 
Variants report configuration determines the data that you are including in the report. You 
choose if the configuration is to be available only to the user who created it, or to all users. 
The configuration does not include the report format or the location in which the report is to 
be saved. Instead, you must specify the format and location in which to save the report every 
time you generate a Batch Variants report.
Figure A-11:  Batch Variants Report dialog box

You can generate a Batch Variants report for a selected sample or samples from the following 
locations in Geneticist Assistant:

• The Samples sub-tab on the Patient tab.

• The Runs tab. A separate report is saved for each sample of the selected run. 

• The Samples pane on the Run tab.

• The Associated Samples pane on the Variant tab.

Managing a Batch Variants report includes generating the report according to a new or saved 
configuration, editing a report configuration, or deleting a report configuration. See:

• “To generate a Batch Variants report based on a new configuration” on page 330.

• “To generate a Batch Variants report based on a saved configuration” on page 331.

• “To delete a Batch Variants Report configuration” on page 333.
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To generate a Batch Variants report based on a new configuration
The name for a Batch Variants report is automatically assigned based on the sample ID 
number and sample name for each sample for which you are generating the report (for 
example, 76_800458.variants.filter) and you cannot change this. You must select a location 
in which to save the report. A separate report is saved for each sample selected.

1. Open the location from which you are generating the report:

• The Samples sub-tab on the Patient tab.

• The Runs tab. 

• The Samples pane on the Run tab.

• The Associated Samples pane on the Variant tab.

2. Do one of the following:

• Select the sample or CTRL-click to select the multiple samples for which the Batch 
Variants report is to be generated, and then right-click any selected sample, and on 
the context menu that opens, click Export > Create Batch Variants report.

• Select the run or CTRL-click to select the multiple runs for which the Batch Variants 
report is to be generated, and then right-click any selected run, and on the context 
menu that opens, click Export > Create Batch Variants report.

The Batch Variants report dialog box opens. See Figure A-11 on page 329.

3. On the Report Type dropdown list, select the report type. (The default value is .csv)

4. If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, the default value of C:/Users/<User>/Desktop is 
displayed. Do one of the following:

• Leave this location as-is, and then go to Step 5.

• To change this location, then next to the Save To field, click the Browse button , 
and then browse to and select the location in which the report is to be saved.

5. Optionally, to filter the data that is to be displayed in the report, select Enable Filter, and 
then from the Filter dropdown list, select the appropriate pre-configured filter.

6. By default, “comma” is selected for the report delimiter. You can leave this value as-is, 
or you can select “tab,” or “other.” If you select “other,” then a blank field is enabled and 
you must specify the delimiter, for example, an underscore (_) in this field.

     

For detailed information about filtering the data that is displayed in a report, see 
“To filter the data that is displayed in a tab pane” on page 32.
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7. Optionally, to set the display preferences for the report, do any of the following:

• Rearrange the data columns.

• Rename a column header.

• Show/hide columns (manually or by loading a configuration).

8. Optionally, to view an onscreen preview of the report before it is generated and saved, 
click Preview.

9. Click OK.

The Batch Variants report is generated for all selected samples. After the report is 
successfully generated, a Batch Report Finished message opens, indicating that the 
report was generated and where the report was saved. 

Figure A-12:  Batch Report Finished message

10. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

To generate a Batch Variants report based on a saved 
configuration

1. Open the location from which you are generating the report:

• The Samples sub-tab on the Patient tab

• The Runs tab. 

• The Samples pane on the Run tab.

• The Associated Samples pane on the Variant tab.

2. Do one of the following:

• Select the sample or CTRL-click to select the multiple samples for which the Batch 
Variants report is to be generated, and then right-click any selected sample, and on 
the context menu that opens, click Export > Create Batch Variants report.

For detailed information about working with data columns, including moving and 
renaming columns, or showing/hiding columns, see “Setting Display Preferences 
in the Geneticist Assistant Main Window” on page 31.
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• Select the run or CTRL-click to select the multiple runs for which the Batch Variants 
report is to be generated, and then right-click any selected run, and on the context 
menu that opens, click Export > Create Batch Variants report.

The Batch Variants report dialog box opens. See Figure A-11 on page 329.

3. On the Batch Variants Report dialog box, select the output format for the report.

4. If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, the default value of C:/Users/<User>/Desktop is 
displayed. Do one of the following:

• Leave this location as-is, and then go to Step 5.

• To change this location, then next to the Save To field, click the Browse button , 
and then browse to and select the location in which the report is to be saved.

5. Right-click on any heading in the Input Format pane, and then choose Select Columns.

The Select Columns dialog box opens. 

6. Click Load Configuration.

The Load Configuration dialog box opens. The dialog box displays all your private and 
public configurations as well as all the configurations that other users have made public.

Figure A-13:  Load Configuration dialog box

7. Select a configuration, and then click Load.

The Load Configuration dialog box and the Select Columns dialog box close.

8. Optionally, to preview an onscreen preview of the report before it is generated and 
saved, click Preview.

9. Click OK.

The Batch Variants report is generated for all selected samples. After the report is 
successfully generated, a Batch Report Finished message opens, indicating that the 
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report was generated and where the report was saved. 

Figure A-14:  Batch Report Finished message

10. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

To delete a Batch Variants Report configuration
You can delete a Batch Variants report configuration only if you created the report 
configuration. When you delete a Batch Variants report configuration, any reports that were 
generated according to the “old” (previous) configuration are not affected. Going forward, 
the “old” configuration is simply not available for selection.

1. Open the location from which you are deleting the report:

• The Samples sub-tab on the Patient tab.

• The Runs tab. 

• The Samples pane on the Run tab.

• The Associated Samples pane on the Variant tab.

2. Do one of the following:

• Select the sample or CTRL-click to select the multiple samples for which the Batch 
Variants report is to be generated, and then right-click any selected sample, and on 
the context menu that opens, click Export > Create Batch Variants report.

• Select the run or CTRL-click to select the multiple runs for which the Batch Variants 
report is to be generated, and then right-click any selected run, and on the context 
menu that opens, click Export > Create Batch Variants report.

The Batch Variants report dialog box opens. See Figure A-11 on page 329.

     

You are not prompted about confirming the deletion of a Batch Variants report 
configuration, so be very sure that the deletion must be deleted before doing so.
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3. Right-click on any heading in the Input Format pane, and then choose Select Columns.

The Select Columns dialog box opens. 

Figure A-15:  Select Columns dialog box

4. Click Load Configuration.

The Load Configuration dialog box opens. The dialog box displays all your private and 
public configurations as well as all the configurations that other users have made public.

Figure A-16:  Load Configuration dialog box

5. Select the configuration that you are deleting, and then click Delete.

The configuration is deleted immediately. The Load Configuration dialog box remains 
open.

6. Click Close (x) to close the Load Configuration dialog box, and then click lose (x) to 
close Batch Variants Report dialog box.
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Generating a Batch Coverage Report
The Batch Coverage report details the coverage information for one or more selected 
samples or for all the samples in a selected run or run. A separate report is saved for each 
sample. You can generate a Batch Coverage report from the following locations in Geneticist 
Assistant:

• The Samples sub-tab on the Patient tab. 

• The Runs tab. 

• The Samples pane on the Run tab.

• The Associated Samples pane on the Variant tab.

The report also includes coverage statistics for the panel that are calculated based on one of 
the following options: 

• All panel samples or selected panel samples.

• Samples that have been added to the panel within the last 30 days of the current day’s date, 
or a custom date range.

• Selected runs for the panel.

Figure A-17:  Batch Coverage Report dialog box 
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To generate a Batch Coverage report
1. Open the location from which you are generating the report:

• The Samples sub-tab on the Patient tab. 

• The Runs tab.

• The Samples pane on the Run tab.

• The Associated Samples pane on the Variant tab.

2. Do one of the following:

• Select the sample or CTRL-click to select the multiple samples for which the Batch 
Coverage report is to be generated, and then right-click any selected sample, and on 
the context menu that opens, click Export > Create Batch Coverage report.

• Select the run or CTRL-click to select the multiple runs for which the Batch 
Coverage report is to be generated, and then right-click any selected run, and on the 
context menu that opens, click Export > Create Batch Coverage report.

The Batch Coverage report dialog box opens. See Figure A-17 on page 335.

3. Leave the report type set to the default value of .csv, or select a different report type.

4. Next to the Save To field, click the Browse button  to open the Save To dialog box, 
and then browse to and select the location in which to save the report.

5. To calculate the panel coverage statistics for the report based on all panel samples, click 
OK; otherwise, specify the different options (listed in the table below) by which to 
calculate the panel coverage statistics, and then click OK. 

After you click OK to generate the report, the Current Jobs tab opens. The tab displays 
the progress of calculating the coverage information for every sample that was selected 
for the report. A report file is saved in the specified format and the specified location. 

Option Description
All panel samples 
added between

To specify a custom date range for calculating the panel coverage statistics, 
select added between, and then change one or both dates as needed. To 
change the dates, you can do either of the following:
• You can select any part of the date that you want to change, or the entire 

date, and then manually enter the new value. (The default date range is 
the last 30 days).

• You can select any part of the date that you want to change, and then use 
the Up/Down arrows to change the date accordingly.
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Selected runs To select specific runs for calculating the panel coverage statistics, choose 

Selected runs, and then next to Selected runs, click the Browse button  
to open the Select Runs dialog box. By default, all the runs for the panel are 
displayed in the dialog box. Select a run, or CTRL-click to select multiple 
runs, and then click OK.

Figure A-18:  Select Runs dialog box

Selected samples To select only specific samples for calculating the panel coverage statistics, 
choose Selected samples, and then next to Selected samples, click the 

Browse button  to open the Select Samples dialog box. By default, all the 
samples for the panel are displayed in the dialog box. Select a sample, or 
CTRL-click to select multiple samples, and then click OK.

Figure A-19:  Select Samples dialog box

Note: If the report is to be generated based on only a small number of 
samples, such as two to four, then, before the statistics are calculated, 
a Very few samples message dialog box opens, warning you of this 
and asking you if you want to continue. You can click Yes, or you can 
click Cancel to return to the Patient tab.

Option Description
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Creating an Action List
An Action list is a list of items that require some type of follow up. You can create multiple 
action lists relative to the type of follow up that is required. You can create an Action list for 
the following:

• Panel regions on the Coverage Regions tab.

• Variants on the Sample Variant Data sub-tab on the Sample tab.

To create an Action list
1. Do one of the following:

• On the Coverage Regions tab:

i Select a single panel, or CTRL-click to select multiple panels.

ii. Right-click any selected panel, and on the context menu that opens, click Add 
Selected Regions to Action List.

• On the Sample Variant Data sub-tab on the Sample tab:

i Select a variant, or CTRL-click to select multiple variants.

ii. Right-click any selected variant, and on the context menu that opens, click Add 
Reports > Add Selected Variants to Action List.

The Add to Action List dialog box opens.

Figure A-20:  Add to Action List dialog box

2. Do one of the following:

• If the Action Type that you are using is already available on the Action Type 
dropdown list, then go to Step 6.

• If this is the first time that you are creating an Action list for the pane, or if the 
Action Type that you want to use is not available on the Action Type dropdown list, 
then you must first add at least one type to the list. Go to Step 3.
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3. Click New Type.

The Add To Action List dialog box is refreshed with an option for adding an action type.

4. In the New Type field, enter an action type, (for example, Review Coverage), and then 
click Add

The action type is added to the Action Type list. The Add to Action List dialog box is 
refreshed to show the full Action Type dropdown list and Comment field.

5. Repeat Step 3 and Step 4 as needed to add more action types.

6. On the Action Type dropdown list, select the appropriate action type.

7. Optionally, in the comment field, enter a comment that explains/supports your decision 
for adding the selected panel regions or variants to an Action list.

8. Click OK.

The Add to Action List dialog box closes. The Action List tab for the sample opens. 
Different panes, grouped by Action Type, list any panel regions for the sample that have 
been selected for an Action list and any variants for the sample that have been added for 
an Action list.

Figure A-21:  Action List tab

If you are creating an Action list for panel regions, then only the action types that 
were created specifically for panel regions are available. Likewise, if you are 
creating an Action list for variants, then only the action types that were created 
specifically for variants are available.
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Comparing Samples in a Run
You can compare all the samples in a run from the Runs tab, or you can compare selected 
samples for a run from the Run tab.

To compare samples in a run
1. Do one of the following:

• From the Runs tab: Right-click the appropriate run on the runs tab, and on the 
context menu that opens, click Compare Samples.

The Sample Comparison dialog box opens. All the samples for the selected run are 
displayed in the dialog box.

• From the Run tab:

i Open the Run tab for the appropriate run.

ii. CTRL-click to select the samples in the Samples pane that you are comparing,

iii. Right-click any selected sample and on the context menu that opens, click 
Compare Samples.

The Sample Comparison dialog box opens. All the selected samples for the run are 
displayed in the dialog box.

Figure A-22:  Sample Comparison dialog box

     
340 Geneticist Assistant User’s Manual



Appendix A
Common Procedures
2. Set the comparison parameters.

3. Click OK.

The Sample Comparison dialog box closes. The Sample Comparison results are 
displayed on the Sample Comparison tab. The far right side of the tab shows the 
sample-specific information for each variant, with each sample identified as 1, 2, and so 
on. If you hover your cursor over the column heading, then the full sample name is 
displayed. The left side of the tab shows the variant information.

Figure A-23:  Sample Comparison tab

Option Description
Show columns The data columns that are displayed for each sample on the Sample 

Comparison tab. Allele Frequency (AF) is always displayed and you 
cannot change this option. By default, Coverage (Cov) is selected.

Filter variants by panel Limits the variants that are displayed don the Sample Comparison tab to 
only those variants that are contained within the selected panel.

Filter variants by 
pathogenicity

Limits the variants that are displayed on the Sample Comparison tab to 
only those variants with the selected pathogenicity.

Shared by Limits the variants are displayed on the Sample Comparison tabl to only 
those variants that meet the required number of samples as specified by 
the operator that is selected on the dropdown list (>, <, or =) and the 
number of samples. If a variant is found a number of samples that does 
meet this criteria, then the variant is not displayed in the results.

AF difference Limits the variants are displayed on the Sample Comparison tabl to only 
those variants that meet the required number of samples as specified by 
the operator that is selected on the dropdown list (>, <, or =) and the AF 
difference value. If a variant is found a number of samples that does 
meet this criteria, then the variant is not displayed in the results.

• Exclude missing 
variants

Selected by default. Regardless of the allele frequency difference, 
always display variants that are not found in one or more samples.

AF between Limits the variants that are displayed on the Sample Comparison tab to 
only those variants with an allele frequency (AF) that falls within the 
indicated range in at least one of the compared samples.
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Adding a Variant Interpretation
A variant interpretation is a comment amount or a description of a variant. You can add 
interpretations to the variants in a patient sample from the Variants sub-tab on the Patient tab 
or from the Sample Variant Data sub-tab on the Sample tab.

To add a variant interpretation
1. Open the Variant sub-tab on the Patient tab or the Sample Variant Data sub-tab on the 

Sample tab.

2. Select a single variant, or CTRL-click to select multiple variants and then right-click to 
open the sub-tab context menu.

3. On the context menu, select Edit Variant and then if:

• A single variant is selected, select Add Single Variant Interpretation to open the Add 
Single Variant Interpretation dialog box. See Figure A-24 below.

• Two or more variants are selected, select Add Compound Variant Interpretation to 
open the Add Compound Variant Interpretation dialog box. All the selected variants 
are displayed in the Included Variants (left) pane when the dialog box opens. See 
Figure A-25 on page 343.

Figure A-24:  Add Single Variant Interpretation dialog box
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Figure A-25:  Add Compound Variant Interpretation dialog box

4. Do one of the following:

• For a single variant, in the blank Interpretation pane, enter the appropriate comment 
or description, and then click OK. 

The Add Single Variant Interpretation dialog box closes. The interpretation is 
displayed in the Interpretation column on the Variants sub-tab for the Patient tab.

• For two or more variants, in the Interpretation Name field:

i Enter an identifying name for the interpretation.

ii. Leave all the variants as-is in the Included Variants pane, or optionally, select 
one or more included variants (CTRL-click to select multiple variants), and then 
click the Move arrow to move these selected variants to the Excluded Variants 
(right) pane.

iii. Optionally, in the Interpretation field, enter a description of the interpretation.

iv. Click OK.

The Add Compound Variant Interpretation dialog box closes. If you open the 
Sample tab from the Patient tab, then you can see the interpretation displayed in 
the Compound Variant Interpretations pane on the Sample Data sub-tab. You can 
double-click an interpretation that is displayed in the Compound Variant 
Interpretations pane to open a Compound Variant Interpretation sub-tab that 
displays the variants that are included for the interpretation. See “Compound 
Variant Interpretation Sub-Tab” on page 240.
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A
Action List

A list of items that require some type of follow up. In Geneticist Assistant, an Action List 
can be created for coverage regions on the Coverage Regions tab or for variants on the 
Sample tab.

Administrator user

A user of Geneticist Assistant to whom all available privileges are automatically assigned. 
Both Administrator privileges and Staff status can be assigned to the same Administrator 
user.

All Exon Mode

One of the allowed modes for the BED File Builder tool. Includes all the exons from all the 
selected transcripts in the BED file.

Artifact Type
Indicates that the variant at is not naturally present in the sample, but instead, it is formed by 
artificial means, such as during preparation of the sample; for example, a Sequencing 
artifact. A single default value, None, is supplied for artifact type. Additional values can be 
specified through the Add/Edit Object function in Geneticist Assistant.

Average Coverage

The average number of aligned reads for a region. This value is reported for all panel regions 
on the Coverage Regions tab and the Coverage Regions sub-tab on the Panel Statistics tab. A 
minimum value for the status of a region to be classified as “Passed” can be set on the 
Quality Control tab of the Settings dialog box.

B
BED file

A BED file is a tab-delimited text file. A panel can be created from a BED file for use in 
Geneticist Assistant. Each row in the file contains a region of the reference that is to be used 
in Geneticist Assistant. At a minimum, the file contains the following information:

• Field #1 - Chromosome number for the region

• Field #2 - Chromosome start position

• Field #3 - Chromosome end position

• Field #4 - Optional comment column
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C
Chemistry

Refers to the chemistry that was used to prepare the samples for sequencing. Values can be 
specified through the Add/Edit Object function in Geneticist Assistant.

CIVic Data pane
Found on the Variants tab. Displays information for the variant from the CIViC (Clinical 
Interpretations of Variants in Cancer) database.. See https://civicdb.org/home.

Client Reference Directory

Contains the information for the reference that was used for aligning data and/or detecting 
variants. If the Geneticist Assistant client and server reside on the same computer, then you 
can set the Client Reference directory and the Server Reference directory to the same 
directory.

ClinVar pane

Found on the Variant tab. Displays the information for a variant from the ClinVar database. 
See http://www.ncbi.nlm.nih.gov/clinvar/intro/.

Coverage Downstream

The number of base pairs after the end of a panel region to which the quality control settings 
must apply. The quality control settings are specified on the Quality Control tab of the 
Settings dialog box.

Coverage Region Status

Indicates whether a panel region passed or failed the coverage settings that were set for the 
run. The status for every region in a panel is displayed on the Coverage Regions tab. Default 
values are Passed or Failed. Additional values can be specified through the Add/Edit Object 
function in Geneticist Assistant.

Coverage Threshold

The minimum required coverage values that a panel region must meet, or it is flagged as 
failed region for a run. Thresholds can be set globally (applies to all panel regions in all runs) 
on the Quality Control tab on the Settings dialog box, or it can set on a per panel basis.

Coverage Upstream

The number of base pairs before the start of a panel region to which the quality control 
settings must apply. The quality control settings are specified on the Quality Control tab of 
the Settings dialog box.

Custom report

Contains only user-specified data. 
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Custom report template

Specifies not only the data that a Sample PDF report is to contain, but also the layout of the 
report. You build a custom report template in the Report Designer.

D
dbNSFP pane

Found on the Variant tab. Displays the information from the dbNSFP database for a variant. 
See https://sites.google.com/site/jpopgen/dbNSFP.

dbSNP pane
Found on the Variant tab. Displays the information from the dbSNP database for a variant. 
See http://www.ncbi.nlm.nih.gov/SNP/get_html.cgi?whichHtml=overview.

E
Ethnicity

The ethnicity (for example, Caucasian/Non-Hispanic) for a patient in your Geneticist 
Assistant database. Values can be specified through the Add/Edit Object function in 
Geneticist Assistant.

Exome Aggregation Consortium pane

Found on the Variant tab. Displays the information for the variant from the Exome 
Aggregation Consortium database for selected global sequencing projects. See 
http://exac.broadinstitute.org/.

Exome Variant Server pane

Found on the Variant tab. Displays the information from the Exome Variant Server database 
for the NHLBI GO Exome Sequencing project for a variant. See 
http://evs.gs.washington.edu/EVS/.

Exon Mode

The default mode for the BED File Builder tool. Allows for the inclusion of the coding 
regions in the BED file, the untranslated regions, or both.

G
Gene Direction
A display setting for sample variants’ reference alleles and observed alleles. Display the 
reference alleles and observed alleles based on the gene orientation. Set on the Variant 
Preferences tab for the Settings dialog box.
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gnomAD Data pane

Found on the Variant tab. Displays information for the variant from the gnomAD (Genome 
Aggregation Database) database. See http://reusabledata.org/gnomad.html.

Group

Two or more users considered a single unit for the purpose of applying the same permissions 
in a single step.

H
Heterozygosity Lower Bound (%)
The minimum variant frequency for a variant to be considered heterozygous. Set on the 
Variant Preferences tab of the Settings dialog box. The default value is 20%.

Heterozygosity Upper Bound (%)

The maximum variant frequency for a variant to be considered heterozygous. Set on the 
Variant Preferences tab of the Settings dialog box. The default value is 80%.

I
Instrument
Refers to the instrument that was used to sequence the samples. Values can be specified 
through the Add/Edit Object function in Geneticist Assistant.

Interpretation

A description or explaining comment for a variant. A variant can have one or more single 
interpretations associated with it, or it can be part of a compound interpretation, which 
means that the interpretation describes or explains multiple variants.

L
LOVD Data pane

Found on the Variant tab. Displays the information from the LOVD (Leiden Open Variation 
Database) for the variant. See http://www.lovd.nl/3.0/docs/.

M
Minimum Coverage

The minimum coverage depth for a region. This value is reported for all panel regions on the 
Coverage Regions sub-tab on the Panel Statistics tab and the Coverage Regions tab. A 
minimum value for the status of a region to be classified as “Passed” can be set on the 
Quality Control tab of the Settings dialog box.
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O
Object

Holds a value or variable that can be applied for carrying out runs in Geneticist Assistant. 

OMIM Data pane

Found on the Variants tab. Displays the information for the variant from the OMIM (Online 
Mendelian Inheritance in Man) database. See http://www.omim.org/.

P
Panel

A collection of genomic regions that are targeted for a specific genomic test or study. Panels 
are added to Geneticist Assistant by providing a BED file that defines the targeted regions, 
known as panel regions. Each sample that is submitted in Geneticist Assistant is assigned to 
a specific panel.

Panel Group

Separately tracks the pathogenicities of variants that might be found in multiple panels. For 
example, the pathogenicity of a selected variant might be set to Deleterious for multiple 
cancer panels; however, the pathogenicity can be set to benign for a cardiac panel. You can 
create a group for each panel, and then assign the appropriate panels to each group.

Panel Region

The regions that have been targeted for a specific panel/test as defined by the BED file that 
was used to create the panel. 

Pathogenicity

The pathogenicity for a selected variant, which is the likelihood that the variant will cause a 
disease. Default values are Deleterious, Likely Deleterious, Unknown, Likely Benign, and 
Benign. Additional values can be specified through the Add/Edit Object function in 
Geneticist Assistant.

Pathogenicity Status

Indicates the status for changing the pathogenicity for a selected variant; for example, from 
Unknown to Benign. Default values are Pending and Confirmed. Additional values can be 
specified through the Add/Edit Object function in Geneticist Assistant.

Patient

Refers to an individual from whom a sample was taken. Any sample that is submitted to 
Geneticist Assistant can be associated with a patient.

Percent Covered (%)

The percent of a panel region that has reads aligned to it. This value is reported for all panel 
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regions on the Coverage Regions sub-tab on the Panel Statistics tab and the Coverage 
Regions tab. A minimum value for the status of a region to be classified as “Passed” can be 
set on the Quality Control tab of the Settings dialog box.

Phenotype

The phenotype for a patient. Values can be specified through the Add/Edit Object function in 
Geneticist Assistant.

Preferred Transcript List
A tab-delimited text file that defines the specific transcript or isoform that is to be used for a 
gene. You can use different transcripts for different panels. The first column in the text file 
contains the gene name. The second column in the text file specifies the transcript by its 
nm_accession number.

R
Read Balance
The balance in forward and reverse oriented reads with the variant as reported in the VCF 
file.

Run

Refers to loading a BAM file and a sorted VCF file or just a sorted VCF file into Geneticist 
Assistant for the purposes of importing a list of variants into the Geneticist Assistant 
database and/or reviewing a list of variants. 

Run Status

The status for a run. Default values are New, QC Passed, Reviewed, and Complete. 
Additional values can be specified through the Add/Edit Object function in Geneticist 
Assistant.

S
Sample Group

Two or more samples considered a single unit for the purpose of repeated processing over a 
period of time; for example, a group of control samples for which the coverage or variant 
frequency is to be tracked. Values can be specified through the Add/Edit Object function in 
Geneticist Assistant.

Sample Group Statistics
Various statistics that can be displayed for a sample group. Displayed on the Sample Variant 
Data sub-tab for the Sample tab.

Sample Status

The status for a sample. Default values are New, QC Passed, Reviewed, and Complete. 
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Additional values can be specified through the Add/Edit Object function in Geneticist 
Assistant.

Server Reference Directory
The directory on the Geneticist Assistant database server that hosts the reference files. If the 
Geneticist Assistant client and server reside on the same computer, then you can set the 
Client Reference directory and the Server Reference directory to the same directory.

Staff user
A user who can log into the django web administrator site. The actions that the Staff user can 
carry out depend upon the permissions assigned to him/her. Both Administrator privileges 
and Staff status can be assigned to the same user.

Standard report
A report that includes all the data that is displayed in a selected pane on a data tab, for 
example, the Samples pane on the Run tab. Six different standard reports are available in 
Geneticist Assistant—Run, Coverage Regions, Panel Statistics, Sample, Variant, and Action 
List.

Standard user
A Geneticist Assistant user who has neither Administrator privileges nor Staff status. 

Subpanel

Contains a fixed number of regions that are contained within a selected panel. To verify 
coverage for a smaller number of regions that are within the panel that has been selected for 
a run, you can use a subpanel.

Supporting Information

Reference information and/or links to the appropriate websites that have been submitted to 
support the pathogenicity that is specified for a variant. Displayed in the Supporting 
Information pane on the Variant tab.

T
Trans

A column on the Sample Variant Data sub-tab on the Sample tab. Indicates whether the 
variant is Transition (Ti) or Transversion (Tv).

Transcript mode
One of the allowed modes for the BED File Builder tool. Adds the full transcript, including 
introns, to the BED file.
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U
User

A person who logs into Geneticist Assistant either to add and review content, or use 
Geneticist Assistant in a read-only capacity. Three types of users are available in Geneticist 
Assistant—an Administrator user, a Staff user, and a standard user. 

V
Variant Frequency

The frequency at which a variant is detected in a sample. In Geneticist Assistant, any value < 
1 is allowed, with 1 = 100%, 0.5 = 50%, and so on.

Variant Preferences

Determines how information about the variants is displayed in all the variant sub-tabs or 
panes in Geneticist Assistant. Set on the Variant Preferences tab for the Settings dialog box.

W
Web user

A person who can log in and submit information to the Geneticist Assistant customer portal. 

Z
Zygosity

Indicates whether the variant is heterozygous or homozygous. In Geneticist Assistant, the 
selected zygosity is based on the Zygosity settings that are specified on the Variant 
Preferences tab of the Settings dialog box.
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Geneticist Assistant User’s Manual
coverage thresholds

manually setting for panel 
regions.................................... 107

setting for all panel regions in all 
runs (global values) .................. 64

setting for panel regions with a QC 
Threshold file.......................... 110

custom fields

adding or editing for a patient

on the Patients tab ............... 141

custom report

generating .............................. 271

Action List report .................... 271

Coverage Regions report ....... 271

Panel Statistics report ............ 271

Run report .............................. 271

Sample report......................... 271

Variant report.......................... 271

D
Data band

adding database fields to ....... 279

adding images to .................... 281

adding text fields to ................ 279

adding to a Sample PDF Report 
template.................................. 277

arranging items in................... 282

data column

contents

specifying the font for ............. 67

headers

specifying the font for ............. 67

Data Source template file

defined...................................... 77

format for .................................. 77



database field

adding to a Data band ............279

database log

reviewing...................................50

dbNSFP pane on the Variant 
tab..............................................255

dbSNP pane on the Variant 
tab..............................................254

Delete Pathogenicity Changes 
tool .............................................295

display preferences

setting in the Geneticist Assistant 
main window .............................31

specifying for variants ...............70

E
encryption key

specifying for patient data .........63

ethnicity

see also object

adding for a patient .................127

defined ......................................55

editing for a patient .................138

Exome Aggregation Consortium 
pane on the Variant tab .............255

Exome Variant Server pane on the 
Variant tab .................................254

F
family data

comparing .......................192, 197

filter template

creating for a tab pane ..............32

deleting .....................................38

loading ......................................38
Finding Samples with Variants 
tool .............................................301

font

specifying for data column 
headers and/or content .............67

G
gender

editing for a patient .................138

gene

deleting the preferred one for a 
panel .......................................112

searching for in the Geneticist 
Assistant database....................46

selecting a different one for a 
variant

on the Sample Variant Data sub-
tab on the Sample tab...........220

on the Variants sub-tab on the 
Patient tab.............................158

setting the preferred one for a 
panel .......................................112

specifying the transcript or isoform 
that is to be used for it in a 
panel .......................................110

Gene Phenotypes pane

on the Variant tab....................254

Geneticist Assistant

installing on a Linux OS ............19

installing on a Windows OS ......17

logging out of ............................25

starting and logging in to...........20

upgrading ..................................26

Geneticist Assistant customer portal

customizing .............................310

layout ......................................310

logging in to.............................307
Geneticist Assistant User’s Manual
purpose ...................................305

required files for ......................307

using to submit patient/sample 
information ..............................312

Geneticist Assistant database

backing up.................................51

searching...................................46

Geneticist Assistant main 
window .........................................27

console......................................29

main menu ................................27

setting display preferences in....31

status bar ..................................29

tabs ...........................................28

title bar ......................................27

toolbar .......................................28

Geneticist Assistant passwords

setting the requirements for ......73

group

adding .......................................93

deleting......................................95

editing........................................95

modifying the permissions for ...95

H
HGVS information

editing for a variant

on the Sample Variant Data sub-
tab on the Sample tab...........221

on the Variants sub-tab on the 
Patient tab.............................159

highlighting color

specifying for variants of a 
pathogenicity .............................65
355



history

deleting for a pathogenicity 
change ....................................295

I
IGV

specifying the settings for .........74

viewing variants in

in the Associated Samples pane 
on the Variant tab .................253

in the Samples pane on the Run 
tab .........................................196

on the Sample Variant Data sub-
tab on the Sample tab...........229

on the Samples sub-tab on the 
Patient tab.............................157

on the Variants sub-tab on the 
Patient tab.............................167

image

adding to a Data band.............281

Import Variants Tool...................297

information

editing for a patient

in the Patient pane on the Patient 
sub-tab on the Patient tab.....146

on the Patients tab ................138

instrument

see also object

defined ......................................55

interpretation

adding for a variant .................222

on the Variants sub-tab on the 
Patient tab.............................160

adding for one or more variants

on the Sample Variant Data sub-
tab on the Sample tab...........224
356
on the Variants sub-tab on the 
Patient tab .............................162

isoform

specifying the one that is to be 
used for a gene in a panel.......110

L
Linux OS

installing Geneticist Assistant 
on ..............................................19

logging out of Geneticist 
Assistant ......................................25

LOVD pane on the Variant tab ...254

M
main menu on Geneticist Assistant 
main window ................................27

main window for Geneticist 
Assistant ......................................27

console......................................29

main menu ................................27

setting display preferences in....31

status bar ..................................29

tabs ...........................................28

title bar ......................................27

toolbar .......................................28

Merge BAM Files tool.................303

metric profile

adding by copying and editing an 
existing profile ...........................81

adding new................................79

defined ......................................77

deleting......................................82

minimum coverage

specifying for panel regions ......64
Geneticist Assistant User’s Manual
N
NextGENe installation directory

specifying the location of .......... 59

NextGENe viewer

viewing variants in

in the Associated Samples pane 
on the Variant tab................. 253

in the Samples pane on the Run 
tab ........................................ 195

on the Sample Variant Data sub-
tab on the Sample tab .......... 229

on the Samples sub-tab on the 
Patient tab ............................ 157

O
object

adding a value for..................... 56

deleting a value from ................ 58

editing a value for ..................... 57

OMIM

specify the settings for.............. 74

OMIM pane on the Variant tab .. 254

on the Sample Variant Data sub-tab 
on the Sample tab ..................... 227

on the Variants sub-tab on the 
Patient tab ................................. 165

Organization of the manual ......... 10

ownership

changing for a patient

in the Patient pane on the Patient 
sub-tab on the Patient tab .... 146

on the Patients tab ............... 141

changing for a related patient

in the Related Patients pane on 
the Patient sub-tab on the Patient 
tab ........................................ 150



in the Related Patients pane on 
the Sample Data sub-tab on the 
Sample tab ...........................237

changing for a run

on the Runs tab ....................182

changing for a sample

in the Associated Samples pane 
on the Variant tab .................253

in the Samples pane on the Run 
tab.........................................192

P
panel

building a BED file for

with the BED File Builder 
tool ........................................289

with the Convert VCF File to BED 
File tool .................................293

building a BED file for by adding or 
deleting regions ......................113

defined ............................103, 105

deleting ...................................117

deleting the preferred gene 
for............................................112

deleting the preferred transcript list 
for............................................110

editing .....................................115

importing into Geneticist 
Assistant .................................105

reviewing statistics for

from the Panels menu ..........118

searching for in the Geneticist 
Assistant database ...................46

setting a preferred transcript list 
for............................................110

setting the same artifact type for 
multiple variants in ..................297

setting the same pathogenicity for 
multiple variants in ..................297

specifying the preferred gene 
for............................................112

panel group

see also object

adding a comment for multiple 
variants in................................297

defined ......................................55

searching for in the Geneticist 
Assistant database....................46

setting the artifact type of multiple 
variants in................................297

setting the pathogenicity of 
multiple variants in ..................297

setting the pathogenicity status of 
multiple variants in ..................297

panel regions

adding to an Action list............202

creating a QC threshold file 
for............................................108

defined ........................... 103, 105

manually setting new coverage 
thresholds for ..........................107

setting new coverage thresholds 
for with a QC Threshold file ....110

setting the statuses for............200

specifying quality control 
(coverage) settings for ..............64

panel statistics

viewing for a run

in the Samples pane on the Run 
tab .........................................192

on the Runs tab ....................181

viewing for a sample

in the Associated Samples pane 
on the Variant tab .................252

in the Samples pane on the 
Samples sub-tab on the Patient 
tab .........................................156
Geneticist Assistant User’s Manual
Panel Statistics report

generating

custom ..................................271

standard ................................267

Panel Statistics tab

Coverage Regions sub-tab 
on ............................................323

from the Panels menu .............118

Patients sub-tab on .................324

Reports sub-tab on..................325

Samples sub-tab on ................323

Variants sub-tab on .................324

pathogenicity

see also object

defined ......................................55

setting for multiple variants in a 
panel group .............................297

setting for multiple variants in a 
panel in a single step ..............297

specifying the highlighting color for 
variants of..................................65

updating for a variant

on the Sample Variant Data sub-
tab on the Sample tab...........225

on the Variants sub-tab on the 
Patient tab.............................163

pathogenicity change

adding supporting information 
for ............................................256

pathogenicity change history

deleting....................................295

Pathogenicity Changes pane on the 
Variant tab..................................251

pathogenicity status

see also object

defined ......................................55
357



setting for multiple variants in a 
panel group .............................297

updating for a variant

on the Sample Variant Data sub-
tab on the Sample tab...........226

on the Variants sub-tab on the 
Patient tab.............................164

patient

adding a comment for

in the Comments pane on the 
Patient sub-tab on the Patient 
tab .........................................152

in the Patient pane on the Patient 
sub-tab on the Patient tab.....146

on the Patients tab ................141

adding a phenotype for ...........127

adding a relationship to

in the Patient pane on the Patient 
sub-tab on the Patient tab.....146

on the Patients tab ................141

adding an ethnicity for .............127

adding and editing the custom 
information for

on the Patients tab ................141

adding new

one at a time .........................127

associating with a sample

in the Samples pane on the Run 
tab .........................................194

on the Sample Data sub-tab on 
the Sample tab......................236

automatically associating a 
sample with based on the sample 
file names................................127

changing the ownership for

in the Patient pane on the Patient 
sub-tab on the Patient tab.....146

on the Patients tab ................141
358
defined ...................125, 127, 137

deleting a comment for............152

deleting a phenotype from.......148

deleting from the Geneticist 
Assistant database..................141

deleting reports for when saved to 
the database ...........................154

editing the comment for

in the Patient pane on the Patient 
sub-tab on the Patient tab .....146

on the Patients tab ................138

editing the ethnicity for ............138

editing the gender for ..............138

editing the identifying information 
for

in the Patient pane on the Patient 
sub-tab on the Patient tab .....146

on the Patients tab ................138

importing multiples with a Patient 
file in to the Custom Portal ......134

importing multiples with a Patient 
file in to the database ..............130

modifying the identifying 
information for .........................146

opening the Patient tab for

from the Patients tab.............141

removing a relationship for......146

setting the permissions for

in the Patient pane on the Patient 
sub-tab on the Patient tab .....146

in the Related Patients pane on 
the Patient sub-tab on the Patient 
tab .........................................150

on the Patients tab ................141

specifying the encryption key for 
associated data .........................63

viewing a list of variants in all the 
samples associated with .........158
Geneticist Assistant User’s Manual
viewing reports for when saved to 
the database........................... 154

viewing the comments for....... 152

viewing the last added comment 
for

on the Patients sub-tab on the 
Panel Statistics tab............... 324

on the Patients tab ............... 141

working with

on the Patient tab ................. 145

on the Patients tab ............... 137

Patient pane

on the Patient sub-tab on the 
Patient tab .............................. 146

on the Sample Data sub-tab on the 
Sample tab ............................. 236

patient sample

deleting a variant from

on the Variants sub-tab on the 
Patient tab ............................ 166

viewing variants in filtered by panel 
in the Associated Samples pane 
on the Variant tab ................... 252

viewing variants in filtered by panel 
in the Samples pane on the 
Samples sub-tab on the Patient 
tab .......................................... 156

Patient sub-tab on the Patient 
tab ............................................. 145

Patient tab

opening for a patient

from the Patients tab ............ 141

Patient sub-tab ....................... 145

Barcodes pane ..................... 155

Comments pane................... 152

Patient pane ......................... 146

Phenotypes pane ................. 148

Related Patients pane.......... 150



Reports pane ........................154

Samples sub-tab .....................155

Variants sub-tab......................158

Patients sub-tab on the Panel 
Statistics tab ..............................324

percent coverage

specifying for panel regions ......64

permissions

modifying for a group ................95

modifying for a user ..................90

setting for a patient

in the Patient pane on the Patient 
sub-tab on the Patient tab ....146

in the Related Patients pane on 
the Patient sub-tab on the Patient 
tab.........................................150

on the Patients tab................141

setting for a related patient

in the Related Patients pane on 
the Sample Data sub-tab on the 
Sample tab ...........................237

setting for a run

in the Samples pane on the Run 
tab.........................................192

on the Runs tab ....................181

setting for sample

in the Associated Samples pane 
on the Variant tab .................252

in the Samples pane on the 
Samples sub-tab on the Patient 
tab.........................................157

phenotype

see also object

adding for a patient .................127

in the Phenotypes pane on the 
Patient sub-tab on the Patient 
tab.........................................148

adding to the Geneticist Assistant 
database through the batch import 
of patients ...................... 131, 135

defined ......................................55

deleting from a patient ............148

Phenotypes pane

on the Patient sub-tab on the 
Patient tab...............................148

preferred transcript

updating for a variant

on the Sample Variant Data sub-
tab on the Sample tab...........228

on the Variants sub-tab on the 
Patient tab.............................166

preferred transcript list

setting for a panel ...................110

proxy server settings

configuring ................................61

PubMed abstract

viewing for a variant

on the Sample Variant Data sub-
tab on the Sample tab...........230

on the Variants sub-tab on the 
Patient tab.............................167

Q
QC Threshold file

creating ...................................108

using to set new coverage 
thresholds for panel regions....110

quality control settings

average coverage

specifying ................................64

minimum coverage

specifying ................................64

percent coverage

specifying ................................64
Geneticist Assistant User’s Manual
Quality metric Report sub-tab on the 
Sample tab .................................242

quality metrics

defined ......................................77

viewing the details for

on the Submission sub-tab on the 
Sample tab............................242

R
Reference database

adding custom fields from to 
various panes and tables for all 
variants....................................261

adding fields from to various panes 
and tables for a selected 
variant .....................................259

reference directory

changing the location of ............59

configuring if you did not configure 
it after the first time that you logged 
into Geneticist Assistant............59

defined ......................................59

Reference information panes on the 
Variant tab..................................254

references

updating ....................................48

region

updating the status comment 
for ............................................200

updating the status for.............200

related patient

adding a comment for .............150

adding a relationship to

in the Related Patients pane on 
the Patient sub-tab on the Patient 
tab .........................................150
359



in the Related Patients pane on 
the Sample Data sub-tab on the 
Sample tab............................237

changing the ownership for

in the Related Patients pane on 
the Patient sub-tab on the Patient 
tab .........................................150

in the Related Patients pane on 
the Sample Data sub-tab on the 
Sample tab............................237

removing a relationship for

in the Related Patients pane on 
the Patient sub-tab on the Patient 
tab .........................................150

in the Related Patients pane on 
the Sample Data sub-tab on the 
Sample tab............................237

setting the permissions for

in the Related Patients pane on 
the Sample Data sub-tab on the 
Sample tab............................237

viewing the information for

in the Related Patients pane on 
the Patient sub-tab on the Patient 
tab .........................................150

viewing the last added comment 
for............................................150

Related Patients pane

on the Patient sub-tab on the 
Patient tab...............................150

on the Sample Data sub-tab on the 
Sample tab ..............................237

relationship

adding to a patient

in the Patient pane on the Patient 
sub-tab on the Patient tab.....146

on the Patients tab ................141

adding to a related patient

in the Related Patients pane on 
the Patient sub-tab on the Patient 
tab .........................................150
360
in the Related Patients pane on 
the Sample Data sub-tab on the 
Sample tab ............................237

removing for a patient .............146

removing for a related patient

in the Related Patients pane on 
the Patient sub-tab on the Patient 
tab .........................................150

in the Related Patients pane on 
the Sample Data sub-tab on the 
Sample tab ............................237

report directory

configuring in Geneticist 
Assistant....................................59

reports

deleting for a patient when saved 
to the database .......................154

deleting for a run when saved to 
the database ...........................207

deleting for a sample when saved 
to the database .......................238

deleting for a variant when saved 
to the database .......................254

viewing for a patient when saved to 
the database ...........................154

viewing for a run when saved to 
the database ...........................207

viewing for a sample when saved 
to the database .......................238

viewing for a variant when saved to 
the database ...........................254

Reports pane

on the Patient sub-tab on the 
Patient tab ...............................154

on the Run tab.........................207

on the Sample Data sub-tab on the 
Sample tab ..............................238

on the Variant tab....................254

Reports sub-tab

on the Panel Statistics tab.......325
Geneticist Assistant User’s Manual
run

adding..................................... 170

adding a comment for

on the Comments pane on the 
Run tab................................. 205

on the Runs tab.................... 183

adding samples to

on the Runs tab.................... 183

applying variant filters to

on the Runs tab............ 182, 193

changing the ownership for

on the Runs tab.................... 182

comparing samples in ............ 181

defined............................ 125, 170

deleting a comment from........ 205

deleting a sample from ........... 195

deleting from the Geneticist 
Assistant database ................. 184

deleting reports for when saved to 
the database........................... 207

editing the values for .............. 180

exporting all variants in to a VCF 
file

on the Runs tab.................... 184

filtering the sample variants 
for ........................................... 181

moving samples to ................. 195

reviewing information for on the 
Runs tab ................................. 179

setting subpanels for

on the Runs tab.................... 184

setting the permissions for

in the Samples pane on the Run 
tab ........................................ 192

on the Runs tab.................... 181

setting the status for ............... 180



viewing reports for when saved to 
the database ...........................207

viewing the last comment added 
for

on the Runs tab ....................183

viewing the panel statistics for

in the Samples pane on the Run 
tab.........................................192

on the Runs tab ....................181

viewing the status for on the Run’s 
Status Changes pane .............204

Run report

generating

custom ..................................271

standard................................267

run status

see also object

defined ......................................55

Run tab

opening ...................................189

overview of..............................189

Reports pane ..........................207

Samples pane .........................189

Run’s Status Changes pane ......204

runs

searching for in the Geneticist 
Assistant database ...................46

Runs tab

changing the number of runs that 
are displayed on .....................180

opening ...................................179

overview of..............................179

S
sample

adding a comment for
in the Samples pane on the Run 
tab .........................................193

on the Sample Data sub-tab on 
the Sample tab......................234

adding to a sample group

in the Samples pane on the Run 
tab .........................................195

associating a patient with

in the Samples pane on the Run 
tab .........................................194

on the Sample Data sub-tab on 
the Sample tab......................236

automatically associating with a 
patient based on sample file 
names .....................................127

changing the ownership for

in the Associated Samples pane 
on the Variant tab .................253

in the Samples pane on the Run 
tab .........................................192

confirming the identify of using a 
barcode ...................................316

creating Batch Variants report for

in the Associated Samples pane 
on the Variant tab .................253

in the Samples pane on the Run 
tab .........................................196

in the Samples pane on the 
Samples sub-tab on the Patient 
tab .........................................157

deleting a comment for ...........234

deleting a variant from

on the Sample Variant Data sub-
tab on the Sample tab...........228

deleting from a run ..................195

deleting reports for when saved to 
the database ...........................238

displaying the coverage for in a run

fromthe Samples pane on the 
Run tab .................................191
Geneticist Assistant User’s Manual
exporting all the variants in to a 
VCF file

in in the Associated Samples 
pane on the Variant tab.........253

in the Samples pane on the Run 
tab ................................ 191, 196

in the Samples pane on the 
Samples sub-tab on the Patient 
tab .........................................157

exporting all variants in to a VCF 
file

on the Sample Variant Data sub-
tab on the Sample tab...........230

on the Variants sub-tab on the 
Patient tab.............................168

exporting selected variants in to a 
VCF file

on the Sample Variant Data sub-
tab on the Sample tab...........230

on the Variants sub-tab on the 
Patient tab.............................168

filtering the variants in with a 
template

in the Samples pane on the Run 
tab .........................................191

generating a Batch Coverage 
report for

in the Samples pane on the 
Associated Samples sub-tab on 
the Variant tab.......................253

in the Samples pane on the Run 
tab .........................................196

in the Samples pane on the 
Samples sub-tab on the Patient 
tab .........................................157

on the Runs tab.....................184

generating a Batch Variants report 
for

on the Runs tab.....................184
361



generating a Sample report for

in the Associated Samples pane 
on the Variant tab .................253

in the Samples pane on the Run 
tab .........................................196

in the Samples pane on the 
Samples sub-tab on the Patien 
tab .........................................157

on the Runs tab ....................184

making a variant filter persistent 
for..............................................69

removing from a sample group

in the Samples pane on the Run 
tab .........................................195

setting the permissions for

in the Associated Samples pane 
on the Variant tab .................252

in the Samples pane on the 
Samples sub-tab on the Patient 
tab .........................................157

setting the status for................190

setting the subpanel for...........194

viewing all variants in filtered by a 
panel

on the Sample Variant Data sub-
tab on the Sample tab...........223

on the Variants sub-tab on the 
Patient tab.............................161

viewing information for

in the Samples pane on the Run 
tab .........................................189

on the Samples sub-tab (Panel 
Statistics tab) ........................323

viewing reports for when saved to 
the database ...........................238

viewing the applicable variant 
interpretations for ....................238

viewing the comments for .......234
362
viewing the coverage information

in the Associated Samples pane 
on the Variant tab..................252

in the Samples pane on the 
Samples sub-tab on the Patient 
tab .........................................156

viewing the details for

in the Samples pane on the Run 
tab .........................................191

in the Samples pane on the 
Samples sub-tab on the Patient 
tab .........................................156

viewing the details for all the 
variants in that were used to define 
a compound variant 
interpretation ...........................240

viewing the details for the patient 
who is associated with it..........236

viewing the last added comment 
for

in the Samples pane on the Run 
tab .........................................193

viewing the panel statistics for

in the Associated Samples pane 
on the Variant tab..................252

in the Samples pane on the 
Samples sub-tab on the Patient 
tab .........................................156

Sample Data sub-tab on the Sample 
tab ..............................................232

sample group

adding a sample to

in the Samples pane on the Run 
tab .........................................195

managing the statistics for ......222

removing a sample from

in the Samples pane on the Run 
tab .........................................195

sample groups

searching for in the Geneticist 
Assistant database....................46
Geneticist Assistant User’s Manual
Sample PDF Report

generating for all samples in one or 
more runs

on the Runs tab.................... 184

generating for one or more 
samples

in the Samples pane on the Run 
tab ........................................ 196

generating from the Reports menu 
with the Sample tab open....... 286

Sample PDF Report template

adding a Data band to ............ 277

creating new by editing an existing 
template.................................. 284

defined............................ 265, 274

designing ................................ 274

editing..................................... 284

layout...................................... 277

loading in to the Report 
Designer ................................. 284

rendering an onscreen preview 
of ............................................ 284

saving as new......................... 283

Sample report

generating

custom.................................. 271

in the Samples pane on the Run 
tab ........................................ 196

in the Samples pane on the 
Samples sub-tab on the Patient 
tab ........................................ 157

on the Runs tab.................... 184

standard ............................... 267

sample status

see also object

defined...................................... 55



sample status change

adding a comment for .............190

Sample tab

Compound Variant Interpretation 
sub-tab ....................................240

opening ...................................211

overview of..............................211

Quality Metric Report 
sub-tab ....................................242

Sample Data sub-tab ..............232

Comments pane ...................234

Compound Variant 
Interpretations pane..............238

Patient pane .........................236

Related Patients pane ..........237

Reports pane ........................238

Status Changes pane ...........232

Sample Variant Data sub-tab..212

Submission sub-tab ................241

Sample Variant Data sub-tab on the 
Sample tab ................................212

samples

adding to a run

on the Runs tab ....................183

comparing ...............................192

comparing in a run ..................181

finding those that contain specific 
variants ...................................301

generating a Sample PDF report 
for

from the Reports menu with the 
Sample tab open ..................286

in the Samples pane on the Run 
tab.........................................196

on the Runs tab ....................184

moving to a run .......................195
searching for in the Geneticist 
Assistant database....................46

showing all that contain all 
selected variants

on the Sample Variant Data sub-
tab on the Sample tab...........223

on the Variants sub-tab on the 
Patient tab.............................161

showing all that contain any 
selected variants

on the Sample Variant Data sub-
tab on the Sample tab...........223

on the Variants sub-tab on the 
Patient tab.............................161

Samples pane on the Run tab ...189

Samples sub-tab

on the Panel Statistics tab ......323

on the Patient tab....................155

SoftGenetics license server

installing ....................................16

modifying the settings for ..........62

Special information about the 
manual ...........................................9

standard reports

Action List report .....................267

Coverage Regions report........267

generating ...............................267

Panel Statistics report .............267

Run report ...............................267

Sample report .........................267

Variant report ..........................267

starting and loggin to to Geneticist 
Assistant ......................................20

statistics

managing for a sample 
group.......................................222
Geneticist Assistant User’s Manual
status

setting for a panel region.........200

setting for a run .......................180

setting for a sample.................190

updating for a region ...............200

viewing for a run on the Run’s 
Status Changes pane..............204

status bar on Geneticist Assistant 
main window ................................29

Status Changes pane on the Sample 
Data sub-tab on the Sample 
tab ..............................................232

submission

defined ....................................305

viewing the details for

on the Submission sub-tab on the 
Sample tab............................241

on the Submissions tab.........315

Submission sub-tab on the Sample 
tab ..............................................241

Submissions tab.........................315

subpanel

adding .....................................119

building a BED file for..............120

defined ...................103, 105, 119

deleting....................................122

setting for a run

on the Runs tab.....................184

setting for a single sample ......194

supporting information

adding for a variant and/or 
pathogenicity change ..............256

Supporting Information pane on the 
Variant tab..................................249

system recommendations for 
Geneticist Assistant .....................15
363



T
tab pane

filtering the data that is displayed in 
it ................................................32

tabs on Geneticist Assistant main 
window .........................................28

template

designing for a Sample PDF 
report.......................................274

text fields

adding to a Data band.............279

title bar on Geneticist Assistant main 
window .........................................27

toolbar on Geneticist Assistant main 
window .........................................28

tools

BED File Builder......................289

Convert VCF File to BED 
File ..........................................293

Delete Pathogenicity Changes 
tool ..........................................295

Finding Samples with 
Variants ...................................301

Import Variants........................297

Merge BAM Files ....................303

transcript

selecting a different one for a 
variant

on the Sample Variant Data sub-
tab on the Sample tab...........220

on the Variants sub-tab on the 
Patient tab.............................159

specifying the one that is to be 
used for a gene in a panel ......110
364
type

editing for a variant

on the Sample Variant Data sub-
tab on the Sample tab ...........221

on the Variants sub-tab on the 
Patient tab .............................159

U
UCSC

viewing variants in

on the Sample Variant Data sub-
tab on the Sample tab ...........229

on the Variants sub-tab on the 
Patient tab .............................167

upgrading Geneticist Assistant ....26

user

adding .......................................87

adding to a group ......................93

defined ......................................87

deleting......................................89

editing........................................90

inactivating ................................90

modifying the permissions for ...90

user interface for the Sample PDF 
Report Designer .........................274

Using the manual ...........................9

V
value

adding for an object...................56

deleting from an object..............58

editing for an object...................57
Geneticist Assistant User’s Manual
variant

adding a comment for

in the Variant Comments pane on 
the Variant tab...................... 250

in the Variant pane on the Variant 
tab ........................................ 247

on the Sample Variant Data sub-
tab on the Sample tab .. 221, 224

on the Variants sub-tab on the 
Patient tab .................... 159, 162

adding an interpretation for .... 222

on the Sample Variant Data sub-
tab on the Sample tab .......... 224

on the Variants sub-tab on the 
Patient tab .................... 160, 162

adding supporting information 
for ........................................... 256

adding to an Action list ........... 230

deleting a comment for........... 251

in the Variant Comments pane on 
the Variant tab...................... 250

deleting from a specific patient 
sample

on the Variants sub-tab on the 
Patient tab ............................ 166

deleting from a specific sample

on the Sample Variant Data sub-
tab on the Sample tab .......... 228

deleting from all samples in which 
it was found

on the Sample Variant Data sub-
tab on the Sample tab .......... 229

on the Variants sub-tab on the 
Patient tab ............................ 167

deleting reports for when saved to 
the database........................... 254

editing the HGVS information for

on the Sample Variant Data sub-
tab on the Sample tab .......... 221



on the Variants sub-tab on the 
Patient tab ............................159

editing the type for

on the Sample Variant Data sub-
tab on the Sample tab ..........221

on the Variants sub-tab on the 
Patient tab ............................159

editing the zygosity for

on the Sample Variant Data sub-
tab on the Sample tab ..........221

selecting a different gene for

on the Sample Variant Data sub-
tab on the Sample tab ..........220

on the Variants sub-tab on the 
Patient tab ............................158

selecting a different transcript for

on the Sample Variant Data sub-
tab on the Sample tab ..........220

on the Variants sub-tab on the 
Patient tab ............................159

setting the same artifact type for 
multiple variants in a panel .....297

setting the same pathogenicity for 
multiple variants in a panel .....297

specifying the pathogenicity 
highlighting color for..................65

updating the artifact type for

on the Sample Variant Data sub-
tab on the Sample tab ..........227

on the Variants sub-tab on the 
Patient tab ............................165

updating the pathogenicity for

on the Sample Variant Data sub-
tab on the Sample tab ..........225

on the Variants sub-tab on the 
Patient tab ............................163

updating the pathogenicity status 
for

on the Sample Variant Data sub-
tab on the Sample tab ..........226
on the Variants sub-tab on the 
Patient tab.............................164

updating the preferred transcript 
for

on the Sample Variant Data sub-
tab on the Sample tab...........228

on the Variants sub-tab on the 
Patient tab.............................166

viewing reports for when saved to 
the database ...........................254

viewing the comments for .......250

viewing the details for

in the Variant pane on the Variant 
tab .........................................247

on the Sample Data sub-tab on 
the Sample tab......................223

viewing the last comment added 
for

in the Variant pane on the Variant 
tab .........................................247

on the Sample Variant Data sub-
tab on the Sample tab...........224

on the Variants sub-tab on the 
Patient tab.............................162

viewing the PubMed abstract for

on the Sample Variant Data sub-
tab on the Sample tab...........230

on the Variants sub-tab on the 
Patient tab.............................167

Variant Changes pane on the 
Variant tab .................................251

Variant Comments pane

on the Variant tab....................250

variant filter

creating from selected variants

on the Sample Variant Data sub-
tab on the Sample tab...........231

on the Variants sub-tab on the 
Patient tab.............................168
Geneticist Assistant User’s Manual
making persistent for a 
sample.......................................69

variant filters

applying to a run

on the Runs tab............ 182, 193

Variant information panes on the 
Variant tab..................................246

variant interpretations

viewing those applicable for a 
sample.....................................238

Variant pane on the Variant 
tab ..............................................247

variant preferences

applying shared display 
preferences ...............................69

clearing all shared 
preferences ...............................69

defined ......................................70

Variant report

generating

custom ..................................271

standard ................................267

Variant tab

Artifact Changes pane.............251

Associated Samples pane.......252

CIViC Data pane .....................254

Clinvar pane ............................255

dbNSFP pane..........................255

dbSNP pane............................254

Exome Aggregation Consortium 
pane ........................................255

Exome Variant Server pane ....254

Gene Phenotypes pane ..........254

LOVD pane .............................254

OMIM pane .............................254

opening ...................................245
365



overview of ..............................245

Pathogenicity Changes pane ..251

Reference information panes ..254

Reports pane ..........................254

Supporting Information pane...249

Variant Changes pane ............251

Variant Comments pane .........250

Variant information panes .......246

Variant pane............................247

World-Wide LOVD pane .........254

variants

adding a comment for in a panel 
group .......................................297

adding an interpretation for

on the Sample Variant Data sub-
tab on the Sample tab...........224

on the Variants sub-tab on the 
Patient tab.............................162

all samples that contain all 
selected

on the Sample Variant Data sub-
tab on the Sample tab...........223

on the Variants sub-tab on the 
Patient tab.............................161

all samples that contain any 
selected

on the Sample Variant Data sub-
tab on the Sample tab...........223

on the Variants sub-tab on the 
Patient tab.............................161

displaying all for a sample filtered 
by a panel

on the Sample Variant Data sub-
tab on the Sample tab...........223

displaying all in a sample filtered 
by a panel

on the Variants sub-tab on the 
Patient tab.............................161
366
exporting all in a run to a VCF file

on the Runs tab.....................184

exporting all in a sample to a VCF 
file

in the Associated Samples pane 
on the Variant tab..................253

in the Samples pane on the Run 
tab .........................................196

in the Samples pane on the 
Samples sub-tab on the Patient 
tab .........................................157

on the Sample Variant Data sub-
tab on the Sample tab ...........230

on the Variants sub-tab on the 
Patient tab .............................168

exporting all in a selected sample 
to a VCF file

in the Samples pane on the Run 
tab .........................................191

exporting selected ones in a 
sample to a VCF file

on the Sample Variant Data sub-
tab on the Sample tab ...........230

on the Variants sub-tab on the 
Patient tab .............................168

filtering for samples in a run ....181

filtering with a panel for a sample

in the Samples pane on the Run 
tab .........................................191

filtering with a template in a sample

in the Samples pane on the Run 
tab .........................................191

finding specific samples with ...301

importing into the Geneticist 
Assistant database..................297

searching for in the Geneticist 
Assistant database....................46

selecting to create a variant filter

on the Sample Variant Data sub-
tab on the Sample tab ...........231
Geneticist Assistant User’s Manual
on the Variants sub-tab on the 
Patient tab ............................ 168

setting the artifact type for in a 
panel group ............................ 297

setting the pathogenicity for in a 
panel group ............................ 297

setting the pathogenicity status for 
in a panel group...................... 297

specifying display preferences 
for ............................................. 70

viewing a list of in all the samples 
associated with a patient ........ 158

viewing in a sample filtered by 
panel

in the Associated Samples pane 
on the Variant tab................. 252

in the Samples pane on the 
Samples sub-tab on the Patient 
tab ........................................ 156

viewing in Alamut

on the Sample Variant Data sub-
tab on the Sample tab .......... 229

on the Variants sub-tab on the 
Patient tab ............................ 167

viewing in IGV

in the Associated Samples pane 
on the Variant tab................. 253

in the Samples pane on the Run 
tab ........................................ 196

on the Sample Variant Data sub-
tab on the Sample tab .......... 229

on the Samples sub-tab on the 
Patient tab ............................ 157

on the Variants sub-tab on the 
Patient tab ............................ 167

viewing in the NextGENe viewer

in the Associated Samples pane 
on the Variant tab................. 253

in the Sample Variant Data sub-
tab on the Sample tab .......... 229



in the Samples pane on the Run 
tab.........................................195

on the Samples sub-tab on the 
Patient tab ............................157

viewing in UCSC

on the Sample Variant Data sub-
tab on the Sample tab ..........229

on the Variants sub-tab on the 
Patient tab ............................167

viewing the details for all those 
used to define a compound variant 
interpretation...........................240

Variants sub-tab

on the Panel Statistics tab ......324

on the Patient tab....................158

VCF file

creating from a BED file ..........293

exporting all variants in a selected 
sample to

in the Samples pane on the Run 
tab.........................................191

W
web user

adding .......................................98

defined ......................................98

deleting .....................................99

editing .....................................100

Windows OS

installing Geneticist Assistant 
on ..............................................17

World-Wide LOVD pane on the 
Variant tab .................................254
Z
zygosity

editing for a variant

on the Sample Variant Data sub-
tab on the Sample tab...........221
Geneticist Assistant User’s Manual
 367



368
 Geneticist Assistant User’s Manual


	Preface
	Chapter 1: Getting Started with Geneticist Assistant
	Geneticist Assistant System Recommendations
	Installing the SoftGenetics License Server
	Installing Geneticist Assistant on a Windows OS
	Starting and Logging in to Geneticist Assistant
	To start to Geneticist Assistant
	To log in to Geneticist Assistant
	To run a trial version of Geneticist Assistant
	To run a purchased version of Geneticist Assistant
	To log out of Geneticist Assistant

	Upgrading Geneticist Assistant
	The Geneticist Assistant Main Window
	Title bar
	Main menu
	Toolbar
	Main window tabs
	Status bar
	Console

	Setting Display Preferences in the Geneticist Assistant Main Window
	To navigate multiple open tabs/Navigate tabs with a minimized main window
	To close multiple tabs in a single step
	To filter the data that is displayed in a tab pane
	To load a saved filter template
	To delete a saved filter template

	To show/hide columns in a tab pane
	To manage tab pane configurations
	To load a pane configuration
	To create/edit a pane configuration
	To delete a pane configuration

	To change the widths of data columns
	To rearrange the order of data columns
	To change the sort order of data
	To rename column headers
	To select data to be included in a custom report

	Searching the Geneticist Assistant Database
	Updating References
	To update a reference

	Reviewing the Database Log
	Backing up the Geneticist Assistant Database
	To back up the Geneticist Assistant database


	Chapter 2: Geneticist Assistant Setup and Maintenance
	Managing Objects in the Geneticist Assistant Database
	To add a value for an object
	To edit an object
	To delete a value from an object

	Specifying your Geneticist Assistant Settings
	To configure Geneticist Assistant directories
	To configure proxy server settings
	To edit the SoftGenetics license server settings
	To specify an encryption key for patient data
	To specify the global Quality Control settings
	To specify the highlighting colors for variants of a pathogenicity
	To specify a basic highlighting color for a pathogenicity
	To specify a custom highlighting color for a pathogenicity

	To set the font for data column headers and/or content
	To apply shared preferences or to clear all tab preferences
	To specify variant preferences
	To specify the Geneticist Assistant password requirements
	To specify third-party (Alamut, IGV, OMIM) settings
	To specify the Alamut settings
	To specify the IGV settings
	To specify the OMIM settings


	Managing Quality Metrics
	Data Source template file
	To add a new metric profile
	To add a new metric profile by copying an existing profile
	To delete a metric profile


	Chapter 3: Geneticist Assistant User Management
	Managing Users
	To add a new user
	To delete a user
	To edit a user

	Managing Groups
	To add a new group
	To delete a group
	To edit a group

	Managing Web Users
	To add a new web user
	To delete a web user
	To edit a web user


	Chapter 4: Managing Panels and Subpanels
	Importing a Panel
	To import a panel
	To manually set new coverage thresholds for panel regions
	To create a QC Threshold file for panel regions
	To set new coverage thresholds for panel regions with a QC Threshold file
	To set or delete a preferred transcript list for a panel
	To set or delete a preferred gene for a panel
	To create a new BED file for a panel by adding or deleting regions


	Editing a Panel
	To edit a panel

	Deleting a Panel
	To delete a panel

	Reviewing Panel Statistics
	To review panel statistics

	Adding a Subpanel
	To add a subpanel
	To create a new BED file for a subpanel by adding or deleting regions

	Deleting a Subpanel
	To delete a subpanel


	Chapter 5: Managing Patients and Runs
	Adding Patients
	To add one patient at a time
	To import a Patients batch file
	To add patients to the Geneticist Assistant database with encryption enabled
	To add patients to the Geneticist Assistant database without encryption

	To import a Submissions batch file

	Accessing and Reviewing Patient Records
	To review existing patient information on the Patients tab
	To edit the identifying information and/or comment for a patient
	To use the context menu for a patient (Patients tab)
	To add or edit custom fields on a per patient basis


	To review existing patient information on the Patient tab
	Patient tab, Patient sub-tab
	Patient tab, Patient sub-tab, Patient pane
	Patient tab, Patient sub-tab, Phenotype pane
	Patient tab, Patient sub-tab, Related Patients pane
	Patient tab, Patient sub-tab, Comments pane
	Patient tab, Patient sub-tab, Reports pane
	Patient tab, Patient sub-tab, Barcodes pane

	Patient tab, Samples sub-tab
	Patient tab, Variants sub-tab
	Patient tab, Variants sub-tab context menu



	Adding a Run
	To add a run


	Chapter 6: Geneticist Assistant Data Review - Runs Tab
	Overview of the Runs Tab
	To change the number of runs displayed on the Runs tab
	To edit values for a selected run

	The Runs Tab Context Menu

	Chapter 7: Geneticist Assistant Data Review - Run Tab
	Overview of the Run Tab
	Samples pane (Run tab)
	To set the sample status

	The Samples Pane (Run tab) Context Menu
	To compare family data
	Coverage Regions tab

	Status Changes pane (Run tab)
	Comments pane (Run tab)
	Reports pane (Run tab)

	Chapter 8: Geneticist Assistant Data Review - Sample Tab
	Overview of the Sample Tab
	Sample Variant Data Sub-Tab
	Variant annotation information
	Global variant count and frequency information
	Sample group statistical information
	Variant options on the Sample Variant Data sub-tab
	Sample Variant Data sub-tab context menu

	Sample Data Sub-Tab
	Status Changes pane (Sample tab, Sample Data sub-tab)
	Comments pane (Sample Data sub-tab on the Sample tab)
	Patient pane (Sample Data sub-tab for the Sample tab)
	Related Patients pane (Sample Data sub-tab for the Sample tab)
	Compound Variant Interpretations pane
	Reports pane (Sample data sub-tab on the Sample tab)

	Compound Variant Interpretation Sub-Tab
	Submission Sub-Tab
	Quality Metric Report Sub-Tab

	Chapter 9: Geneticist Assistant Data Review - Variant Tab
	Overview of the Variant Tab
	Variant information panes
	Variant pane
	Supporting Information pane
	Variant Comments pane
	Variant Interpretations pane
	Pathogenicity Changes pane
	Artifact Changes pane
	Variant Changes pane
	Associated Samples pane
	Variant’s Reports pane
	Gene Phenotypes pane

	Reference information panes

	Working with Reference Information Panes on the Variant Tab
	To add supporting information for a variant
	To add fields from a reference database to variant tables and panes
	To add a custom field to variant tables and panes


	Chapter 10: Geneticist Assistant Reports
	Generating a Standard Report
	To generate a standard report

	Generating a Custom Report
	To generate a custom report

	Designing a Sample PDF Report Template
	The PDF Report Designer user interface
	Object Inspector toolbar

	Sample PDF Report template layout
	To add Data bands to a Sample PDF Report template
	To add and arrange Data band items
	To add a database field to a Data band
	To add a text field to a Data band
	To add an image to a Data band
	To arrange items in a Data band

	To save a new Sample PDF Report template

	Other PDF Sample Report Template options

	Generating a Sample PDF Report
	To generate a Sample PDF report


	Chapter 11: Geneticist Assistant Tools
	Building a BED File with the BED File Builder Tool
	To build a BED file with the BED File Builder tool

	Convert VCF File to a BED File Tool
	To convert a VCF file to a BED file

	Deleting Pathogenicity Changes with the Delete Pathogenicity Changes Tool
	To delete historical pathogenicity changes with the Delete Pathogenicity Changes tool

	Importing Variants with the Import Variants Tool
	To import variants with the Import Variants tool
	To import the variants’ pathogenicities, pathogenicity statuses, comments, and/or artifact types
	To manually define the variants’ pathogenicities, pathogenicity statuses, comments, and/or artifact types


	Find Samples with Variants Tool
	To find samples with specific variants with the Find Samples with Variants tool

	Merging BAM Files with the Merge BAM Files Tool
	To merge BAM files


	Chapter 12: The Geneticist Assistant Customer Portal and Submissions
	Logging in to the Geneticist Assistant Customer Portal
	To log in to the Geneticist Assistant customer portal

	The Geneticist Assistant Customer Portal Layout
	Submitting Patient/Sample Tracking Information through the Geneticist Assistant Customer Portal
	To submit patient/sample tracking information through the customer portal

	The Submissions Tab
	To use the barcode to confirm sample identity


	Appendix A: Common Procedures
	Reviewing Panel Statistics
	To review panel statistics
	Coverage Regions sub-tab (Panel Statistics tab)
	Samples sub-tab (Panel Statistics tab)
	Variants sub-tab (Panel Statistics tab)
	Patients sub-tab (Panel Statistics tab)
	Reports sub-tab (Panel Statistics tab)


	Setting Read and Write Permissions
	To set Read and Write permissions for a patient, sample, or run

	Managing a Batch Variants Report
	To generate a Batch Variants report based on a new configuration
	To generate a Batch Variants report based on a saved configuration
	To delete a Batch Variants Report configuration

	Generating a Batch Coverage Report
	To generate a Batch Coverage report

	Creating an Action List
	To create an Action list

	Comparing Samples in a Run
	To compare samples in a run

	Adding a Variant Interpretation
	To add a variant interpretation


	Glossary
	Index

